
Welcome to M.Y.O.B. Help!
Click a command centre icon to get help for that command centre, or click the name of a menu for help about that 
menu.

 

 

 

 

 

File menu
Edit menu
Setup menu
Reports menu
Windows menu
Form menu 
Help menu

For nominal information about using M.Y.O.B., click the Search button at the top of the window.

For help about the on-line help system, press F1.



File menu
The File menu contains windows that allow you to perform various maintenance tasks within M.Y.O.B. These 
procedures describe how to use the windows that are opened using the File menu. 

New command 
Open command 
Save command 
Revert to Saved command 
Backup command 
Restore command 
Purge Journal Entries command 
Purge Closed Sales command 
Purge Closed Purchases command 
Purge Contact Logs command 
Start a New Financial Year command 
Import Data command 
Export Data command 



Edit menu
The Edit menu contains commands that allow you to work with the information that appears in M.Y.O.B. windows. 
These procedures describe how to use the Edit menu's commands. 

Undo command 
Cut command 
Copy command 
Paste command 
Clear command 
Reverse command 
Select All command 
Deselect All command 
Select from List command 
Recap Transaction command 



Setup menu
The Setup menu contains windows that allow you to prepare your M.Y.O.B. system for use. These procedures 
describe how to use the windows that are opened using the Setup menu. 

Set Up M.Y.O.B. command 
Preferences command 
VAT Codes command 
Company Information command 
Linked Accounts command 
Balances command 



Reports menu
The Reports menu allows you to select and print all reports in the M.Y.O.B. system. You can set up the batch printing 
feature using this menu, as well.

These topics contain information about working with the reports available from the Reports menu.

Page Setup selections 
Locating a report 
Printing a report to the computer screen 
Using fonts in reports 
Choosing a font for forms and reports 
Customising forms and reports with default fonts 
Using wildcards 
Batch reporting 
Creating a report batch 
Editing a report batch 
Printing a report batch 
Filtering reports in a batch 



Windows menu
The Windows menu works in the same way as the standard Windows menu in any Windows software program. Refer
to your Windows documentation for information about using the Windows menu.



Form menu
The Form menu allows you to work with various parts of the cheques, invoices, purchase orders and statements you 
create using M.Y.O.B.

These topics contain information about working with forms.

Working with forms 
Do you need to customise your forms? 
Finding the Customise Forms window 
Selecting a field 
Changing the size of a field 
Changing the location of a field 
Cutting, copying, pasting and deleting data fields 
Changing the font, size and style of a field 
Saving a customised form 
Printing a customised form 
Customising a cheque 
Customising a purchase order 
Customising an invoice 
Customising a statement 
Customising a mailing label 



Help menu
The M.Y.O.B. Help menu is labelled "Help" and is the rightmost menu in the menu bar.    

See also
Using M.Y.O.B. on-line help 



Nominal Ledger Command Centre
The Nominal Ledger Command Centre allows you to set up and maintain your chart of accounts, enter nominal 
transactions into the M.Y.O.B. system, track your business's jobs and review the status of your company's journals, 
balance sheet and profit and loss statement.

For information about the windows you can access in this command centre, click any of the buttons in the illustration 
below.

Click a topic below for information about using the Nominal Ledger Command Centre:

Working with your chart of accounts 
Entering Nominal Journal transactions 
Using the Transaction Journal window 
Using the To Do List window 
Analysing your account information 
Using the Inquiry Register window 



Chequebook Command Centre
The Chequebook Command Centre allows you to work with your company's accounts with bank privileges, such as 
your bank, petty cash and credit card accounts. In this command centre, you can record withdrawals and deposits, 
reconcile accounts and review the status of your bank accounts.

For information about the windows you can access in this command centre, click any of the buttons in the illustration 
below.

Click a topic below for information about using the Chequebook Command Centre:

Using your bank accounts in the Chequebook Command Centre 
Writing cheques and making withdrawals 
Printing cheques 
Making deposits 
Reconciling accounts 
Using the Transaction Journal window 
Using the To Do List window 
Using the Cash Flow worksheet 
Using the Inquiry Register window 



Sales Ledger Command Centre
The Sales Ledger Command Centre allows you to record and print invoices, apply payments from customers, settle 
sales transactions, print customer statements and analyse the current status of your sales activity. 

For information about the windows you can access in this command centre, click any of the buttons in the illustration 
below. 

 

Click a topic below for information about using the Sales Ledger Command Centre:

General information about the Sales Ledger Command Centre 
Working with item invoices 
Working with service invoices 
Working with professional invoices 
Working with other sales 
Working with pending invoices 
Recording payments from customers 
Settling credits and writing refund cheques 
Working with a cash drawer 
Using M.Y.O.B. as a point-of-sale system 
Using the Transaction Journal window 
Using the To Do List window
Using the Inquiry Register window 



Purchase Ledger Command Centre
The Purchase Ledger Command Centre allows you to record and print purchase orders, make payments to suppliers,
settle purchasing transactions and analyse the current status of your purchasing activity.

For information about the windows you can access in this command centre, click any of the buttons in the illustration 
below.

Click a topic below for information about using the Purchase Ledger Command Centre:

Types of purchasing transactions 
Working with item purchase orders 
Working with service purchase orders 
Working with professional purchase orders 
Working with other purchases 
Working with pending purchase orders 
Paying your bills 
Settling debits and receiving refund cheques 
Using the Transaction Journal window 
Using the To Do List window 
Using the Inquiry Register window 



Stock Control Command Centre
The Stock Control Command Centre allows you to track the status of the items and services stored, sold and 
purchased by your company.

For information about the windows you can access in this command centre, click any of the buttons in the illustration 
below.

Click a topic below for information about using the Stock Control Command Centre:

How M.Y.O.B. Stock Control works 
Working with item records 
Adjusting stock 
Counting stock 
Transferring stock 
Auto-building stock 
Using the Transaction Journal window 
Using the To Do List window 
Analysing stock 
Using the Inquiry Register window 



Card File Command Centre
The Card File Command Centre allows you to work with the records of your customers, suppliers, employees and 
personal contacts. In this command centre, you can create and print mailing labels and personalised letters, organise 
your Card File records by assigning special identifiers to each record, and create a special group of records for 
people you frequently contact.

For information about the windows you can access in this command centre, click any of the buttons in the illustration 
below.

Click a topic below for information about using the Card File Command Centre:

Working with the Card File 
Working with the Contact Log 
Creating personalised letters 
Creative uses for the Card File and Contact Log 
Using the To Do List window 
Using the Inquiry Register window 



Using M.Y.O.B. windows
Most M.Y.O.B. windows work in the same way as standard Windows windows.

With the exception of M.Y.O.B.'s command centres, M.Y.O.B. windows work just like the standard windows you're 
accustomed to.

Data entry windows, such as Sales, Card File Entry and Write Paycheques, contain standard title bars, scroll bars 
and control menus. You can have as many data entry windows open as you want.

Response windows, such as Print Cheques, Ageing Date and Select from List, require that you enter information 
into them or make a selection from them before you open another window. These windows usually allow you to set 
criteria of some sort before the next window is opened. Although you can move these windows around on your 
desktop, you can't access other M.Y.O.B. windows until the response window is closed.

Refer to the documentation for your computer you're using for more information about using standard windows.



Using M.Y.O.B. command centres
M.Y.O.B.'s command centres are all located in one central place.

This central location is the Command Centre window. The Command Centre window displays the name of the 
company you're working with and the current date.

M.Y.O.B.'s command centres contain a row of icons in the top half of the window, which represent the six divisions of 
M.Y.O.B. Each time you view the Command Centre window, one of the icons is highlighted, and a flowchart of tasks 
is displayed below the row of icons. The highlighted icon is the current command centre, and the flowchart displayed 
below the row of icons contains the major tasks associated with that command centre. For example, when the 
Chequebook icon is highlighted, tasks such as Write Cheques and Make a Deposit - typical tasks you'd complete with
a chequebook - are displayed in the flowchart.

Each command centre also includes the M.Y.O.B. Analyst, which is a "miniature command centre" that contains 
various analysis functions that are specific to the command centre that's displayed. See Using the M.Y.O.B. Analyst.

To display a command centre, click once on the icon whose flowchart you want to see, or select a command centre 
name from the Command Centre menu at the top of your computer screen.

Tasks are accessed from command centres simply by clicking once on the name of a task. When you select a task, a 
window will appear, where you can make the necessary entries to perform the task.



Using the M.Y.O.B. Analyst
The M.Y.O.B. Analyst, found in each command centre, is a "miniature command centre" that contains various 
analysis functions that are specific to the command centre that's displayed. The To Do List is also included in each 
command centre's M.Y.O.B. Analyst.

To display a specific M.Y.O.B. Analyst, display the command centre that the Analyst is associated with. To access a 
window from the Analyst, click once on the appropriate button.

The following windows are opened from the M.Y.O.B. Analyst:

Command Centre M.Y.O.B. Analyst windows
Nominal Ledger To Do List

Analyse Balance Sheet
Analyse Profit & Loss
Inquiry Register

Chequebook To Do List
Cash Flow Worksheet
Inquiry Register

Sales Ledger To Do List
Analyse Sales
Analyse Debtors
Inquiry Register

Purchase Ledger To Do List
Analyse Creditors
Inquiry Register

Stock Control To Do List
Analyse Stock
Inquiry Register

Card File To Do List
Inquiry Register



Using M.Y.O.B. icons
A number of icons are used throughout M.Y.O.B. to help speed data entry and simplify the ways you access windows 
in M.Y.O.B. These icons are described below. 

Zoom arrows, displayed next to various fields throughout M.Y.O.B., allow you to review, or "zoom," to more detailed 
information about a specific topic, such as a transaction or customer record. This detailed information usually is 
located in the window in which the topic was originally entered. For example, the Payee field of the Write Paycheques
window has a zoom arrow next to it; when an employee name is displayed in this field, clicking the zoom arrow will 
open the Card File Entry window, where you originally entered information about the employee.

Two types of zoom arrows can appear next to transaction numbers:

* A white zoom arrow indicates that you can zoom to more detailed information about a transaction and make 
changes or delete the transaction, if you wish.

* A grey zoom arrow allows you to zoom to more detailed information about a transaction only. If you wish to change 
information that's display-only, you must reverse the transaction information. Grey zoom arrows also appear next to a 
transaction if the transaction has been purged.

Stock transaction numbers don't have zoom arrows next to them.

Search icons, displayed next to various fields throughout M.Y.O.B., allow you to open search list windows that 
contain records you've previously entered into the M.Y.O.B. system, such as customers and delivery methods. You 
can then select a record from the search list to appear in the field.

The search icon appears next to a field only when an entry in the field is optional. If a name is required in a field, you 
can open a search list by pressing TAB or ENTER (whichever key you're using to move from one field to another).



Using search lists
Search lists allow you to choose existing records quickly.

M.Y.O.B. provides a system of search lists that allow you to choose existing records quickly and accurately. Search 
lists, titled "Select from List," are available for every field where you must enter the name or number of a record 
you've created in M.Y.O.B., such as: 

* Accounts you entered in the Edit Accounts window

* Items you entered in the Item Information window

* Customers, suppliers, employees and personal contacts you entered in the Card File Entry window

* Jobs you entered in the New Job window

When you open a search list, the possible selections you can make for the field you opened the search list from are 
displayed. For example, if you open a search list from a Customer field, only customer names will appear in the list. 
Double-click the selection you want; the search list will disappear and the selection you made will be displayed. 

You can open a search list from a field in a few different ways:

* Click the search icon next to the field.

* Leave the field blank, then press TAB or ENTER (whichever key you're using to move from one field to another). 

* Leave the field blank, then select the Search command from the Edit menu. (The word "Search" in the menu will be 
followed by the type of record you're searching for; for example, Search Jobs will appear in the Edit menu if the 
highlight is positioned in a Job field.) This method is available only if an entry is required in the field.

You can select a record from the search list in a few different ways, as well:

* If you entered a few characters in the field before you opened the search list, the search list will appear with the 
highlight positioned on the record name or number most closely matching the characters you typed. Select the record
you want, and the selection you made will be displayed.

* If you left the field blank, the search list will appear with the highlight positioned on the first record in the list. Scroll 
through the list and select the record you want; the selection you made will be displayed.

* In the Search for field at the top of the search list, enter as many characters of the record name or number as you 
want, then press TAB or ENTER (whichever key you're using to move from one field to another). The search list will 
disappear, and the first record that matches the characters you typed will be displayed.

You can also create a new record using a search list. To do so, follow these steps:

1. Open a search list.

2. Click the New button at the bottom of the search list. The window used to create the a new record, such as Card 
File Entry, will appear.

3. Enter the new record's information and close the window. The window from which you opened the search list will 
reappear.

4. Open the search list again.

5. Select the new record from the search list. The record name or number will be displayed.



Using Easy-Add
You can enter new records quickly and easily using M.Y.O.B.'s Easy-Add function. Accounts, customers, suppliers, 
employees and personal contacts can be added to your company's records "on the fly" as you perform your daily 
business tasks. 

To create a new record using Easy-Add, open a search list for an account or Card File card, then enter the number or
name you want to add. Click the Easy-Add button at the bottom of the search list; the number or name is added to 
your records. You can then proceed to complete your task with the new account or card. Whenever you have time, go
to the appropriate window (Edit Accounts or Card File Entry) and enter the remainder of the record you added with 
Easy-Add.



Using Easy-Fill
When you're making entries of account numbers and card names in M.Y.O.B., Easy-Fill allows you to do your work a 
little faster. When you're entering an existing name or number, Easy-Fill recognises the entry you're making and 
automatically fills the rest of the entry for you.



Types of fields in M.Y.O.B.
Various types of fields exist in M.Y.O.B., and they all work a little differently to serve their purposes. This section 
summarises the types of fields you'll work with in M.Y.O.B. 

Data entry fields are the most common fields you'll work with in M.Y.O.B. These fields allow you to enter characters -
sometimes letters only, sometimes numbers only, and sometimes both letters and numbers - that you'll eventually 
save into your data file. 

Text fields are data entry fields that allow you to enter more than one line of text. To enter a new line of text, press 
ENTER at the end of a line. Use TAB to move to another field from a text field. 

Buttons come in a few different styles in M.Y.O.B. Generally, the purpose of buttons is to perform an action or step, 
such as opening a window or recording an invoice. 

Radio buttons allow you to make one selection from a number of choices. Referred to as "selections" in M.Y.O.B. 
documentation, radio buttons are selected by clicking the circle next to the text that accompanies it.

Check boxes allow you activate or inactivate a particular M.Y.O.B. function. Also referred to as "selections" in 
M.Y.O.B. documentation, check boxes are selected by clicking the square next to the text that accompanies it. 

Tabs allow you to switch between views in a window, such as the card types in the View Card File window. To select 
a new view, simply click the tab whose view you want. 

See also
Scrolling lists 



Scrolling lists
Scrolling lists are "giant fields" that allow you to perform a number of tasks, including entering and viewing transaction
detail, as well as selecting items.

Scrolling lists differ, depending upon the window they appear in. However, they all work the same in one aspect: if 
there are more items in the list than can be displayed at one time, you can use the scroll bar on the right-hand side of 
the list to "scroll" through the items in the list.

Many scrolling lists, usually in M.Y.O.B.'s transaction entry windows such as the Sales window and Purchases 
window, allow you to make entries in them. The locations where you make these entries work like normal data entry 
fields.



Using your keyboard with M.Y.O.B.
Various keys on your keyboard are used to perform functions in M.Y.O.B. data entry windows. These keys are 
described below. 

In the descriptions below, you'll see a number of references to "tab sequence." The tab sequence is the order in 
which the highlight moves from field to field in a window when you press TAB.

[TAB]    Press the TAB key to move the highlight from a field to the next field in the tab sequence. 

If a field requires an entry before you move to the next field, you must make an entry in the field before you can use 
the TAB key before you move the highlight to the next field.

The TAB key works differently than the DOWN ARROW key. If the highlight is in a text field, pressing the TAB key 
moves the highlight from the text field to the next field in the tab sequence, while pressing the DOWN ARROW key 
moves the highlight to the bottom of the text field instead. 

[SHIFT] [TAB]    Hold down the SHIFT key and press the TAB key to move the highlight from a field to the previous 
field in the tab sequence. 

If a field requires an entry before you move to the previous field, you must make an entry in the field before you can 
use the SHIFT+TAB key combination before you move the highlight to the previous field.

The SHIFT+TAB key combination works differently than the UP ARROW key. If the highlight is in a text field, pressing 
SHIFT+TAB moves the highlight to the previous field in the tab sequence, while pressing UP ARROW moves the 
highlight to the top of the text field.

[DOWN ARROW]    Press the DOWN ARROW key to move the highlight from a field to the next field in the tab 
sequence. 

The DOWN ARROW key works differently than the TAB key. If the highlight is in a text field, pressing the DOWN 
ARROW key moves the highlight to the bottom of the text field, while pressing the TAB key moves the highlight to the 
next field in the tab sequence.

[UP ARROW]    Press the UP ARROW key to move the highlight from a field to the previous field in the tab sequence.

The UP ARROW key works differently than the SHIFT+TAB key combination. If the highlight is in a text field, pressing
the UP ARROW key moves the highlight to the top of the text field, while pressing the SHIFT+TAB combination 
moves the highlight to the previous field in the tab sequence. 

[LEFT ARROW] [RIGHT ARROW]    Press the LEFT ARROW key to move the highlight one character to the left in a 
data entry field. Press the RIGHT ARROW key to move the highlight one character to the right. 

[ENTER]    The ENTER key can be used in a number of ways, depending upon whether you marked the The Enter 
Key Works Like the Tab Key when Entering Data selection in the Preferences window.

If you marked the The Enter Key Works Like the Tab Key when Entering Data selection in the Preferences window, 
pressing the ENTER key in most cases moves the highlight from a field to the next field in the window. Refer to the 
description of the TAB key for more information about how this works.

Most M.Y.O.B. windows have a default button, which is a single button with a thick outline around it. Default buttons 
are usually the most frequently chosen buttons, such as OK or Record.

If you didn't mark the The Enter Key Works Like the Tab Key when Entering Data selection in the Preferences 
window, pressing the ENTER key will, in most cases, click the window's default button.

[CONTROL] [ENTER]    Hold down the CONTROL key and press ENTER to select a window's default button. 

[DELETE]    Press the DELETE key to erase a character in a data entry field or text field. 



Entering dates
Each time you enter a date, M.Y.O.B. checks to be sure you've entered it correctly. However, to make things easier, 
keep the guidelines for entering dates listed below in mind: 

* M.Y.O.B. provides a default date, which is the current date, in each date field. If you want to quickly change a day in 
the same month, enter the day only; the entire date will change to that day. If you want to change a day in a different 
month, enter both the month and the day.

* Each time you enter a date in a date field, be sure to checks you've entered the correct day, month and year.

* Only numbers can be used to enter dates in M.Y.O.B. Don't spell out the name of months, days and years.

* You can enter dates in either Month/Day/Year format or Day/Month/Year format. To set up M.Y.O.B. for the format 
you want to use, select the format using the appropriate control panel on your computer.

* Months, days and years must be separated by a non-numeric character, such as a slash (/), hyphen (-) or period (.).
After you move the highlight to another field, the parts of a date will be automatically separated by slashes, 
regardless of the characters you used to separate the date.

* For the months of January through to September and the first nine days of a month, you don't need to use a zero in 
the number. For example, you only need to type 1/1 for January first, not 01/01. If you wish, however, you can type 
the zero.

* You can either enter the last two numbers of a year in the 20th century, or you can enter all four numbers of a year. 
After you move the highlight to another field, only the last two numbers of the year will be displayed.

* If you need to enter a year after 1999, enter the all four numbers of the year (for example, 2001).    After you move 
the highlight to another field, only the last two numbers of the year will be displayed.

* When you enter transactions, M.Y.O.B. doesn't allow you to enter dates from previous financial years or before your 
conversion month. You can also "lock" previous accounting periods from transaction entries, using the Preferences 
window. These functions prevent you from changing your financial records from closed accounting periods. If you 
attempt to enter a date from such a period, an alert message will appear, informing you of the incorrect entry.

* In the Preferences window, you have the option of displaying an alert message when you enter a date after the 
current date (in other words, a date in the future). You can still use the date if you wish, but you may want to check to 
see whether the date is correct before you continue. The alert message is used merely as a reminder for your 
convenience.

See also
Entering amounts 
Entering percentages 
Entering account numbers 



Entering amounts
Each time you enter an amount, M.Y.O.B. checks to be sure you've entered it correctly. However, to make things 
easier, keep the guidelines for entering amounts listed below in mind: 

* When amounts are displayed on your computer screen, they're comprised of a currency symbol, whole unit amount,
decimal and partial unit amount.

* When you enter an amount, you can enter the currency symbol if you wish, but it's not necessary. After you move 
the highlight to another field, the currency symbol will automatically appear.

* If you're entering a number higher than 999, you can enter a comma to separate numbers if you wish, but it's not 
necessary. After you move the highlight to another field, commas will automatically appear in the appropriate places 
in the amount.

* If you're entering a whole amount only, you don't need to include the decimal and 00 to indicate zero pence. For 
example, if you're entering eight pounds, enter 8; after you move the highlight to a different field, £8.00 will be 
displayed.

* Up to 13 numbers can be entered to the left of a decimal.

* You can use either a period (.) or a comma (,) to designate a decimal. (Select the method you want to use for 
decimals in your computer's appropriate control panel.)

* More than three numbers can be entered to the right of the decimal, but only three numbers will be used. If more 
than three numbers are entered, the decimal amount will be rounded to the nearest decimal. For example, if you 
enter 2345 to the right of the decimal, the number that's displayed after you move the highlight to a different field will 
be 235.

* If you're entering an amount less than one pound, type the decimal before you enter the amount.

See also
Entering dates 
Entering percentages 
Entering account numbers 



Entering percentages
Each time you enter a percentage, M.Y.O.B. checks to be sure you've entered it correctly. However, to make things 
easier, keep the guidelines for entering percentages listed below in mind: 

* When percentages are displayed on your computer screen, they're comprised of a full percentage, decimal, partial 
percentage and percent symbol (%).

* Enter full percentages as whole numbers. For example, if you want to provide a 10 percent discount on a sale, enter
10 as the discount percentage (not .1). M.Y.O.B. will automatically display the percentage as 10%.

* When you enter a percentage, you can enter the percent symbol if you wish, but it's not necessary. After you move 
the highlight to another field, the percent symbol will automatically appear.

* If you're entering a full percentage only, you don't need to include the decimal and 00.

* You can use either a period (.) or a comma (,) to designate a decimal in the percentage. (Select the method you 
want to use for decimals in your computer's appropriate control panel.)

* More than two numbers can be entered to the right of the decimal, but only two numbers will be used. If more than 
two numbers are entered, the decimal percentage will be rounded to the nearest decimal. For example, if you enter 
345 to the right of the decimal, the number that's displayed after you move the highlight to a different field will be 35.

* If you're entering a partial percentage only, type the decimal before you enter the percentage.

See also
Entering dates 
Entering amounts 
Entering account numbers 



Entering account numbers
Each time you enter an account number, M.Y.O.B. checks to be sure you've entered it correctly. However, to make 
things easier, keep the guidelines for entering account numbers listed below in mind: 

* When account numbers are displayed on your computer screen, they're comprised of a prefix, indicating the 
account type of the account; a hyphen; and the last four numbers of the account number.

* When you enter an account number, you can enter the hyphen if you wish, but it's not necessary. After you move 
the highlight to a different field, the hyphen will automatically appear.

* If you don't enter all the numbers of an account number and the numbers you typed are assigned to only one 
account, the remaining numbers for the account will be filled in when you attempt to move the highlight to a different 
field. For example, if you enter 12 and only account number 1-2000 exists in the 1-2000 to 1-2999 range, 1-2000 will 
automatically appear in the field.

* If you don't enter all the numbers of an account number and the numbers you typed are assigned to more than one 
account, the Select from List window will appear when you press TAB or ENTER (whichever key you're using to move
from one field to another). From the list, you can select the account you want to use. You can also create a new 
account using the list.

See also
Entering dates 
Entering amounts 
Entering percentages 



The M.Y.O.B. data file
One data file contains all your company's financial information.

When you make entries in M.Y.O.B., that information is stored within one physical file in your computer, called a data 
file. This single file allows you to work with your company's financial information without expending a lot of time and 
effort with your computer's file storage system. 

You can use M.Y.O.B. to keep accounting records for more than one company. If you do so, one data file will exist for 
each company. A data file is created immediately when you create a new company; if you've already begun using 
M.Y.O.B., you might remember that you created a data file for your company during the M.Y.O.B. Interview process. 
You can also create a new data file by selecting New from the File menu.

M.Y.O.B. is a single-user accounting system; that is, only one person can make entries into M.Y.O.B. at one time. 
You can, however, store your M.Y.O.B. data file on a network, if the file is too large for your hard disk or if you wish to 
access the same data file with different computers at separate times. 

Keep in mind that if you intend to use multiple computers to access the same data file on a network, each computer 
must use a unique copy of M.Y.O.B., registered with a different customer number. In other words, if you wish to use 
three computers to access an M.Y.O.B. data file on a network, your company must have three unique customer 
numbers.

See also
Changing the name of your data file 



Changing the name of your data file
If you want to change the name of the physical file on your computer's hard disk containing M.Y.O.B. data, you can do
so. Follow the steps below.

1. Exit M.Y.O.B.

2. Using Windows File Manager, click once on the data file you want to rename.

3. Select Rename from the File menu; the Rename window will appear.

4. In the To field, enter the new name you want to use for the file, including the extension .DAT at the end of the 
name.

5. Click OK. The new name is assigned to the file.

See also
The M.Y.O.B. data file 



Using the New command
The New command allows you to set up a new data file for a company's financial information. When you create a 
new data file using the New command, you'll start the M.Y.O.B. Setup Interview, which asks you a few important 
questions about your company and creates your data file. 

Immediately after you choose New, an alert message appears, asking you whether you want to save the changes 
you've made to the current data file. Click either Yes or No. Another alert message may appear, asking you whether 
you want to back up the current data file. Make the choice you want; if you choose Yes, M.Y.O.B. creates a backup of 
your data file.

After these messages are complete, an introduction window for the Setup Interview should be visible on your 
computer screen. Click Next to begin the M.Y.O.B. Setup Interview and begin creating your new data file.

Instructions about using the M.Y.O.B. Setup Interview are displayed on your computer screen as you proceed through
the interview. You can also refer to the "Setup" chapter of the Getting Started manual for more information about 
using the Setup Interview.

See also
The M.Y.O.B. data file 



Using the Open command
The Open command allows you to access an existing data file containing a company's financial information. When 
you open an existing data file using the Open command, you'll close the current data file you're working with first. 

Immediately after you choose Open, an alert message appears, asking you whether you want to save the changes 
you've made to the current data file. Click either Yes or No. Another alert message may appear, asking you whether 
you want to back up the current data file. Make the choice you want; if you choose Yes, M.Y.O.B. creates a backup of 
your data file.

After these messages are complete, a dialogue box appears, requesting that you select the data file you want to 
open. Locate the data file, select it and click Open to open it. 

You can also click the Create button in the dialogue box, if you want to create a new data file for a company. This 
button works in the same way as the New command. 

See also
Using the New command 



Using the Save command
When you work with M.Y.O.B., the information you enter isn't saved immediately in your company's data file. Instead, 
this information is stored in a temporary area of your computer's memory until you make the decision to save it in the 
data file. This provides you with the option of exiting M.Y.O.B. without saving incorrect entries in the data file since the
last time you saved changes. 

If you're working in M.Y.O.B. and you want to save the information you've entered since the last time you exited the 
program (or the last time information was saved), choose the Save command from the File menu. We recommend 
that you save your information regularly - every few minutes or hours, depending upon how much work you're doing 
with the program.

If a power fluctuation or computer problem interrupts your work, only the information you've saved in the data file will 
exist; the unsaved information in the temporary area of your computer will most likely be lost.

You can also save the information you've entered when you select Exit or Quit from the File menu. An alert message  
will appear, giving you the option to save your changes before you exit the program.

See also
The M.Y.O.B. data file 
Using the Revert to Saved command 



Using the Revert to Saved command
When you work with M.Y.O.B., the information you enter isn't saved immediately in your company's data file. Instead, 
this information is stored in a temporary area of your computer's memory until you make the decision to save it in the 
data file. This provides you with the option of exiting M.Y.O.B. without saving incorrect entries in the data file since the
last time you saved changes. 

If you wish to erase all unsaved changes you've made, choose the Revert to Saved command from the File menu. An
alert message will appear, asking you whether you want to revert to the last saved version of your data. If you click 
Yes, all information you've entered or changed since the last time you selected Save from the File menu - or since 
you entered M.Y.O.B., if you haven't saved information since you entered the program - will be removed from the 
temporary area of your computer's memory.

See also
The M.Y.O.B. data file 
Using the Save command 



Using the Backup and Restore commands
As reliable as computers are these days, they can't be fully trusted to provide you with trouble-free recordkeeping. As 
is the case with all machines, computers are capable of failure. In addition, interruptions in your power supply can 
seriously damage the hardware and software you use to keep track of your business. In short, you need to ensure 
the information you enter into your computer is safe; without this security, all the information you've ever entered into 
your computer could disappear in a moment, never to be recovered. 

As a result, we strongly recommend that you preserve your M.Y.O.B. information in another location regularly - and 
very often. The process of preserving your information in another location is called making a backup. The "other 
location" you preserve your information is called a backup. 

You can use M.Y.O.B.'s Backup command to automatically create a backup of your data file, and the Restore 
command to use a backup file. Before we discuss the Backup and Restore commands, however, here are some facts
about backups:

* A backup typically takes the form of a diskette, removable hard disk or tape backup system, depending upon the 
size of the information that's being preserved. You can get information about these systems from most computer 
manuals, as well as the person who sold you your M.Y.O.B. package.

* If your data file is less than 800 kilobytes (K) in size, it can easily be backed up onto a double-sided diskette.

* If your data file is less than 1.4 megabytes (MB) in size, it can be easily backed up onto a high-density diskette.

* If your data file is more than 1.4MB in size, special software programs are available that allow you to compress your
data file to a smaller size, so it could possibly fit onto a high-density diskette.

Some facts about making backups:
* The process of making a backup of your M.Y.O.B. data file is usually as easy as copying the data file to another 
location - a standard task that's quickly performed on any computer.

* The time you spend making backups of your data file pales in comparison to the amount of time you may need to 
spend re-entering data lost as a result of a damaged data file.

* If you don't want to use M.Y.O.B.'s Backup and Restore commands, other software programs are available that 
automate the entire process of making backups - not only for your M.Y.O.B. data file, but for your entire hard disk, as 
well. If you don't want to take the time to make backups yourself, consider purchasing such a product.

We also recommend that you make multiple backups of your M.Y.O.B. data file - that is, more than one copy of your 
data file at different locations, at different times. The purpose of multiple backups is simple: backups can fail as easily 
as computers. If you've made one backup of your data file and your computer damages the data file on your hard 
disk, your sole insurance is the backed-up file. If the backed-up file is damaged, you're in just as much trouble as you 
would be without any backup at all.

Not everyone makes backups of their M.Y.O.B. data file, and we often hear from these people as they attempt to 
recover from damaged data files. As much as we'd like to help, the most common way to regain lost data - if a backup
doesn't exist - is to re-enter the lost data, which may take hours, days or even weeks. Since you don't have time to 
waste, strongly consider making a commitment to making regular backups of your data file.

See also
Following a system of making backups 
Making a backup 
Restoring a backup 
The M.Y.O.B. data file



Following a system of making backups
It's important that you follow a system of making and storing your backups properly so you're always covered in event
of an emergency. Here are some suggestions for making backups: 

* Make a backup each time you exit M.Y.O.B. To make this easy to remember, mark the Prompt for Data Backup 
Upon Closing selection in the Preferences window. Then, each time you exit M.Y.O.B., an alert message  will appear, 
asking whether you want to create a backup of your data file. 

* It's a good idea to store your backups in places other than the hard disk where your company's data file exists. If 
your hard disk is damaged, a backup file could become as damaged as any other file on your computer. We 
recommend that as soon as you make a backup, copy that backup to a diskette or to a network location.

* Another way to ensure data safety is to keep more than one backup from different time periods, such as days or 
weeks. Say, for example, you use M.Y.O.B. every day; keep five backup diskettes - one for each business day of the 
week. At the end of each day, copy your backup onto the appropriate day's diskette. The next week, copy Monday's 
backup onto the diskette that contained the previous Monday's backup, and so on for the rest of the week. This will 
ensure that you'll always have a reliable backup from a recent past time period.

* After you've made all entries for an accounting period -which typically happens a few days into the next accounting 
period - make an official "end-of-the-month" backup and store it in a safe place. We suggest you label this backup 
clearly with the name of the month. At the end of the 12-month financial year, then, you should have 12 monthly 
backups.

See also
Making a backup 
Restoring a backup 
The M.Y.O.B. data file
Using the Backup and Restore commands 



Making a backup
M.Y.O.B.'s Backup command creates a backup of the data file you're currently using, and compresses it to a smaller, 
more manageable size. Follow the steps below to use M.Y.O.B.'s Backup command.

When you installed M.Y.O.B., special software used for the backup process was also installed. If an alert message 
appears when you try to use the Backup command, this software may have been removed from the location where it 
needs to exist. Contact Technical Support for information about re-installing this software.

1. Be sure you've made all the accounting entries you want to include in the backup, and you've chosen Save from 
the File menu.

2. Choose Backup from the File menu. A dialogue box appears, allowing you to enter a name and select a location for
the backup file you're about to create.

3. Enter the name you want to assign to the backup, or accept the default name, and select the location you want to 
create the backup. (If a diskette is in your diskette drive, you can create the backup on the diskette, if you want.)

4. Click Save to create the backup.

See also
Using the Backup and Restore commands 
Restoring a backup 



Restoring a backup
M.Y.O.B.'s Restore command closes the data file you're currently using, decompresses an M.Y.O.B. backup file so 
you can use it, and opens the decompressed file. Follow the steps below to use M.Y.O.B.'s Restore command.

When you installed M.Y.O.B., special software used for the restore process was also installed. If an alert message 
appears when you try to use the Restore command, this software may have been removed from the location where it 
needs to exist. Contact Technical Support for information about re-installing this software.

If you want, you can use other software programs to decompress a backup instead of the Restore command. If you 
wish, you can also use PKUNPOST to decompress a backup.

1. Be sure you've made all the accounting entries you want to include in the data file you're currently using, and 
you've chosen Save from the File menu.

2. Choose Restore from the File menu. If you marked the Prompt for Data Backup Upon Closing selection in the 
Preferences window, an alert message appears, asking you whether you want to back up the data file you're currently
using. If you want to make a backup of this file, follow steps 2 through to 4 in Making a backup.

3. A dialogue box appears. In this box, locate the backup you want to restore. When you've found the backup, click 
Open.

4. Another dialogue box appears, allowing you to select the location you want to decompress the backup. Select a 
location and click Restore.

5. An alert message appears, showing you what the decompressed file will be named and where it will be located 
when after it's decompressed. Click OK to decompress the backup. When the restore process is done, M.Y.O.B. will 
reappear, using the decompressed backup as the current data file.

See also
Using the Backup and Restore commands 
Making a backup 



Using the Purge commands
After you've used M.Y.O.B. for a long time, you'll notice that the size of your data file has grown considerably. 
Information such as journal entries, invoices, purchase orders, contacts and sales history figures build up over time. 
When your data file has grown larger than you want it to, you can remove specific parts of the data from the file. The 
process of removing data from your data file is called purging. 

Various types of information, including journal entries, closed sales and purchasing transactions and contact logs, can
be removed from a data file. The information you can remove won't prevent you from keeping accurate financial 
records, but removing some types of information could change the way you analyse your information. We suggest 
you carefully consider the results of purging data from your data file before you do so; although you can recover the 
information from a backup copy of the data file, the process may take more time and effort than you're willing to 
invest.

If you intend to purge information, it's important that you purge in a specific order:

1. Closed sales transactions
2. Closed purchasing transactions
3. Journal entries

(Contact information can be purged at any time.)

Keep in mind that your M.Y.O.B. data file can grow to a substantial size before it slows the performance of M.Y.O.B. 
itself. If you don't have a real need to reduce the size of your data file, we suggest you don't purge information from 
the file.



Purging journal entries
Journal entries are transactions assigned to specific accounts in M.Y.O.B. For instance, a bank account's journal 
entries include transactions that relate to making deposits and writing cheques. If you choose to purge journal entries,
the detailed transaction information that's used to track where your account balances come from will be removed. 
Using the bank account example, if you purge journal entries from your bank account, the individual deposits and 
withdrawals that make up the bank account's balance will be deleted. 

Transactions assigned to sales and purchases aren't purged with other journal entries. If you wish to purge the 
transactions assigned to a particular sale or purchase, first close the sale or purchase, then purge the closed sale or 
closed purchase. You can then purge the journal entries that were assigned to the sale or purchase.

You can specify a time period for which you wish to purge journal entries. For the accuracy of your records, this time 
period should not include an accounting period that's not completely closed.

When journal entries are purged from an account, the monthly balances of the account for the time frame you purged 
are retained. Using this information, you can continue to print accurate balance sheets and profit and loss statements;
however, detailed trial balance reports and account inquiry reports for the account won't provide much information at 
all.

Similarly, when journal entries that were assigned to a job are purged, only the monthly balances of the job for the 
time frame you purged are retained.

After you've purged journal entries, you can still make journal entries for the time frame you purged. However, the 
transactions you enter will cause your accounting records for that time frame to appear incomplete.

The main reason you'd want to purge journal entries from the M.Y.O.B. system is to speed M.Y.O.B.'s access to your 
data file. If your hard disk has plenty of room and your M.Y.O.B. data file isn't too large, there's no need to purge 
journal entries.

Follow the steps below to purge journal entries from your data file.

1. Print all the reports that you wish to keep that show the transactions you'll be purging. Account inquiry reports 
contain most of the information you may want to retain.

2. Exit M.Y.O.B. and make a backup of your data file.

3. Re-enter M.Y.O.B. and open the Nominal Ledger Command Centre. 

4. Choose Purge Journal Entries from the File menu. The Purge Journal Entries window will appear.

5. From the list, enter the first month from which you do NOT want to remove journal entries. Be especially careful 
when you select a month - do not include an accounting period that isn't completely closed. All journal entries dated 
before the month you select will be marked for purging.

6. Click the Continue button. Another Purge Journal Entries window will appear, listing all the accounts in your chart 
of accounts.

7. From the list of accounts, select the accounts whose unreconciled journal entries you don't want to purge. 
Typically, you should select the accounts you regularly reconcile in the Reconcile Accounts window.

8. Click the Purge Journal Entries button. The journal entries for the time frame you specified and for the accounts 
you didn't select in this window will be purged.

See also
Using the Purge commands 
Purging closed sales 
Purging closed purchases 
Purging contact logs 



Purging closed sales
Closed sales are sales transactions, originally entered in the Sales window, that are paid in full. If you conduct many 
sales transactions, purging closed sales may significantly reduce the size of your data file. 

Sales transactions that aren't fully paid can't be purged.

When you purge a closed sale, the transactions that were made to pay the sale in full - otherwise known as the 
closed sale's journal entries - are not purged at the same time. Journal entries are purged in a separate process; we 
suggest you purge journal entries after you purge closed sales. See Purging journal entries for more information.

Follow the steps below to purge closed sales from your data file.

1. Print all the reports that you wish to keep that show the closed sales you'll be purging. You might consider printing 
a copy of the Sales Journal, which contains detailed information about all sales transactions.

2. Exit M.Y.O.B. and make a backup of your data file.

3. Re-enter M.Y.O.B. and open the Sales Ledger Command Centre.

4. Choose Purge Closed Sales from the File menu. The Purge Closed Sales window  appears.
 
5. From the list, enter the first month from which you do NOT want to remove closed sales. Be especially careful 
when you select a month - do not include an accounting period that isn't completely closed. All closed sales dated 
before the month you select are marked for purging.

6. Choose to purge detailed information about closed sales only, or to purge entire closed sales. If you choose to 
purge detail only, the sales transaction ID number, date, customer, memo, deliver to address, comment, promised 
date, deliver via, VAT, carriage amounts, salesperson and customer purchase order number for each closed sale will 
remain. If you choose to purge entire closed sales, all information about the closed sales will be removed.

7. Click the Continue button. Another Purge Closed Sales window appears, listing all the customers in the Card File.

8. From the list of customers, select the customers whose closed sales you want to purge.

9. Click the Purge Closed Sales button. The closed sales for the time frame you specified and for the customers you 
selected in this window are purged.

If you purged only the detail of closed sales, you can still view the remaining information about each closed sale in 
the Sales Journal. When you click a zoom arrow next to a closed sale whose detail has been purged, the original 
window in which the transaction was entered will appear, displaying only the information that wasn't purged.

If you purged entire closed sales, you can still use the Sales Journal to view the transactions that used to be assigned
to the closed sales. Since these transactions' sales records have been removed, however, you won't be able to view 
any more detail about the transactions other than that which appears in the Sales Journal.

See also
Using the Purge commands 
Purging closed purchases 
Purging journal entries 
Purging contact logs 



Purging closed purchases
Closed purchases are purchasing transactions, originally entered in Purchases window, that are paid in full. If you 
conduct many purchasing transactions, purging closed purchases may significantly reduce the size of your data file. 

Purchasing transactions that aren't fully paid can't be purged.

When you purge a closed purchase, the transactions that were made to pay the purchase in full - otherwise known as
the closed purchasess journal entries - are not purged at the same time. Journal entries are purged in a separate 
process; we suggest you purge journal entries after you purge closed purchases. See Purging journal entries for 
more information.

Follow the steps below to purge closed purchases from your data file.

1. Print all the reports that you wish to keep that show the closed purchases you'll be purging. You might consider 
printing a copy of the Purchases Journal, which contains detailed information about all purchasing transactions.

2. Exit M.Y.O.B. and make a backup of your data file.

3. Re-enter M.Y.O.B. and open the Purchase Ledger Command Centre.

4. Choose Purge Closed Purchases from the File menu. The Purge Closed Purchases window appears.

5. From the list, enter the first month from which you do NOT want to remove closed purchases. Be especially careful
when you select a month - do not include an accounting period that isn't completely closed. All closed purchases 
dated before the month you select will be marked for purging.

6. Choose to purge detailed information about closed purchases only, or to purge entire closed purchases. If you 
choose to purge detail only, the purchasing transaction ID number, date, supplier, deliver via, comment, promised 
date, VAT, carriage, memo and supplier invoice number for each closed purchase will remain. If you choose to purge 
entire closed purchases, all information about the closed purchases will be removed.

7. Click the Continue button. Another Purge Closed Purchases window appears, listing all the suppliers in the Card 
File.

8. From the list of suppliers, select the suppliers whose closed purchases you want to purge.

9. Click the Purge Closed Purchases button. The closed purchases for the time frame you specified and for the 
suppliers you selected in this window are purged.

If you purged only the detail of closed purchases, you can still view the remaining information about each closed 
purchase in the Purchases Journal. When you click a zoom arrow next to a closed purchase whose detail has been 
purged, the original window in which the transaction was entered will appear, displaying only the information that 
wasn't purged.

If you purged entire closed purchases, you can still use the Purchases Journal to view the transactions that used to 
be assigned to the closed purchases. Since these transactions' purchasing records have been removed, however, 
you won't be able to view any more detail about the transactions other than that which appears in the Purchases 
Journal.

See also
Using the Purge commands 
Purging closed sales 
Purging journal entries 
Purging contact logs 



Purging contact logs
Contact logs are the records of meetings and transactions you've had with customers, suppliers, employees and 
personal contacts. If you make contact with many people, purging contact logs may significantly reduce the size of 
your data file. 

Contact logs don't affect other accounting records, so you can purge as many contact records as you want without 
worrying about your accounting information.

Follow the steps below to purge contact logs from your data file.

1. Print all the reports that you wish to keep that show the contact logs you'll be purging. You might consider printing a
copy of the Contact Log report, which contains detailed information about all contacts.

2. Exit M.Y.O.B. and make a backup of your data file.

3. Re-enter M.Y.O.B. and open the Card File Command Centre.

4. Choose Purge Contact Logs from the File menu. The Purge Contact Logs window will appear.

5. From the list, enter the first month from which you do NOT want to remove contact logs. All contact logs dated 
before the month you select will be marked for purging.

6. Choose to purge contact logs for customers, suppliers, employees or personal contacts only, or to purge contact 
logs for all people and companies in the Card File.

7. If you've assigned identifiers to people and companies in the Card File and wish to purge contact logs for contacts 
with the same identifier(s), enter the identifier(s). We suggest you assign a common identifier (P for "purge" may be 
fitting) to each person or company whose contact log you routinely purge, so you can enter that identifier in this 
window.

8. If you don't want to remove contact logs that have recontact dates assigned to them, indicate this in this window, 
as well.

9. Click the Continue button. Another Purge Contact Logs window will appear, listing all the people and companies in 
the Card File that match the criteria you entered in the first Purge Contact Logs window.

10. From the list, select the people and companies whose contact logs you want to purge.

11. Click the Purge Contact Logs button. The contact logs for the time frame you specified and for the people and 
companies you selected in this window are purged.

See also
Using the Purge commands 
Purging closed sales 
Purging closed purchases 
Purging journal entries 



Using the Start a New Year commands
Starting new financial years is an important process in M.Y.O.B., in which a number of tasks are performed to 
officially close the previous year and to start the new year. Fortunately, M.Y.O.B. takes care of nearly all these 
processes automatically. This section contains information about how to start a new financial year.

See also
Starting a new financial year 
Making entries in a new financial year 



Starting a new financial year
Starting a new financial years is important processes in M.Y.O.B., in which a number of tasks are performed to 
officially close the previous year and to start the new year. Fortunately, M.Y.O.B. takes care of nearly all these 
processes automatically. This section contains information about how to start a new financial year. 

When you've entered all the information you need to enter in a financial year, you're ready to close the year and start 
a new financial year. 

Things that happen when you start a new financial year include:

1. The previous financial year's monthly totals for all accounts are changed to "last year" categories. If "last year" 
amounts already existed, those amounts will be replaced.

2. All closed sales, closed purchases and journal entries assigned to closed sales and closed purchases are purged.

3. The balance of your current-year earnings account is transferred to your retained earnings account.

4. The balances of your income, cost of sales, expense, other income and other expense accounts are returned to 
zero.

5. If you wish, the new financial year can be changed so it ends in a different month than the previous financial year. 
(If you choose to make this change, cheque with an accountant about how to report information for a "short" financial 
year.)

6. If you wish, the new financial year can be changed so it contains 13 accounting periods. If your previous financial 
year used 13 periods but you didn't make any entries in the 13th period, you can also change your new financial year 
so it contains only 12 accounting periods

Things that DON'T happen when you start a new financial year include:

1. Journal entries assigned to open or pending invoices or purchase orders aren't purged.

2. Transactions that haven't been reconciled using the Reconcile Accounts window aren't purged.

3. Contact log entries aren't purged.

4. Any information dated in the new financial year isn't changed.

The process of starting a new financial year in M.Y.O.B. consists mainly of following on-screen instructions. M.Y.O.B. 
performs most of the work. Follow the steps below to begin a new financial year.

1. Print all the reports that you wish to keep that show the previous year's transaction activity. You might consider 
printing a copy of each M.Y.O.B. journal, because they show all transaction activity for a specified period.

2. Re-enter M.Y.O.B. and choose Start a New Financial Year from the File menu.

3. Follow the instructions that appear on your computer screen.

See also
Using the Start a New Year commands 
Making entries in a new financial year    



Making entries in a new financial year
If you want to make entries in a new financial year before the previous financial year is completed, you can do so. 
When you start the new financial year, the transactions you entered for the new year won't be affected. 

There is a drawback to entering transactions in a new financial year when the previous financial year isn't closed yet, 
however: your balance sheets and profit and loss statements for the new financial year can't be printed until the 
process of starting a new financial year is completed.

See also
Using the Start a New Year commands 
Starting a new financial year    



Using the Import Data and Export Data commands
M.Y.O.B. allows you to take various information entered in other software programs and incorporate it into your 
company's data file. You can also incorporate information entered in one M.Y.O.B. data file into another M.Y.O.B. data
file. This process is called importing data. 

Similarly, you can take various information entered in M.Y.O.B. and use it in other software programs or in other 
M.Y.O.B. data files. This process is called exporting data. 

When you import data, the information you're working with must be in a file with a tab-delimited or comma-separated 
file format. When you export data, the information you export will be contained in a tab-delimited or comma-separated
file format. These file formats are described below.

* Tab-delimited files contain fields that are separated by tab characters. For example, if a tab character appears 
between Osvold and 300 Roundhill Drive in a file of customer names, the file counts Osvold and 300 Roundhill Drive 
as two separate fields in a record. 

Tab-delimited files are often used by popular spreadsheet and worksheet programs. 

* Comma-separated files contain records that are separated by commas. For example, if a comma appears between 
Osvold and 300 Roundhill Drive in a file of customer names, the file counts Osvold and 300 Roundhill Drive as two 
separate fields in a record. 

Comma-separated files are often used by popular database programs.

See also
Importing data 
Exporting Data 



Importing data
You can import the following types of information into M.Y.O.B.:

- Accounts
- Item records
- Customer records
- Supplier records
- Employee records
- Personal records
- Nominal Journal entries*
- Other sales**
- Other purchases**

* Any journal entries  you attempt to import into M.Y.O.B. will be entered into the Nominal Journal.
** Invoices and purchase orders can't be imported into M.Y.O.B.

Follow the instructions below to import data into your data file.

1. Exit M.Y.O.B. and make a backup of your data file.

2. Choose Import Data from the File menu, and select the type of information you want to import. The Import File 
window will appear.

3. In the Import File Format field, select the file format of the import file whose information you're incorporating into 
your data file.

4. In the First Record Is field, select whether the first record in the import file is a header record or a data record. 
Header records are usually used as titles in import files; for example, some header records in an import file of 
customers might be titled "Customer Name," "Address" and "Telephone Number." If you indicate that your import file's
first record is a header record, that record won't be imported into M.Y.O.B.

5. Depending upon the type of information you're importing, more fields will appear in the Import File window. These 
fields will appear in the following circumstances:

* If you're importing accounts or item records, select whether to reject duplicate records or update existing records in 
the Duplicate Records field.

In M.Y.O.B., you can't have accounts and items with the same number. If you attempt to import an account or item 
with a duplicate number, M.Y.O.B. will either reject the number or add the record's unique information to your data file,
depending upon your selection here.

For example, say Item No.100 already exists in your data file and you select Update Existing Record here. When you 
import information about another Item No.100, the information about Item No.100 in your data file will be changed to 
reflect the information that's in the import file.

If you choose to reject duplicate records, the information that's rejected will be placed in the Import Log report, which 
is created at the time you import.

* If you're importing customer, supplier, employee or personal contact records, select whether to reject duplicate 
records, update existing records or add duplicate records.

In M.Y.O.B., you can have customers, suppliers, employees or personal contacts with the same name. If you attempt 
to import a duplicate number or name, M.Y.O.B. will either reject the name, add the record's unique information to the 
record with the same name or add a new record to your data file, depending upon your selection here.

For example, say Debra Carvell already exists in your data file and you select Update Existing Record here. When 
you import information about another Debra Carvell, the information about Debra Carvell in your data file will be 
changed to reflect the information that's in the import file. If you select Add Them instead, a new Debra Carvell record
will be included in your data file when you import.

If you choose to reject duplicate records, the information that's rejected will be placed in the Import Log report, which 



is created at the time you import.

6. After you've made your selections in the Import File window, click Continue. A dialogue box appears, allowing you 
to locate your import file. Locate the file and click Open.

7. The Import Data window appears. In this window, match the information in the import file with its corresponding 
fields in M.Y.O.B. To do this, click once on the name of a field in your import file (the import file's fields are displayed 
in the left-hand column of this window), then click the M.Y.O.B. field in the right-hand side of the window that you want
to match the import field with.

For example, if the name of an import file's field is Item Number, select the Item Number field in the column on the 
left-hand side of the window, then click the Item Number field in the right-hand side of the window.

When you match an import field with an M.Y.O.B. field, the import field's name will appear in the Matching Import 
Field column of the window.

If you want to remove an import field's name from the Matching Import Field column, click the M.Y.O.B. field name.

M.Y.O.B. fields whose names have asterisks (*) next to them must have matching import file fields assigned to them.

If all the fields in the import file match the fields in the M.Y.O.B. Fields column, you can match all the fields at one time
by clicking the Match All button at the bottom of the window.

8. When you're done matching fields, click the Import button. The importing process begins. 

During the importing process, the Import Log report is created. This report, titled MYOBLOG.TXT, lists information 
about any problems that occurred during the importing process, as well as information about rejected duplicate 
records. This report is created as a file, and is located in the same place as your data file.

Each time you import, the Import Log report is created, using the same name. If an Import Log report already exists 
when you create another one, the existing report will be removed.

See also
Exporting Data 



Exporting data
You can export the following types of information from M.Y.O.B.:

- Accounts
- Item records
- Customer records
- Supplier records
- Employee records
- Personal records
- Journal entries
- Other sales*
- Other purchases*

* Invoices and purchase orders can't be exported from M.Y.O.B.

Follow the instructions below to export data from your data file.

1. Exit M.Y.O.B. and make a backup of your data file.

2. Choose Export Data from the File menu, and select the type of information you want to export. The Export File 
window will appear.

3. In the Export File Format field, select the file format you want to use for the export file.

4. In the First Record Is field, select whether you want the first record in the export file to be a header record or a data
record. Header records are usually used as titles in export files; for example, some header records in an export file 
of customers might be titled "Customer Name," "Address" and "Telephone Number."

5. Depending upon the type of information you're exporting, more fields will appear in the Export File window. These 
fields will appear in the following circumstances:

* If you're exporting accounts, select to export account balances from the current or the previous financial year, then 
select the period whose ending balances you want to export. 

* If you're exporting customer, supplier, employee or personal contact records, you can restrict the people whose 
records you export by entering identifiers and Postcodes.

* If you enter more than one identifier in the Identifier field, the people whose records you export will only be those 
who match all the identifiers you entered.

* If you enter a partial Postcode in the Postcode field, the people whose records you export will be those whose 
Postcodes match the numbers you entered.

* If you're exporting journal entries, choose the journal you want to export from. You can also select a time period to 
restrict the journal entries to export.

* If you're exporting other sales or other purchases, you can restrict the transactions you export by the identifiers 
assigned to the customers and suppliers you conducted the transactions with. You can also select a time period to 
restrict the other sales and other purchases to export.

6. After you've made your selections in the Export File window, click Continue. The Export Data window opens.

7. In the Export Data window, choose the M.Y.O.B. fields you want to export, and the order in which you want to 
export them. To do this, click on the first field you want to export in the M.Y.O.B. Fields column. The title Field 1 will 
appear in the Export Order column next to the field you selected, and the field name will also appear at the top of the 
Export Fields column in the left-hand side of the window. Follow this process for each field you want to export.

M.Y.O.B. fields whose names have asterisks (*) next to them must be included in the Export Fields column before you
can export any data.

If you want to remove a field's name from the Export Fields column, click on the field's name in the M.Y.O.B. Fields 



column.

If you want to export all the fields in the order they're shown in the M.Y.O.B. Fields column, click the Match All button. 
If you want to clear the entire Export Fields column, click the Unmatch All button.

8. When you're done selecting fields, click the Export button. A dialogue box appears, allowing you to name the 
export file that will be created, as well as assign a location to the file.

9. Name your export file, select a location for it and click OK. The exporting process begins. 

See also
Importing data 



Using M.Y.O.B.'s editing commands
The Undo, Cut, Copy, Paste and Clear commands in M.Y.O.B. are the same standard editing commands that most 
software programs use. Refer to your computer's documentation for detailed information about using these 
commands. 

The Erase command in M.Y.O.B. appears when an "erasable" record is displayed in an M.Y.O.B. window. Records 
that are "erasable" aren't recorded yet; that is, you haven't clicked a button in the window to save the record in 
M.Y.O.B.'s temporary memory. 

The Delete command in M.Y.O.B. appears when a "deleteable" record is displayed in an M.Y.O.B. window. Records 
that are "deleteable" include records that haven't been saved yet (that is, you haven't chosen Save from the File 
menu yet). If your data file is changeable, saved records are also "deleteable." 

See also
Changeable transactions 
Unchangeable transactions 



Using the Reverse commands
If you chose to lock the transactions you enter from changes (by marking the Data File Records CANNOT be 
Changed, Saved Entries Must be Reversed selection in the Preferences window) and you want to make a change to 
a saved transaction, you must create a reversing entry to cancel the incorrect transaction. For instance, if you save 
a £20 invoice and then realise the transaction's amount should have been £200 instead, you'll need to create a 
reversing entry of negative £20 to cancel the original transaction, and then create a new invoice for the correct £200 
amount. 

When you view the journal associated with the transactions you created and reversed (for example, when you view 
the Sales Journal after you've entered a reversing invoice entry), the reversing entry will be displayed. In addition, the
balance of the accounts affected by the incorrect transaction will return to its amount before the incorrect transaction 
occurred.

If you changed your linked accounts after you recorded the transaction, you must manually reverse the transaction. 
To do this, create a transaction of the same type and enter an amount opposite of the transaction you want to 
reverse.

After you've saved a reversing entry, don't forget to create a new transaction with the correct information.

The Reverse command in the Edit menu appears only when you're viewing a window that has transactions that can 
be reversed. The name of the command will contain the type of transaction you can reverse, such as "Reverse 
Invoice."

For information about reversing a specific type of transaction, refer to a procedure that describes the type of 
transaction you're working with.

See also
Changeable transactions 
Unchangeable transactions 



Using the select commands
The select commands - Select All, Deselect All and Search - allow you to make choices in M.Y.O.B. windows.

See also
Selecting everything in a list 
De-selecting everything in a list 
Using a search list 



Selecting everything in a list
When you're using a window that contains a list, use the Select All command to select every item in the list. The 
window will change to show that everything is selected. 

See also
Using the select commands 
De-selecting everything in a list 
Using a search list 



De-selecting everything in a list
When you're using a window that contains a list, use the Deselect All command to remove all selections from the list. 
The window will change to show that nothing is selected. 

See also
Using the select commands 
Selecting everything in a list 
Using a search list 



Using a search list
M.Y.O.B. provides a system of search lists that allow you to choose existing records quickly and accurately. Search 
lists, titled "Select from List," are accessed using the Search command and are available for every field where you 
must enter the name or number of a record you've created in M.Y.O.B., such as: 

* Accounts you entered in the Edit Accounts window

* Items you entered in the Item Information window

* Customers, suppliers, employees and personal contacts you entered in the Card File Entry window

* Jobs you entered in the New Job window

See also
Using the select commands 
De-selecting everything in a list 
Using search lists 



Using the Recap Transaction command
The Recap Transaction command allows you to quickly view a summary of a transaction before you record it. This 
summary includes the name of the journal the transaction will be saved in - a helpful tool, if the journal isn't apparent 
by the type of transaction you're entering. 

To use the Recap Transaction command, select it after you've entered all information about a transaction but before 
you click the Record button. The Recap Transaction window  appears, showing the summary information for the 
transaction. When youve finished viewing the summary information, click OK; the transaction window reappears.

After you've used the Recap Transaction command, don't forget to record the transaction you entered.



Using the Set Up M.Y.O.B. commands
The Set Up M.Y.O.B. command has a sub-menu attached to it, containing the names of three command centres that 
should have various information entered before you can use them. When you choose a command centre name from 
the Set Up M.Y.O.B. sub-menu, the Set Up M.Y.O.B. window appears, displaying the necessary setup steps for the 
command centre you selected. 

For each set of information you need, zoom arrows are available for you to quickly navigate to the windows in which 
this setup information is entered. When a step is completed, a check mark will appear next to the description of the 
step.

See also
Setting up Nominal Ledger 
Setting up Sales Ledger 
Setting up Purchase Ledger 



Setting up Nominal Ledger
Choose Nominal Ledger from the Set Up M.Y.O.B. sub-menu to set up necessary information for the Nominal Ledger 
Command Centre. To set up Nominal Ledger, you should complete the following tasks: 

1. Set up nominal company information. Use the Company Information command to enter this information.

2. Create/modify your chart of accounts. If you didn't load a starter chart of accounts when you installed M.Y.O.B., or 
if you need to make changes to the starter chart of accounts you selected in the M.Y.O.B. Setup Interview, use the 
Edit Accounts window to create and modify your chart of accounts. Even if you did load a starter chart of accounts, it 
might be a good idea to review the accounts you chose anyway, just to be sure you've got the accounts you want.

3. Assign opening balances to each account in your chart of accounts. To do this, use the Account Opening Balances 
window, which is opened using the Balances command. See Entering account opening balances for more information
about entering account opening balances.

The total balance assigned to your asset accounts should equal the total balance of your liability and capital 
accounts. You'll use the Account Opening Balances window to make this happen, also.

See also
Using the Balances commands 
Using the Set Up M.Y.O.B. commands 
Setting up Sales Ledger 
Setting up Purchase Ledger



Setting up Sales Ledger
Choose Sales Ledger from the Set Up M.Y.O.B. sub-menu to set up necessary information for the Sales Ledger 
Command Centre. To set up Sales Ledger, you should complete the following tasks: 

1. Complete setting up Nominal Ledger. See Setting up Nominal Ledger for more information about setting up 
Nominal Ledger.

2. Verify your Sales Ledger linked accounts. Linked accounts are set up automatically when you create your data file, 
but it's a good idea for you to check the accounts that were assigned, so you're sure the accounts you want to be 
linked are linked. See Using the Linked Accounts commands for more information about linked accounts.

3. Enter customer information. Before you can enter sales transactions, you need to enter information about the 
customers you conduct those transactions with. Each customer's information is often called a customer card. Use 
the Card File Entry window to enter this information.

4. Enter historical sales. Before you can use M.Y.O.B. to correctly track your business's financial information, 
M.Y.O.B. needs to know about all your business's sales transactions with a current balance due, as of the first day of 
your conversion month. This information is entered using the Customer Balances window. See Using the Balances 
commands for more information about entering historical sales.

The total balance of all your sales transactions with a current balance due must equal the balance of your Debtors 
Control account. You'll use the Customer Balances window to make this happen, also.

See also
Using the Set Up M.Y.O.B. commands 
Setting up Nominal Ledger 
Setting up Purchase Ledger 



Setting up Purchase Ledger
Choose Purchase Ledger from the Set Up M.Y.O.B. sub-menu to set up necessary information for the Purchase 
Ledger Command Centre. To set up Purchase Ledger, you should complete the following tasks: 

1. Complete setting up Nominal Ledger. See Setting up Nominal Ledger for more information about setting up 
Nominal Ledger.

2. Verify your Purchase Ledger linked accounts. Linked accounts are set up automatically when you create your data 
file, but it's a good idea for you to check the accounts that were assigned, so you're sure the accounts you want to be 
linked are linked. See Using the Linked Accounts commands for more information about linked accounts.

3. Enter supplier information. Before you can enter purchasing transactions, you need to enter information about the 
suppliers you conduct those transactions with. Each supplier's information is often called a supplier card. Use the 
Card File Entry window  to enter this information.

4. Enter historical purchases. Before you can use M.Y.O.B. to correctly track your business's financial information, 
M.Y.O.B. needs to know about all your business's purchasing transactions with a current balance due, as of the first 
day of your conversion month. This information is entered using the Creditors Balances window. See Using the 
Balances commands for more information about entering historical purchases.

The total balance of all your purchasing transactions with a current balance due must equal the balance of your 
Creditors Control account. You'll use the Supplier Balances window to make this happen, also. 

See also
Using the Set Up M.Y.O.B. commands 
Setting up Nominal Ledger 
Setting up Sales Ledger 



Using the Preferences command
The Preferences command opens the Preferences window, where you can tailor M.Y.O.B. to the way you work.

See also
Changeable transactions 
Unchangeable transactions 
Locking periods 
Creating a new master password 



Unchangeable transactions
If you choose to lock transactions from changes after they're saved, you must make reversing entries each time you
want to change a transaction. Reversing entries are actual transactions with amounts that are usually opposite of 
their original transactions. For instance, if you save a £20 invoice and then realise the transaction's amount should 
have been £200 instead, you'll need to create a reversing entry of negative £20 to cancel the original transaction, and
then create a new invoice for the correct £200 amount. 

The benefit of making reversing entries is that you'll have a comprehensive list of all the changes you've made to your
accounting records. This comprehensive list, often known as the "audit trail," is often preferred by accountants.

Possible disadvantages of making reversing entries include the process takes slightly more time, and the larger 
number of transactions will increase the size of your data file.

When you view information about a locked transaction in M.Y.O.B. (for example, in Transaction Journal windows), a 
grey zoom arrow will appear next to the transaction's number. Clicking the zoom arrow will open the original window 
in which the transaction was entered; however, you won't be able to make changes to the transaction.

See also
Using the Reverse commands.
Changeable transactions 



Changeable transactions
If you choose to allow changes to saved transactions, you can simply display a transaction you want to change and 
make the change to it. To use the example used in Unchangeable transactions, you could open the Sales window, 
display the £20 transaction, add another zero to the amount and save the transaction again. 

The benefit of changing original transactions is that you'll be able to quickly make your changes, without using 
additional transactions to make corrections.

Possible disadvantages of allowing changes to original transactions include the fact that you may have more than 
one printed document (such as an invoice) with the same identifying number but with different amounts on them, as 
well as the fact that your accountant may prefer to review all transaction detail.

When you view information about a changeable transaction in M.Y.O.B. (for example, in Transaction Journal 
windows), a white zoom arrow will appear next to the transaction's number. Clicking the zoom arrow will open the 
original window in which the transaction was entered, where you can make changes to the transaction.

See also
Using the Reverse commands.
Unchangeable transactions 



Locking periods
When you've made all - or almost all - entries you need to enter in an accounting period (in your financial), you're 
ready to close the period. 

Accounting periods in M.Y.O.B. don't need to be officially closed - that is, "locked" from more accounting entries - until
you're ready to close the entire financial year and start a new year. Even if it's December, you can still make entries in
January of the same year. However, we suggest you make a practice of following the suggestions listed below when 
you think you've made all the entries for a specific period.

The process of closing an accounting period in M.Y.O.B. doesn't include the purging or changing of any of your 
accounting records. The things you do to "close" an accounting period are more for the sake of keeping track of your 
periodic business activity, so you have accurate historical records to refer to in the future. As a result, the tasks listed 
below are merely suggestions - but they're suggestions that may help you out a great deal someday. 

1. If you've received statements from your bank, use the Reconcile Accounts window to reconcile amounts in 
M.Y.O.B. with the amounts on the statements.

2. Print a Summary Trial Balance report for the period. Check to see whether the activity that appears in the report is 
what you expected; for example, zero amounts in accounts that usually have regular activity may indicate a problem. 
A Detail Trial Balance report will provide you with more information, if you need it.

3. If the information in the trial balance reports is acceptable, print the reports you want to keep as part of your 
permanent business records. Suggested reports include the balance sheet, profit and loss statement, Aged Debtors 
report, Aged Creditors report and all journal reports.

4. Exit M.Y.O.B. and make a backup of your data file.

5. Re-enter M.Y.O.B. and choose Preferences from the Setup menu. When the Preferences window appears, select 
the Security tab.

6. Change your selection in the Lock Periods list to the period you're closing. This will prevent you from inadvertently 
making an entry in a month you don't want new entries in.

This selection merely places a temporary "lock" on the month you select and all months before it. If you need to make
an entry in a month that occurs before your selection, simply change the month here.



Creating a new master password
Follow the steps below to enter a new or existing master password.

1. Choose Preferences from the Setup menu to open the Preferences window. Click the Security tab at the top of the 
window, then click the Passwords button at the bottom of the window. The Set Up Passwords window  appears.

2. In the New Master Password field, enter the master password you wish to use, then click the Record New 
Password button. Passwords aren't case-sensitive; that is, it doesn't matter whether you type lowercase or uppercase
letters in your password.

3. An alert message appears, allowing you to review the entry you made. Review the password you typed, then click 
OK; the master password is created. You can now exit the password windows by clicking the OK button in the 
Password Access window, or you can continue to set up your security system.

See also
Opening the Password Access window 
Creating a new sub-password 
Restricting access using a sub-password 
Editing a password 
Removing a password 



Opening the Password Access window
If you've already set up a master password and don't have the Password Access window  open, follow the steps 
below to open the Password Access window.

1. Choose Preferences from the Setup menu to open the Preferences window. Click the Security tab at the top of the 
window, then click the Passwords button at the bottom of the window. A window appears, requesting you enter the 
master password.

2. Enter the exact password. When you type an existing master password, an asterisk (*) appears for each character 
you type, ensuring others can't read the password on the computer screen as you type it.

3. After you've entered the password, click the OK button. The Password Access window appears.

See also
Creating a new master password 
Creating a new sub-password 
Restricting access using a sub-password 
Editing a password 
Removing a password 



Creating a new sub-password
Follow the steps below to create a new sub-password.

1. If you haven't already done so, open the Password Access window.

2. The Password Access window contains two lists. On the left-hand side of the window, a list of all existing 
passwords is displayed. If you've just begun working with passwords, only **MASTER** will appear in this list. On the 
right-hand side of the window, a list of all M.Y.O.B. command centres and their accompanying windows is displayed. 
To create a sub-password, click the New button; the Set Up Passwords window  appears.

3. Enter a sub-password in the New Sub-Password field. Passwords aren't case-sensitive; that is, it doesn't matter 
whether you type lowercase or uppercase letters in your password.

4. When youve finished typing the password, click the Record New Password button. The Password Access window 
reappears, with the new sub-password appearing in the list in the left-hand side of the window.

See also
Creating a new master password 
Opening the Password Access window 
Restricting access using a sub-password 
Editing a password 
Removing a password 



Restricting access using a sub-password
Follow the steps below to restrict access to parts of the M.Y.O.B. system using sub-passwords.

1. If you haven't already done so, open the Password Access window  and create a sub-password.

2. Select the sub-password you wish to use in the list in the left-hand side of the window. If you've selected a sub-
password for which access rights have been previously established, small Xs may appear in the Not Allowed column. 

3. Select the command centres and windows for which users with this password will NOT be able to access by 
clicking on the appropriate names. When you select a command centre or window, an X will appear in the Not 
Allowed column next to the label you selected. If you select a command centre or a window that opens another 
window, an X will appear next to the name of the other window, as well.

4. When youve finished restricting access for the sub-password, either select another sub-password to restrict access
or click the OK button to close the Password Access window.

5. To activate the access rights you've established, exit and restart M.Y.O.B. When you exit M.Y.O.B., we recommend
that you make a backup of your company's data file to ensure the access rights are properly saved.

See also
Creating a new master password 
Opening the Password Access window 
Creating a new sub-password 
Editing a password 
Removing a password 



Removing a password
Follow the steps below to remove a password.

If you wish to delete the master password, all sub-passwords must be deleted first.

1. If you haven't already done so, open the Password Access window.

2. In the Password Access window, be sure that the password you want to remove is highlighted in the list on the left-
hand side of the window. When the password is highlighted, click the Delete button.

3. If you chose to delete a sub-password, the password will be removed. If you chose to delete the master password, 
an alert message will appear, informing you that all password protection will be removed for this company's data file 
when you remove the master password. Click OK; the message All passwords have been deleted will appear. Click 
OK to return to the Preferences window.

See also
Creating a new master password 
Opening the Password Access window 
Creating a new sub-password 
Restricting access using a sub-password 
Editing a password 



Editing a password
Follow the steps below to change an existing master password or sub-password.

1. If you haven't already done so, open the Password Access window.

2. In the Password Access window, be sure that the password you want to edit is highlighted in the list on the left-
hand side of the window. When the password is highlighted, click Edit.

3. The Set Up Passwords window  will appear, displaying the password. Change the password, then click Record 
Changes. If you edited a master password, an alert message will appear, allowing you to review the new password. 
Click OK to return to the Password Access window.

See also
Creating a new master password 
Opening the Password Access window 
Creating a new sub-password 
Restricting access using a sub-password 
Removing a password 



Selecting a different month in the Business Calendar
Three calendar years are stored in M.Y.O.B.: the year containing the end of your current financial year, along with the
year before and the year after it. Use the arrows above the calendar to scroll through one month at a time.

See also
Changing the status of a day in the Business Calendar 



Changing the status of a day in the Business Calendar
To change the business status of a single day, click on the day. To change the status of a day throughout the entire 
three-year calendar, click on the day in the Shortcut for Setting Average Business Week panel. An alert message 
appears, asking you to confirm your selection or cancel it.

Remember, when using the Shortcut panel, changing the business status of a day will change the status of that day 
throughout M.Y.O.B.'s three-year business calendar.

See also
Selecting a different month in the Business Calendar 



Using the Linked Accounts commands
Since all the transactions you enter into M.Y.O.B. are assigned to accounts, it could take quite a while to memorise 
which account each type of transaction is supposed to be assigned to. To reduce your data entry time and the 
possibility for mistaken assignments, M.Y.O.B. was designed to automatically assign nearly all your transactions to 
the proper accounts at the time you enter the transactions. This function also takes the often-confusing task of 
entering debits and credits properly out of your hands. The tools M.Y.O.B. uses for this feature are called linked 
accounts. 

When you set up your M.Y.O.B. system, specific accounts were automatically linked to particular types of 
transactions. For example, one asset account was assigned to all sales transactions that result in money owed to 
you; each time you enter a sales transaction that's not fully paid at the time of the sale, the amount you're owed will 
automatically be added to this account's balance. When you actually enter the sale, you won't have to worry about 
selecting the account to assign the balance due amount, because the account is already selected.

Linked accounts are displayed in the Sales Ledger Linked Accounts, Purchase Ledger Linked Accounts,    and 
Nominal Ledger Linked Accounts windows.

Throughout M.Y.O.B. documentation, you'll see explanations of how linked accounts are affected by the transactions 
you enter.



Using the Balances commands
Before you can use M.Y.O.B. to correctly track your business's financial information, M.Y.O.B. needs to know 
amounts for the following things, as of the first day of your conversion month: 

* The balances of all the accounts in your chart of accounts

* All your business's sales transactions with a current balance due

* All your business's purchasing transactions with a current balance due

The Balance command has three commands attached to it: Account Opening Balances, Customer Balances and 
Supplier Balances. The windows that are opened using these commands allow you to enter this information.

See also
Entering account opening balances 
Balancing your opening account balances 
Entering account historical balances 
Entering historical sales 
Entering historical purchases 



Entering account opening balances
Account opening balances are the balances of your accounts as of the first day of your conversion month. You're 
not required to enter account opening balances before you start using M.Y.O.B., but your financial records may not be
completely accurate if you don't. 

If your conversion month is the first month of your financial year, all you need to enter is the balances of your balance
sheet accounts (asset, liability and capital accounts). If your conversion month isn't the beginning of your financial 
year, you should enter the balances of all your accounts.

Use the Account Opening Balances window to enter account opening balances.

Enter your balances as positive numbers. Don't, for example, enter your assets as positive and your liabilities as 
negative. M.Y.O.B. knows the normal sign of your accounts. Enter a negative amount only if the account has a 
negative balance.

If you or your accountant has a trial balance report for the month before your conversion month, the ending balance 
for each account for the month is the opening balance for each account in M.Y.O.B. If you don't have a trial balance 
report, you can use the amounts on a current balance sheet for your asset, liability and capital accounts' opening 
balances, and the amounts on a yeartodate profit and loss statement for income, cost of sales and expense accounts'
opening balances.

If your conversion month is the first month of your financial year, the opening balance of all your income and expense 
accounts, as well as your Current-year Earnings account, should be zero. Additionally, the previous year's earnings 
should already be included in the balance of your Retained Earnings account.

M.Y.O.B. includes an capital account for your current-year earnings. The opening balance for this account is 
calculated automatically. Although this account doesn't appear in the Account Opening Balances window, don't worry 
- it does exist. Since M.Y.O.B. will track these amounts automatically, you don't need to create a current-year 
earnings account and enter an opening balance for it.

See also

Using the Balances commands 
Balancing your opening account balances 
Entering account historical balances 
Entering historical sales 
Entering historical purchases 



Balancing your opening account balances
The total of the opening balances  you assign to your asset accounts should equal the total opening balances of your 
liability and capital accounts. As you enter your account opening balances, you'll see an amount in the Amount left to 
be allocated field at the bottom of the window. When you enter opening balances, this amount changes to reflect your
entries. When this amount is zero, your account opening balances are balanced properly.

It's not always easy to get this amount to zero, however, so M.Y.O.B. allows you to "fudge" your opening balances if 
you need to. If, after you've entered all your accounts' opening balances, the amount in the Amount left to be 
allocated field isn't zero, click the Close button. The unallocated amount will be allocated to a special capital account 
called Historical Balancing.

Even though you can "fudge" the balancing of your opening balances, your records will be more accurate if the 
balance of the Historical Balancing account is zero. Therefore, when you're entering account opening balances, try to 
get the amount in the Amount left to be allocated field down to zero.

See also
Using the Balances commands 
Entering account opening balances 
Entering account historical balances 
Entering historical sales 
Entering historical purchases 



Entering account historical balances
Account historical balances are the balances of your accounts as of the end of various months before you began 
using M.Y.O.B. You're not required to enter account historical balances before you start using M.Y.O.B., but this 
information may come in handy if you want to compare this year's account balances with last year's. 

Use the Account Historical Balances window  to enter account historical balances. 

Enter your balances as positive numbers. Don't, for example, enter your assets as positive and your liabilities as 
negative. M.Y.O.B. Accounting knows the normal sign of your accounts. Enter a negative amount only if the account 
has a negative balance.

For balance sheet accounts (assets, liabilities, and capital), enter the ending balances for each account for the 
selected month. For profit and loss accounts (income, cost of sales, and expense), enter the net activity for each 
account for the selected month.

Here's some more information about entering historical balances:

* You can enter historical amounts for accounting periods that occurred before you converted to M.Y.O.B. only.

* You can't enter historical amounts for the accounting period preceding your conversion month; these amounts are 
entered in the Account Opening Balances window instead. However, if your conversion month is at the beginning of a
new financial year, you can enter historical amounts for your income, cost of sales, expense, other income and other 
expense accounts for the month preceding your conversion month.

* For asset, liability and capital accounts, enter month-end balances of each account. There is one exception, 
however: the capital account named Current Year Earnings has a balance that's calculated automatically by M.Y.O.B. 
You can't enter a historical balance for the Current Year Earnings account.

* For income, cost of sales, expense, other income and other expense accounts, enter the total value of each 
account's transaction activity.

When you enter historical balances for income, cost of sales, or expense accounts, M.Y.O.B. changes your account 
opening balances to reflect the entries you make. If, for example, you have a financial year that runs from April to 
March and your conversion month is July, the opening balances for your income, cost of sales and expense accounts
are the total activity for April to June. M.Y.O.B., however, considers this opening balance as the historical balance for 
June only. If you then enter historical balances for April to May, they will be subtracted from the June activity figure.

If your conversion month is at the beginning of your financial year, you can enter net activity for your income, cost of 
sales, expense, other income and other expense accounts for the last month of the previous financial year, since you 
can't enter these numbers in the Account Opening Balances window.

See also
Using the Balances commands 
Entering account opening balances 
Balancing your opening account balances 
Entering historical sales 
Entering historical purchases 



Entering historical sales
Historical sales - also known as debtors opening balances - are your business's sales transactions with a current 
balance due as of the first day of your conversion month. Before you use the Sales Ledger Command Centre, you 
should enter the historical sales that make up the balance of your linked debtors account - the account that's 
displayed in the Asset Account for Tracking Debtors field of the Sales Ledger Linked Accounts window. 

Even though entering historical sales isn't required, your records will be more accurate if you do enter your historical 
sales.

Historical sales are entered in the Historical Sale window, opened from the Customer Balances window. Follow the 
steps below to enter your historical sales.

1. Note the amount that appears in the Linked Debtors Account Balance field at the bottom half of the Customer 
Balances window. You should enter historical sales that, when totalled, equal this amount. The Out of Balance 
Amount field shows the difference between the sales amounts you've entered and the balance of your linked debtors 
account.

2. Before you enter historical sales, your customer cards can be set up. Use the Card File Entry window to set up 
your customers, if you haven't already done so. (You can also enter your customer records at the same time as when 
you're entering your historical information, if you want.)

3. Click the zoom arrow in the scrolling list next to the name of a customer who has a current sales balance with your 
business. The scrolling list changes to show all the historical sales that exist for the customer. (If you're just starting 
out, no sales appear in the scrolling list.)

4. To enter a historical sale, click the Add Sale button. The Historical Sale window appears.

5. Enter all information that applies to the historical sale. When you reach the Amount Due field, be sure to enter the 
remaining amount of the sale, not the original amount.

6. Continue entering historical sales for all customers until the amount that appears in the Out of Balance Amount 
field of the Customer Balances window is zero (or as close to zero as you can get it). When youve finished, click the 
Close button in the Customer Balances window.

See also
Using the Balances commands 
Entering account opening balances 
Balancing your opening account balances 
Entering account historical balances 
Entering historical purchases 



Entering historical purchases
Historical purchases - also known as creditor opening balances - are your business's purchasing transactions 
with a current balance due as of the first day of your conversion month. Before you use the Purchase Ledger 
Command Centre, you should enter the historical purchases that make up the balance of your linked creditors 
account - the account that's displayed in the Liability Account for Tracking Creditors field of the Purchase Ledger 
Linked Accounts window. 

Even though entering historical purchases isn't required, your records will be more accurate if you do enter your 
historical purchases.

Historical purchases are entered in the Historical Purchase window, which is opened from the Supplier Balances 
window. Follow the steps below to enter your historical purchases.

1. Note the amount that appears in the Linked Creditors Account Balance field at the bottom half of the Supplier 
Balances window. You should enter historical purchases that, when totalled, equal this amount. The Out of Balance 
Amount field shows the difference between the purchasing amounts you've entered and the balance of your linked 
creditors account.

2. Before you enter historical purchases, your supplier cards must be set up. Use the Card File Entry window  to set 
up your suppliers, if you haven't already done so. (You can also enter your supplier records at the same time as when
you're entering your historical information, if you want.)

3. Click the zoom arrow in the scrolling list next to the name of a supplier with whom you have a current purchasing 
balance. The scrolling list changes to show all the historical purchases that exist for the supplier. (If you're just starting
out, no purchases appear in the scrolling list.)

4. To enter a historical purchase, click the Add Purchase button. The Historical Purchase window appears.

5. Enter all information that applies to the historical purchase. When you reach the Amount Due field, be sure to enter
the remaining amount of the purchase, not the original amount.

6. Continue entering historical purchases for all suppliers until the amount that appears in the Out of Balance Amount 
field of the Supplier Balances window is zero (or as close to zero as you can get it). When youve finished, click the 
Close button in the Supplier Balances window.

See also
Using the Balances commands 
Entering account opening balances 
Balancing your opening account balances 
Entering account historical balances 
Entering historical sales 



Using M.Y.O.B. on-line help
M.Y.O.B. on-line help is a comprehensive on-line reference system that's installed with the M.Y.O.B. accounting 
program. On-line help contains information about all windows and data entry fields in M.Y.O.B., as well as step-by-
step instructions for performing accounting tasks.

On-line help is accessed by pressing F1. 



Types of accounts in M.Y.O.B.
There are eight types of accounts in M.Y.O.B., and each serves a different purpose in your business. Depending 
upon the type of starter chart of accounts you installed for your company - if you installed a starter chart of accounts 
at all - you may or may not have accounts from each of the eight account types in your own chart of accounts. 

This section contains a brief overview of each M.Y.O.B. account type.

Asset accounts
Asset accounts track things a business owns, such as the money in a bank account, computers and office buildings. 
Money owed to a business is also considered an asset. 

Current assets can be converted into cash (including cash itself) within a relatively short period of time (usually less 
than a year).

Fixed assets usually take more than a year to convert into cash. An office building can be considered a fixed asset.

Asset accounts are assigned the prefix 1 in M.Y.O.B., and normally have a debit balance.

Liability accounts
Liability accounts track things a business owes, such as a working capital loan. Money owed by a business for 
purchases is also considered a liability. 

Current liabilities are due within a relatively short period of time (usually less than a year).

Long-term liabilities usually aren't due for more than a year.

Liability accounts are assigned the prefix 2 in M.Y.O.B., and normally have a credit balance.

Income accounts
Income accounts, also known as "revenue accounts," track the increase in capital from the sale of items or services. 

Income accounts are assigned the prefix 4 in M.Y.O.B., and normally have a credit balance.

Expense accounts
Expense accounts track the cost incurred when a business attempts to create income. 

Expense accounts are assigned the prefix 6 in M.Y.O.B., and normally have a debit balance.

Capital accounts
Capital accounts track a company's net worth. A company's capital, also known as "owners' capital" or "equity,"    is 
calculated by subtracting its liabilities from its assets. Some common capital accounts are current year earnings, 
retained earnings and shareholders' capital. 

Capital accounts are assigned the prefix 3 in M.Y.O.B., and normally have a credit balance.

Cost of sales accounts
Cost of sales accounts track the amount paid to sell an item or service. The amounts tracked by cost of sales 
accounts are sometimes referred to as "cost of goods sold" amounts. 

Cost of sales amounts are subtracted from income amounts to determine gross profit.

Cost of sales accounts are assigned the prefix 5 in M.Y.O.B., and normally have a debit balance.

Other income accounts
Other income accounts track the income that isn't directly related to a company's operations, such as interest income.

Other income accounts are assigned the prefix 8 in M.Y.O.B., and normally have a credit balance.

Other expense accounts
Other expense accounts track the expenses that aren't directly related to a company's operations, such as loan 
interest and fines. 



Other expense accounts are assigned the prefix 9 in M.Y.O.B., and normally have a debit balance.

See also
Organising accounts 
Account levels 



Organising accounts
You can make tracking your accounts easier by collecting them into groups. Groups are created by using header 
accounts and detail accounts. 

* Header accounts are used only for grouping accounts of a similar purpose. Typically, header accounts have detail 
accounts "under" them; that is, detail accounts are assigned to specific header accounts. In the list in the left-hand 
side of the Chart of Accounts window, header accounts appear in bold type, and their detail accounts appear below 
them in plain type. 

Transaction amounts can't be assigned (posted) to header accounts - only to detail accounts. You can, however, 
combine the amounts of all the detail accounts under a header and display the total amount with the header account 
on reports. To do this, mark the selection in the Edit Accounts window named When Reporting, Generate a Subtotal 
for This Section.

Header accounts aren't required in M.Y.O.B., except for the eight Level 1 accounts (asset, liability, income, expense, 
capital, cost of sales, other income and other expense). Header accounts you create must be either Level 2 or Level 
3.

* Detail accounts are the accounts you assign transactions to. 

Each detail account is assigned to the header account that appears directly above it in the list in the left-hand side of 
the Chart of Accounts window. Detail accounts appear in plain type, and header accounts appear in bold type.

Amounts can be assigned (posted) to detail accounts; that is, when you enter a transaction in M.Y.O.B., you can 
enter the number of a detail account. The amount of the transaction will then be included in the balance of the detail 
account.

You can indicate whether a detail account has bank privileges - in other words, you can make an account a "bank 
account" - by marking the Detail Bank Account selection in the Edit Accounts window.

Detail accounts can be Level 2, Level 3 or Level 4.

The capital account called Current Year Earnings is a detail account; unlike other detail accounts, however, you can't 
assign transactions to it. This account, is used by M.Y.O.B. to automatically record your company's profit or loss.

See also
Types of accounts in M.Y.O.B. 
Account levels 



Account levels
Account levels are another tool you can use to organise the accounts in your chart of accounts. 

You can assign Level 2, Level 3 or Level 4 to detail accounts. Header accounts can be assigned either Level 2 or 
Level 3.

Level 1 is permanently assigned to each of the eight account types in M.Y.O.B., and can't be assigned to any other 
account. 

Depending upon the account, you can change its level. For example, if the account is a Level 2 header account with 
detail accounts under it, you won't be able to change its level. Similarly, if the account is a Level 3 detail account with 
a Level 2 header account above it, you won't be able to change its level up to Level 2.

See also
Types of accounts in M.Y.O.B. 
Organising accounts 



Editing an account
You may change the account number, account name, and, if allowed, the account level of an account. A detail 
account with transactions assigned to it may not be deleted or changed to a header account. A header account may 
be changed to a detail account. 

When you change an account's number, the account list is reordered (in account number order). If a header is 
separated from its sub-accounts, the sub-accounts are moved up one level. If the header is moved up or down a 
level, its sub-accounts are moved with it. 

See also
Types of accounts in M.Y.O.B. 
Account levels 
Organising accounts 



Entering budgets
You can create budgets in M.Y.O.B. to track your business's financial progress with a set of figures you'd like to 
achieve for each of your accounts. Use the History and Budgets window  to establish budgets.

When setting your budgets, be careful what sign (+ or -) you use. Positive budget amounts tell M.Y.O.B. to expect the 
account balance to grow during the month. When you set a £100 monthly budget for an income account, it means 
you're expecting £100 income for the month. Budget £100 for an asset and you're expecting the asset to grow by 
£100 during the month. Budget £100 for a liability and you're expecting the liability to grow £100. If you're buying 
down a loan, enter the budget as minus £100 per month. 

Enter the amount of net activity for balance sheet accounts, NOT the expected balance of the account for the budget 
activity. For example, if your March actual budget for Stock is £32,500 and your April actual budget is £34,500, enter 
£2,000, NOT £34,500 in the History and Budgets window for April.

See also
Using budget shortcuts 



Using budget shortcuts
You can quickly set up your budgets using the Budget Shortcuts window. 

Enter an amount and a frequency (Weekly, Bi-Weekly, Half-Monthly or Monthly). M.Y.O.B. multiplies the amount by 
the number of occurrences in a year. It divides that number by 12 to determine the monthly budget. If, for example, 
you have a £2,000 payroll expense every other week, enter £2,000 and choose Bi-Weekly. M.Y.O.B. multiplies £2,000
by 26 and divides the result by 12 for a monthly budget of £4,333.33. Enter a monthly increase or monthly percentage
increase and M.Y.O.B. begins with the January budgeted amount and increases it by the specified amount or percent.

M.Y.O.B. doesn't budget the 13th period.

See also
Entering budgets 



Creating a recurring Nominal Journal entry
The Nominal Journal Entry window allows you to enter transactions that aren't specific to the Chequebook, Sales 
Ledger, Purchase Ledger and Stock Control command centres. 

If you want to use the same Nominal Journal transaction on a regular basis, follow these instructions to create a 
recurring Nominal Journal entry. 

1. Use the Nominal Journal Entry window to enter the transaction's information as you normally would.

2. Click the Save as Recurring button. The Save as Recurring window appears. Enter the necessary information 
about the transaction in this window, then click Record. The transaction is saved as a recurring transaction.

3. Whenever you want to use the recurring Nominal Journal entry, open the Nominal Journal Entry window and click 
the Use Recurring button.

4. A window will appear, displaying all recurring transactions you've set up. Double-click the transaction you want, and
the transaction's information will appear in the Nominal Journal Entry window. 

5. To record the transaction, click Record. The recurring Nominal Journal entry will be recorded as an actual 
transaction, and you'll be able to use the same recurring Nominal Journal entry again.

See also
Changing a recurring Nominal Journal entry 
Removing a recurring Nominal Journal entry 



Changing a recurring Nominal Journal entry
To change a recurring Nominal Journal entry's name or frequency, open the Nominal Journal Entry window, click Use 
Recurring, select the recurring transaction and click Edit. To change the transaction's detail, wait until the next time 
you need to record it. When it's displayed, change it before you click Record. The next time you use it, the new detail 
will be displayed. 

See also
Creating a recurring Nominal Journal entry 
Removing a recurring Nominal Journal entry 



Removing a recurring Nominal Journal entry
To delete a recurring transaction, open the Nominal Journal Entry window, click Use Recurring, select the transaction 
you want to remove and click Delete. 

Deleting a recurring transaction only deletes it from your list of recurring transactions. All actual transactions recorded
previously using this recurring transaction are not affected.

See also
Creating a recurring Nominal Journal entry 
Changing a recurring Nominal Journal entry 



Using your bank accounts in the Chequebook Command 
Centre
The cheques you write in the Chequebook Command Centre use money that's in the bank accounts in your chart of 
accounts. Bank accounts are specified in the Edit Accounts window; after you've specified that an account has bank 
privileges, the name of the bank account will appear in lists throughout the M.Y.O.B. where you must specify the 
account you're writing cheques from. 

To indicate that an account is a bank account, display the account in the Edit Accounts window and choose the Detail 
Bank Account selection.

See also
Writing cheques and making withdrawals 
Writing a cheque 
Writing a void cheque 
Locating a cheque 
Removing or changing a cheque before it's saved 
Removing or changing a cheque after it's saved 
Reversing (voiding) a cheque 
Creating a recurring cheque 
Changing a recurring cheque 
Removing a recurring cheque 
Entering non-cheque withdrawals 
Printing cheques 



Writing a cheque
The Write Cheques window allows you to create records of your cheques drawn from any of your business's bank 
accounts. The top half of the window is designed to look like an actual paper cheque, with data entry fields that allow 
you to enter cheque information. the bottom half of the window contains a scrolling list of the accounts and jobs 
affected by the cheque, as well as the amounts that comprise each cheque.

See also
Writing cheques and making withdrawals    
Writing a void cheque 
Locating a cheque 
Removing or changing a cheque before it's saved 
Removing or changing a cheque after it's saved 
Reversing (voiding) a cheque 
Creating a recurring cheque 
Changing a recurring cheque 
Removing a recurring cheque 
Entering non-cheque withdrawals 
Printing cheques 



Writing a void cheque
Follow these steps to write a cheque with a zero amount. 

1. Use the Write Cheques window to create a cheque as you normally create cheques. However, instead of entering 
an amount in the Amount field, enter £0.00.

2. When youve finished, click Record.

3. An alert message appears, asking whether you wish to void this cheque. Click OK.

See also
Writing cheques and making withdrawals 
Writing a cheque 
Locating a cheque 
Removing or changing a cheque before it's saved 
Removing or changing a cheque after it's saved 
Reversing (voiding) a cheque 
Creating a recurring cheque 
Changing a recurring cheque 
Removing a recurring cheque 
Entering non-cheque withdrawals 
Printing cheques 



Locating a cheque
There are four ways to locate a cheque you've written: 

* Click the Transaction Journal button in the Chequebook Command Centre. The Transaction Journal window 
appears, displaying the Cash Disbursements Journal. This journal contains all cheques you've written during the date
range that's displayed at the top of the window.

* In the Write Cheques window, click the Journal button at the bottom of the window to open the Inquiry Register 
window.

* In the Write Cheques window, click the zoom arrow next to the Balance field to open the Transaction Journal 
window.

* Click the Inquiry button in the M.Y.O.B. Analyst, then select the Account tab and enter the bank account from which 
the cheque was written. The cheques for that bank account will be displayed.

See also
Writing cheques and making withdrawals 
Writing a cheque 
Writing a void cheque 
Removing or changing a cheque before it's saved 
Removing or changing a cheque after it's saved 
Reversing (voiding) a cheque 
Creating a recurring cheque 
Changing a recurring cheque 
Removing a recurring cheque 
Entering non-cheque withdrawals 
Printing cheques 



Removing or changing a cheque before it's saved
If you want to remove or change a cheque you've entered - but haven't chosen Save from the File menu yet - follow 
the steps below. 

1. Locate the cheque and display it in the Write Cheques window.

2. To change the cheque, change the information in the same way you normally enter information. To remove the 
cheque, select Delete Cheque from the Edit menu.

See also
Writing cheques and making withdrawals 
Writing a cheque 
Writing a void cheque 
Locating a cheque 
Removing or changing a cheque after it's saved 
Reversing (voiding) a cheque 
Creating a recurring cheque 
Changing a recurring cheque 
Removing a recurring cheque 
Entering non-cheque withdrawals 
Printing cheques 



Removing or changing a cheque after it's saved
If your transactions are changeable, follow the steps below to remove or change a cheque after it's saved. 

If your transactions are unchangeable, these instructions don't apply to you; instead, you must void incorrect cheques
and create new cheques with correct information. See Reversing (voiding) a cheque for more information.

1. Display the cheque you wish to remove or change in the Write Cheques window.

2. To change the cheque, change the information in the same way you normally enter information. To remove the 
cheque, select Delete Cheque from the Edit menu.

See also
Writing cheques and making withdrawals 
Writing a cheque 
Writing a void cheque 
Locating a cheque 
Removing or changing a cheque before it's saved 
Reversing (voiding) a cheque 
Creating a recurring cheque 
Changing a recurring cheque 
Removing a recurring cheque 
Entering non-cheque withdrawals 
Printing cheques 



Reversing (voiding) a cheque
If your transactions are unchangeable, you must reverse a cheque to remove its effect on your financial records. 

If your transactions are changeable, you don't need to reverse a cheque to change it; instead, you can display the 
cheque in the Write Cheques window and make changes to it.

A reversing transaction is a new transaction that replicates the original transaction with debit amounts shown as credit
amounts and vice versa. After recording a reversing transaction, you have two transactions (the original and the 
reversing), but the current account balances appear as if the original transaction never happened. Reversing a 
cheque is M.Y.O.B.'s equivalent to voiding a cheque.

1. Display the cheque you want to void in the Write Cheques window.

2. Choose Reverse Cheque from the Edit menu. M.Y.O.B. creates a cheque transaction containing an amount exactly
opposite of the amount in the original cheque.

You can make a few changes to the transaction you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with it.

If you're reversing a cheque from a previous accounting period, consider assigning a date from that period to the 
transaction you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the reversed cheque. The Write Cheques window disappears.

See also
Writing cheques and making withdrawals 
Writing a cheque 
Writing a void cheque 
Locating a cheque 
Removing or changing a cheque before it's saved 
Removing or changing a cheque after it's saved 
Creating a recurring cheque 
Changing a recurring cheque 
Removing a recurring cheque 
Entering non-cheque withdrawals 
Printing cheques 



Creating a recurring cheque
If you want to use the same cheque transaction on a regular basis, follow these instructions to create a recurring 
cheque. 

1. Use the Write Cheques window to enter the cheque's information as you normally would.

2. Click the Save as Recurring button. The Save as Recurring window appears. Enter the necessary information 
about the transaction in this window, then click Record. The cheque is saved as a recurring transaction.

3. Whenever you want to use the recurring cheque, open the Write Cheques window and click the Use Recurring 
button.

4. A window will appear, displaying all recurring cheques you've set up. Double-click the cheque you want, and the 
cheque's information will appear in the Write Cheques window. 

5. To record the transaction, click Record. The recurring cheque will be recorded as an actual cheque, and you'll be 
able to use the same recurring cheque again.

See also
Writing cheques and making withdrawals 
Writing a cheque 
Writing a void cheque 
Locating a cheque 
Removing or changing a cheque before it's saved 
Removing or changing a cheque after it's saved 
Reversing (voiding) a cheque 
Changing a recurring cheque 
Removing a recurring cheque 
Entering non-cheque withdrawals 
Printing cheques 



Changing a recurring cheque
To change a recurring cheque's name or frequency, open the Write Cheques window, click Use Recurring, select the 
recurring transaction and click Edit. To change the transaction's detail (such as the payee and amounts), wait until the
next time you need to record it. When it's displayed, change it before you click Record. The next time you use it, the 
new detail will be displayed. 

See also
Writing cheques and making withdrawals 
Writing a cheque 
Writing a void cheque 
Locating a cheque 
Removing or changing a cheque before it's saved 
Removing or changing a cheque after it's saved 
Reversing (voiding) a cheque 
Creating a recurring cheque 
Removing a recurring cheque 
Entering non-cheque withdrawals 
Printing cheques 



Removing a recurring cheque
To delete a recurring transaction from your list, open the Write Cheques window, click Use Recurring, select the 
transaction you want to remove and click Delete. 

Deleting a recurring transaction only deletes it from your list of recurring transactions. All actual transactions recorded
previously using this recurring transaction are not affected.

See also
Writing cheques and making withdrawals 
Writing a cheque 
Writing a void cheque 
Locating a cheque 
Removing or changing a cheque before it's saved 
Removing or changing a cheque after it's saved 
Reversing (voiding) a cheque 
Creating a recurring cheque 
Changing a recurring cheque 
Entering non-cheque withdrawals 
Printing cheques 



Entering non-cheque withdrawals
There are two ways to record withdrawals from your bank account without writing a cheque. 

* By entering a transaction in the Nominal Journal Entry window in the Nominal Ledger Command Centre

* By using the Write Cheques window

Whichever method you choose, the transaction appears in the Inquiry Register and Reconcile Accounts windows. 
The only major differences are that cheque transactions appear in the Cash Disbursements Journal  and can be 
linked to a card, whereas Nominal Journal transactions appear in the Nominal Journal and are unlinked.

Using the Nominal Journal Entry window
Credit your bank account for the amount of the withdrawal. Debit the destination account (Bank fees expense, your 
savings account, etc.). The transaction is placed in the Nominal Journal.

Using the Write Cheques window
In the Cheque No. field, enter a non-numeric descriptor for the withdrawal. That way, you'll know the transaction isn't 
an actual cheque when you view it in a inquiry window or on a report. This will also allow you to skip the transaction 
when you print a range of numbered cheques.

See also
Writing cheques and making withdrawals 
Writing a cheque 
Writing a void cheque 
Locating a cheque 
Removing or changing a cheque before it's saved 
Removing or changing a cheque after it's saved 
Reversing (voiding) a cheque 
Creating a recurring cheque 
Changing a recurring cheque 
Removing a recurring cheque 
Printing cheques 



Printing cheques
Print cheques in M.Y.O.B. using the Print Cheques window.

The cheques you print in M.Y.O.B. can be customised to match the way you want your cheques to look. To do this, 
click the Customise button at the bottom of the Print Cheques window.

See also
Writing cheques and making withdrawals 
Writing a cheque 
Writing a void cheque 
Locating a cheque 
Removing or changing a cheque before it's saved 
Removing or changing a cheque after it's saved 
Reversing (voiding) a cheque 
Creating a recurring cheque 
Changing a recurring cheque 
Removing a recurring cheque 
Entering non-cheque withdrawals 



Entering a deposit
The Make a Deposit window allows you to create records of your deposits made into any of your business's bank 
accounts.

See also
Locating a deposit 
Removing or changing a deposit before it's saved 
Removing or changing a deposit after it's saved 
Reversing a deposit 
Creating a recurring deposit 
Changing a recurring deposit 
Removing a recurring deposit 



Locating a deposit
There are four ways to locate a deposit you've made: 

* Click the Transaction Journal button in the Chequebook Command Centre. The Transaction Journal window 
appears, displaying the Cash Receipts Journal. This journal contains all deposits you've written during the date range
that's displayed at the top of the window.

* In the Make a Deposit window, click the Journal button at the bottom of the window to open the Inquiry Register 
window.

* In the Make a Deposit window, click the zoom arrow next to the Balance field to open the Transaction Journal 
window.

* Click the Inquiry button in the M.Y.O.B. Analyst, then select the Account tab and enter the bank account to which the
deposit was made. The deposits for that bank account will be displayed.

See also
Entering a deposit 
Removing or changing a deposit before it's saved 
Removing or changing a deposit after it's saved 
Reversing a deposit 
Creating a recurring deposit 
Changing a recurring deposit 
Removing a recurring deposit 



Removing or changing a deposit before it's saved
If you want to remove or change a deposit entry you've made - but haven't chosen Save from the File menu  yet - 
follow the steps below. 

1. Locate the deposit and display it in the Make a Deposit window.

2. To change the deposit, change the information in the same way you normally enter information. To remove the 
deposit, select Delete Deposit from the Edit menu.

See also
Entering a deposit 
Locating a deposit 
Removing or changing a deposit after it's saved 
Reversing a deposit 
Creating a recurring deposit 
Changing a recurring deposit 
Removing a recurring deposit 



Removing or changing a deposit after it's saved
If your transactions are changeable, follow the steps below to remove or change a deposit after it's saved. 

If your transactions are unchangeable, these instructions don't apply to you; instead, you must void incorrect deposits
and create new deposits with correct information. See Reversing a deposit for more information.

1. Display the deposit you wish to remove or change in the Make a Deposit window.

2. To change the deposit, change the information in the same way you normally enter information. To remove the 
deposit, select Delete Deposit from the Edit menu.

See also
Entering a deposit 
Locating a deposit 
Removing or changing a deposit before it's saved 
Reversing a deposit 
Creating a recurring deposit 
Changing a recurring deposit 
Removing a recurring deposit 



Reversing a deposit
If your transactions are unchangeable, you must reverse a deposit to remove its effect on your financial records. 

If your transactions are changeable, you don't need to reverse a deposit to change it; instead, you can display the 
deposit in the Make a Deposit window and make changes to it.

A reversing transaction is a new transaction that replicates the original transaction with debit amounts shown as credit
amounts and vice versa. After recording a reversing transaction, you have two transactions (the original and the 
reversing), but the current account balances appear as if the original transaction never happened. 

1. Display the deposit you want to reverse in the Make a Deposit window.

2. Choose Reverse Deposit from the Edit menu. M.Y.O.B. creates a deposit transaction containing an amount exactly
opposite of the amount in the original deposit.

You can make a few changes to the transaction you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with it.

If you're reversing a deposit from a previous accounting period, consider assigning a date from that period to the 
transaction you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the reversed deposit. The Make a Deposit window disappears.

See also
Entering a deposit 
Locating a deposit 
Removing or changing a deposit before it's saved 
Removing or changing a deposit after it's saved 
Creating a recurring deposit 
Changing a recurring deposit 
Removing a recurring deposit 



Creating a recurring deposit
If you want to use the same deposit transaction on a regular basis, follow these instructions to create a recurring 
deposit. 

1. Use the Make a Deposit window to enter the deposit's information as you normally would.

2. Click the Save as Recurring button. The Save as Recurring window appears. Enter the necessary information 
about the transaction in this window, then click Record. The deposit is saved as a recurring transaction.

3. Whenever you want to use the recurring deposit, open the Make a Deposit window and click the Use Recurring 
button.

4. A window will appear, displaying all recurring deposits you've set up. Double-click the deposit you want, and the 
deposit's information will appear in the Make a Deposit window. 

5. To record the transaction, click Record. The recurring deposit will be recorded as an actual deposit, and you'll be 
able to use the same recurring deposit again.

See also
Entering a deposit 
Locating a deposit 
Removing or changing a deposit before it's saved 
Removing or changing a deposit after it's saved 
Reversing a deposit 
Changing a recurring deposit 
Removing a recurring deposit 



Changing a recurring deposit
To change a recurring transaction's name or frequency, click Use Recurring, select the transaction and click Edit. To 
change the detail (memo, accounts, amounts, etc.) of a transaction, wait until the next time you need to record it. 
When it is displayed, change it before recording. The next time you use it, the new detail is displayed. 

See also
Entering a deposit 
Locating a deposit 
Removing or changing a deposit before it's saved 
Removing or changing a deposit after it's saved 
Reversing a deposit 
Creating a recurring deposit 
Removing a recurring deposit 



Removing a recurring deposit
To delete a recurring transaction from your list, click Use Recurring, select it and click Delete. 

Deleting a recurring transaction only deletes it from your list of recurring transactions. All actual transactions recorded
previously using this recurring transaction are not affected. 

See also
Entering a deposit 
Locating a deposit 
Removing or changing a deposit before it's saved 
Removing or changing a deposit after it's saved 
Reversing a deposit 
Creating a recurring deposit 
Changing a recurring deposit 



Reconciling accounts
You need to keep your M.Y.O.B. records of your bank accounts' balances matched up with your bank's records. To do
this, use the Reconcile Accounts window.

A few tips about reconciling your bank accounts
Remember to enter all bank charges before reconciling. Bank charges can be entered as a cheque in the Write 
Cheques window or in the Nominal Journal Entry window.

If you enter new transactions or correct an old one, remember to choose Save from the File menu before continuing 
with the reconciliation.

An out-of-balance situation can be caused by many things. Among them are:

* You haven't checked all cleared transactions or you've checked an uncleared transaction.

* A transaction on your statement hasn't been entered in M.Y.O.B.

* You entered an incorrect amount in the New Balance from Statement field in the Reconcile Accounts window.

* The individual cheque and deposit amounts entered in M.Y.O.B. disagree with your statement. (If your Out of 
Balance amount is a multiple of 9, look for a numbers transposition; a 28, for example, entered as an 82.)

* Your bank may be wrong!

You may have some difficulty reconciling if you have uncleared cheques and deposits recorded before your 
conversion month. If so, enter the uncleared cheques and deposits (you may have to use a different date for these 
transactions). Use your bank account as the allocation account so you don't change its balance.

If you decide to exit the Reconcile Accounts window without successfully reconciling a bank account, the transactions
marked as cleared remain marked. You can pick up where you left off at any time. 



Types of sales transactions
In M.Y.O.B., you can record a number of different types of sales transactions, each of which is designed to match the 
sales you make in your business. All sales transactions are entered using the Sales window. 

A brief description of each type of sales transaction is located below.

* Item invoices are used to record the sale of items and services for which you selected I Sell This Item in the Item 
Information window. When you save an item invoice, your in-house quantities of the items for which you also selected
I Stock This Item in the Item Information window (also known as stock items) listed on the invoice change 
accordingly. You can print item invoices and send them to your customers, if you wish. 

* Service invoices are used to record the sale of items and services that you didn't enter information about in the 
Item Information window. This type of invoice allows you to track sales transactions that don't affect your stock 
quantities. You can print service invoices and send them to your customers, if you wish. 

* Professional invoices are also used to record the sale of items and services that you didn't enter information about
in the Item Information window, and include the specific date each item was sold. You can print professional invoices 
and send them to your customers, if you wish. 

* Other sales are used to record the sale of items and services that you didn't enter information about in the Item 
Information window, and that don't require a printed invoice. 

* Pending invoices are used to record item invoices and service invoices that you expect to occur. Pending invoices 
don't change the quantities of your stock items when they're saved; rather, they're kept in the Pending File until you 
convert them to actual invoices. 

See also
Working with item invoices 
Working with service invoices 
Working with professional invoices 
Working with other sales 
Working with pending invoices 



Assigning credit terms to customers
Credit terms can be assigned to customers in two ways: 

* By determining a set of default credit terms for all your customers

* By assigning a specific set of terms to an individual customer

Follow the instructions below for each method.

Determining default credit terms for all customers
This method will establish a set of credit terms for all new customer records you create in M.Y.O.B. Each time you 
create a new customer record, the terms you established here will appear as default terms for the new customer. (If 
you wish, you can change the defaults.)

1. Choose Linked Accounts/Sales Ledger Accounts from the Setup menu. The Sales Ledger Linked Accounts window
appears.

2. Click the Terms button in the lower left-hand corner of the window. The Credit Terms window appears.

3. Select the terms you want to use as default terms in the Credit Terms window. When youve finished, click OK.

Assigning specific terms to an individual customer
This method will assign a set of credit terms for one customer only. 

1. Display the customer's record in the Card File Entry window. To do this, click Cards in the Card File Command 
Centre to display the View Card File window, select the Customer tab, then click the zoom arrow next to the 
customer's name. (If you're creating a new customer record, click the New button at the bottom of the window.) The 
Card File Entry window appears.

2. At the bottom of the Card File Entry window, click the Terms button. The Credit Terms window will appear.

3. Select the terms you want to assign to the customer. When youve finished, click OK.



How finance charges are calculated
If you assign finance charges to balances that aren't paid by their due date, finance charges will be assessed 
beginning the day after the balance due date. Due dates and finance charge amounts are determined by the 
selections you made for the customer in the Credit Terms window. 

A finance charge amount is determined by multiplying an overdue balance by 1/30th of the monthly finance charge 
rate for each day the balance is overdue. If a customer paid part of an overdue balance during the overdue period - 
and you used the Customer Payments window to apply the payment - the finance charge amount will be based upon 
the remaining overdue balance.

See also
How finance charges are tracked 



How finance charges are tracked
Finance charges are calculated at the time customer statements are printed, and their amounts can be printed on the 
statement, if you wish. However, finance charge amounts are not tracked in M.Y.O.B.; they're merely printed on 
statements. This gives you the flexibility in deciding how finance charges should be administered. With this in mind, 
you should consider a few things when you're dealing with finance charges in M.Y.O.B.: 

* To track finance charges, you can do one of three things:

- Enter the payment of finance charges in the Finance Charge field in the Customer Payments window, or 

- Create an entire invoice for the finance charges in the Sales window, then use the Customer Payments window to 
enter payments against the invoice, or

- Add the finance charge amount to the outstanding balance of the open sale, then use the Customer Payments 
window to enter payments against the open sale.

* Since the finance charge amounts that appear on statements are always calculated based upon the total overdue 
balance of an open sale, any payments made previously against finance charges aren't taken into consideration. As a
result, the finance charge amount on a statement may be incorrect.

See also
How finance charges are calculated 



Creating an item invoice
Use the Sales window to create an item invoice. 

To designate which type of invoice you want, click the Invoice Type button at the bottom of the Sales window; a 
window appears, listing the types of sales transactions you can create. When you select Item Invoice, the data entry 
fields in the Sales window reflect the type you selected.

See also
Entering two or more lines for an item description 
Locating an item invoice 
Removing or changing an item invoice before it's saved 
Removing or changing an item invoice after it's saved 
Reversing item invoices 
Reversing an item invoice with no payments assigned to it 
Reversing a partially paid item invoice 
Reversing a closed item invoice 
Printing invoices with backordered items 



Entering two or more lines for an item description
If you want to create more than one line of text to describe an item you're including on an invoice, use the following 
information to create more lines of text. 

* You can enter up to 255 characters for an item description. All 255 characters will print on an invoice.

* If 255 characters aren't enough, create a special item in the Item Information window for descriptions. To do this, 
follow these steps:

1. In the Stock Control Command Centre, click Items List. The Items List window will appear. Click the New button.

2. Create a new item, using a backslash (\) as the first character of the item's number.

3. Mark the I Sell This Item selection. In the Income Account for Tracking Sales field, enter any income account's 
number.

4. Be sure the Price field and Selling Unit of Measure field are blank, and leave the Track Sales History and VAT 
Code When Sold selections unmarked.

5. Click OK to record the item, then close the Item Information window.

6. Whenever you want to use the "item" for a description in an invoice, enter its number in the Item No. column of the 
Sales window - don't forget to leave the Deliver and Backorder columns blank - and enter the description in the 
Description column.

7. If you want to place a blank line between items on the invoice, enter the first item and move the highlight to the 
second line. In the second line, enter the "\" item in the Item No. field, then enter a space in the Description field. 
Move to the third line and enter the other item in the transaction.

See also
Creating an item invoice 
Locating an item invoice 
Removing or changing an item invoice before it's saved 
Removing or changing an item invoice after it's saved 
Reversing item invoices 
Reversing an item invoice with no payments assigned to it 
Reversing a partially paid item invoice 
Reversing a closed item invoice 
Printing invoices with backordered items 



Locating an item invoice
Follow the steps below to find an invoice you created in the Sales window. 

1. Select Inquiry from the M.Y.O.B. Analyst. The Inquiry Register window appears.

2. If you know the number of the transaction you want to view, click the Invoice tab, then enter the transaction's 
number in the Invoice No. field.

If you don't know the number of the transaction you want to view, click the Card tab, then enter the name of the 
customer whose transaction you're looking for.

3. The transaction you're looking for appears in the scrolling list. If you want to view detail about the transaction, click 
the zoom arrow next to the transaction's number to open the window in which the transaction was originally entered.

See also
Creating an item invoice 
Entering two or more lines for an item description 
Removing or changing an item invoice before it's saved 
Removing or changing an item invoice after it's saved 
Reversing item invoices 
Reversing an item invoice with no payments assigned to it 
Reversing a partially paid item invoice 
Reversing a closed item invoice 
Printing invoices with backordered items 



Removing or changing an item invoice before it's saved
If you want to remove or change an invoice you've entered - but haven't chosen Save from the File menu yet - follow 
the steps below. 

1. Locate the invoice and display it in the Sales window.

2. To change the invoice, change the information in the same way you normally enter information. To remove the 
invoice, select Delete Invoice from the Edit menu.

See also
Creating an item invoice 
Entering two or more lines for an item description 
Locating an item invoice 
Removing or changing an item invoice after it's saved 
Reversing item invoices 
Reversing an item invoice with no payments assigned to it 
Reversing a partially paid item invoice 
Reversing a closed item invoice 
Printing invoices with backordered items 



Removing or changing an item invoice after it's saved
If your transactions are changeable, follow the steps below to remove or change an invoice after it's saved. 

If your transactions are unchangeable, these instructions don't apply to you; instead, you must reverse incorrect 
invoices and create new invoices with correct information. See Reversing item invoices for more information.

1. Display the invoice you wish to remove or change in the Sales window.

2. If you intend to remove the invoice but payments are applied to it, remove the payments before you attempt to 
remove the invoice. See Recording payments from customers for more information about removing payments.

3. To change the invoice, change the information in the same way you normally enter information. To remove the 
invoice, select Delete Invoice from the Edit menu.

See also
Creating an item invoice 
Entering two or more lines for an item description 
Locating an item invoice 
Removing or changing an item invoice before it's saved 
Reversing item invoices 
Reversing an item invoice with no payments assigned to it 
Reversing a partially paid item invoice 
Reversing a closed item invoice 
Printing invoices with backordered items 



Reversing item invoices
If your transactions are unchangeable, you must reverse an invoice to remove its effect on your financial records. 

Many scenarios exist if you want to reverse an invoice. Click the instructions that apply to your situation:

* Reversing an item invoice with no payments assigned to it 

* Reversing a partially paid item invoice 

* Reversing a closed item invoice 

If your transactions are changeable, you don't need to reverse an invoice to change it; instead, you can display the 
invoice in the Sales window and make changes to it.

See also
Creating an item invoice 
Entering two or more lines for an item description 
Locating an item invoice 
Removing or changing an item invoice before it's saved 
Removing or changing an item invoice after it's saved 
Printing invoices with backordered items 



Reversing an item invoice with no payments assigned to it
Two situations can exist if you want to reverse an item invoice with no payments assigned to it: 

* If the customer returned all the items that were on the invoice

* If the customer didn't return all the items that were on the invoice

Follow the steps below for the situation that applies to you.

If the customer returned all the items
You need to create a credit note that removes the total amount of the invoice and returns the total quantities of the 
items on the invoice back to their previous levels.

1. Locate the item invoice you want to reverse and display it in the Sales window.

2. Choose Reverse Invoice from the Edit menu. M.Y.O.B. creates a credit note containing amounts and quantities 
exactly opposite of the amounts and quantities in the item invoice.

You can make a few changes to the credit note you've created (such as the date and the memo), but you can't 
change the accounts, amounts and quantities that are associated with the credit note.

If you're reversing an invoice from a previous accounting period, consider assigning a date from that period to the 
credit note you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the credit note. At this time, the item quantities that were listed on the invoice return 
to their previous levels. The Sales window disappears.

4. Select Settle Returns & Credits from the Sales Ledger Command Centre. A search list appears; from this list, 
select the credit note you created and click the Apply to Open Invoice button. The credit note appears in the Settle 
Returns & Credits window.

5. In the list of transactions at the bottom of the Settle Returns & Credits window, enter the entire amount of the credit
note in the Amount Applied field of the item invoice you want to reverse.

6. Click Record. The Settle Returns & Credits window disappears; the item invoice is reversed.

If the customer didn't return all the items
You need to create a credit note that removes a partial amount of the invoice and decreases your quantities of the 
items on the invoice by the number of items that were returned. 

If you're in this situation, you can't automatically reverse the invoice by selecting Reverse Invoice from the Edit menu.
Actually, since you're not clearing the entire transaction from your records, you're not reversing the invoice at all - 
you're merely changing it to reflect the actual amounts and quantities in the item invoice.

1. In the Sales window, begin creating a new item invoice by entering the necessary customer information at the top 
of the window. 

2. In the Item Invoice View section, use a negative number to enter the quantity of items that were returned. For 
example, if the original item invoice recorded the sale of 10 widgets but the customer returned five widgets, enter -5 
widgets in one line of Item Invoice View. The amount of the invoice is automatically calculated, and a negative 
number appears in the Total column.

3. If you need to make any changes to the amounts or other fields in this window, you can do so. When youve 
finished, click Record. The invoice you just created is called a credit note. At this time, the item quantities on the 
credit note increase the quantities of your stock items.

4. Select Settle Returns & Credits from the Sales Ledger Command Centre. A search list appears; from this list, 
select the credit note you created and click the Apply to Open Invoice button. The credit note appears in the Settle 
Returns & Credits window.

5. In the list of transactions at the bottom of the Settle Returns & Credits window, enter the entire amount of the credit



note in the Amount Applied field of the item invoice you want to change.

6. Click Record. The Settle Returns & Credits window disappears; the changes are made to the item invoice.

See also
Creating an item invoice 
Entering two or more lines for an item description 
Locating an item invoice 
Removing or changing an item invoice before it's saved 
Removing or changing an item invoice after it's saved 
Reversing item invoices 
Reversing a partially paid item invoice 
Reversing a closed item invoice 
Printing invoices with backordered items 



Reversing a partially paid item invoice
Follow the steps below to reverse an item invoice that's only partially paid. This process returns all balances to the 
amounts they had before the invoice was recorded, and returns the quantities of your stock items on the invoice back 
to the quantities they had before the invoice was recorded. 

1. Display the item invoice you want to reverse in the Sales window.

2. Choose Reverse Invoice from the Edit menu. M.Y.O.B. creates a credit note containing amounts and quantities 
exactly opposite of the amounts and quantities in the item invoice.

You can make a few changes to the credit note you've created (such as the date and the memo), but you can't 
change the accounts, amounts and quantities that are associated with the credit note.

If you're reversing an item invoice from a previous accounting period, consider assigning a date from that period to 
the credit note you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the credit note. The Sales window disappears.

4. Select Settle Returns & Credits from the Sales Ledger Command Centre. A search list appears; from this list, 
highlight the credit note you created and click the Apply to Open Invoice button.

5. At this point, you may choose to do one of three things:

* Apply part of the credit note amount to the remaining balance of the item invoice you want to reverse, then apply the
rest of the credit note to another sales transaction's remaining balance. To do this, follow these steps:

a. Enter part of the credit note amount in the item invoice's Amount Applied field so the transaction has no remaining 
balance.

b. Enter the rest of the credit note in another sales transaction's Amount Applied field.

c. Click Record. 

* Apply part of the credit note amount to the remaining balance of the item invoice you want to reverse, and write a 
refund cheque to the customer for the rest of the credit note amount. To do this, follow these steps:

a. Change the Credit Amount field so it's the same as the remaining balance of the item invoice you want to reverse.

b. Enter the Credit Amount field's amount in the Amount Applied field of the item invoice you want to reverse, so the 
item invoice has no remaining balance.

c. Click Record; the item invoice is reversed. The credit note, containing the unapplied amount, remains in the 
system.

d. Select Settle Returns & Credits again.

e. Select the credit note and click the Write a Refund Cheque button. The Settle Returns & Credits window appears, 
displaying a refund cheque with the remaining amount of the credit note.

f. Click Record to save the refund cheque.

* Apply part of the credit note amount to the remaining balance of the item invoice you want to reverse, and save the 
rest of the credit note amount for later. To do this, follow these steps:

a. Change the Credit Amount field so it's the same as the remaining balance of the item invoice you want to reverse.

b. Enter the Credit Amount field's amount in the Amount Applied field of the item invoice you want to reverse, so the 
item invoice has no remaining balance.

c. Click Record; the item invoice is reversed. The credit note, containing the unapplied amount, remains in the 
system. Keep in mind that the credit note will exist until you apply it to another transaction or write a refund cheque 



for it.

See also
Creating an item invoice 
Entering two or more lines for an item description 
Locating an item invoice 
Removing or changing an item invoice before it's saved 
Removing or changing an item invoice after it's saved 
Reversing item invoices 
Reversing an item invoice with no payments assigned to it 
Reversing a closed item invoice 
Printing invoices with backordered items 



Reversing a closed item invoice
Follow the steps below to reverse an item invoice, originally entered in the Sales window, that's completely paid. This 
process returns all balances to the amounts they had before the invoice was recorded, and returns the quantities of 
your stock items on the invoice back to the quantities they had before the invoice was recorded. 

1. Display the item invoice you want to reverse in the Sales window.

2. Choose Reverse Invoice from the Edit menu. M.Y.O.B. creates a credit note containing amounts and quantities 
exactly opposite of the amounts and quantities on the item invoice.

You can make a few changes to the credit note you've created (such as the date and the memo), but you can't 
change the accounts, amounts and quantities that are associated with the credit note.

If you're reversing an item invoice from a previous accounting period, consider assigning a date from that period to 
the credit note you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the credit note. At this time, the item quantities that were listed on the invoice return 
to their previous levels. The Sales window disappears.

4. Select Settle Returns & Credits from the Sales Ledger Command Centre. A search list appears; from this list, 
highlight the credit note you created.

5. At this point, you may choose to do one of two things:

* Write a refund cheque to the customer. To do this, follow these steps:

a. Click the Write a Refund Cheque button. The Settle Returns & Credits window appears, displaying a refund 
cheque in the amount of the credit note.

b. Click Record to save the refund cheque; the item invoice is reversed.

* Apply the credit note amount to one or more of the customer's open sales. To do this, follow these steps:

a. Click the Apply to Open Invoice button. The Settle Returns & Credits window appears, displaying the credit note.

b. In the list of transactions at the bottom of the Settle Returns & Credits window, enter the total amount of the credit 
note in the Amount Applied field(s) of the open sale(s) you want to apply the amount to. 

c. Click Record to save the transaction you created; the item invoice is reversed.

See also
Creating an item invoice 
Entering two or more lines for an item description 
Locating an item invoice 
Removing or changing an item invoice before it's saved 
Removing or changing an item invoice after it's saved 
Reversing item invoices 
Reversing an item invoice with no payments assigned to it 
Reversing a partially paid item invoice 
Printing invoices with backordered items 



Printing invoices with backordered items
If you've included backordered items on an invoice, the backordered items will be printed on the invoice. However, 
the value of the items you backordered won't be printed on the invoice. 

If you don't want to print backordered items on an invoice, don't enter quantities in the Backorder column of the Sales 
window.

See also
Creating an item invoice 
Entering two or more lines for an item description 
Locating an item invoice 
Removing or changing an item invoice before it's saved 
Removing or changing an item invoice after it's saved 
Reversing item invoices 
Reversing an item invoice with no payments assigned to it 
Reversing a partially paid item invoice 
Reversing a closed item invoice 



Creating a service invoice
Use the Sales window to create a service invoice. 

To assign a service invoice type to a sales transaction, click the Invoice Type button at the bottom of the Sales 
window; a window appears, listing the types of sales transactions you can create. When you make a selection, the 
Sales window will contain the fields you need to create the service invoice.

See also
Locating a service invoice 
Removing or changing a service invoice before it's saved 
Removing or changing a service invoice after it's saved 
Reversing service invoices 
Reversing a service invoice with no payments assigned to it 
Reversing a partially paid service invoice 
Reversing a closed service invoice 



Locating a service invoice
Follow the steps below to find a service invoice you entered in the Sales window. 

1. Select Inquiry from the M.Y.O.B. Analyst. The Inquiry Register window appears.

2. If you know the number of the transaction you want to view, click the Invoice tab, then enter the transaction's 
number in the Invoice No. field.

If you don't know the number of the transaction you want to view, click the Card tab, then enter the name of the 
customer whose transaction you're looking for.

3. The transaction you're looking for appears in the scrolling list. If you want to view detail about the transaction, click 
the zoom arrow next to the transaction's number to open the window in which the transaction was originally entered.

See also
Creating a service invoice 
Removing or changing a service invoice before it's saved 
Removing or changing a service invoice after it's saved 
Reversing service invoices 
Reversing a service invoice with no payments assigned to it 
Reversing a partially paid service invoice 
Reversing a closed service invoice 



Removing or changing a service invoice before it's saved
If you want to remove or change an invoice you've entered - but haven't chosen Save from the File menu yet - follow 
the steps below. 

1. Locate the invoice and display it in the Sales window.

2. To change the invoice, change the information in the same way you normally enter information. To remove the 
invoice, select Delete Invoice from the Edit menu.

See also
Creating a service invoice 
Locating a service invoice 
Removing or changing a service invoice after it's saved 
Reversing service invoices 
Reversing a service invoice with no payments assigned to it 
Reversing a partially paid service invoice 
Reversing a closed service invoice 



Removing or changing a service invoice after it's saved
If your transactions are changeable, follow the steps below to remove or change a service invoice  after it's saved. 

If your transactions are unchangeable, these instructions don't apply to you; instead, you must reverse incorrect 
service invoices and create new service invoices with correct information. See Reversing service invoices for more 
information.

1. Locate the service invoice you wish to remove or change and display it in the Sales window.

2. If you intend to remove the service invoice but payments are applied to it, remove the payments before you attempt
to remove the service invoice. See Recording payments from customers for more information about removing 
payments.

3. To change the transaction, change the information in the same way you normally enter information. To remove the 
transaction, select Delete Sale from the Edit menu.

See also
Creating a service invoice 
Locating a service invoice 
Removing or changing a service invoice before it's saved 
Reversing service invoices 
Reversing a service invoice with no payments assigned to it 
Reversing a partially paid service invoice 
Reversing a closed service invoice 



Reversing service invoices
If your transactions are unchangeable, you must reverse a service invoice to remove its effect on your financial 
records. 

Three scenarios exist if you want to reverse a service invoice. Click the instructions in this section that apply to your 
situation:

* Reversing a service invoice with no payments assigned to it 

* Reversing a partially paid service invoice 

* Reversing a closed service invoice 

If your transactions are changeable, you don't need to reverse your service invoices to change them; instead, you 
can display the service invoice in the Sales window and make changes to it.

See also
Creating a service invoice 
Locating a service invoice 
Removing or changing a service invoice before it's saved 
Removing or changing a service invoice after it's saved 



Reversing a service invoice with no payments assigned to it
Follow the steps below to reverse a service invoice that doesn't have payments assigned to it. 

1. Locate the service invoice you want to reverse and display it in the Sales window.

2. Choose Reverse Invoice from the Edit menu. M.Y.O.B. creates a credit note containing an amount exactly opposite
of the amount in the service invoice.

You can make a few changes to the credit note you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the credit note.

If you're reversing a sale from a previous accounting period, consider assigning a date from that period to the credit 
note you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the credit note. The Sales window disappears.

4. Select Settle Returns & Credits from the Sales Ledger Command Centre. A search list appears; from this list, 
select the credit note you created and click the Apply to Open Invoice button. The credit note appears in the Settle 
Returns & Credits window.

5. In the list of service invoices at the bottom of the Settle Returns & Credits window, enter the amount of the credit 
note in the Amount Applied field of the service invoice you want to reverse.

6. Click Record. The Settle Returns & Credits window disappears; the service invoice is reversed.

See also
Creating a service invoice 
Locating a service invoice 
Removing or changing a service invoice before it's saved 
Removing or changing a service invoice after it's saved 
Reversing service invoices 
Reversing a partially paid service invoice 
Reversing a closed service invoice 



Reversing a partially paid service invoice
Follow the steps below to reverse a service invoice that's only partially paid. 

1. Display the service invoice you want to reverse in the Sales window.

2. Choose Reverse Invoice from the Edit menu. M.Y.O.B. creates a credit note containing an amount exactly opposite
of the amount in the service invoice.

You can make a few changes to the credit note you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the credit note.

If you're reversing a service invoice from a previous accounting period, consider assigning a date from that period to 
the credit note you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the credit note. The Sales window disappears.

4. Select Settle Returns & Credits from the Sales Ledger Command Centre. A search list appears; from this list, 
highlight the credit note you created and click the Apply to Open Invoice button.

5. At this point, you may choose to do one of three things:

* Apply part of the credit note amount to the remaining balance of the service invoice you want to reverse, then apply 
the rest of the credit note to a service invoice's remaining balance. To do this, follow these steps:

a. Enter part of the credit note amount in the service invoice's Amount Applied field so the service invoice has no 
remaining balance.

b. Enter the rest of the credit note in a service invoice's Amount Applied field.

c. Click Record to save the transaction; the service invoice is reversed. 

* Apply part of the credit note amount to the remaining balance of the service invoice you want to reverse, and write a
refund cheque for the rest of the credit note amount. To do this, follow these steps:

a. Change the Credit Amount field so it's the same as the remaining balance of the service invoice you want to 
reverse.

b. Enter the Credit Amount field's amount in the Amount Applied field of the service invoice you want to reverse, so 
the service invoice has no remaining balance.

c. Click Record; the service invoice is reversed. The credit note, containing the unapplied amount, remains in the 
system.

d. Select Settle Returns & Credits again.

e. Select the credit note and click the Write a Refund button. The Settle Returns & Credits window appears, 
displaying a refund cheque in the remaining amount of the credit note.

f. Click Record to save the refund cheque.

* Apply part of the credit note amount to the remaining balance of the service invoice you want to reverse, and save 
the rest of the credit note amount for later. To do this, follow these steps:

a. Change the Credit Amount field so it's the same as the remaining balance of the service invoice you want to 
reverse.

b. Enter the Credit Amount field's amount in the Amount Applied field of the service invoice you want to reverse, so 
the service invoice has no remaining balance.

c. Click Record; the service invoice is reversed. The credit note, containing the unapplied amount, remains in the 
system. Keep in mind that the credit note will exist until you apply it to a service invoice or write a refund cheque for it.



See also
Creating a service invoice 
Locating a service invoice 
Removing or changing a service invoice before it's saved 
Removing or changing a service invoice after it's saved 
Reversing service invoices 
Reversing a service invoice with no payments assigned to it 
Reversing a closed service invoice 



Reversing a closed service invoice
Follow the steps below to reverse a service invoice that's completely paid. 

1. Display the invoice you want to reverse in the Sales window.

2. Choose Reverse Invoice from the Edit menu. M.Y.O.B. creates a credit note containing an amount exactly opposite
of the amount in the closed service invoice.

You can make a few changes to the credit note you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the credit note.

If you're reversing a closed service invoice from a previous accounting period, consider assigning a date from that 
period to the credit note you've created. This will allow your reports for that accounting period to reflect the proper 
amounts.

3. Click Record Reversal to save the credit note. The Sales window disappears.

4. Select Settle Returns & Credits from the Sales Ledger Command Centre. A search list appears; from this list, 
highlight the credit note you created.

5. At this point, you may choose to do one of two things:

* Write a refund cheque to the customer. To do this, follow these steps:

a. Click the Write a Refund Cheque button. The Settle Returns & Credits window appears, displaying a refund 
cheque in the amount of the credit note.

b. Click Record to save the refund cheque; the closed service invoice is reversed.

* Apply the credit note amount to one or more of the customer's open sales. To do this, follow these steps:

a. Click the Apply to Open Invoice button. The Settle Returns & Credits window appears, displaying the credit note.

b. In the list of transactions at the bottom of the Settle Returns & Credits window, enter the total amount of the credit 
note in the Amount Applied field(s) of the open sale(s) you want to apply the amount to. 

c. Click Record to save the transaction you created; the closed service invoice is reversed.

See also
Creating a service invoice 
Locating a service invoice 
Removing or changing a service invoice before it's saved 
Removing or changing a service invoice after it's saved 
Reversing service invoices 
Reversing a service invoice with no payments assigned to it 
Reversing a partially paid service invoice 



Creating a professional invoice
Use the Sales window to create a professional invoice. 

To assign a professional invoice type to a sales transaction, click the Invoice Type button at the bottom of the Sales 
window; a window appears, listing the types of sales transactions you can create. When you make a selection, the 
Sales window will contain the fields you need to create the professional invoice.

See also
Locating a professional invoice 
Removing or changing a professional invoice before it's saved 
Removing or changing a professional invoice after it's saved 
Reversing professional invoices 
Reversing a professional invoice with no payments assigned to it 
Reversing a partially paid professional invoice 
Reversing a closed professional invoice 



Locating a professional invoice
Follow the steps below to find a professional invoice you entered in the Sales window. 

1. Select Inquiry from the M.Y.O.B. Analyst. The Inquiry Register window appears.

2. If you know the number of the transaction you want to view, click the Invoice tab, then enter the transaction's 
number in the Invoice No. field.

If you don't know the number of the transaction you want to view, click the Card tab, then enter the name of the 
customer whose transaction you're looking for.

3. The transaction you're looking for appears in the scrolling list. If you want to view detail about the transaction, click 
the zoom arrow next to the transaction's number to open the window in which the transaction was originally entered.

See also
Creating a professional invoice 
Removing or changing a professional invoice before it's saved 
Removing or changing a professional invoice after it's saved 
Reversing professional invoices 
Reversing a professional invoice with no payments assigned to it 
Reversing a partially paid professional invoice 
Reversing a closed professional invoice 



Removing or changing a professional invoice before it's saved
If you want to remove or change an invoice you've entered - but haven't chosen Save from the File menu yet - follow 
the steps below. 

1. Locate the invoice and display it in the Sales window.

2. To change the invoice, change the information in the same way you normally enter information. To remove the 
invoice, select Delete Invoice from the Edit menu. 

See also
Creating a professional invoice 
Locating a professional invoice 
Removing or changing a professional invoice after it's saved 
Reversing professional invoices 
Reversing a professional invoice with no payments assigned to it 
Reversing a partially paid professional invoice 
Reversing a closed professional invoice 



Removing or changing a professional invoice after it's saved
If your transactions are changeable, follow the steps below to remove or change a professional invoice after it's 
saved.

If your transactions are unchangeable, these instructions don't apply to you; instead, you must reverse incorrect 
professional invoices and create new professional invoices with correct information. See Reversing professional 
invoices for more information.

1. Locate the professional invoice you wish to remove or change and display it in the Sales window.

2. If you intend to remove the professional invoice but payments are applied to it, remove the payments before you 
attempt to remove the professional invoice. See Recording payments from customers for more information about 
removing payments.

3. To change the transaction, change the information in the same way you normally enter information. To remove the 
transaction, select Delete Sale from the Edit menu.

See also
Creating a professional invoice 
Locating a professional invoice 
Removing or changing a professional invoice before it's saved 
Reversing professional invoices 
Reversing a professional invoice with no payments assigned to it 
Reversing a partially paid professional invoice 
Reversing a closed professional invoice 



Reversing professional invoices
If your transactions are unchangeable, you must reverse a professional invoice to remove its effect on your financial 
records. 

Three scenarios exist if you want to reverse a professional invoice. Refer to the instructions in this section that apply 
to your situation:

* Reversing a professional invoice with no payments assigned to it 

* Reversing a partially paid professional invoice

* Reversing a closed professional invoice 

If your transactions are changeable, you don't need to reverse your professional invoices to change them; instead, 
you can display the professional invoice in the Sales window and make changes to it.

See also
Creating a professional invoice 
Locating a professional invoice 
Removing or changing a professional invoice before it's saved 
Removing or changing a professional invoice after it's saved 



Reversing a professional invoice with no payments assigned to it
Follow the steps below to reverse a professional invoice that doesn't have payments assigned to it. 

1. Locate the professional invoice you want to reverse and display it in the Sales window.

2. Choose Reverse Invoice from the Edit menu. M.Y.O.B. creates a credit note containing an amount exactly opposite
of the amount in the professional invoice.

You can make a few changes to the credit note you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the credit note.

If you're reversing a sale from a previous accounting period, consider assigning a date from that period to the credit 
note you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the credit note. The Sales window disappears.

4. Select Settle Returns & Credits from the Sales Ledger Command Centre. A search list appears; from this list, 
select the credit note you created and click the Apply to Open Invoice button. The credit note appears in the Settle 
Returns & Credits window.

5. In the list of professional invoices at the bottom of the Settle Returns & Credits window, enter the amount of the 
credit note in the Amount Applied field of the professional invoice you want to reverse.

6. Click Record. The Settle Returns & Credits window disappears; the professional invoice is reversed.

See also
Creating a professional invoice 
Locating a professional invoice 
Removing or changing a professional invoice before it's saved 
Removing or changing a professional invoice after it's saved 
Reversing professional invoices 
Reversing a partially paid professional invoice 
Reversing a closed professional invoice 



Reversing a partially paid professional invoice
Follow the steps below to reverse a professional invoice that's only partially paid. 

1. Display the professional invoice you want to reverse in the Sales window.

2. Choose Reverse Invoice from the Edit menu. M.Y.O.B. creates a credit note containing an amount exactly opposite
of the amount in the professional invoice.

You can make a few changes to the credit note you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the credit note.

If you're reversing a professional invoice from a previous accounting period, consider assigning a date from that 
period to the credit note you've created. This will allow your reports for that accounting period to reflect the proper 
amounts.

3. Click Record Reversal to save the credit note. The Sales window disappears.

4. Select Settle Returns & Credits from the Sales Ledger Command Centre. A search list appears; from this list, 
highlight the credit note you created and click the Apply to Open Invoice button.

5. At this point, you may choose to do one of three things:

* Apply part of the credit note amount to the remaining balance of the professional invoice you want to reverse, then 
apply the rest of the credit note to a professional invoice's remaining balance. To do this, follow these steps:

a. Enter part of the credit note amount in the professional invoice's Amount Applied field so the professional invoice 
has no remaining balance.

b. Enter the rest of the credit note in a professional invoice's Amount Applied field.

c. Click Record to save the transaction; the professional invoice is reversed. 

* Apply part of the credit note amount to the remaining balance of the professional invoice you want to reverse, and 
write a refund cheque for the rest of the credit note amount. To do this, follow these steps:

a. Change the Credit Amount field so it's the same as the remaining balance of the professional invoice you want to 
reverse.

b. Enter the Credit Amount field's amount in the Amount Applied field of the professional invoice you want to reverse, 
so the professional invoice has no remaining balance.

c. Click Record; the professional invoice is reversed. The credit note, containing the unapplied amount, remains in the
system.

d. Select Settle Returns & Credits again.

e. Select the credit note and click the Write a Refund button. The Settle Returns & Credits window appears, 
displaying a refund cheque in the remaining amount of the credit note.

f. Click Record to save the refund cheque.

* Apply part of the credit note amount to the remaining balance of the professional invoice you want to reverse, and 
save the rest of the credit note amount for later. To do this, follow these steps:

a. Change the Credit Amount field so it's the same as the remaining balance of the professional invoice you want to 
reverse.

b. Enter the Credit Amount field's amount in the Amount Applied field of the professional invoice you want to reverse, 
so the professional invoice has no remaining balance.

c. Click Record; the professional invoice is reversed. The credit note, containing the unapplied amount, remains in the



system. Keep in mind that the credit note will exist until you apply it to a professional invoice or write a refund cheque 
for it.

See also
Creating a professional invoice 
Locating a professional invoice 
Removing or changing a professional invoice before it's saved 
Removing or changing a professional invoice after it's saved 
Reversing professional invoices 
Reversing a professional invoice with no payments assigned to it 
Reversing a closed professional invoice 



Reversing a closed professional invoice
Follow the steps below to reverse a professional invoice that's completely paid. 

1. Display the invoice you want to reverse in the Sales window.

2. Choose Reverse Invoice from the Edit menu. M.Y.O.B. creates a credit note containing an amount exactly opposite
of the amount in the closed professional invoice.

You can make a few changes to the credit note you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the credit note.

If you're reversing a closed professional invoice from a previous accounting period, consider assigning a date from 
that period to the credit note you've created. This will allow your reports for that accounting period to reflect the proper
amounts.

3. Click Record Reversal to save the credit note. The Sales window disappears.

4. Select Settle Returns & Credits from the Sales Ledger Command Centre. A search list appears; from this list, 
highlight the credit note you created.

5. At this point, you may choose to do one of two things:

* Write a refund cheque to the customer. To do this, follow these steps:

a. Click the Write a Refund Cheque button. The Settle Returns & Credits window appears, displaying a refund 
cheque in the amount of the credit note.

b. Click Record to save the refund cheque; the closed professional invoice is reversed.

* Apply the credit note amount to one or more of the customer's open sales. To do this, follow these steps:

a. Click the Apply to Open Invoice button. The Settle Returns & Credits window appears, displaying the credit note.

b. In the list of transactions at the bottom of the Settle Returns & Credits window, enter the total amount of the credit 
note in the Amount Applied field(s) of the open sale(s) you want to apply the amount to. 

c. Click Record to save the transaction you created; the closed professional invoice is reversed.

See also
Creating a professional invoice 
Locating a professional invoice 
Removing or changing a professional invoice before it's saved 
Removing or changing a professional invoice after it's saved 
Reversing professional invoices 
Reversing a professional invoice with no payments assigned to it 
Reversing a partially paid professional invoice 



Creating an other sale
Use the Sales window to create an other sale. 

To assign an other sale type to a sales transaction, click the Invoice Type button at the bottom of the Sales window; a 
window appears, listing the types of sales transactions you can create. When you make a selection, the Sales 
window will contain the fields you need to create the other sale.

See also
Locating an other sale 
Removing or changing an other sale before it's saved 
Removing or changing an other sale after it's saved 
Reversing other sales 
Reversing an other sale with no payments assigned to it 
Reversing a partially paid other sale 
Reversing a closed other sale 



Locating an other sale
Follow the steps below to find an other sale you entered in the Sales window. 

1. Select Inquiry from the M.Y.O.B. Analyst. The Inquiry Register window appears.

2. If you know the number of the transaction you want to view, click the Invoice tab, then enter the transaction's 
number in the Invoice No. field.

If you don't know the number of the transaction you want to view, click the Card tab, then enter the name of the 
customer whose transaction you're looking for.

3. The transaction you're looking for appears in the scrolling list. If you want to view detail about the transaction, click 
the zoom arrow next to the transaction's number to open the window in which the transaction was originally entered.

See also
Creating an other sale 
Removing or changing an other sale before it's saved 
Removing or changing an other sale after it's saved 
Reversing other sales 
Reversing an other sale with no payments assigned to it 
Reversing a partially paid other sale 
Reversing a closed other sale 



Removing or changing an other sale before it's saved
If you want to remove or change an other sale you've entered - but haven't chosen Save from the File menu yet - 
follow the steps below. 

1. Locate the transaction and display it in the Sales window.

2. To change the transaction, change the information in the same way you normally enter information. To remove the 
transaction, select Delete Invoice from the Edit menu.

See also
Creating an other sale 
Locating an other sale 
Removing or changing an other sale after it's saved 
Reversing other sales 
Reversing an other sale with no payments assigned to it 
Reversing a partially paid other sale 
Reversing a closed other sale 



Removing or changing an other sale after it's saved
If your transactions are changeable, follow the steps below to remove or change an other sale  after it's saved. 

If your transactions are unchangeable, these instructions don't apply to you; instead, you must reverse incorrect other
sales and create new other sales with correct information. See Reversing other sales for more information.

1. Locate the other sale you wish to remove or change and display it in the Sales window.

2. If you intend to remove the other sale but payments are applied to it, remove the payments before you attempt to 
remove the other sale. See Recording payments from customers for more information about removing payments.

3. To change the transaction, change the information in the same way you normally enter information. To remove the 
transaction, select Delete Sale from the Edit menu.

See also
Creating an other sale 
Locating an other sale 
Removing or changing an other sale before it's saved 
Reversing other sales 
Reversing an other sale with no payments assigned to it 
Reversing a partially paid other sale 
Reversing a closed other sale 



Reversing other sales
If your transactions are unchangeable, you must reverse an other sale to remove its effect on your financial records. 

Three scenarios exist if you want to reverse an other sale. Refer to the instructions in this section that apply to your 
situation:

* Reversing an other sale with no payments assigned to it 

* Reversing a partially paid other sale 

* Reversing a closed other sale 

If your transactions are changeable, you don't need to reverse your other sales to change them; instead, you can 
display the other sale in the Sales window and make changes to it.

See also
Creating an other sale 
Locating an other sale 
Removing or changing an other sale before it's saved 
Removing or changing an other sale after it's saved 



Reversing an other sale with no payments assigned to it
Follow the steps below to reverse an other sale that doesn't have payments assigned to it. 

1. Locate the other sale you want to reverse and display it in the Sales window.

2. Choose Reverse Sale from the Edit menu. M.Y.O.B. creates a credit note containing an amount exactly opposite of
the amount in the other sale.

You can make a few changes to the credit note you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the credit note.

If you're reversing a sale from a previous accounting period, consider assigning a date from that period to the credit 
note you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the credit note. The Sales window disappears.

4. Select Settle Returns & Credits from the Sales Ledger Command Centre. A search list appears; from this list, 
select the credit note you created and click the Apply to Open Invoice button. The credit note appears in the Settle 
Returns & Credits window.

5. In the list of other sales at the bottom of the Settle Returns & Credits window, enter the amount of the credit note in
the Amount Applied field of the other sale you want to reverse.

6. Click Record. The Settle Returns & Credits window disappears; the other sale is reversed.

See also
Creating an other sale 
Locating an other sale 
Removing or changing an other sale before it's saved 
Removing or changing an other sale after it's saved 
Reversing other sales 
Reversing a partially paid other sale 
Reversing a closed other sale 



Reversing a partially paid other sale
Follow the steps below to reverse an other sale that's only partially paid. 

1. Display the other sale you want to reverse in the Sales window.

2. Choose Reverse Invoice from the Edit menu. M.Y.O.B. creates a credit note containing an amount exactly opposite
of the amount in the other sale.

You can make a few changes to the credit note you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the credit note.

If you're reversing an other sale from a previous accounting period, consider assigning a date from that period to the 
credit note you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the credit note. The Sales window disappears.

4. Select Settle Returns & Credits from the Sales Ledger Command Centre. A search list appears; from this list, 
highlight the credit note you created and click the Apply to Open Invoice button.

5. At this point, you may choose to do one of three things:

* Apply part of the credit note amount to the remaining balance of the other sale you want to reverse, then apply the 
rest of the credit note to an other sale's remaining balance. To do this, follow these steps:

a. Enter part of the credit note amount in the other sale's Amount Applied field so the other sale has no remaining 
balance.

b. Enter the rest of the credit note in an other sale's Amount Applied field.

c. Click Record to save the transaction; the other sale is reversed. 

* Apply part of the credit note amount to the remaining balance of the other sale you want to reverse, and write a 
refund cheque for the rest of the credit note amount. To do this, follow these steps:

a. Change the Credit Amount field so it's the same as the remaining balance of the other sale you want to reverse.

b. Enter the Credit Amount field's amount in the Amount Applied field of the other sale you want to reverse, so the 
other sale has no remaining balance.

c. Click Record; the other sale is reversed. The credit note, containing the unapplied amount, remains in the system.

d. Select Settle Returns & Credits again.

e. Select the credit note and click the Write a Refund button. The Settle Returns & Credits window appears, 
displaying a refund cheque in the remaining amount of the credit note.

f. Click Record to save the refund cheque.

* Apply part of the credit note amount to the remaining balance of the other sale you want to reverse, and save the 
rest of the credit note amount for later. To do this, follow these steps:

a. Change the Credit Amount field so it's the same as the remaining balance of the other sale you want to reverse.

b. Enter the Credit Amount field's amount in the Amount Applied field of the other sale you want to reverse, so the 
other sale has no remaining balance.

c. Click Record; the other sale is reversed. The credit note, containing the unapplied amount, remains in the system. 
Keep in mind that the credit note will exist until you apply it to an other sale or write a refund cheque for it.

See also
Creating an other sale 



Locating an other sale 
Removing or changing an other sale before it's saved 
Removing or changing an other sale after it's saved 
Reversing other sales 
Reversing an other sale with no payments assigned to it 
Reversing a closed other sale 



Reversing a closed other sale
Follow the steps below to reverse an other sale that's completely paid. 

1. Display the closed sale you want to reverse in the Sales window.

2. Choose Reverse Invoice from the Edit menu. M.Y.O.B. creates a credit note containing an amount exactly opposite
of the amount in the closed other sale.

You can make a few changes to the credit note you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the credit note.

If you're reversing a closed other sale from a previous accounting period, consider assigning a date from that period 
to the credit note you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the credit note credit note. The Sales window disappears.

4. Select Settle Returns & Credits from the Sales Ledger Command Centre. A search list appears; from this list, 
highlight the credit note you created.

5. At this point, you may choose to do one of two things:

* Write a refund cheque to the customer. To do this, follow these steps:

a. Click the Write a Refund Cheque button. The Settle Returns & Credits window appears, displaying a refund 
cheque in the amount of the credit note.

b. Click Record to save the refund cheque; the closed other sale is reversed.

* Apply the credit note amount to one or more of the customer's open sales. To do this, follow these steps:

a. Click the Apply to Open Invoice button. The Settle Returns & Credits window appears, displaying the credit note.

b. In the list of transactions at the bottom of the Settle Returns & Credits window, enter the total amount of the credit 
note in the Amount Applied field(s) of the open sale(s) you want to apply the amount to. 

c. Click Record to save the transaction you created; the closed other sale is reversed.

See also
Creating an other sale 
Locating an other sale 
Removing or changing an other sale before it's saved 
Removing or changing an other sale after it's saved 
Reversing other sales 
Reversing an other sale with no payments assigned to it 
Reversing a partially paid other sale 



About the Pending File
If there are times when you want to record an invoice or purchase order that hasn't occurred yet, or if you want to 
create an estimate of how much a transaction will cost you or a customer, you can create an invoice or purchase 
order and place it in M.Y.O.B.'s Pending File. The Pending File is a "storage area" where pending transactions are 
contained until they're converted into actual transactions. 

Until you convert a pending transaction into an actual transaction, a transaction in the Pending File doesn't change 
your financial records at all.

See also
Creating a pending invoice 
Creating a pending purchase order 



Creating a pending invoice
There are two ways to create a pending invoice: 

* By creating an invoice and placing the entire invoice in the Pending File

* By creating an invoice containing a backordered quantity

Follow the steps below that apply to your situation.

Placing an entire invoice in the Pending File
Creating a pending invoice is almost the same process as creating a non-pending invoice. Item invoices, service 
invoices and professional invoices can be placed in the Pending File. Follow the steps below to create a pending 
invoice.

1. Create the invoice as you would create a regular item, service or professional invoice. Enter quantities and 
amounts the same way, as well. (You can include backordered quantities, too.)

2. If a deposit was made on the pending invoice, enter that amount in the Paid Today field. 

3. When youve entered the invoice information, click the Pending button. If any deposit money had been placed on 
the pending invoice, your linked customer deposits account is increased by the amount of the deposit, and your 
linked debtors bank account is increased. Otherwise, none of your financial records are changed. The invoice is 
saved in the Pending File.

Placing a backordered quantity in the Pending File
Creating a pending invoice for a backordered quantity is almost the same process as creating a non-pending invoice. 
Follow the steps below to place a backordered quantity in the Pending File.

1. Create an item invoice as you would create a regular item invoice, entering a quantity in the Backorder column for 
each item you wish to place in the Pending File. (You can include quantities in the Deliver column, too.)

2. If a deposit was made on the pending invoice, enter that amount in the Paid Today field. 

3. When youve entered the invoice information, click the Record button. An invoice is created in the Pending File, 
containing each item that has a quantity in the Backorder column. If you entered a quantity in the Deliver column for 
any items, an actual invoice is created for those items.

See also
Locating a pending invoice 
Recording a deposit on a pending invoice 
Converting a pending invoice to an actual invoice 
Removing a pending invoice before it's saved 
Removing or changing a pending invoice after it's saved 



Locating a pending invoice
Follow the steps below to find a pending invoice you entered in the Sales window. 

1. Select Sales from the Sales Ledger Command Centre. The Sales window appears.

2. In the Customer field, enter or select the name of the customer whose pending invoice you're looking for. A search 
list appears, containing all pending invoices for the customer.

3. From the search list, select the pending invoice you want. The pending invoice is displayed in the Sales window.

See also
Creating a pending invoice 
Recording a deposit on a pending invoice 
Converting a pending invoice to an actual invoice 
Removing a pending invoice before it's saved 
Removing or changing a pending invoice after it's saved 



Recording a deposit on a pending invoice
There are two ways you can record a deposit on a pending invoice: 

* If you're in the process of creating a pending invoice, enter the deposit amount in the Paid Today field of the Sales 
window. This process is described in Creating a pending invoice .

* If the customer made a deposit on a pending invoice that already exists, use the Customer Payments window. 
Follow the steps below to do this.

1. Open the Customer Payments window from the Sales Ledger Command Centre.

2. In the Amount field, enter the amount the customer gave as a deposit.

3. In the list of transactions at the bottom of the Customer Payments window, enter the deposit amount in Amount 
Applied field for the pending invoice you want to apply the deposit to. (Pending invoices have the word "Pending" in 
their Status column.)

4. When youve finished, click the Record button. Your linked customer deposits account is increased by the amount 
of the deposit, and your linked debtors bank account is increased.

See also
Creating a pending invoice 
Locating a pending invoice 
Converting a pending invoice to an actual invoice 
Removing a pending invoice before it's saved 
Removing or changing a pending invoice after it's saved 



Converting a pending invoice to an actual invoice
When a pending invoice becomes an actual transaction, you need to change the status of the pending invoice. Follow
the steps below to do this. 

1. From the Sales Ledger Command Centre, select Sales. The Sales window appears.

2. Enter or select the name of the customer whose pending invoice you want to convert. A search list appears, listing 
all the pending invoices for the customer.

3. Select the pending invoice you want to convert and click the Use Pending Invoice button. The pending invoice 
appears in the Sales window.

4. Make any changes to the pending invoice at this time, as you would make changes to a non-pending invoice.

5. When youve finished working with the pending invoice, click the Record button. The pending invoice is converted 
to an actual invoice. If any deposit money had been placed on the pending invoice, your linked customer deposits 
account  is decreased by the amount of the deposit, and your linked debtors account is decreased.

See also
Creating a pending invoice 
Locating a pending invoice 
Recording a deposit on a pending invoice 
Removing a pending invoice before it's saved 
Removing or changing a pending invoice after it's saved 



Removing a pending invoice before it's saved
If you want to remove or change a pending invoice you've entered - but haven't chosen Save from the File menu  yet 
- follow the steps below. 

1. Locate the pending invoice and display it in the Sales window.

2. To change the pending invoice, change the information in the same way you normally enter information. To remove
the pending invoice, select Delete Pending Invoice from the Edit menu.

See also
Creating a pending invoice 
Locating a pending invoice 
Recording a deposit on a pending invoice 
Converting a pending invoice to an actual invoice 
Removing or changing a pending invoice after it's saved 



Removing or changing a pending invoice after it's saved
There are two type of pending invoices: those without deposits and those with deposits. 

Pending invoices without deposits
1. Locate the pending invoice and display it in the Sales window.

2. To change the pending invoice, change the information in the same way you normally enter information. To remove
the pending invoice, select Delete Pending Invoice from the Edit menu.

Pending invoices with deposits
A pending invoice with a deposit may not be deleted unless the deposit is deleted. Once you save your data, you 
cannot delete the deposit.

To remove a pending invoice with an "undeletable" deposit, you must erase the detail of the invoice (change all 
quantities to zero or change the type of invoice) and record it as an actual invoice. This creates an invoice with a 
negative balance due, also known as a credit note. Use the Settle Returns & Credits window to apply the credit to 
one of the customer's open sales.

Note: When you record a pending invoice with a deposit as an actual invoice, M.Y.O.B. moves the money from your 
linked customer deposits account to your linked debtors account. Your linked customer deposits account is 
decreased by the amount of the deposit and the linked debtors account is decreased. 

See also
Creating a pending invoice 
Locating a pending invoice 
Recording a deposit on a pending invoice 
Converting a pending invoice to an actual invoice 
Removing a pending invoice before it's saved 



Recording payments from customers
The payments customers make to you are recorded in the Sales Ledger Command Centre, using the Customer 
Payments window. 

Click on a topic below for more information about recording payments from customers.

Locating a customer payment 
Removing or changing a customer payment before it's saved 
Removing or changing a customer payment after it's saved 
Reversing a customer payment 



Locating a customer payment
Follow the steps below to find a customer payment you entered in the Customer Payments window. 

1. Select Inquiry from the M.Y.O.B. Analyst. The Inquiry Register window appears.

2. If you know the number of the transaction you want to view, click the Invoice tab, then enter the number of the 
invoice the payment was made against in the Invoice No. field.

If you don't know the number of the original invoice, click the Card tab, then enter the name of the customer whose 
transaction you're looking for.

3. The transaction you're looking for appears in the scrolling list. If you want to view detail about the transaction, click 
the zoom arrow next to the transaction's number to open the window in which the transaction was originally entered.

See also
Recording payments from customers 
Removing or changing a customer payment before it's saved 
Removing or changing a customer payment after it's saved 
Reversing a customer payment 



Removing or changing a customer payment before it's saved
If you want to remove or change a customer payment you've entered - but haven't chosen Save from the File menu 
yet - follow the steps below. 

1. Locate the payment and display it in the Customer Payments window.

2. To change the payment, change the information in the same way you normally enter information. To remove the 
payment, select Delete Payment from the Edit menu.

See also
Recording payments from customers 
Locating a customer payment 
Removing or changing a customer payment after it's saved 
Reversing a customer payment 



Removing or changing a customer payment after it's saved
If your transactions are changeable, follow the steps below to remove or change a customer payment after it's been 
saved. 

If your transactions are unchangeable, these instructions don't apply to you; instead, you must reverse incorrect 
customer payments and create new customer payments with correct information. See Reversing a customer payment
for more information.

1. Locate the customer payment you wish to remove or change and display it in the Customer Payments window.

2. To change the customer payment, change the information in the same way you normally enter information. To 
remove the customer payment, select Delete Payment from the Edit menu.

See also
Recording payments from customers 
Locating a customer payment 
Removing or changing a customer payment before it's saved 
Reversing a customer payment 



Reversing a customer payment
Follow the steps below to reverse a customer payment. 

1. Display the customer payment you want to reverse in the Customer Payments window.

2. Choose Reverse Payment from the Edit menu. M.Y.O.B. creates a payment transaction containing an amount 
exactly opposite of the amount in the customer payment.

You can make a few changes to the transaction you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with it.

If you're reversing a customer payment from a previous accounting period, consider assigning a date from that period
to the transaction you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the reversed payment transaction. The Customer Payments window disappears, 
and the open sale you originally applied the payment to is changed.

If you attempt to reverse a payment with a discount applied to it, you must also reverse the discount. To do this, 
locate the discount transaction in the Sales Journal and reverse it.

See also
Recording payments from customers 
Locating a customer payment 
Removing or changing a customer payment before it's saved 
Removing or changing a customer payment after it's saved 



Settling credits and writing refund cheques
During the course of conducting your sales transactions, there may be times when you owe a customer money, 
whether it's because of a returned item, a customer's overpayment on their balance or an incorrect amount that 
appeared on an invoice you sent them. Whatever the reason, you need to change your financial records in M.Y.O.B. 
when you "even the score" with the customer. To do this, you create a credit note - an invoice with a negative    
amount that indicates you owe the customer money. Using a credit note, you can either reduce the customer's 
outstanding balance with your company or write a refund cheque to the customer. This process of creating a credit 
note and applying it to an outstanding balance or writing a refund cheque is called settling credits. 

When you create a credit note for a customer - a process that can happen in a number of windows in the Sales 
Ledger Command Centre- the amount of the credit note is recorded as part of the customer's total outstanding sales 
balance with your company. For example, say a customer has three open invoices and owes you £1,000 from those 
invoices. In addition, the customer has two credit notes worth £400 - money you owe the customer. Putting these two 
amounts together, the customer owes you only £600. Until you settle credits, however, M.Y.O.B. still considers the 
customer's outstanding balance as £1,000. This is because the money owed to the customer isn't calculated as part 
of their outstanding balance.

Depending upon what you do when you settle credits, you can reduce that outstanding balance. To use the example 
above, if you apply the £400 in credit notes to one or more of the open invoices the customer has, his or her total 
outstanding balance is reduced to £600. On the other hand, if you write a refund cheque for £400 to pay off the 
customer's two credit notes, the customer's total outstanding balance is still £1,000. When you settle credits, 
therefore, all you really do is take action on the money you owe your customers.

When you apply a credit note to an open sale - usually the most common task performed with a credit note - the 
transaction is recorded in the Sales Journal. Two entries are made to your linked debtors account: the first cancels 
the credit note by decreasing the linked debtors account, and the second pays off part (or all) of the open sale by 
decreasing the linked debtors account.

Most of the work of settling credits is accomplished in the Settle Returns & Credits window.

Click on a topic below for more information about settling credits and writing refund cheques.

Applying a credit note to an open sale 
Applying a credit note to a closed sale 
Applying a credit note to a pending invoice 
Locating an applied credit note 
Removing or changing an applied credit note before it's saved 
Removing an applied credit note after it's saved 
Reversing an applied credit note 
Locating a credit refund cheque 
Removing or changing a credit refund cheque before it's saved 
Removing a credit refund cheque after it's saved 
Reversing a credit refund cheque 



Applying a credit note to an open sale
Follow the steps below to apply the amount of a credit note to a transaction entered in the Sales window that isn't 
completely paid. 

1. Select Settle Returns & Credits from the Sales Ledger Command Centre. A search list appears; from this list, 
highlight the credit note you wish to apply and click the Apply to Open Invoice button. The Settle Returns & Credits 
window appears, listing all transactions (open, closed and pending) assigned to the customer.

2. Locate the open sale you want - open sales are labelled "Open" in the Status column - then enter the amount of 
the credit note in the open sale's Amount Applied field.

3. Click Record to save the transaction. The credit note is applied.

See also
Settling credits and writing refund cheques 
Applying a credit note to a closed sale 
Applying a credit note to a pending invoice 
Locating an applied credit note 
Removing or changing an applied credit note before it's saved 
Removing an applied credit note after it's saved 
Reversing an applied credit note 
Locating a credit refund cheque 
Removing or changing a credit refund cheque before it's saved 
Removing a credit refund cheque after it's saved 
Reversing a credit refund cheque 



Applying a credit note to a closed sale
Follow the steps below to apply the amount of a credit note to a transaction entered in the Sales window that's 
completely paid. 

When you apply a credit note to a closed sale - in other words, when you apply an amount to a transaction that 
doesn't have a balance due - the closed sale is removed, and a new credit note in the amount you applied to the 
closed sale is created.

1. Select Settle Returns & Credits from the Sales Ledger Command Centre. A search list appears; from this list, 
highlight the credit note you wish to apply and click the Apply to Open Invoice button. The Settle Returns & Credits 
window appears, listing all transactions (open, closed and pending) assigned to the customer.

2. Locate the closed sale you want - closed sales are labelled "Closed" in the Status column - then enter the amount 
of the credit note in the closed sale's Amount Applied field.

3. Click Record to save the transaction. The closed sale is removed, and a new credit note in the amount you applied 
to the closed sale is created.

See also
Settling credits and writing refund cheques 
Applying a credit note to an open sale 
Applying a credit note to a pending invoice 
Locating an applied credit note 
Removing or changing an applied credit note before it's saved 
Removing an applied credit note after it's saved 
Reversing an applied credit note 
Locating a credit refund cheque 
Removing or changing a credit refund cheque before it's saved 
Removing a credit refund cheque after it's saved 
Reversing a credit refund cheque 



Applying a credit note to a pending invoice
Applying a credit note to a pending invoice is the same procedure as recording a deposit on a pending invoice. See 
Recording a deposit on a pending invoice for more information about this task. 

See also
Settling credits and writing refund cheques 
Applying a credit note to an open sale 
Applying a credit note to a closed sale 
Locating an applied credit note 
Removing or changing an applied credit note before it's saved 
Removing an applied credit note after it's saved 
Reversing an applied credit note 
Locating a credit refund cheque 
Removing or changing a credit refund cheque before it's saved 
Removing a credit refund cheque after it's saved 
Reversing a credit refund cheque 



Locating an applied credit note
Follow the steps below to find a credit note you applied in the Settle Returns & Credits window. 

1. From the Sales Ledger Command Centre, click Inquiry in the M.Y.O.B Analyst. The Transaction Inquiry window 
appears with the Invoice tab selected.

2. In the Invoice No. field, enter or select the name of the invoice whose applied credit note you're looking for. A new 
list in the Transaction Inquiry window appears, displaying all transactions assigned to the invoice you entered.

3. Applied credit note are recognised by their source journal code of SJ. Search the ID No. column for transactions 
numbered with SJ prefixes and click the zoom arrow next to the credit note you want to view. The Settle Returns & 
Credits window appears, displaying the original credit note as you entered it.

See also
Settling credits and writing refund cheques 
Applying a credit note to an open sale 
Applying a credit note to a closed sale 
Applying a credit note to a pending invoice 
Removing or changing an applied credit note before it's saved 
Removing an applied credit note after it's saved 
Reversing an applied credit note 
Locating a credit refund cheque 
Removing or changing a credit refund cheque before it's saved 
Removing a credit refund cheque after it's saved 
Reversing a credit refund cheque 



Removing or changing an applied credit note before it's saved
If you want to remove or change an applied credit note you've entered - but haven't chosen Save from the File menu 
yet - follow the steps below. 

1. Locate the applied credit note and display it in the Settle Returns & Credits window.

2. To change the applied credit note , change the information in the same way you normally enter information. To 
remove the applied credit note, select Delete Credit from the Edit menu.

See also
Settling credits and writing refund cheques 
Applying a credit note to an open sale 
Applying a credit note to a closed sale 
Applying a credit note to a pending invoice 
Locating an applied credit note 
Removing an applied credit note after it's saved 
Reversing an applied credit note 
Locating a credit refund cheque 
Removing or changing a credit refund cheque before it's saved 
Removing a credit refund cheque after it's saved 
Reversing a credit refund cheque 



Removing an applied credit note after it's saved
If your transactions are changeable, follow the steps below to remove an applied credit note after it's been saved. 
Applied credit notes that have been saved can't be changed; the only modification you can make to them is to 
remove them. 

If your transactions are unchangeable, these instructions don't apply to you; instead, you must reverse incorrect 
applied credit notes and re-apply credit notes with correct information. See Reversing an applied credit note for more 
information.

1. Locate the credit note you wish to remove or change, and display it in the Settle Returns & Credits window.

2. To remove the credit note, select Delete Credit from the Edit menu.

See also
Settling credits and writing refund cheques 
Applying a credit note to an open sale 
Applying a credit note to a closed sale 
Applying a credit note to a pending invoice 
Locating an applied credit note 
Removing or changing an applied credit note before it's saved 
Reversing an applied credit note 
Locating a credit refund cheque 
Removing or changing a credit refund cheque before it's saved 
Removing a credit refund cheque after it's saved 
Reversing a credit refund cheque 



Reversing an applied credit note
Follow the steps below to reverse a credit note you applied to a customer's open sale. 

1. Display the applied credit note you want to reverse in the Settle Returns & Credits window.

2. Choose Reverse Credit from the Edit menu. M.Y.O.B. creates a transaction containing an amount exactly opposite 
of the amount in the applied credit note credit note.

You can make a few changes to the transaction you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with it.

If you're reversing a credit note from a previous accounting period, consider assigning a date from that period to the 
transaction you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the reversed transaction. The Settle Returns & Credits window disappears, and the 
open sale you originally assigned the credit note to is returned to its previous amount.

See also
Settling credits and writing refund cheques 
Applying a credit note to an open sale 
Applying a credit note to a closed sale 
Applying a credit note to a pending invoice 
Locating an applied credit note 
Removing or changing an applied credit note before it's saved 
Removing an applied credit note after it's saved 
Locating a credit refund cheque 
Removing or changing a credit refund cheque before it's saved 
Removing a credit refund cheque after it's saved 
Reversing a credit refund cheque 



Locating a credit refund cheque
Follow the steps below to find a credit refund cheque you entered in the Settle Returns & Credits window. 

1. Select Inquiry from the M.Y.O.B. Analyst. The Inquiry Register window appears.

2. If you know the number of the transaction you want to view, click the Invoice tab, then enter the number of the 
invoice the refund cheque was created from in the Invoice No. field.

If you don't know the number of the original invoice, click the Card tab, then enter the name of the customer whose 
transaction you're looking for.

3. The transaction you're looking for appears in the scrolling list. If you want to view detail about the transaction, click 
the zoom arrow next to the transaction's number to open the window in which the transaction was originally entered.

See also
Settling credits and writing refund cheques 
Applying a credit note to an open sale 
Applying a credit note to a closed sale 
Applying a credit note to a pending invoice 
Locating an applied credit note 
Removing or changing an applied credit note before it's saved 
Removing an applied credit note after it's saved 
Reversing an applied credit note 
Removing or changing a credit refund cheque before it's saved 
Removing a credit refund cheque after it's saved 
Reversing a credit refund cheque 



Removing or changing a credit refund cheque before it's saved
If you want to remove or change a refund cheque you've entered - but haven't chosen Save from the File menu yet - 
follow the steps below. 

1. Locate the refund cheque and display it in the Settle Returns & Credits window.

2. To change the refund cheque, change the information in the same way you normally enter information. To remove 
the refund cheque, select Delete Credit from the Edit menu.

See also
Settling credits and writing refund cheques 
Applying a credit note to an open sale 
Applying a credit note to a closed sale 
Applying a credit note to a pending invoice 
Locating an applied credit note 
Removing or changing an applied credit note before it's saved 
Removing an applied credit note after it's saved 
Reversing an applied credit note 
Locating a credit refund cheque 
Removing a credit refund cheque after it's saved 
Reversing a credit refund cheque 



Removing a credit refund cheque after it's saved
If your transactions are changeable, follow the steps below to remove a credit refund cheque after it's been saved. 
Credit refund cheques that have been saved can't be changed; the only modification you can make to them is to 
remove them. 

If your transactions are unchangeable, these instructions don't apply to you; instead, you must reverse incorrect 
credit refund cheques and then create new credit refund cheques with correct information. See Reversing a credit 
refund cheque for more information.

1. Locate the credit refund cheque you wish to remove or change, and display it in the Settle Returns & Credits 
window.

2. To remove the credit refund cheque, select Delete Credit from the Edit menu.

See also
Settling credits and writing refund cheques 
Applying a credit note to an open sale 
Applying a credit note to a closed sale 
Applying a credit note to a pending invoice 
Locating an applied credit note 
Removing or changing an applied credit note before it's saved 
Removing an applied credit note after it's saved 
Reversing an applied credit note 
Locating a credit refund cheque 
Removing or changing a credit refund cheque before it's saved 
Reversing a credit refund cheque 



Reversing a credit refund cheque
Follow the steps below to reverse a credit refund cheque. 

1. Display the refund cheque you want to reverse in the Settle Returns & Credits window.

2. Choose Reverse Credit from the Edit menu. M.Y.O.B. creates a transaction containing an amount exactly opposite 
of the amount in the refund cheque.

You can make a few changes to the transaction you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with it.

If you're reversing a refund cheque from a previous accounting period, consider assigning a date from that period to 
the transaction you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the reversed transaction. The Settle Returns & Credits window disappears, and the 
credit note for which you originally wrote the refund cheque is recreated.

See also
Settling credits and writing refund cheques 
Applying a credit note to an open sale 
Applying a credit note to a closed sale 
Applying a credit note to a pending invoice 
Locating an applied credit note 
Removing or changing an applied credit note before it's saved 
Removing an applied credit note after it's saved 
Reversing an applied credit note 
Locating a credit refund cheque 
Removing or changing a credit refund cheque before it's saved 
Removing a credit refund cheque after it's saved 



Working with a cash drawer
If you use M.Y.O.B.'s sales transactions in a point-of-sale system, or group your receipts on a daily basis for a single 
deposit, or if you accept credit cards as payment for your invoices, you may want to consider using a cash drawer 
account. 

A cash drawer account is an asset account that tracks cash receipts not yet deposited in the bank. A cash drawer 
account provides a way to track undeposited cash and "streamline" your bank deposits for easier reconciliation.

Without a cash drawer account, M.Y.O.B. records a deposit transaction each time you record a customer payment. A 
cash drawer account lets you record the bank deposit when you actually put the money in the bank (or when the 
credit card company actually transfers the money into your account).

Click on a topic below for more information about working with a cash drawer.

Setting up a cash drawer account 
Using a cash drawer 



Setting up a cash drawer account
1. Open the Chart of Accounts window and create an asset account called Cash Drawer. In the Edit Accounts 
window, mark the Detail Bank Account selection.

2. Make this account your linked debtors bank account by entering the account's number in the Bank Account for 
Customer Receipts field of the Sales Ledger Linked Accounts window.

See also
Working with a cash drawer 
Using a cash drawer 



Using a cash drawer
Whenever you receive money in the Sales and Customer Payments windows, the money is automatically assigned to
your cash drawer account. 

When you prepare a bank deposit, select Make a Deposit in the Chequebook Command Centre. Select the account 
into which you'll deposit the money. This account, known as an allocation account, moves the money from your cash 
drawer account to the selected bank account.

When you reconcile your bank account, each deposit into your Cash Drawer account will appear as a single amount.

Similarly, when your credit card company pays you for those sales paid in credit cards, select Make a Deposit in the 
Chequebook Command Centre and select the account into which they'll be depositing the funds. The amount you 
enter in the Amount field of this window is the amount paid to you by the credit card company. The allocation account 
number for the gross amount (the amount charged on the credit cards) is your cash drawer account, while the credit 
card company's fee (which should be the difference between the cash drawer account's amount and the amount 
you're depositing) is allocated to your cost of sales (or expense) account for credit card fees. 

Credit card fees will show up as a negative amount.

See also
Setting up a cash drawer account 
Working with a cash drawer 



Using M.Y.O.B. as a point-of-sale system
M.Y.O.B. works very well as a point-of-sale system. Simply place your computer and printer next to your cash register
and load invoice forms into your printer. Then, select Preferences from the Setup menu and mark the Print Invoices 
Immediately Upon Recording selection. 

If you're really adventurous, you can enter your stock into the Item Information window, using each item's bar code as
its item number. Then connect a bar code reader to your computer, and scan the item number directly from the item 
into your invoices or purchase orders when you're selling or buying the item.



Types of purchasing transactions
In M.Y.O.B., you can record a number of different types of purchasing transactions, each of which is designed to 
match the purchases you make in your business. All purchasing transactions are entered using the Purchases 
window. 

A brief description of each type of purchasing transaction is located below.

* Item purchase orders are used to record the purchase of items for which you selected I Buy This Item in the Item 
Information window. When you save an item purchase order, your in-house quantities of the items for which you also 
selected I Stock This Item in the Item Information window (also known as stock items) listed on the purchase order 
will change accordingly. You can print item purchase orders and send them to your suppliers, if you wish. 

* Service purchase orders are used to record the purchase of items and services that you didn't enter information 
about in the Item Information window. This type of purchase order allows you to track purchasing transactions that 
don't affect your stock quantities. You can print service purchase orders and send them to your suppliers, if you wish. 

* Professional purchase orders are also used to record the purchase of items and services that you didn't enter 
information about in the Item Information window, and include the specific date each item was purchased. You can 
print professional purchase orders and send them to your suppliers, if you wish. 

* Other purchases are used to record the purchase of items and services that you didn't enter information about in 
the Item Information window, and that don't require a printed purchase order. 

* Pending purchase orders are used to record item purchase orders and service purchase orders that you expect to
occur. Pending purchase orders don't change the quantities of your stock items when they're saved; rather, they're 
kept in the Pending File until you convert them to actual purchase orders. 

See also
Working with item purchase orders 
Working with service purchase orders 
Working with professional purchase orders 
Working with other purchases 
Working with pending purchase orders 



Creating an item purchase order
Use the Purchases window to create an item purchase order. 

To designate which type of purchase order you want, click the PO Type button at the bottom of the Purchases 
window; a window appears, listing the types of purchasing transactions you can create. When you select Item 
Purchase Order, the data entry fields in the Purchases window will reflect the type you selected.

See also
Locating an item purchase order 
Removing or changing an item purchase order before it's saved 
Removing or changing an item purchase order after it's saved 
Reversing item purchase orders 
Reversing an item purchase order with no payments assigned to it 
Reversing a partially paid item purchase order 
Reversing a closed item purchase order 



Locating an item purchase order
Follow the steps below to find a purchase order you created in the Purchases window. 

1. Select Inquiry from the M.Y.O.B. Analyst. The Inquiry Register window appears.

2. If you know the number of the transaction you want to view, click the Purchase tab, then enter the transaction's 
number in the Purchase No. field.

If you don't know the number of the transaction you want to view, click the Card tab, then enter the name of the 
supplier whose transaction you're looking for.

3. The transaction you're looking for appears in the scrolling list. If you want to view detail about the transaction, click 
the zoom arrow next to the transaction's number to open the window in which the transaction was originally entered.

See also
Creating an item purchase order 
Removing or changing an item purchase order before it's saved 
Removing or changing an item purchase order after it's saved 
Reversing item purchase orders 
Reversing an item purchase order with no payments assigned to it 
Reversing a partially paid item purchase order 
Reversing a closed item purchase order 



Removing or changing an item purchase order before it's 
saved
1. Display the purchase order you wish to remove or change in the Purchases window.

2. If you intend to remove the purchase order but payments are applied to it, remove the payments before you 
attempt to remove the purchase order. See Paying your bills for more information about removing payments.

3. To change the purchase order, change the information in the same way you normally enter information. To remove 
the purchase order, select Erase Purchase from the Edit menu.

See also
Creating an item purchase order 
Locating an item purchase order 
Removing or changing an item purchase order after it's saved 
Reversing item purchase orders 
Reversing an item purchase order with no payments assigned to it 
Reversing a partially paid item purchase order 
Reversing a closed item purchase order 



Removing or changing an item purchase order after it's saved
If your transactions are changeable, follow the steps below to remove or change a purchase order after it's saved. 

If your transactions are unchangeable, these instructions don't apply to you; instead, you must reverse incorrect 
purchase orders and create new purchase orders with correct information. See Reversing item purchase orders for 
more information.

1. Display the purchase order you wish to remove or change in the Purchases window.

2. If you intend to remove the purchase order but payments are applied to it, remove the payments before you 
attempt to remove the purchase order. See Paying your bills for more information about removing payments.

3. To change the purchase order, change the information in the same way you normally enter information. To remove 
the purchase order, select Delete Purchase from the Edit menu.

See also
Creating an item purchase order 
Locating an item purchase order 
Removing or changing an item purchase order before it's saved 
Reversing item purchase orders 
Reversing an item purchase order with no payments assigned to it 
Reversing a partially paid item purchase order 
Reversing a closed item purchase order 



Reversing item purchase orders
If your transactions are unchangeable, you must reverse a purchase order to remove its effect on your financial 
records. 

Many scenarios exist if you want to reverse a purchase order. Refer to the instructions in this section that apply to 
your situation:

* Reversing an item purchase order with no payments assigned to it 

* Reversing a partially paid item purchase order 

* Reversing a closed item purchase order 

If your transactions are changeable, you don't need to reverse a purchase order to change it; instead, you can display
the purchase order in the Purchases window and make changes to it.

See also
Creating an item purchase order 
Locating an item purchase order 
Removing or changing an item purchase order before it's saved 
Removing or changing an item purchase order after it's saved 



Reversing an item purchase order with no payments assigned to it
Two situations can exist if you want to reverse an item purchase order with no payments assigned to it: 

* If you returned all the items that were on the purchase order to the supplier

* If you didn't return all the items that were on the purchase order to the supplier

Follow the steps below for the situation that applies to you.

If you returned all the items on the purchase order
You need to create a debit purchase that removes the total amount of the purchase order and returns the total 
quantities of the items on the purchase order back to their previous levels.

1. Locate the item purchase order you want to reverse and display it in the Purchases window.

2. Choose Reverse Purchase from the Edit menu. M.Y.O.B. creates a debit purchase containing amounts and 
quantities exactly opposite of the amounts and quantities in the item purchase order.

You can make a few changes to the debit purchase you've created (such as the date and the memo), but you can't 
change the accounts, amounts and quantities that are associated with the debit purchase.

If you're reversing a purchase order from a previous accounting period, consider assigning a date from that period to 
the debit purchase you've created. This will allow your reports for that accounting period to reflect the proper 
amounts.

3. Click Record Reversal to save the debit purchase. At this time, the item quantities that were listed on the purchase 
order return to their previous levels. The Purchases window disappears.

4. Select Settle Returns & Debits from the Purchase Ledger Command Centre. A search list appears; from this list, 
select the debit purchase you created and click the Apply to Open Purchase button. The debit purchase appears in 
the Settle Returns & Debits window.

5. In the list of transactions at the bottom of the Settle Returns & Debits window, enter the entire amount of the debit 
purchase in the Amount Applied field of the item purchase order you want to reverse.

6. Click Record. The Settle Returns & Debits window disappears; the item purchase order is reversed.

If you didn't return all the items on the purchase order
You need to create a debit purchase that removes a partial amount of the purchase order and decreases your 
quantities of the items on the purchase order by the number of items that were returned. 

If you're in this situation, you can't automatically reverse the purchase order by selecting Reverse Purchase from the 
Edit menu. Actually, since you're not clearing the entire transaction from your records, you're not reversing the 
purchase order at all - you're merely changing it to reflect the actual amounts and quantities in the item purchase 
order.

1. In the Purchases window, begin creating a new item purchase order by entering the necessary supplier information
at the top of the window. 

2. In the Item Purchase Order View section, use a negative number to enter the quantity of items that were returned. 
For example, if the original item purchase order recorded the purchase of 10 widgets but you returned five widgets, 
enter -5 widgets in one line of Item Purchase Order View. The amount of the purchase order is automatically 
calculated, and a negative number appears in the Total column.

3. If you need to make any changes to the amounts or other fields in this window, you can do so. When youve 
finished, click Record. The purchase order you just created is called a debit purchase. At this time, the item quantities
on the debit purchase decrease the quantities of your stock items.

4. Select Settle Returns & Debits from the Purchase Ledger Command Centre. A search list appears; from this list, 
select the debit purchase you created and click the Apply to Open Purchase button. The debit purchase appears in 
the Settle Returns & Debits window.



5. In the list of transactions at the bottom of the Settle Returns & Debits window, enter the entire amount of the debit 
purchase in the Amount Applied field of the item purchase order you want to change.

6. Click Record. The Settle Returns & Debits window disappears; the changes are made to the item purchase order.

See also
Creating an item purchase order 
Locating an item purchase order 
Removing or changing an item purchase order before it's saved 
Removing or changing an item purchase order after it's saved 
Reversing item purchase orders 
Reversing a partially paid item purchase order 
Reversing a closed item purchase order 



Reversing a partially paid item purchase order
Follow the steps below to reverse an item purchase order that's only partially paid. This process returns all balances 
to the amounts they had before the purchase order was recorded, and returns the quantities of your stock items on 
the purchase order back to the quantities they had before the purchase order was recorded. 

1. Display the item purchase order you want to reverse in the Purchases window.

2. Choose Reverse Purchase from the Edit menu. M.Y.O.B. creates a debit purchase containing amounts and 
quantities exactly opposite of the amounts and quantities in the item purchase order.

You can make a few changes to the debit purchase you've created (such as the date and the memo), but you can't 
change the accounts, amounts and quantities that are associated with the debit purchase.

If you're reversing an item purchase order from a previous accounting period, consider assigning a date from that 
period to the debit purchase you've created. This will allow your reports for that accounting period to reflect the proper
amounts.

3. Click Record Reversal to save the debit purchase. The Purchases window disappears.

4. Select Settle Returns & Debits from the Purchase Ledger Command Centre. A search list appears; from this list, 
highlight the debit purchase you created and click the Apply to Open Purchase button.

5. At this point, you may choose to do one of three things:

* Apply part of the debit purchase amount to the remaining balance of the item purchase order you want to reverse, 
then apply the rest of the debit purchase to another item purchase order's remaining balance. To do this, follow these 
steps:

a. Enter part of the debit purchase amount in the item purchase order's Amount Applied field so the transaction has 
no remaining balance.

b. Enter the rest of the debit purchase in another item purchase order's Amount Applied field.

c. Click Record to save the transaction; the item purchase order is reversed.

* Apply part of the debit purchase amount to the remaining balance of the item purchase order you want to reverse, 
and deposit a refund cheque from the supplier for the rest of the debit purchase amount. To do this, follow these 
steps:

a. Change the Debit Amount field so it's the same as the remaining balance of the item purchase order you want to 
reverse.

b. Enter the Debit Amount field's amount in the Amount Applied field of the item purchase order you want to reverse, 
so the transaction has no remaining balance.

c. Click Record; the item purchase order is reversed. The debit purchase, containing the unapplied amount, remains 
in the system.

d. Select Settle Returns & Debits again.

e. Select the debit purchase and click the Deposit a Refund Cheque button. The Settle Returns & Debits window 
appears, displaying a refund cheque in the remaining amount of the debit purchase.

f. Click Record to save the refund cheque.

* Apply part of the debit purchase amount to the remaining balance of the item purchase order you want to reverse, 
and save the rest of the debit purchase amount for later. To do this, follow these steps:

a. Change the Debit Amount field so it's the same as the remaining balance of the item purchase order you want to 
reverse.



b. Enter the Debit Amount field's amount in the Amount Applied field of the item purchase order you want to reverse, 
so the transaction has no remaining balance.

c. Click Record; the item purchase order is reversed. The debit purchase, containing the unapplied amount, remains 
in the system. Keep in mind that the debit purchase will exist until you apply it to another transaction or write a refund 
cheque for it.

See also
Creating an item purchase order 
Locating an item purchase order 
Removing or changing an item purchase order before it's saved 
Removing or changing an item purchase order after it's saved 
Reversing item purchase orders 
Reversing an item purchase order with no payments assigned to it 
Reversing a closed item purchase order 



Reversing a closed item purchase order
Follow the steps below to reverse an item purchase order, originally entered in the Purchases window, that's 
completely paid. This process returns all balances to the amounts they had before the purchase order was recorded, 
and returns the quantities of your stock items  on the purchase order back to the quantities they had before the 
purchase order was recorded. 

1. Display the item purchase order you want to reverse in the Purchases window.

2. Choose Reverse Purchase from the Edit menu. M.Y.O.B. creates a debit purchase containing amounts and 
quantities exactly opposite of the amounts and quantities on the item purchase order.

You can make a few changes to the debit purchase you've created (such as the date and the memo), but you can't 
change the accounts, amounts and quantities that are associated with the debit purchase.

If you're reversing an item purchase order from a previous accounting period, consider assigning a date from that 
period to the debit purchase you've created. This will allow your reports for that accounting period to reflect the proper
amounts.

3. Click Record Reversal to save the debit purchase . At this time, the item quantities that were listed on the purchase
order return to their previous levels. The Purchases window disappears.

4. Select Settle Returns & Debits from the Purchase Ledger Command Centre. A search list appears; from this list, 
highlight the debit purchase you created.

5. At this point, you may choose to do one of two things:

* Deposit a refund cheque from the supplier. To do this, follow these steps:

a. Click the Deposit a Refund Cheque button. The Settle Returns & Debits window appears, displaying a refund 
cheque in the amount of the debit purchase.

b. Click Record to save the refund cheque; the item purchase order is reversed.

* Apply the debit purchase amount to one or more of the your open purchases with the supplier. To do this, follow 
these steps:

a. Click the Apply to Open Purchase button. The Settle Returns & Debits window appears, displaying the debit 
purchase.

b. In the list of transactions at the bottom of the Settle Returns & Debits window, enter the total amount of the debit 
purchase in the Amount Applied field(s) of the open purchase(s) you want to apply the amount to. 

c. Click Record to save the transaction you created; the item purchase order is reversed.

See also
Creating an item purchase order 
Locating an item purchase order 
Removing or changing an item purchase order before it's saved 
Removing or changing an item purchase order after it's saved 
Reversing item purchase orders 
Reversing an item purchase order with no payments assigned to it 
Reversing a partially paid item purchase order 



Creating a service purchase order
Use the Purchases window to create a service purchase order. 

To assign a service purchase order type to a purchasing transaction, click the PO Type button at the bottom of the 
Purchases window; a window appears, listing the types of purchasing transactions you can create. When you choose
to create a service purchase order, the Purchases window will contain the fields you need to create the service 
purchase order.

See also
Locating a service purchase order 
Removing or changing a service purchase order before it's saved 
Removing or changing a service purchase order after it's saved 
Reversing service purchase orders 
Reversing a service purchase order with no payments assigned to it 
Reversing a partially paid service purchase order 
Reversing a closed service purchase order 



Locating a service purchase order
Follow the steps below to find a purchase order you created in the Purchases window. 

1. Select Inquiry from the M.Y.O.B. Analyst. The Inquiry Register window appears.

2. If you know the number of the transaction you want to view, click the Purchase tab, then enter the transaction's 
number in the Purchase No. field.

If you don't know the number of the transaction you want to view, click the Card tab, then enter the name of the 
supplier whose transaction you're looking for.

3. The transaction you're looking for appears in the scrolling list. If you want to view detail about the transaction, click 
the zoom arrow next to the transaction's number to open the window in which the transaction was originally entered.

See also
Creating a service purchase order 
Removing or changing a service purchase order before it's saved 
Removing or changing a service purchase order after it's saved 
Reversing service purchase orders 
Reversing a service purchase order with no payments assigned to it 
Reversing a partially paid service purchase order 
Reversing a closed service purchase order 



Removing or changing a service purchase order before it's
saved
1. Display the purchase order you wish to remove or change in the Purchases window.

2. If you intend to remove the purchase order but payments are applied to it, remove the payments before you 
attempt to remove the purchase order. See Paying your bills for more information about removing payments.

3. To change the purchase order, change the information in the same way you normally enter information. To remove 
the purchase order, select Erase Purchase from the Edit menu.

See also
Creating a service purchase order 
Locating a service purchase order 
Removing or changing a service purchase order after it's saved 
Reversing service purchase orders 
Reversing a service purchase order with no payments assigned to it 
Reversing a partially paid service purchase order 
Reversing a closed service purchase order 



Removing or changing a service purchase order after it's saved
If your transactions are changeable, follow the steps below to remove or change a service purchase order after it's 
been saved. 

If your transactions are unchangeable, these instructions don't apply to you; instead, you must reverse incorrect 
service purchase orders and create new service purchase orders with correct information. See Reversing service 
purchase orders for more information.

1. Locate the service purchase order you wish to remove or change, and display it in the Purchases window.

2. If you intend to remove the service purchase order but payments are applied to it, remove the payments before you
attempt to remove the service purchase order.

3. To change the transaction, change the information in the same way you normally enter information. To remove the 
transaction, select Delete Purchase from the Edit menu.

See also
Creating a service purchase order 
Locating a service purchase order 
Removing or changing a service purchase order before it's saved 
Reversing service purchase orders 
Reversing a service purchase order with no payments assigned to it 
Reversing a partially paid service purchase order 
Reversing a closed service purchase order 



Reversing service purchase orders
If your transactions are unchangeable, you must reverse a service purchase order to remove its effect on your 
financial records. 

Many scenarios exist if you want to reverse a service purchase order. Refer to the instructions in this section that 
apply to your situation:

* Reversing a service purchase order with no payments assigned to it 

* Reversing a partially paid service purchase order 

* Reversing a closed service purchase order 

If your transactions are changeable, you don't need to reverse your service purchase orders to change them; instead,
you can display the service purchase order in the Purchases window and make changes to it.

See also
Creating a service purchase order 
Locating a service purchase order 
Removing or changing a service purchase order before it's saved 
Removing or changing a service purchase order after it's saved 



Reversing a service purchase order with no payments assigned to it
Follow the steps below to reverse a service purchase order that doesn't have payments assigned to it. 

1. Locate the service purchase order you want to reverse and display it in the Purchases window.

2. Choose Reverse Purchase from the Edit menu. M.Y.O.B. creates a debit purchase containing an amount exactly 
opposite of the amount in the service purchase order.

You can make a few changes to the debit purchase you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the debit purchase.

If you're reversing a purchase from a previous accounting period, consider assigning a date from that period to the 
debit purchase you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the debit purchase. The Purchases window disappears.

4. Select Settle Returns & Debits from the Purchase Ledger Command Centre. A search list appears; from this list, 
select the debit purchase you created and click the Apply to Open Purchase button. The debit purchase appears in 
the Settle Returns & Debits window.

5. In the list of transactions at the bottom of the Settle Returns & Debits window, enter the amount of the debit 
purchase in the Amount Applied field of the service purchase order you want to reverse.

6. Click Record. The Settle Returns & Debits window disappears; the service purchase order is reversed.

See also
Creating a service purchase order 
Locating a service purchase order 
Removing or changing a service purchase order before it's saved 
Removing or changing a service purchase order after it's saved 
Reversing service purchase orders 
Reversing a partially paid service purchase order 
Reversing a closed service purchase order 



Reversing a partially paid service purchase order
Follow the steps below to reverse a service purchase order that's only partially paid. 

1. Display the service purchase order you want to reverse in the Purchases window.

2. Choose Reverse Purchase from the Edit menu. M.Y.O.B. creates a debit purchase containing an amount exactly 
opposite of the amount in the service purchase order.

You can make a few changes to the debit purchase you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the debit purchase.

If you're reversing a service purchase order from a previous accounting period, consider assigning a date from that 
period to the debit purchase you've created. This will allow your reports for that accounting period to reflect the proper
amounts.

3. Click Record Reversal to save the debit purchase. The Purchases window disappears.

4. Select Settle Returns & Debits from the Purchase Ledger Command Centre. A search list appears; from this list, 
highlight the debit purchase you created and click the Apply to Open Purchase button.

5. At this point, you may choose to do one of three things:

* Apply part of the debit purchase amount to the remaining balance of the service purchase order you want to 
reverse, then apply the rest of the debit purchase to another service purchase order's remaining balance. To do this, 
follow these steps:

a. Enter part of the debit purchase amount in the service purchase order's Amount Applied field so the transaction 
has no remaining balance.

b. Enter the rest of the debit purchase in another service purchase order's Amount Applied field.

c. Click Record to save the transaction; the service purchase order is reversed. 

* Apply part of the debit purchase amount to the remaining balance of the service purchase order you want to 
reverse, and deposit a refund cheque for the rest of the debit purchase amount. To do this, follow these steps:

a. Change the Debit Amount field so it's the same as the remaining balance of the service purchase order you want to
reverse.

b. Enter the Debit Amount field's amount in the Amount Applied field of the service purchase order you want to 
reverse, so the transaction has no remaining balance.

c. Click Record; the service purchase order is reversed. The debit purchase, containing the unapplied amount, 
remains in the system.

d. Select Settle Returns & Debits again.

e. Select the debit purchase and click the Deposit a Refund button. The Settle Returns & Debits window appears, 
displaying a refund cheque in the remaining amount of the debit purchase.

f. Click Record to save the refund cheque.

* Apply part of the debit purchase amount to the remaining balance of the service purchase order you want to 
reverse, and save the rest of the debit purchase amount for later. To do this, follow these steps:

a. Change the Debit Amount field so it's the same as the remaining balance of the service purchase order you want to
reverse.

b. Enter the Debit Amount field's amount in the Amount Applied field of the service purchase order you want to 
reverse, so the transaction has no remaining balance.



c. Click Record; the service purchase order is reversed. The debit purchase, containing the unapplied amount, 
remains in the system. Keep in mind that the debit purchase will exist until you apply it to another transaction or 
deposit a refund cheque for it.

See also
Creating a service purchase order 
Locating a service purchase order 
Removing or changing a service purchase order before it's saved 
Removing or changing a service purchase order after it's saved 
Reversing service purchase orders 
Reversing a service purchase order with no payments assigned to it 
Reversing a closed service purchase order 



Reversing a closed service purchase order
Follow the steps below to reverse a service purchase order that's completely paid. 

1. Display the closed purchase you want to reverse in the Purchases window.

2. Choose Reverse Purchase from the Edit menu. M.Y.O.B. creates a debit purchase containing an amount exactly 
opposite of the amount in the closed purchase.

You can make a few changes to the debit purchase you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the debit purchase.

If you're reversing a closed purchase from a previous accounting period, consider assigning a date from that period to
the debit purchase you've created. This will allow your reports for that accounting period to reflect the proper 
amounts.

3. Click Record Reversal to save the debit purchase. The Purchases window disappears.

4. Select Settle Returns & Debits from the Purchase Ledger Command Centre. A search list appears; from this list, 
highlight the debit purchase you created.

5. At this point, you may choose to do one of two things:

* Record the deposit of a refund cheque you received from the supplier. To do this, follow these steps:

a. Click the Deposit a Refund Cheque button. The Settle Returns & Debits window appears, displaying a refund 
cheque in the amount of the debit purchase.

b. Click Record to save the refund cheque; the closed purchase is reversed.

* Apply the debit purchase amount to one or more of your open purchases with this supplier. To do this, follow these 
steps:

a. Click the Apply to Open Purchase button. The Settle Returns & Debits window appears, displaying the debit 
purchase.

b. In the list of transactions at the bottom of the Settle Returns & Debits window, enter the total amount of the debit 
purchase in the Amount Applied field(s) of the open purchase(s) you want to apply the amount to. 

c. Click Record to save the transaction you created; the closed purchase is reversed.

See also
Creating a service purchase order 
Locating a service purchase order 
Removing or changing a service purchase order before it's saved 
Removing or changing a service purchase order after it's saved 
Reversing service purchase orders 
Reversing a service purchase order with no payments assigned to it 
Reversing a partially paid service purchase order 



Creating a professional purchase order
Use the Purchases window to create a professional purchase order.

To assign a professional purchase order type to a purchasing transaction, click the PO Type button at the bottom of 
the Purchases window; a window appears, listing the types of purchasing transactions you can create. When you 
choose to create a professional purchase order, the data entry fields in the Purchases window will contain the fields 
you need to create the professional purchase order.

See also
Locating a professional purchase order 
Removing or changing a professional purchase order before it's saved 
Removing or changing a professional purchase order after it's saved 
Reversing professional purchase orders 
Reversing a professional purchase order with no payments assigned to it 
Reversing a partially paid professional purchase order 
Reversing a closed professional purchase order 



Locating a professional purchase order
Follow the steps below to find a purchase order you created in the Purchases window. 

1. Select Inquiry from the M.Y.O.B. Analyst. The Inquiry Register window appears.

2. If you know the number of the transaction you want to view, click the Purchase tab, then enter the transaction's 
number in the Purchase No. field.

If you don't know the number of the transaction you want to view, click the Card tab, then enter the name of the 
supplier whose transaction you're looking for.

3. The transaction you're looking for appears in the scrolling list. If you want to view detail about the transaction, click 
the zoom arrow next to the transaction's number to open the window in which the transaction was originally entered.

See also
Creating a professional purchase order 
Removing or changing a professional purchase order before it's saved 
Removing or changing a professional purchase order after it's saved 
Reversing professional purchase orders 
Reversing a professional purchase order with no payments assigned to it 
Reversing a partially paid professional purchase order 
Reversing a closed professional purchase order 



Removing or changing a professional purchase order 
before it's saved
1. Display the purchase order you wish to remove or change in the Purchases window.

2. If you intend to remove the purchase order but payments are applied to it, remove the payments before you 
attempt to remove the purchase order. See Paying your bills for more information about removing payments.

3. To change the purchase order, change the information in the same way you normally enter information. To remove 
the purchase order, select Erase Purchase from the Edit menu.

See also
Creating a professional purchase order 
Locating a professional purchase order 
Removing or changing a professional purchase order after it's saved 
Reversing professional purchase orders 
Reversing a professional purchase order with no payments assigned to it 
Reversing a partially paid professional purchase order 
Reversing a closed professional purchase order 



Removing or changing a professional purchase order after it's saved
If your transactions are changeable, follow the steps below to remove or change a professional purchase order after 
it's been saved. 

If your transactions are unchangeable, these instructions don't apply to you; instead, you must reverse incorrect 
professional purchase orders and create new professional purchase orders with correct information. See Reversing 
professional purchase orders for more information.

1. Locate the professional purchase order you wish to remove or change, and display it in the Purchases window.

2. If you intend to remove the professional purchase order but payments are applied to it, remove the payments 
before you attempt to remove the professional purchase order.

3. To change the transaction, change the information in the same way you normally enter information. To remove the 
transaction, select Delete Purchase from the Edit menu.

See also
Creating a professional purchase order 
Locating a professional purchase order 
Removing or changing a professional purchase order before it's saved 
Reversing professional purchase orders 
Reversing a professional purchase order with no payments assigned to it 
Reversing a partially paid professional purchase order 
Reversing a closed professional purchase order 



Reversing professional purchase orders
If your transactions are unchangeable, you must reverse a professional purchase order to remove its effect on your 
financial records. 

Many scenarios exist if you want to reverse a professional purchase order. Refer to the instructions in this section that
apply to your situation:

* Reversing a professional purchase order with no payments assigned to it 

* Reversing a partially paid professional purchase order 

* Reversing a closed professional purchase order 

If your transactions are changeable, you don't need to reverse your professional purchase order to change them; 
instead, you can display the professional purchase order in the Purchases window and make changes to it.

See also
Creating a professional purchase order 
Locating a professional purchase order 
Removing or changing a professional purchase order before it's saved 
Removing or changing a professional purchase order after it's saved 



Reversing a professional purchase order with no payments assigned 
to it
Follow the steps below to reverse a professional purchase order that doesn't have payments assigned to it. 

1. Locate the professional purchase order you want to reverse and display it in the Purchases window.

2. Choose Reverse Purchase from the Edit menu. M.Y.O.B. creates a debit purchase containing an amount exactly 
opposite of the amount in the professional purchase order.

You can make a few changes to the debit purchase you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the debit purchase.

If you're reversing a purchase from a previous accounting period, consider assigning a date from that period to the 
debit purchase you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the debit purchase. The Purchases window disappears.

4. Select Settle Returns & Debits from the Purchase Ledger Command Centre. A search list appears; from this list, 
select the debit purchase you created and click the Apply to Open Purchase button. The debit purchase appears in 
the Settle Returns & Debits window.

5. In the list of transactions at the bottom of the Settle Returns & Debits window, enter the amount of the debit 
purchase in the Amount Applied field of the professional purchase order you want to reverse.

6. Click Record. The Settle Returns & Debits window disappears; the professional purchase order is reversed.

See also
Creating a professional purchase order 
Locating a professional purchase order 
Removing or changing a professional purchase order before it's saved 
Removing or changing a professional purchase order after it's saved 
Reversing professional purchase orders 
Reversing a partially paid professional purchase order 
Reversing a closed professional purchase order 



Reversing a partially paid professional purchase order
Follow the steps below to reverse a professional purchase order that's only partially paid. 

1. Display the professional purchase order you want to reverse in the Purchases window.

2. Choose Reverse Purchase from the Edit menu. M.Y.O.B. creates a debit purchase containing an amount exactly 
opposite of the amount in the professional purchase order.

You can make a few changes to the debit purchase you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the debit purchase.

If you're reversing a professional purchase order from a previous accounting period, consider assigning a date from 
that period to the debit purchase you've created. This will allow your reports for that accounting period to reflect the 
proper amounts.

3. Click Record Reversal to save the debit purchase. The Purchases window disappears.

4. Select Settle Returns & Debits from the Purchase Ledger Command Centre. A search list appears; from this list, 
highlight the debit purchase you created and click the Apply to Open Purchase button.

5. At this point, you may choose to do one of three things:

* Apply part of the debit purchase amount to the remaining balance of the professional purchase order you want to 
reverse, then apply the rest of the debit purchase to another professional purchase order's remaining balance. To do 
this, follow these steps:

a. Enter part of the debit purchase amount in the professional purchase order Amount Applied field so the transaction 
has no remaining balance.

b. Enter the rest of the debit purchase in another professional purchase order Amount Applied field.

c. Click Record to save the transaction; the professional purchase order is reversed. 

* Apply part of the debit purchase amount to the remaining balance of the professional purchase order you want to 
reverse, and deposit a refund cheque for the rest of the debit purchase amount. To do this, follow these steps:

a. Change the Debit Amount field so it's the same as the remaining balance of the professional purchase order you 
want to reverse.

b. Enter the Debit Amount field's amount in the Amount Applied field of the professional purchase order you want to 
reverse, so the transaction has no remaining balance.

c. Click Record; the professional purchase order is reversed. The debit purchase, containing the unapplied amount, 
remains in the system.

d. Select Settle Returns & Debits again.

e. Select the debit purchase and click the Deposit a Refund button. The Settle Returns & Debits window appears, 
displaying a refund cheque in the remaining amount of the debit purchase.

f. Click Record to save the refund cheque.

* Apply part of the debit purchase amount to the remaining balance of the professional purchase order you want to 
reverse, and save the rest of the debit purchase amount for later. To do this, follow these steps:

a. Change the Debit Amount field so it's the same as the remaining balance of the professional purchase order you 
want to reverse.

b. Enter the Debit Amount field's amount in the Amount Applied field of the professional purchase order you want to 
reverse, so the transaction has no remaining balance.



c. Click Record; the professional purchase order is reversed. The debit purchase, containing the unapplied amount, 
remains in the system. Keep in mind that the debit purchase will exist until you apply it to another transaction or 
deposit a refund cheque for it.

See also
Creating a professional purchase order 
Locating a professional purchase order 
Removing or changing a professional purchase order before it's saved 
Removing or changing a professional purchase order after it's saved 
Reversing professional purchase orders 
Reversing a professional purchase order with no payments assigned to it 
Reversing a closed professional purchase order 



Reversing a closed professional purchase order
Follow the steps below to reverse a professional purchase order that's completely paid. 

1. Display the closed purchase you want to reverse in the Purchases window.

2. Choose Reverse Purchase from the Edit menu. M.Y.O.B. creates a debit purchase containing an amount exactly 
opposite of the amount in the closed purchase.

You can make a few changes to the debit purchase you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the debit purchase.

If you're reversing a closed purchase from a previous accounting period, consider assigning a date from that period to
the debit purchase you've created. This will allow your reports for that accounting period to reflect the proper 
amounts.

3. Click Record Reversal to save the debit purchase. The Purchases window disappears.

4. Select Settle Returns & Debits from the Purchase Ledger Command Centre. A search list appears; from this list, 
highlight the debit purchase you created.

5. At this point, you may choose to do one of two things:

* Record the deposit of a refund cheque you received from the supplier. To do this, follow these steps:

a. Click the Deposit a Refund Cheque button. The Settle Returns & Debits window appears, displaying a refund 
cheque in the amount of the debit purchase.

b. Click Record to save the refund cheque; the closed purchase is reversed.

* Apply the debit purchase amount to one or more of your open purchases with this supplier. To do this, follow these 
steps:

a. Click the Apply to Open Purchase button. The Settle Returns & Debits window appears, displaying the debit 
purchase.

b. In the list of transactions at the bottom of the Settle Returns & Debits window, enter the total amount of the debit 
purchase in the Amount Applied field(s) of the open purchase(s) you want to apply the amount to. 

c. Click Record to save the transaction you created; the closed purchase is reversed.

See also
Creating a professional purchase order 
Locating a professional purchase order 
Removing or changing a professional purchase order before it's saved 
Removing or changing a professional purchase order after it's saved 
Reversing professional purchase orders 
Reversing a professional purchase order with no payments assigned to it 
Reversing a partially paid professional purchase order 



Creating an other purchase
Use the Purchases window to create an other purchase. 

To assign an other purchase type to a purchasing transaction, click the PO Type button at the bottom of the 
Purchases window; a window appears, listing the types of purchasing transactions you can create. When you choose
to create an other purchase, the data entry fields in the Purchases window will contain the fields you need to create 
the other purchase.

See also
Locating an other purchase 
Removing or changing an other purchase before it's saved 
Removing or changing an other purchase after it's saved 
Reversing other purchases 
Reversing an other purchase with no payments assigned to it 
Reversing a partially paid other purchase 
Reversing a closed other purchase 



Locating an other purchase
Follow the steps below to find an other purchase  you created in the Purchases window. 

1. Select Inquiry from the M.Y.O.B. Analyst. The Inquiry Register window appears.

2. If you know the number of the transaction you want to view, click the Purchase tab, then enter the transaction's 
number in the Purchase No. field.

If you don't know the number of the transaction you want to view, click the Card tab, then enter the name of the 
supplier whose transaction you're looking for.

3. The transaction you're looking for appears in the scrolling list. If you want to view detail about the transaction, click 
the zoom arrow next to the transaction's number to open the window in which the transaction was originally entered.

See also
Creating an other purchase 
Removing or changing an other purchase before it's saved 
Removing or changing an other purchase after it's saved 
Reversing other purchases 
Reversing an other purchase with no payments assigned to it 
Reversing a partially paid other purchase 
Reversing a closed other purchase 



Removing or changing an other purchase before it's saved
1. Display the other purchase you wish to remove or change in the Purchases window.

2. If you intend to remove the other purchase but payments are applied to it, remove the payments before you 
attempt to remove the other purchase. See Paying your bills for more information about removing payments.

3. To change the other purchase, change the information in the same way you normally enter information. To remove 
the other purchase, select Erase Purchase from the Edit menu.

See also
Creating an other purchase 
Locating an other purchase 
Removing or changing an other purchase after it's saved 
Reversing other purchases 
Reversing an other purchase with no payments assigned to it 
Reversing a partially paid other purchase 
Reversing a closed other purchase 



Removing or changing an other purchase after it's saved
If your transactions are changeable, follow the steps below to remove or change an other purchase after it's been 
saved. 

If your transactions are unchangeable, these instructions don't apply to you; instead, you must reverse incorrect other
purchases and create new other purchases with correct information. See Reversing other purchases for more 
information.

1. Locate the other purchase you wish to remove or change, and display it in the Purchases window.

2. If you intend to remove the other purchase but payments are applied to it, remove the payments before you 
attempt to remove the other purchase.

3. To change the transaction, change the information in the same way you normally enter information. To remove the 
transaction, select Delete Purchase from the Edit menu.

See also
Creating an other purchase 
Locating an other purchase 
Removing or changing an other purchase before it's saved 
Reversing other purchases 
Reversing an other purchase with no payments assigned to it 
Reversing a partially paid other purchase 
Reversing a closed other purchase 



Reversing other purchases
If your transactions are unchangeable, you must reverse an other purchase to remove its effect on your financial 
records. 

Many scenarios exist if you want to reverse an other purchase. Refer to the instructions in this section that apply to 
your situation:

* Reversing an other purchase with no payments assigned to it 

* Reversing a partially paid other purchase 

* Reversing a closed other purchase 

If your transactions are changeable, you don't need to reverse your other purchases to change them; instead, you 
can display the other purchase in the Purchases window and make changes to it.

See also
Creating an other purchase 
Locating an other purchase 
Removing or changing an other purchase before it's saved 
Removing or changing an other purchase after it's saved 



Reversing an other purchase with no payments assigned to it
Follow the steps below to reverse an other purchase that doesn't have payments assigned to it. 

1. Locate the other purchase you want to reverse and display it in the Purchases window.

2. Choose Reverse Purchase from the Edit menu. M.Y.O.B. creates a debit purchase containing an amount exactly 
opposite of the amount in the other purchase.

You can make a few changes to the debit purchase you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the debit purchase.

If you're reversing a purchase from a previous accounting period, consider assigning a date from that period to the 
debit purchase you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the debit purchase. The Purchases window disappears.

4. Select Settle Returns & Debits from the Purchase Ledger Command Centre. A search list appears; from this list, 
highlight the debit purchase you created and click the Apply to Open Purchase button. The debit purchase appears in
the Settle Returns & Debits window.

5. In the list of transactions at the bottom of the Settle Returns & Debits window, enter the amount of the debit 
purchase in the Amount Applied field of the other purchase you want to reverse.

6. Click Record. The Settle Returns & Debits window disappears; the other purchase is reversed.

See also
Creating an other purchase 
Locating an other purchase 
Removing or changing an other purchase before it's saved 
Removing or changing an other purchase after it's saved 
Reversing other purchases 
Reversing a partially paid other purchase 
Reversing a closed other purchase 



Reversing a partially paid other purchase
Follow the steps below to reverse an other purchase thatsonly partially paid. 

1. Display the other purchase you want to reverse in the Purchases window.

2. Choose Reverse Purchase from the Edit menu. M.Y.O.B. creates a debit purchase containing an amount exactly 
opposite of the amount in the other purchase.

You can make a few changes to the debit purchase you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the debit purchase.

If you're reversing an other purchase from a previous accounting period, consider assigning a date from that period to
the debit purchase you've created. This will allow your reports for that accounting period to reflect the proper 
amounts.

3. Click Record Reversal to save the debit purchase. The Purchases window disappears.

4. Select Settle Returns & Debits from the Purchase Ledger Command Centre. A search list appears; from this list, 
highlight the debit purchase you created and click the Apply to Open Purchase button.

5. At this point, you may choose to do one of three things:

* Apply part of the debit purchase amount to the remaining balance of the other purchase you want to reverse, then 
apply the rest of the debit purchase to another other purchase's remaining balance. To do this, follow these steps:

a. Enter part of the debit purchase amount in the other purchase's Amount Applied field so the transaction has no 
remaining balance.

b. Enter the rest of the debit purchase in another other purchase's Amount Applied field.

c. Click Record to save the transaction; the other purchase is reversed. 

* Apply part of the debit purchase amount to the remaining balance of the other purchase you want to reverse, and 
deposit a refund cheque for the rest of the debit purchase amount. To do this, follow these steps:

a. Change the Debit Amount field so it's the same as the remaining balance of the other purchase you want to 
reverse.

b. Enter the Debit Amount field's amount in the Amount Applied field of the other purchase you want to reverse, so the
transaction has no remaining balance.

c. Click Record; the other purchase is reversed. The debit purchase, containing the unapplied amount, remains in the
system.

d. Select Settle Returns & Debits again.

e. Select the debit purchase and click the Deposit a Refund button. The Settle Returns & Debits window appears, 
displaying a refund cheque in the remaining amount of the debit purchase.

f. Click Record to save the refund cheque.

* Apply part of the debit purchase amount to the remaining balance of the other purchase you want to reverse, and 
save the rest of the debit purchase amount for later. To do this, follow these steps:

a. Change the Debit Amount field so it's the same as the remaining balance of the other purchase you want to 
reverse.

b. Enter the Debit Amount fields amount in the Amount Applied field of the other purchase you want to reverse, so the
transaction has no remaining balance.

c. Click Record; the other purchase is reversed. The debit purchase, containing the unapplied amount, remains in the



system. Keep in mind that the debit purchase will exist until you apply it to another transaction or deposit a refund 
cheque for it.

See also
Creating an other purchase 
Locating an other purchase 
Removing or changing an other purchase before it's saved 
Removing or changing an other purchase after it's saved 
Reversing other purchases 
Reversing an other purchase with no payments assigned to it 
Reversing a closed other purchase 



Reversing a closed other purchase
Follow the steps below to reverse an other purchase that's completely paid. 

1. Display the closed purchase you want to reverse in the Purchases window.

2. Choose Reverse Purchase from the Edit menu. M.Y.O.B. creates a debit purchase containing an amount exactly 
opposite of the amount in the closed purchase.

You can make a few changes to the debit purchase you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with the debit purchase.

If you're reversing a closed purchase from a previous accounting period, consider assigning a date from that period to
the debit purchase you've created. This will allow your reports for that accounting period to reflect the proper 
amounts.

3. Click Record Reversal to save the debit purchase. The Purchases window disappears.

4. Select Settle Returns & Debits from the Purchase Ledger Command Centre. A search list appears; from this list, 
highlight the debit purchase you created.

5. At this point, you may choose to do one of two things:

* Record the deposit of a refund cheque you received from the supplier. To do this, follow these steps:

a. Click the Deposit a Refund Cheque button. The Settle Returns & Debits window appears, displaying a refund 
cheque in the amount of the debit purchase.

b. Click Record to save the refund cheque; the closed purchase is reversed.

* Apply the debit purchase amount to one or more of your open purchases with this supplier. To do this, follow these 
steps:

a. Click the Apply to Open Purchase button. The Settle Returns & Debits window appears, displaying the debit 
purchase.

b. In the list of transactions at the bottom of the Settle Returns & Debits window, enter the total amount of the debit 
purchase in the Amount Applied field(s) of the open purchase(s) you want to apply the amount to. 

c. Click Record to save the transaction you created; the closed purchase is reversed.

See also
Creating an other purchase 
Locating an other purchase 
Removing or changing an other purchase before it's saved 
Removing or changing an other purchase after it's saved 
Reversing other purchases 
Reversing an other purchase with no payments assigned to it 
Reversing a partially paid other purchase 



Creating a pending purchase order
There are two ways to create a pending purchase order: 

* By creating a purchase order and placing the entire purchase order in the Pending File

* By creating a purchase order containing a backordered quantity

Follow the steps below that apply to your situation.

Placing an entire purchase in the Pending File
Creating a pending purchase order is almost the same process as creating a non-pending purchase order. Item 
purchase orders, professional purchase ordersand service purchase orders  can be placed in the Pending File. 
Follow the steps below to create a pending purchase order.

1. Create the purchase order as you would create a regular purchase order. Enter quantities and amounts the same 
way, as well. (You can include backordered quantities, too.)

2. If you made a deposit on the pending purchase order, enter that amount in the Paid Today field. 

3. When youve entered the purchasing information, click the Pending button. If any deposit money had been placed 
on the pending purchase order, your linked creditors deposits account is increased by the amount of the deposit, and 
your linked creditors bank account is decreased. Otherwise, none of your financial records are changed. The 
purchase order is saved in the Pending File.

Placing a backordered quantity in the Pending File
Creating a pending purchase order for a backordered quantity is almost the same process as creating a non-pending 
purchase order. Follow the steps below to place a backordered quantity in the Pending File.

1. Create an item purchase order as you would create a regular item purchase order, entering a quantity in the 
Backorder column for each item you wish to place in the Pending File. (You can include quantities in the Received 
column, too.)

2. If you made a deposit on the pending purchase order, enter that amount in the Paid Today field. 

3. When youve entered the purchase order information, click the Record button. An purchase order is created in the 
Pending File for each item with a quantity in the Backorder column. If you entered a quantity in the Received column 
for any items, a non-pending purchase order is created for those items.

See also
Locating a pending purchase order 
Recording a deposit on a pending purchase order 
Converting a pending purchase order to an actual purchase order 
Removing a pending purchase order before it's saved 
Removing or changing a pending purchase order after it's saved 



Locating a pending purchase order
Follow the steps below to find a pending purchase order you entered in the Purchases window. 

1. Select Purchases from the Purchase Ledger Command Centre. The Purchases window appears.

2. In the Supplier field, enter or select the name of the supplier whose pending purchase order you're looking for. A 
search list appears, containing all pending purchase orders for the supplier.

3. From the search list, select the pending purchase order you want. The pending purchase order is displayed in the 
Purchases window.

See also
Creating a pending purchase order 
Recording a deposit on a pending purchase order 
Converting a pending purchase order to an actual purchase order 
Removing a pending purchase order before it's saved 
Removing or changing a pending purchase order after it's saved 



Recording a deposit on a pending purchase order
There are two ways you can record a deposit on a pending purchase order: 

* If you're in the process of creating a pending purchase order, enter the deposit amount in the Paid Today field of the
Purchases window. This process is described in Creating a pending purchase order .

* If you're making a deposit on a pending purchase order that already exists, use the Bill Payments window. Follow 
the steps below to do this.

1. Open the Bill Payments window from the Purchase Ledger Command Centre.

2. In the Amount field, enter the amount you gave the supplier for a deposit.

3. In the list of transactions at the bottom of the Bill Payments window, enter the deposit amount in Amount Applied 
field for the pending purchase order you want to apply the deposit to. (Pending purchase orders have the word 
"Pending" in their Status column.)

4. When youve finished, click the Record button. Your linked creditors deposits account is increased by the amount of
the deposit, and your linked creditors account is increased.

See also
Creating a pending purchase order 
Locating a pending purchase order 
Converting a pending purchase order to an actual purchase order 
Removing a pending purchase order before it's saved 
Removing or changing a pending purchase order after it's saved 



Converting a pending purchase order to an actual purchase order
When a pending purchase order becomes an actual transaction, you need to change the status of the pending 
purchase order. Follow the steps below to do this. 

1. From the Purchase Ledger Command Centre, select Purchases. The Purchases window appears.

2. Enter or select the name of the supplier whose pending purchase order you want to convert. A search list appears, 
listing all the pending purchase orders for the supplier.

3. Select the pending purchase order you want to convert and click the Use Pending P.O. button. The pending 
purchase order appears in the Purchases window.

4. Make any changes to the pending purchase order at this time, as you would make changes to an actual purchase 
order. 

5. When youve finished working with the pending purchase order, click the Record button. The pending purchase 
order is converted to an actual purchase order. If any deposit money had been placed on the pending purchase 
order, your linked creditors deposits account is decreased by the amount of the deposit, and your linked creditors 
account is decreased.

See also
Creating a pending purchase order 
Locating a pending purchase order 
Recording a deposit on a pending purchase order 
Removing a pending purchase order before it's saved 
Removing or changing a pending purchase order after it's saved 



Removing a pending purchase order before it's saved
If you want to remove or change a pending purchase order you've entered - but haven't chosen Save from the File 
menu yet - follow the steps below. 

1. Locate the pending purchase order and display it in the Purchases window.

2. To change the pending purchase order, change the information in the same way you normally enter information. To
remove the pending purchase order, select Delete Pending Purchase from the Edit menu.

See also
Creating a pending purchase order 
Locating a pending purchase order 
Recording a deposit on a pending purchase order 
Converting a pending purchase order to an actual purchase order 
Removing or changing a pending purchase order after it's saved 



Removing or changing a pending purchase order after it's saved
There are two type of pending purchase order: those without deposits and those with deposits. 

Pending purchase orders without deposits
1. Locate the pending purchase order and display it in the Purchases window.

2. To change the pending purchase order, change the information in the same way you normally enter information. To
remove the pending purchase order, select Delete Pending Purchase from the Edit menu.

Pending purchase orders with deposits
A pending purchase order with a deposit may not be deleted unless the deposit is deleted. Once you save your data, 
you cannot delete the deposit.

To remove a pending purchase order with an "undeletable" deposit, you must erase the detail of the purchase order 
(change all quantities to zero or change the type of purchase order) and record it as an actual purchase order. This 
creates an purchase order with a negative balance due, also known as a debit purchase. Use the Settle Returns & 
Debits window to apply the debit to one of your open purchases with the supplier.

When you record a pending purchase order with a deposit as an actual purchase order, M.Y.O.B. moves the money 
from your linked supplier deposits account to your linked creditors account. Your linked supplier deposits account is 
decreased by the amount of the deposit and the linked creditors account is decreased. 

See also
Creating a pending purchase order 
Locating a pending purchase order 
Recording a deposit on a pending purchase order 
Converting a pending purchase order to an actual purchase order 
Removing a pending purchase order before it's saved 



Paying your bills
The payments you make to suppliers are recorded in the Purchase Ledger Command Centre, using the Bill 
Payments window. 

Click on a topic below for more information about paying your bills.

Locating a supplier payment 
Removing a supplier payment before it's saved 
Removing or changing a supplier payment after it's saved 
Reversing a supplier payment 



Locating a supplier payment
Follow the steps below to find a supplier payment you entered in the Bill Payments window. 

1. Choose Inquiry from the M.Y.O.B. Analyst; the Transaction Inquiry window appears. Click the Card tab.

2. In the Name field, enter or select the name of the supplier whose payment you're looking for. The Supplier 
Transaction Detail window appears, displaying all transactions for the supplier for the specified date range.

3. Supplier payments are recognised by their source journal code of CD. Search the ID No. column for transactions 
numbered with CD prefixes and click the zoom arrow next to the payment you want to view. The Bill Payments 
window appears, displaying the original payment as you entered it.

See also
Paying your bills 
Removing a supplier payment before it's saved 
Removing or changing a supplier payment after it's saved 
Reversing a supplier payment 



Removing or changing a supplier payment before it's 
saved
1. Display the supplier payment you wish to remove or change in the Bill Payments window.

2. To change the supplier payment, change the information in the same way you normally enter information. To 
remove the payment, select Erase Payment from the Edit menu.

See also
Paying your bills 
Locating a supplier payment 
Removing or changing a supplier payment after it's saved 
Reversing a supplier payment 



Removing or changing a supplier payment after it's saved
If your transactions are changeable, follow the steps below to remove or change a supplier payment after it's been 
saved. 

If your transactions are unchangeable, these instructions don't apply to you; instead, you must reverse incorrect 
supplier payments and create new supplier payments with correct information.

1. Locate the supplier payment you wish to remove or change and display it in the Bill Payments window.

2. To change the supplier payment, change the information in the same way you normally enter information. To 
remove the supplier payment, select Delete Payment from the Edit menu.

See also
Paying your bills 
Locating a supplier payment 
Removing a supplier payment before it's saved 
Reversing a supplier payment 



Reversing a supplier payment
Follow the steps below to reverse a supplier payment. 

1. Display the supplier payment you want to reverse in the Bill Payments window.

2. Choose Reverse Payment from the Edit menu. M.Y.O.B. creates a payment transaction containing an amount 
exactly opposite of the amount in the supplier payment.

You can make a few changes to the transaction you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with it.

If you're reversing a supplier payment from a previous accounting period, consider assigning a date from that period 
to the transaction you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the reversed payment transaction. The Bill Payments window disappears, and the 
open purchase you originally applied the payment to is changed.

If you attempt to reverse a payment with discount applied to it, you must also reverse the discount. To do this, locate 
the discount transaction in the Purchases Journal and reverse it.

See also
Paying your bills 
Locating a supplier payment 
Removing a supplier payment before it's saved 
Removing or changing a supplier payment after it's saved 



Settling debits and receiving refund cheques
During the course of conducting your purchasing transactions, there may be times when a supplier owes you money, 
whether it's because of a returned item, an overpayment on your balance or an incorrect amount that appeared on a 
purchase order. Whatever the reason, you need to change your financial records in M.Y.O.B. when the supplier 
"evens the score" with you. To do this, you create a debit purchase - a purchasing transaction with a negative 
amount that indicates the supplier owes you money. Using a debit purchase, you can either reduce your outstanding 
balance with the supplier or deposit a refund cheque from the supplier. This process of creating a debit purchase and 
applying it to an outstanding balance or a refund cheque is called settling debits. 

When you create a debit purchase - a process that can happen in a number of windows in the Purchase Ledger 
Command Centre- the amount of the debit purchase is recorded as part of your total outstanding purchasing balance 
with the supplier. For example, say you have three open purchase orders and you owe £1,000 from those purchases.
In addition, you have two debit purchases worth £400 - money the supplier owes you. Putting these two amounts 
together, you owe the supplier only £600. Until you settle debits, however, M.Y.O.B. still considers your outstanding 
balance as £1,000. This is because the money owed by the supplier isn't calculated as part of your outstanding 
balance.

Depending upon what you do when you settle debits, you can reduce that outstanding balance. To use the example 
above, if you apply the £400 in debit purchases to one or more of the open purchases you have, your total 
outstanding balance is reduced to £600. On the other hand, if you deposit a refund cheque the supplier wrote to you 
for £400 to pay off your two debit purchases, your total outstanding balance is still £1,000. When you settle debits, 
therefore, all you really do is take action on the money owed to you by your suppliers.

When you apply a debit purchase to an open purchase - usually the most common task performed with a debit 
purchase - the transaction is recorded in the Purchases Journal. Two entries are made to your linked creditors 
account: the first cancels the debit purchase by increasing the linked creditors account, and the second pays off part 
(or all) of the open purchase by decreasing the linked creditors account.

Most of the work of settling credits is accomplished in the Settle Returns & Debits window.

Click on a topic below for more information about settling debits and receiving refund cheques.

Applying a debit purchase to an open purchase 
Applying a debit purchase to a closed purchase 
Locating an applied debit purchase 
Applying a debit purchase to a pending purchase order 
Removing an applied debit purchase before it's saved 
Removing an applied debit purchase after it's saved 
Reversing an applied debit purchase 
Locating a debit refund cheque 
Removing a debit refund cheque after it's saved 
Reversing a debit refund cheque 



Applying a debit purchase to an open purchase
Follow the steps below to apply the amount of a debit purchase to a transaction entered in the Purchases window 
that isn't completely paid. 

1. Select Settle Returns & Debits from the Purchase Ledger Command Centre. A search list appears; from this list, 
highlight the debit purchase you wish to apply and click the Apply to Open P.O. button. The Settle Returns & Debits 
window appears, listing all transactions (open, closed and pending) assigned to the supplier.

2. Locate the open purchase you want - open purchases are labelled "Open" in the Status column - then enter the 
amount of the debit purchase in the open purchase's Amount Applied field.

3. Click Record to save the transaction. The debit purchase is applied.

See also
Settling debits and receiving refund cheques 
Applying a debit purchase to a closed purchase 
Locating an applied debit purchase 
Applying a debit purchase to a pending purchase order 
Removing an applied debit purchase before it's saved 
Removing an applied debit purchase after it's saved 
Reversing an applied debit purchase 
Locating a debit refund cheque 
Removing a debit refund cheque after it's saved 
Reversing a debit refund cheque 



Applying a debit purchase to a closed purchase
Follow the steps below to apply the amount of a debit purchase to a transaction entered in the Purchases window 
that's completely paid. 

When you apply a debit purchase to a closed purchase - in other words, when you apply an amount to a transaction 
that doesn't have a balance due - the closed purchase is removed, and a new debit purchase in the amount you 
applied to the closed purchase is created.

1. Select Settle Returns & Debits from the Purchase Ledger Command Centre. A search list appears; from this list, 
highlight the debit purchase you wish to apply and click the Apply to Open Invoice button. The Settle Returns & 
Debits window appears, listing all transactions (open, closed and pending) assigned to the supplier.

2. Locate the closed purchase you want - closed purchases are labelled "Closed" in the Status column - then enter 
the amount of the debit purchase in the closed purchase's Amount Applied field.

3. Click Record to save the transaction. The closed purchase is removed, and a new debit purchase in the amount 
you applied to the closed purchase is created.

See also
Settling debits and receiving refund cheques 
Applying a debit purchase to an open purchase 
Locating an applied debit purchase 
Applying a debit purchase to a pending purchase order 
Removing an applied debit purchase before it's saved 
Removing an applied debit purchase after it's saved 
Reversing an applied debit purchase 
Locating a debit refund cheque 
Removing a debit refund cheque after it's saved 
Reversing a debit refund cheque 



Locating an applied debit purchase
Follow the steps below to find a debit purchase you applied in the Settle Returns & Debits window. 

1. Select Inquiry from the M.Y.O.B. Analyst. The Inquiry Register window appears.

2. In the Purchase No. field, enter or select the name of the purchase order whose applied debit purchase you're 
looking for. A new list in the Inquiry Register window appears, displaying all transactions assigned to the purchase 
order you entered.

3. Applied debit purchase are recognised by their source journal code  of PJ. Search the ID No. column for 
transactions numbered with PJ prefixes and click the zoom arrow next to the debit purchase you want to view. The 
Settle Returns & Debits window appears, displaying the original debit purchase as you entered it.

See also
Settling debits and receiving refund cheques 
Applying a debit purchase to an open purchase 
Applying a debit purchase to a closed purchase 
Applying a debit purchase to a pending purchase order 
Removing an applied debit purchase before it's saved 
Removing an applied debit purchase after it's saved 
Reversing an applied debit purchase 
Locating a debit refund cheque 
Removing a debit refund cheque after it's saved 
Reversing a debit refund cheque 



Applying a debit purchase to a pending purchase order
Applying a debit purchase to a pending purchase order is the same procedure as recording a deposit on a pending 
purchase order. See Recording a deposit on a pending purchase order for more information about this task. 

See also
Settling debits and receiving refund cheques 
Applying a debit purchase to an open purchase 
Applying a debit purchase to a closed purchase 
Locating an applied debit purchase 
Removing an applied debit purchase before it's saved 
Removing an applied debit purchase after it's saved 
Reversing an applied debit purchase 
Locating a debit refund cheque 
Removing a debit refund cheque after it's saved 
Reversing a debit refund cheque 



Removing an applied debit purchase before it's saved
If you want to remove a debit purchase you've applied - but haven't chosen Save from the File menu yet - in the 
Settle Returns & Debits window, select Erase Debit from the Edit menu or click the Cancel button. The debit purchase
won't be applied. 

See also
Settling debits and receiving refund cheques 
Applying a debit purchase to an open purchase 
Applying a debit purchase to a closed purchase 
Locating an applied debit purchase 
Applying a debit purchase to a pending purchase order 
Removing an applied debit purchase after it's saved 
Reversing an applied debit purchase 
Locating a debit refund cheque 
Removing a debit refund cheque after it's saved 
Reversing a debit refund cheque 



Removing an applied debit purchase after it's saved
If your transactions are changeable, follow the steps below to remove an applied debit purchase after it's been saved.
Applied debit purchases that have been saved can't be changed; the only modification you can make to them is to 
remove them. 

If your transactions are unchangeable, these instructions don't apply to you; instead, you must reverse incorrect 
applied debit purchases and re-apply debit purchases with correct information.

1. Locate the debit purchase you wish to remove or change, and display it in the Settle Returns & Debits window.

2. To remove the debit purchase, select Delete Debit from the Edit menu.

See also
Settling debits and receiving refund cheques 
Applying a debit purchase to an open purchase 
Applying a debit purchase to a closed purchase 
Locating an applied debit purchase 
Applying a debit purchase to a pending purchase order 
Removing an applied debit purchase before it's saved 
Reversing an applied debit purchase 
Locating a debit refund cheque 
Removing a debit refund cheque after it's saved 
Reversing a debit refund cheque 



Reversing an applied debit purchase
Follow the steps below to reverse a debit purchase you applied to an open purchase. 

1. Display the applied debit purchase you want to reverse in the Settle Returns & Debits window.

2. Choose Reverse Debit from the Edit menu. M.Y.O.B. creates a transaction containing an amount exactly opposite 
of the amount in the applied debit purchase.

You can make a few changes to the transaction you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with it.

If you're reversing a debit purchase from a previous accounting period, consider assigning a date from that period to 
the transaction you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the reversed transaction. The Settle Returns & Debits window disappears, and the 
open purchase you originally assigned the debit purchase to is returned to its previous amount.

See also
Settling debits and receiving refund cheques 
Applying a debit purchase to an open purchase 
Applying a debit purchase to a closed purchase 
Locating an applied debit purchase 
Applying a debit purchase to a pending purchase order 
Removing an applied debit purchase before it's saved 
Removing an applied debit purchase after it's saved 
Locating a debit refund cheque 
Removing a debit refund cheque after it's saved 
Reversing a debit refund cheque 



Locating a debit refund cheque
Follow the steps below to find a debit refund cheque you entered in the Settle Returns & Debits window. 

1. Open the Transaction Journal window and click the Receipts tab. All transactions in the Cash Receipts Journal  is 
displayed for the date range that's displayed.

2. Credit refund cheques are recognised by the accounts that are affected by them. Look for a transaction that 
includes a credit amount to your linked creditors account and a debit to your linked creditors bank account.

3. When you locate the refund cheque you're looking for, click the zoom arrow next to the cheque's number. The 
Settle Returns & Debits window appears, displaying the debit refund cheque's information.

See also
Settling debits and receiving refund cheques 
Applying a debit purchase to an open purchase 
Applying a debit purchase to a closed purchase 
Locating an applied debit purchase 
Applying a debit purchase to a pending purchase order 
Removing an applied debit purchase before it's saved 
Removing an applied debit purchase after it's saved 
Reversing an applied debit purchase 
Removing a debit refund cheque after it's saved 
Reversing a debit refund cheque 



Removing or changing a debit refund cheque before it's saved
If you want to remove a refund cheque you've entered - but haven't chosen Save from the File menu yet - in the 
Settle Returns & Debits window, select Erase Debit from the Edit menu or click the Cancel button. The refund cheque
is removed. 

See also
Settling debits and receiving refund cheques 
Applying a debit purchase to an open purchase 
Applying a debit purchase to a closed purchase 
Locating an applied debit purchase 
Applying a debit purchase to a pending purchase order 
Removing an applied debit purchase before it's saved 
Removing an applied debit purchase after it's saved 
Reversing an applied debit purchase 
Locating a debit refund cheque 
Removing a debit refund cheque after it's saved 
Reversing a debit refund cheque 



Removing a debit refund cheque after it's saved
If your transactions are changeable, follow the steps below to remove a debit refund cheque after it's been saved. 
Debit refund cheques that have been saved can't be changed; the only modification you can make to them is to 
remove them. 

If your transactions are unchangeable, these instructions don't apply to you; instead, you must reverse incorrect debit
refund cheques and then create new debit refund cheques with correct information.

1. Locate the debit refund cheque you wish to remove or change, and display it in the Settle Returns & Debits 
window.

2. To remove the debit refund cheque, select Delete Debit from the Edit menu.

See also
Settling debits and receiving refund cheques 
Applying a debit purchase to an open purchase 
Applying a debit purchase to a closed purchase 
Locating an applied debit purchase 
Applying a debit purchase to a pending purchase order 
Removing an applied debit purchase before it's saved 
Removing an applied debit purchase after it's saved 
Reversing an applied debit purchase 
Locating a debit refund cheque 
Reversing a debit refund cheque 



Reversing a debit refund cheque
Follow the steps below to reverse a debit refund cheque. 

1. Display the refund cheque you want to reverse in the Settle Returns & Debits window.

2. Choose Reverse Debit from the Edit menu. M.Y.O.B. creates a transaction containing an amount exactly opposite 
of the amount in the refund cheque.

You can make a few changes to the transaction you've created (such as the date and the memo), but you can't 
change the accounts and amounts that are associated with it.

If you're reversing a refund cheque from a previous accounting period, consider assigning a date from that period to 
the transaction you've created. This will allow your reports for that accounting period to reflect the proper amounts.

3. Click Record Reversal to save the reversed transaction. The Settle Returns & Debits window disappears, and the 
debit purchase for which the refund cheque was created is recreated.

See also
Settling debits and receiving refund cheques 
Applying a debit purchase to an open purchase 
Applying a debit purchase to a closed purchase 
Locating an applied debit purchase 
Applying a debit purchase to a pending purchase order 
Removing an applied debit purchase before it's saved 
Removing an applied debit purchase after it's saved 
Reversing an applied debit purchase 
Locating a debit refund cheque 
Removing a debit refund cheque after it's saved 



How M.Y.O.B. Stock Control works
M.Y.O.B. allows you to track all things you buy, sell and store, regardless of whether those things are physical items 
or services. With information about each of these things stored in M.Y.O.B., you can include them on invoices and 
purchase orders, keep track of quantities and analyse your sales and purchasing activity. 

For all the items you stock, M.Y.O.B. keeps a running balance of the number of units on hand and the total value of 
those units. It computes the average cost of a single item by dividing the total value by the number of units.

In a perfect world, stock tracking is very simple. When you record an item purchase order, M.Y.O.B. adds the quantity
to the number of units on hand and adds the cost of those items to the total item stock value. When you record an 
item invoice, M.Y.O.B. reduces the on-hand quantity. It also reduces the total value of the item's stock by moving 
money from the stock account to the cost of sales account. It calculates how much money to move by working out the
average unit cost (total value/total units on hand) and multiplying the average unit cost by the number of units sold.

But most businesses don't exist in a perfect world. Many things happen (damage, theft, etc.) that can affect stock. 
That's why M.Y.O.B. provides tools in windows such as Count Stock and Stock Adjustments. They help you keep your
M.Y.O.B. stock in synch with your actual stock.

Click on a topic below for more information about M.Y.O.B. Stock.

Using services as items 
Understanding units of measure 
Working with item records 
Adjusting stock 
Counting stock 
Transferring stock 
Auto-building stock 



Using services as items
If you can break the services you offer into individual items, you should consider using the Item Information window to
enter them as service items. This enables you to use the item invoice for billing your customers. Further, if you track 
the service's sales history, M.Y.O.B. will keep track of the sales volume. 

Say you are a consultant. You bill £50 an hour for some services and £75 per hour for other services. By entering 
each service as an item you can quickly construct an invoice for a customer. M.Y.O.B. will perform the maths - 
instead of you working out what 23 times £50 plus 13 times £75 is - and will keep track of the number of hours sold.

See also
How M.Y.O.B. Stock Control works 
Creating a service invoice 
Creating a service purchase order 



Understanding units of measure
If you buy and sell items in the same unit volume (case, dozen, etc.), the Buying Unit of Measure and Selling Unit of 
Measure fields in the Item Information window should be left empty. But if you buy and sell in different unit volumes, 
these fields are very important. This can be best described by example: 

Say you buy beer by the 24-can case and sell it by the single can. The buying unit of measure is 24 and the selling 
unit of measure is 1. That's how M.Y.O.B. knows to increment your stock by 24 units for every case purchased.

If you don't enter this information, when you buy three cases of beer, M.Y.O.B. will add three units to stock instead of 
72. This can create stock item-tracking nightmare.

See also
Working with item records 



Working with item records
The item records you can work with in the Item Information window in Stock can be either physical items or services.

Click on a topic below for more information about working with item records.

Creating a new item record 
Editing an existing item record 
Removing an item record 
Organising items into groups 
Setting the price of an item 
Percent margin versus percent markup 
Restocking your stock 
Tracking item sales history 



Creating a new item record
To add an item to your list, choose Items List from the Stock Control Command Centre and click the New button to 
open the Item Information window.

It's important you understand the three major fields in this window, so keep reading:

Using the I Buy This Item selection
If you intend to use M.Y.O.B.'s item purchase order feature for an item, mark the I Buy This Item selection. If it's an 
item you manufacture, leave it unmarked. 

Using the I Sell This Item selection
If you intend to use M.Y.O.B.'s item invoice feature for an item, mark the I Sell This Item selection. If it's an item used 
only in the manufacture of other items, leave it unmarked. 

Using the I Stock This Item selection
Mark this selection only if you want M.Y.O.B. to track the stock quantity and value of the item. Don't feel pressured to 
stock every item. If you leave it unmarked, M.Y.O.B. will add to an expense (or cost of sales) account when you buy 
the item and add to an income account when you sell the item. 

If you stock the item, M.Y.O.B. adds to the income and expense (or cost of sales) account only when the item is sold. 
The stock account is incremented when you buy the item, and decremented when you sell the item.

See also
Using services as items 
Working with item records 
Editing an existing item record 
Removing an item record 
Organising items into groups 
Setting the price of an item 
Percent margin versus percent markup 
Restocking your stock 
Tracking item sales history 



Editing an existing item record
To edit an item in your list, choose Items List from the Stock Control Command Centre. Find the item in the list and 
simply double-click it, or click the zoom arrow next to it, or highlight it and click the Edit button. 

See also
Working with item records 
Creating a new item record 
Removing an item record 
Organising items into groups 
Setting the price of an item 
Percent margin versus percent markup 
Restocking your stock 
Tracking item sales history 



Removing an item record
While viewing the Item Information window, choose Delete Stock Item from the Edit menu. 

You cannot delete items that are referenced on any invoice or purchase order  - open, closed, or pending - in 
M.Y.O.B. This means that you cannot delete the item until all invoices and/or purchase orders referencing that item 
are purged. Since the most common time to purge invoices and purchase orders is during the Start a New Year 
process, most often you cannot delete an item until after you start the next financial year.

Further, you may not delete an item that has a current quantity or value. Use the Stock Adjustments window to zero 
out an item's quantity and/or value.

If you're stuck with an unwanted item for the rest of the year, change its name and number to something like "ZZZ-
Delete" to move it to the end of your items list and out of your way.

See also
Working with item records 
Creating a new item record 
Editing an existing item record 
Organising items into groups 
Setting the price of an item 
Percent margin versus percent markup 
Restocking your stock 
Tracking item sales history 



Organising items into groups
If you need to group items, pay careful attention when assigning item numbers. If you construct your item numbers 
properly, when reporting on items, you can use wildcard characters to select a desired sub-group of items. 

If, for example, you have two warehouse locations - Hertfordshire and Yorkshire - append a location number to the 
end of every item number. Item number 12324-HT would be used for an item in Hertfordshire    and 12324-YK would 
identify the same item in Yorkshire. At report time, the search for *-HT would report on only those items in 
Hertfordshire .

See also
Working with item records 
Creating a new item record 
Editing an existing item record 
Removing an item record 
Setting the price of an item 
Percent margin versus percent markup 
Restocking your stock 
Tracking item sales history 



Setting the price of an item
M.Y.O.B. accepts unit prices up to three decimals. On an invoice, it multiplies the unit price by the quantity sold before
rounding to pennies. The price of an item can be changed in the Item Information window, by using the Set Item 
Prices window  or by using the Pricing Shortcuts window.

Using the Item Information window
In the Item Information window, change the Selling Price field.

Using the Set Item Prices window
Choose Set Item Prices from the Stock Control Command Centre.

All items that you sell are listed. If an item is not listed and should be, mark the I Sell this Item selection in the Item 
Information window. The current selling price is listed in the optional selling information. Selling Price is the default 
price for one selling unit on the item invoice.

When you set the price of an item, you are just setting the default price for item invoices. You can override the price 
when completing an invoice. M.Y.O.B. accepts unit prices up to three decimals. On the invoice, it multiplies the unit 
price by the quantity sold before rounding to pennies. For your information, you may choose to see each item's 
average cost or last purchase price. If the item was transferred into stock rather than bought, the last transfer price is 
displayed. 

Using the Pricing Shortcuts window
Use item pricing shortcuts to update the prices of multiple items at one time. It's a great way to re-price your items to 
reflect changing costs or prepare for a business-wide sale.

Note: Before changing the price of multiple items, choose Save from the File menu. If you are unhappy with the new 
prices, you can reset them by choosing Revert to Saved from the File menu.

Check the items you wish to update. At the bottom of the Set Item Prices window, click the Shortcuts button. 

See also
Working with item records 
Creating a new item record 
Editing an existing item record 
Removing an item record 
Organising items into groups 
Percent margin versus percent markup 
Restocking your stock 
Tracking item sales history 



Percent margin versus percent markup
Unless you're in the software business, you sell your products for more than they cost you. Markup is the difference 
between your cost and the selling price. Percent markup is calculated by dividing the markup by the cost (and 
expressing the result as a percent). An item that costs you £10 and sells for £12 has a £2 markup. The markup 
percent is 20%. 

Percent margin is calculated by dividing your markup by the selling price (and expressing the result as a percent). In 
our example, the margin is £2/£12 or 16.67%.

The cost basis is key to calculating markup and margin. You may choose to use the item's average cost or the cost of
the item the last time you purchased it or transferred it into stock.

See also
Working with item records 
Creating a new item record 
Editing an existing item record 
Removing an item record 
Organising items into groups 
Setting the price of an item 
Restocking your stock 
Tracking item sales history 



Restocking your stock
One of M.Y.O.B.'s most powerful features is its ability to "look over your shoulder" and warn you of potential problems
before they become real problems. 

When you click the Restock button at the bottom of the Item Information window, you can enter all the information 
M.Y.O.B. needs to prepare a purchase order automatically when your stock runs too low.

These purchase orders can be created from the Restock Alert section of your To Do List. Further, if you run out of the 
item while writing an invoice, M.Y.O.B. can prepare a purchase order at that time.

See also
Working with item records 
Creating a new item record 
Editing an existing item record 
Removing an item record 
Organising items into groups 
Setting the price of an item 
Percent margin versus percent markup 
Tracking item sales history 



Tracking item sales history
M.Y.O.B. can track sales figures on a per-item basis. These figures are useful for comparison between this year and 
last year. This section deals with item sales history. 

If you wish to compare this year's sales to last year's sales for an item (in Analyse Sales), enter the unit sales, sales 
amounts, and cost of sales for the months preceding your using M.Y.O.B. in the Sales History window. Once you 
check Track Sales History in the Card File Entry window, whenever you sell this item, the units sold, sales amount 
and cost of sales are added automatically to the totals for that month.

M.Y.O.B. doesn't prohibit you from changing these numbers. It increments the amounts at the time of the sale. If you 
change them, M.Y.O.B. CANNOT reconstruct the monthly totals from its sales records. It simply adds the next sale to 
the amounts you entered.

See also
Working with item records 
Creating a new item record 
Editing an existing item record 
Removing an item record 
Organising items into groups 
Setting the price of an item 
Percent margin versus percent markup 
Restocking your stock 



Adjusting stock
Whenever your actual stock quantity or value disagrees with M.Y.O.B.'s records, it's time to adjust your stock. 

Once you determine the reason for the stock adjustment, the actual adjustment transaction is easy. Here are a few 
common adjustments:

Unexplained loss or theft    Although not easy to tolerate, losses of this type are easy to account for. Enter the item 
and a negative quantity. M.Y.O.B. uses the average unit cost of the item to total your loss. All you do is allocate the 
loss to an expense account. Most businesses maintain a separate account - called something like "Shrinkage" - for 
this purpose.

Items that leave the business without an invoice    Some businesses are very "fluid" organisations. Sometimes it's 
impossible to enter an invoice for everything that goes out. If you have less stock on hand than M.Y.O.B.'s records 
show, enter the item and a negative quantity. Then allocate the total amount to the relevant cost of sales account for 
this item.

Items that come into the business without a purchase order    This is most common when you avoid the purchase
order process by simply writing the supplier a cheque and allocating the purchase to an expense account. Afterward, 
you find that you want the items in stock. In this situation, enter a positive quantity and unit cost. Allocate it to the 
expense account. M.Y.O.B. will move the money out of the expense account and into the stock account.

Click on a topic below for more information about adjusting stock.

Adjusting item quantities only 
Adjusting item values only 
Removing or changing stock item adjustment transaction before it's saved 
Removing or changing stock item adjustment transaction after it's saved 



Adjusting item quantities only
If the total value of an item is correct, but the quantity is wrong, just enter a quantity adjustment and change the Unit 
Cost to £0.00. The stock will be adjusted without a cash transaction being created. 

A zero transaction is not recorded in the Stock Journal.

See also
Adjusting stock 
Adjusting item values only 
Removing or changing stock item adjustment transaction before it's saved 
Removing or changing stock item adjustment transaction after it's saved 



Adjusting item values only
If the quantity is correct, but the total value of the item is not, enter 0 in the Quantity field in the Stock Adjustments 
window. Enter a positive amount to add to your stock value and a negative amount to reduce it.

The allocation account is important. If you don't want the linked stock asset account (as noted in the Item Information 
window) to change, use it as the allocation account. M.Y.O.B. will move money from the stock account to the stock 
account. The asset account will not change.

If you want the linked stock asset account to change, allocate to an expense or cost of sales account.

See also
Adjusting stock 
Adjusting item quantities only 
Removing or changing stock item adjustment transaction before it's saved 
Removing or changing stock item adjustment transaction after it's saved 



Removing stock item adjustment transaction before it's 
saved
If you want to remove a stock adjustment you've entered - but haven't chosen Save from the File menu yet - in the 
Stock Adjustments window, select Erase Adjustment from the Edit menu or click the Cancel button. The transaction is
removed. 

See also
Adjusting stock 
Adjusting item quantities only 
Adjusting item values only 
Removing or changing a stock adjustment transaction after it's saved 



Removing a stock adjustment transaction after it's saved
Unlike other types of transactions, once a stock adjustment is recorded, you may not change, delete or automatically 
reverse it. You may review it by clicking the Journal button in the Stock Adjustments window. If you need to change or
reverse the transaction, you must enter a new adjustment transaction that contains opposite amounts in it. 

See also
Adjusting stock 
Adjusting item quantities only 
Adjusting item values only 
Removing or changing a stock adjustment transaction before it's saved 



Counting stock
The Count Stock window is a quick step in adjusting your stock. It helps prepare a mass update of your stock 
quantities and values. Although M.Y.O.B. prompts you for a default allocation account, you should review each line of 
the Stock Adjustments window, paying special attention to the allocation account, before recording the transaction. 

Be sure to record any stock transfers before counting your stock. This avoids accidentally expensing missing stock 
that was really used to build another item.

When calculating the average cost of an item, M.Y.O.B. divides the current stock value by the number of units in 
stock. Average cost is used when recording the cost of sales when selling a stock item. Remember, when you adjust 
stock, you may be affecting the average cost. 

See also
Adjusting stock 



Transferring stock
Use the Transfer Stock window when you turn raw material (timber) into finished goods (furniture). 

A stock transfer reduces the value of one or more stock items and increases the value of one or more other stock 
items.

The values must balance. In our example, let's say it takes 10 £5 boards to make one table. The first line of the stock 
transfer would be -10 boards at £5 each for a total amount of minus £50. The second line would have 1 table at £50 
for a total amount of positive £50. In this transaction we've moved £50 from one item and added it to another item.

Click on a topic below for more information about transferring stock.

Removing a stock transfer transaction before it's saved 
Removing a stock transfer transaction after it's saved 



Removing a stock transfer transaction before it's saved
If you want to remove a stock transfer  you've entered - but haven't chosen Save from the File menu yet - in the Stock
Transfers window, select Erase Transfer from the Edit menu or click the Cancel button. The transaction is removed. 

See also
Transferring stock 
Removing a stock transfer transaction after it's saved 



Removing a stock transfer transaction after it's saved
Unlike other types of transactions, once a stock transfer is recorded, you may not change, delete or automatically 
reverse it. You may review it by clicking the Journal button in the Stock Transfers window. If you need to change or 
reverse the transaction, you must manually enter a new transfer transaction that contains opposite amounts. 

See also
Transferring stock 
Removing a stock transfer transaction before it's saved 



Auto-building stock
The Auto-build button at the bottom of the Item Information window allows you to create stock transfer templates for 
manufactured items. 

When you choose Auto-Build Stock from the Stock Control Command Centre, all items with auto-build templates are 
displayed. You decide the quantity to build and M.Y.O.B. will create the stock transfer transaction.

See also
Transferring stock 



Working with the Card File
The View Card File and Card File Entry  windows are the heart of the Card File Command Centre and an important 
part of the entire M.Y.O.B. system.

Click on a topic below for more information about working with the Card File.

Locating a card in the Card File 
Using identifiers 
Tracking sales history 
Overriding a volume discount 
Editing a card in the Card File 
Removing a card from the Card File 



Locating a card in the Card File
To display the View Card File window  from the Card File Command Centre, choose Cards. 

At the top of the View Card File window are five tabs: one tab for each card type - Customer, Supplier, Employee, and
Personal - and one tab titled All Cards. Clicking a tab displays a list of cards of the selected type.

In addition to the tabs, there is a Search field for locating a single card, as well as additional selection fields for 
limiting, or filtering, the displayed list of cards.

To use the Search field, enter the first few characters of the company name or the individual's last name and press 
TAB. M.Y.O.B. highlights the closest match in the displayed list.

If you cannot find a card that you are confident exists, click the All Cards tab and delete all selection criteria. The 
entire list of cards will be displayed alphabetically by last name or company name.

See also
Working with the Card File 
Using identifiers 
Tracking sales history 
Overriding a volume discount 
Editing a card in the Card File 
Removing a card from the Card File 



Using identifiers
M.Y.O.B. allows you to assign up to 10 one-letter identifiers to a card. You may note the meaning of each one-letter 
identifier using the Identifiers window. 

Use identifiers to:

* Separate prospective customers from actual customers.

* Group your cards by type (wholesale versus retail customers, for example), region or salesperson.

* Print labels and/or create personalised letters for the same group of cards every month.

Most card-based activities and reports, including all creditor and debtor reports, can be selected by identifier.

More sophisticated usage may call for multiple identifiers per card. When you select a card-based report by more 
than one identifier, M.Y.O.B. chooses only those cards that have been assigned both identifiers. Say, for example, 
you use W to identify your wholesale customers and G to identify government agencies. When you filter a report 
using the identifiers GW, the report will contain only those customers who are both wholesale customers and 
government agencies.

See also
Working with the Card File 
Locating a card in the Card File 
Tracking sales history 
Overriding a volume discount 
Editing a card in the Card File 
Removing a card from the Card File 



Tracking sales history
On customer and employee cards there is a selection called Track Sales History. If you check it, M.Y.O.B. will keep 
track of the monthly sales for this customer or employee. This number is used in the Analyse Sales reports and in the 
Analyse Sales window in the Sales Ledger Command Centre. 

To track sales by employee, be sure to enter the employee's name in the Salesperson field in the Sales window.

M.Y.O.B. begins tracking sales revenue at the time the Track Sales History selection is marked. If you check it after 
using M.Y.O.B. for a few months, it does not go back and recreate the sales history.

If you wish to enter sales numbers for previous months, click the History button.

M.Y.O.B. does not prohibit you from changing historical sales numbers. It increments the amounts at the time of the 
sale. If you change them, M.Y.O.B. CANNOT reconstruct the monthly totals from its sales records. It simply adds the 
next sale to the amounts you entered.

See also
Working with the Card File 
Locating a card in the Card File 
Using identifiers 
Overriding a volume discount 
Editing a card in the Card File 
Removing a card from the Card File 



Overriding a volume discount
You can set the credit terms for a customer or a supplier in the Credit Terms window. Discounts from credit terms are 
entered in the Sales and Purchases windows. If you usually give a customer a percentage discount, enter it here. On 
the invoice, the discount will be displayed on every line. The Discount field in the Sales window will display the 
appropriate amount, but you can change or delete the discount if you want. The same holds true for suppliers and 
purchase orders. 

See also
Working with the Card File 
Locating a card in the Card File 
Using identifiers 
Tracking sales history 
Editing a card in the Card File 
Removing a card from the Card File 



Editing a card in the Card File
Follow the steps below to change information about a customer, supplier, employee or personal contact in the Card 
File. 

1. From the list of command centres, click Card File. The Card File Command Centre will appear. From the Card File 
Command Centre, click Cards. The View Card File window  appears. To edit a card, simply double-click it, or click the
zoom arrow next to it, or highlight it and click the Edit button.

OR...

1. Click the zoom arrow next to any Customer, Supplier or Employee field in M.Y.O.B. to open the Card File Entry 
window.

2. Make your changes, then click Close to close the Card File Entry window.

To create a new card, click the New button.

See also
Working with the Card File 
Locating a card in the Card File 
Using identifiers 
Tracking sales history 
Overriding a volume discount 
Removing a card from the Card File 



Removing a card from the Card File
Follow the steps below to remove the record of a customer, supplier, employee or personal contact from the Card 
File. 

If a card in the Card File has transactions assigned to it, you can't delete the record until the transactions are 
removed.

1. From the list of command centres, click Card File. The Card File Command Centre will appear. From the Card File 
Command Centre, click Card File. The View Card File window  appears. To edit a card, simply double-click it, or click 
the zoom arrow next to it, or highlight it and click the Edit button.

OR...

1. Click the zoom arrow next to any Customer, Supplier or Employee field in M.Y.O.B. to open the Card File Entry 
window.

2. Select Delete Card from the Edit menu. If no transactions are assigned to the person or company, the record will 
be removed.

See also
Working with the Card File 
Locating a card in the Card File 
Using identifiers 
Tracking sales history 
Overriding a volume discount 
Editing a card in the Card File 



Working with the Contact Log
In addition to being a superior accounting system, M.Y.O.B. can be an effective business management tool. The 
Contact Log maintains a comprehensive list of contact events - sales, purchases, phone calls, mailing, etc. - for every
card in your Card File. 

Use the contact log as your business "diary." When a customer or supplier calls, the Contact Log will give you a 
complete history of your relationship in a single window.

M.Y.O.B. is even more unique in that it will create Contact Log entries for you automatically. You can request that 
M.Y.O.B. create a Contact Log entry for every cheque, deposit, sale and purchase.

Click on a topic below for more information about working with the Contact Log.

Creating a contact for a card not in the Card File 
Using Last Contact Date 
Using Recontact Date 
Entering telephone numbers for modem use 



Creating a contact for a card not in the Card File
If you wish to view information about a contact made with a person or company not in the Card File, you must create 
a card in the Card File for that person or company and then assign contact information to that card. To do this, enter 
the name of the person or company in the Name field of the Contact Log Entry window and press TAB or RETURN; a
list of all cards in the Card File will appear. Click the New button to create a new card; the Card File Entry window  will
appear, where you can enter detailed information about the person or company. After you create the new card, the 
Contact Log Entry window will reappear, where you can enter information about contacts made with the person or 
company. 

See also
Working with the Contact Log 
Using Last Contact Date 
Using Recontact Date 
Entering telephone numbers for modem use 



Using Last Contact Date
Enter a date in the Last Contact Before field of the View Contact Log window, and M.Y.O.B. selects only those cards 
with contact log entries dated before this date.

This feature is very useful if you are using M.Y.O.B.'s Card File and Contact Log to track business prospects. It is very
easy to identify those potential customers not contacted within the last week, month, or whatever prospecting cycle 
you use. (For most effective prospecting, use this feature in combination with the Identifiers field. Use a unique 
identifier to separate prospective customers from current customers.) 

See also
Working with the Contact Log 
Creating a contact for a card not in the Card File 
Using Recontact Date 
Entering telephone numbers for modem use 



Using Recontact Date
In the Contact Log Entry window, use the Recontact Date field to note when to recontact a person. This field is used 
as a selection filter in the View Card File, Mailing Labels, Personalised Letters and To Do List windows. Enter a date 
and M.Y.O.B. selects only those cards with Contact Log recontact dates equal to or earlier than the date entered. 

To get the best use out of this feature, when you recontact the person, remember to delete the recontact date from 
the Contact Log entry. If you leave old recontact dates in your Contact Log , the card will always match this selection 
criterion. 

The quickest way to review and delete recontact dates is by using the To Do List. All recontact alerts can be reviewed
at one time and, if necessary, deleted.

See also
Working with the Contact Log 
Creating a contact for a card not in the Card File 
Using Last Contact Date 
Entering telephone numbers for modem use 



Entering telephone numbers for modem use
If you have a modem and intend to make telephone calls using M.Y.O.B., here are a few suggestions for entering 
telephone numbers in the Card File Entry window: 

* Additional characters don't affect the way modems are used to make telephone calls. You can enter parentheses 
and hyphens in the number, if you want.

* To create a two-second delay before the dialing process begins, enter a comma at any place in the telephone 
number. For example, if you must first dial a 9 to make external calls from your building, you might consider entering 
a telephone number in the following manner: 9,555-1234

* To use pulse dialing in your modem, enter the letter P before the telephone number.

See also
Working with the Contact Log 
Creating a contact for a card not in the Card File 
Using Last Contact Date 
Using Recontact Date 



Creating personalised letters
Use the Card File data to merge with letters created using your word processing software. M.Y.O.B. creates tab-
delimited mail merge files from your card file information. A tab-delimited file is a text file that uses the TAB character 
to separate fields. This file works with most word processors. Check your word processor user's guide to see if yours 
supports the M.Y.O.B. merge. 

Click on a topic below for more information about creating personalised letters.

Using a contact's name in personalised letters 
Using a salutation in personalised letters 



Using a contact's name in personalised letters
The Card File Entry window  contains a field called Contact Name. The field is optional, but helpful if a card is 
indexed by a company name rather than an individual name. You can specify that the contact's name appear on 
personalised letters.

By including a contact name, you have better assurance that your letter will reach the correct party. A letter addressed
to Mr. Robert Smith Acme Sales will be much more effective than a letter addressed to just Acme Sales.

See also
Creating personalised letters 
Using a salutation in personalised letters 



Using a salutation in personalised letters
A personalised letter should be just that; personalised. M.Y.O.B. helps you by providing a Salutation field in the Card 
File Entry window. In this field, you can enter the name that a person prefers to be called, instead of their formal 
name. 

Letters destined for the wastebin are those that begin with something like "Dear Mr. Robert Smith.... By entering 
"Bob" in the Salutation field, you can create a letter that starts with a much more friendly "Dear Bob..., and stands a 
better chance of being read.

See also
Creating personalised letters 
Using a contact's name in personalised letters 



Tracking walk-in trade
If you conduct your business in cash, create a customer record for each form of payment your receive - cash, 
cheques or Visa, for example. In the Card File Entry window, mark the Track Sales History selection for those 
"customers." That way, when you analyse your sales by customer, you can get a report on how much of your 
business is based on cash transactions. 



The Contact Log as a reminder pad
Create a card named "Reminders." Every time you want to enter a reminder, make a Contact Log entry for this card. 
Use the recontact date as the reminder date. The reminder will show up on your To Do List as an overdue contact. 



Keeping track of the company car
Create a card called "Company Car." Every time you use your company car for business, make a Contact Log for this
card. When Tax time comes around, this should give you a complete, accurate and up-to-date record of your 
automobile usage. 



The Contact Log as a travel log
If you keep all your business travel records together, create a card named "Travel." After each trip, make Contact Log 
entries for your expenses, business contacts, and so on. If you need to follow up on a business contact, enter a 
recontact date in the Contact Log Entry window. Your To Do List  will enter an overdue contact as a reminder. 

If you keep track of your trips separately, create a card for each trip.



Tracking your time billing
There are a few ways you can use M.Y.O.B. for time billing. You decide which is best for you: 

* If you bill your time at a single rate, use the Contact Log  to keep track of elapsed time with each of your clients. 
When it comes time to send an invoice to the client, generate a Contact Log Report for the date range you want to 
include on the invoice. The elapsed time is totalled for the date range.

* If you're on retainer, a Contact Log Report is a great way to report your activities to your clients.

* Many service businesses use M.Y.O.B.'s pending service invoices for time billing. Every new billing period, set up a 
pending invoice for each of your clients. Every time you perform a billable task, choose Sales and enter the client's 
name. You're alerted to the pending invoice.

Choose the pending invoice for that client and enter another line for today's services. Then place it back in the 
Pending File. When the billing period ends, locate the pending invoice, record it as an actual invoice, print it and send
it to your client.

Many people use M.Y.O.B. service invoices for time billing. However, if you enter your services (for example, 1 hour 
of consulting) as items in the Item Information window, you can use item invoices to bill your time.



Using the Transaction Journal window
The M.Y.O.B. Transaction Journal window allows you to view summary information about all transactions you've 
entered for a time period you specify. 

The Transaction Journal window also provides you with the ability to display transactions in a specific group only. 
These groups, each referred to as a separate "journal," include:

* Cash Disbursements Journal 
* Cash Receipts Journal 
* Nominal Journal 
* Stock Journal 
* Purchases Journal 
* Sales Journal 

The Transaction Journal window can be opened in a number of ways:

* Select the journal you wish to view by selecting Transaction Journal from a command centre. 

* Select Transaction Journal from the Command Centre menu.

* Select the journal you wish to view from the Index to Reports window, then click OK.

When the Transaction Journal window is open, the current journal you're viewing is displayed in a tab at the top of the
window. If you wish to view transaction information in a different journal - or all transactions in all journals - click a 
different tab.

You can also enter a range of dates in the Transaction Journal window from which you can display specific 
transactions.



Viewing account detail
Using the Inquiry selection in the M.Y.O.B. Analyst, you can quickly view information about a specific account in the 
M.Y.O.B. system. Follow the steps below to view an account's detail: 

1. Open the Inquiry Register window by clicking the Inquiry button in the M.Y.O.B. Analyst.

2. Enter or select the number of the account you wish to view information about; the information about the selected 
account is displayed.

See also
Using the Inquiry Register window 
Viewing customer, supplier, employee, personal contact detail 
Viewing sales transaction detail 
Viewing purchasing transaction detail 
Viewing job detail 



Viewing customer, supplier, employee, personal contact detail
Using the Inquiry selection in the M.Y.O.B. Analyst, you can quickly view information about a specific customer, 
supplier, employee or personal contact in the M.Y.O.B. system. Follow the steps below to view detail: 

1. Open the Inquiry Register window by selecting Inquiry from the M.Y.O.B. Analyst and clicking the Card tab.

2. Enter or select the name of the customer whose information you wish to view; the information about the selected 
customer is displayed.

See also
Using the Inquiry Register window 
Viewing account detail 
Viewing sales transaction detail 
Viewing purchasing transaction detail 
Viewing job detail 



Viewing sales transaction detail
Using the Inquiry Register window, you can quickly view information about a specific sales transaction in the M.Y.O.B.
system. Follow the steps below to view a sales transaction's detail: 

1. Open the Inquiry Register window by selecting Inquiry from the M.Y.O.B. Analyst, or by clicking the zoom arrow 
next to the Status field in the Settle Returns & Credits window.

2. If you opened the Inquiry Register window by using the M.Y.O.B. Analyst, enter or select the number of the sales 
transaction you wish to view information about; the information about the selected transaction is displayed. If you 
opened the Inquiry Register window by clicking the zoom arrow in the Settle Returns & Credits window, the 
information about the selected transaction is automatically displayed.

See also
Using the Inquiry Register window 
Viewing account detail 
Viewing customer, supplier, employee, personal contact detail 
Viewing purchasing transaction detail 
Viewing job detail 



Viewing purchasing transaction detail
Using the Inquiry Register window, you can quickly view information about a specific purchasing transaction in the 
M.Y.O.B. system. Follow the steps below to view a purchasing transaction's detail: 

1. Open the Inquiry Register window by selecting Inquiry from the M.Y.O.B. Analyst, or by clicking the zoom arrow 
next to the Status field in the Settle Returns & Debits window.

2. If you opened the Inquiry Register window by using the M.Y.O.B. Analyst, enter or select the number of the 
purchasing transaction you wish to view information about; the information about the selected transaction is 
displayed. If you opened the Inquiry Register window by clicking the zoom arrow in the Settle Returns & Debits 
window, the information about the selected transaction is automatically displayed.

See also
Using the Inquiry Register window 
Viewing account detail 
Viewing customer, supplier, employee, personal contact detail 
Viewing sales transaction detail 
Viewing job detail 



Viewing job detail
Using the Inquiry Register window, you can quickly view information about a specific job in the M.Y.O.B. system. 
Follow the steps below to view a job's detail: 

1. Open the Inquiry Register window by clicking the Inquiry button in the M.Y.O.B. Analyst, then click the Job tab.

2. Enter or select the number of the job whose information you wish to view; the information about the selected job is 
displayed.

See also
Using the Inquiry Register window 
Viewing account detail 
Viewing customer, supplier, employee, personal contact detail 
Viewing sales transaction detail 
Viewing purchasing transaction detail 



Using the To Do List window
The To Do List window contains lists of reminders that allow you to perform your regular business tasks on a 
consistent basis. M.Y.O.B. uses the dates you set up in the Business Calendar window to add reminders to the To Do
List. If the number of days for a reminder - except for money due to you that's overdue - places the reminder on a 
non-business day, the reminder will be moved to the previous business day. 



Analysing your account information
M.Y.O.B. contains some very powerful analysis functions for you to gain valuable information about your accounts. 
The Balance Sheet and Profit & Loss buttons in the Nominal Ledger M.Y.O.B. Analyst allow you to access these 
functions. 

The Analyse Balance Sheet window allows you to view detailed information about your asset, liability and capital 
accounts - known collectively as your balance sheet accounts. This window, using criteria set in the Analysis 
Selection window, also provides a graph feature that allows you to view illustrated reports of your account activity. 

The Analyse Profit & Loss window allows you to view detailed information about your income, cost of sales, expense, 
other income and other expense accounts - known collectively as your profit and loss accounts. 



Using the Cash Flow Worksheet
The Cash Flow Worksheet window allows you to estimate your short-term cash needs by using information you've 
entered throughout M.Y.O.B. to create a forecast of your bank accounts' future. 

The information this window uses to forecast cash needs includes recurring transaction information entered in the 
Save Recurring Transaction window  in many of M.Y.O.B.'s command centres.

The Cash Flow Worksheet consists of two views: Worksheet View and Analysis View. Each is described below.

Worksheet View provides a list of a number of transactions that are overdue or expected to occur for this account. 
This view allows you to verify and enter all the transactions that will affect the account during the specified number of 
days. 

The transactions that appear as defaults in this list include:

* All recurring transactions that are expected to occur for this account within the specified range of days. The 
frequency that was established in the Save Recurring Transaction window for each transaction is used to determine 
the date when the transaction should occur.

* All recurring transactions that were supposed to occur before the current date. These transactions will appear only if
the account was designated a linked bank account in either the Sales Ledger Linked Accounts window or the 
Purchase Ledger Linked Accounts window.

You can change any of the information that appears in Worksheet View to better estimate your cash flow needs. For 
example, if one of the default transactions indicates you'll be spending £1,000 for June's commission payments, but 
you know you'll only spend £500, you can change that amount. If no commission payment was needed for June, you 
could delete the amount entirely.

You can also add transactions to Worksheet View. To do this, scroll to the bottom of the list and add transaction 
information in the blank line. When youve finished, press TAB to create a new blank line, where you can enter 
additional transaction information.

Changes, deletions and additions you make in Worksheet View are used for the purposes of the Cash Flow 
Worksheet window only. The changes you make here won't be reflected anywhere else in the M.Y.O.B. system.

Analysis View lists all the transactions that appeared in Worksheet View, along with their corresponding amounts 
and the running balance of the account as each transaction amount is added or subtracted from it. This view allows 
you to see the status of the account during the specified time period. 



Analysing stock
Knowing what items you have on hand is fairly simple. It gets complicated when you consider your items on order 
from suppliers and delivery to customers. 

Many businesses run what they call an "order book." It's what they use to track the comings and goings of stock 
items. Analyse Stock (in the M.Y.O.B. Analyst section of the Stock Control Command Centre) is your electronic order 
book.

M.Y.O.B. constantly monitors what you have:

* On hand

* On order (pending purchase orders) from suppliers

* On backorder (pending invoices) to customers

Using this information, M.Y.O.B. can project what your item stock levels will be in the near future. Use the zoom 
arrows  to view the pending purchases or pending invoices for a detailed review.



Page Setup selections
Your page setup selections affect the way reports appear when you display them on your computer screen. If, for 
example, you have landscape (sideways) orientation and letter-size paper selected when you set up your page size, 
your reports' screen display is approximately 11 inches wide. If your page setup orientation is portrait, the display is 
approximately eight inches wide. Use the horizontal scroll bar to view the right side of the report.

All M.Y.O.B. reports are designed to fit in portrait mode on your printer. If the selected report will not fit, you are 
alerted. To make the report fit, you must either change your page setup or customise the report.



Locating a report
You can find reports under the Reports menu. The first selection is Index to Reports, which is a scrollable list of all 
reports in M.Y.O.B., sorted by command centre. To select a report from the Index to Reports window, double-click it or
highlight it and click OK.



Printing a report to the computer screen
M.Y.O.B. displays the selected report on the screen exactly as it would appear on your printer. 

Your page setup selections affect the way reports appear when you display them on your computer screen. If, for 
example, you have landscape (sideways) orientation and letter-size paper selected when you set up your page size, 
your reports' screen display is approximately 11 inches wide. If your page setup orientation is portrait, the display is 
approximately eight inches wide. Use the horizontal scroll bar to view the right side of the report.

To display a report on-screen, click the Filters button in the report window, choose the Screen selection, then click 
Print. To print a report thats displayed on-screen, choose Print from the File menu.



Using fonts in reports
Note the list of fonts you can use when you print a report. There are two types of fonts - system fonts and device 
fonts which are particular to your printer (or your third-party font software), and are provided by your printer driver (or 
font) software. If you choose a system font for your report, it will appear as similar as possible on the screen and the 
printer. If, however, you use a printer-specific font, M.Y.O.B. takes the characteristics of the chosen printer font and 
makes the best match possible to an available screen font in order to display the report on the screen. You may not 
get a result that exactly matches a report that's printed on paper.

M.Y.O.B. has one screen report window. If you generate two screen reports, the second report will replace the first 
report.

See also
Choosing a font for forms and reports 
Customising forms and reports with default fonts 



Choosing a font for forms and reports
When you select a font, M.Y.O.B. calculates the approximate number of columns that will fit on a printed page, using 
your current page setup selections. 

The widest M.Y.O.B. report is 106 columns. If a report's calculated number of columns is greater than 106, it may not 
fit on a printed page; in this case, you must either change your page settings to accommodate a wider page or 
choose a font that fits better.

See also
Using fonts in reports 
Customising forms and reports with default fonts 



Customising forms and reports with default fonts
When you choose a default font for a form or report, every field is changed to the default font. If you wish to use 
different fonts for different sections of a form or report, you must customise the report individually. 

The font selections you make for forms and reports don't affect forms and reports you've already customised.

See also
Using fonts in reports 
Choosing a font for forms and reports 



Using wildcards
Wildcards are special characters you can use to expand your search criteria when selecting account numbers, item 
numbers and job numbers for use in reports. 

M.Y.O.B. uses two wildcard characters, the asterisk (*) and the question mark (?).

Using the asterisk
Consider the Account Inquiry Report. Instead of retrieving this report for all accounts or only a single account, you can
use wildcards to retrieve this report for a group of accounts.

If you want an Account Inquiry Report for all your asset accounts, for example, choose Account Inquiry in the Index to
Reports window. Enter 1* in the Selected field and enter the rest of the window's required information. M.Y.O.B. will 
choose all accounts starting with 1 (in other words, all asset accounts).

Using the question mark
Let's say you want to print a Job Inquiry report for the Cadwell Corporation. All Cadwell jobs begin with the letter C. 
However, you have other jobs that start with C. Cadwell jobs have three-character numbers, while other "C" jobs are 
four characters. Here you would use the position-specific question mark. Enter C?? and M.Y.O.B. will choose only 
those jobs that begin with C and have two other characters in their job number.

Refer to the appendix of the User's Guide for a list of all M.Y.O.B. reports that use wildcards.



Batch reporting
Batch reports allow you to print a group of reports at one time. By using batch reports, you can print all your monthly 
financial and management reports while you're away from your desk. Batch reports save you from tying up your 
computer and printer during business hours. 

See also
Creating a report batch 
Editing a report batch 
Printing a report batch 
Filtering reports in a batch 



Creating a report batch
1. Choose Batch Reports from the Reports menu. A list of your report batches is displayed.

2. To create a new batch, click the New button.

3. Enter a name for the batch.

4. Choose the reports that belong to the batch by clicking the name of each report. A mark will appear next to each 
selected report, indicating that it's included in the new batch. To remove a report from the batch, click the name a 
second time. The mark will disappear and the report will no longer be included in this batch. Click OK to accept the 
batch.

See also
Batch reporting 
Editing a report batch 
Printing a report batch 
Filtering reports in a batch 



Editing a report batch
1. Choose Batch Reports from the Reports menuA list of your report batches is displayed.

2. To edit a batch, highlight the batch name and then click the Edit button. You can edit the name of the report batch, 
as well as the list of reports included in the batch.

3. A mark appears next to each report that it is included in this report batch. To add a report to the batch, click the 
report name. A mark will appear next to the name, indicating that it's included in the batch. To remove a report from 
the batch, click the report name. The mark will disappear and the report will no longer be included in this batch. Click 
OK to accept the batch.

See also
Batch reporting 
Creating a report batch 
Printing a report batch 
Filtering reports in a batch 



Printing a report batch
1. Choose a reporting period from the list at the top of the Batch Reports window. 

2. Choose a report batch from the list and click Print. All reports in the batch are printed. M.Y.O.B. skips over any 
report in the batch that doesn't have any reportable information for the period.

The printer information - number of copies, orientation, etc. - will be applied to every report in the batch.

See also
Batch reporting 
Creating a report batch 
Editing a report batch 
Filtering reports in a batch 



Filtering reports in a batch
You can choose the reporting period for a report batch.

The reporting period at the top of the Batch Reports window controls the date range of the reports. If, for example, 
you choose January, your activity-based reports will include activity from January 1st to January 31st. Balance sheet 
reports will be generated as of the end of January. Reports of your sales and purchasing activity will be aged as of 
January 31st.

See also
Batch reporting 
Creating a report batch 
Editing a report batch 
Printing a report batch 



Working with forms
M.Y.O.B.'s forms customisation feature allows you to change the look and content of your printed cheques, invoices, 
statements, purchase orders and mailing labels. You can: 

* Change the size of any form
* Change the number of forms on a single sheet of paper
* Add text fields
* Draw lines and boxes
* Paste graphics anywhere on the form
* Move fields
* Change the size of fields
* Select the font, size or style of any text or data field
* Select the data fields you want to print on the form

See also
Do you need to customise your forms? 
Finding the Customise Forms window 



Do you need to customise your forms?
If your forms (cheques, invoices, statements, purchase orders, and mailing labels) are not M.Y.O.B.-compatible 
forms, use the Customise Forms window to make M.Y.O.B.'s printed output match your form. 

You can order cheques, invoices (service, professional and item), purchase orders (service and item), and mailing 
labels that are specially designed to work with M.Y.O.B. An order form for M.Y.O.B.-compatible forms is included in 
your M.Y.O.B. package.

If you use the M.Y.O.B. pre-printed forms, you aren't required to customise your forms, but feel free to use it to 
personalise your forms output. 

See also
Working with forms 
Finding the Customise Forms window 



Finding the Customise Forms window
When you select Print Cheques, Print Invoices, Print Statements, Print Purchases or Mailing Labels, a window 
named Forms Selection appears. To customise the form, click the Customise button at the bottom of the window. 

If more than one type of form (for example, service invoice  vs. item invoice) exists, the form type currently selected 
when you click Customise is the form type you've selected to customise.

See also
Working with forms 
Do you need to customise your forms? 



Selecting a field
To select a field in the Customise Forms window, click the arrow tool and then click the field. When the field is 
selected, it's outlined in a black box with a small black rectangle (called a "handle") at the lower right-hand corner. 

If a field overlaps another field, when you click, the field "in front" is selected. If you want to select the field behind it, 
choose Send to Back from the Form menu. Then click again. 



Changing the size of a field
When a field is selected in the Customise Forms window, it's outlined with a black rectangle. A handle (a small black 
box) is at the lower right-hand corner of the rectangle (for lines, there's a handle at either end of the line). Click and 
drag the handle to change the size of the field. 

Another, more exact, way to change the size of a field is to double-click it and change its coordinates in the Field 
Information window.



Changing the location of a field
To move a field in the Customise Forms window, click the middle of the field and hold down the mouse button. The 
pointer changes to a hand icon. Drag the mouse while holding down the mouse button. An outline of the field travels 
with the hand icon. Release the mouse button when the field is at the desired location. 

Another more exact way to change the location of a field is to double-click it and change its coordinates in the Field 
Information window.



Cutting, copying, pasting and deleting data fields
You can cut, copy and paste fields in the same form. You may also cut, copy and paste between related forms. An 
example of related forms can be found in an item invoices . There are three related forms: preprinted, plain paper and
customised. You may cut, copy and paste between these three forms. You can't, however, copy a field from an item 
invoice and paste it into a cheque. 

You may delete copies of data fields, unless it is the last copy of the field. In that case it will not be deleted, it will be 
made inactive.



Changing the font, size and style of a field
Double-click a text or data field to display the Field Information window. Change the font, size or style and click OK.

You can change the default font for every form by choosing Default Fonts from the File menu or by clicking Fonts in 
the Preferences window.



Saving a customised form
When youve finished customising a form, click OK in the Customise window. The format you're working on is saved 
as the user-customised form. If you've saved a customised format previously, you're warned that this version will 
replace the previous version.

The formats provided with M.Y.O.B. (for example, the pre-printed format and the plain paper format) are not changed.
Regardless of which format you originally selected to customise, the customised format is always saved as the user-
customised form.



Printing a customised form
To print a customised form, select User-Customised in any form's window, then click Print.



Customising a cheque
Here's how to customise your cheques: 

1. Select Print Cheques from the Chequebook Command Centre. 

2. Choose the form (Continuous-Feed Cheque or Laser Cheque) that most closely matches your cheques.

3. Click Customise.

The cheque form has two parts: the cheque and the stub. Depending upon the type of cheque, M.Y.O.B. prints three 
types of stubs: a regular stub, a payable stub, and a refund cheque stub. Regular stubs are used when printing 
cheques entered in the Write Cheques window. Payable stubs are used when printing cheques entered in the Bill 
Payments window. And refund cheque stubs are used when printing cheques entered in Settle Credits.

You can customise the cheque or any of the four stubs. Choose which to customise from the Form menu.

When customising a cheque stub, the cheque fields are displayed, but inaccessible. You must choose Cheque Layout
from the Form menu to customise the cheque fields.

The Continuous-Feed Cheque format and the Laser Cheque format are not changed. Regardless of which format you
originally selected to customise, the customised format is always saved as the User-Customised Cheque.

Don't waste your cheque forms experimenting with forms customisation. When customising keep plain white paper in 
your printer. Print alignment cheques and hold it up to the form until they line up.

See also
Changing the font, size and style of a field 
Changing the location of a field 
Changing the size of a field 
Choosing a font for forms and reports 
Selecting a field 



Customising a purchase order
There are three types of purchase orders in M.Y.O.B.: item purchase orders, professional purchase orders  and 
service purchase orders. You can make a customised version of each type. Here's how: 

1. Select Print Purchases from the Purchase Ledger Command Centre.

2. Choose the appropriate purchase order type (Service, Professional, or Item).

3. Choose the purchase order format (Pre-Printed Purchase Order or M.Y.O.B.'s Plain Paper Purchase Order) that 
most closely matches your form. The pre-printed purchase order format doesn't have lines or column headers (they're
already printed on the form); the plain paper purchase order includes lines and headers.

4. Click Customise.

5. Click any of the selections below for information about changing your purchase order. 

Changing the font, size and style of a field 
Changing the location of a field 
Changing the size of a field 
Choosing a font for forms and reports 
Selecting a field 



Customising an invoice
There are three types of invoices in M.Y.O.B.: item invoices , service invoices and professional invoices. Each type of 
invoice has a packing slip and delivery label. You can make a customised version of each type. Here's how: 

If you don't use packing slips, you can use the packing slip form to create a second customised invoice.

1. Select Print Invoices from the Sales Ledger Command Centre.

2. Choose the appropriate invoice type (Service, Item, Professional, Packing Slip or Delivery Label).

3. Choose the invoice format (Pre-Printed Form or M.Y.O.B.'s Plain Paper Form) that most closely matches your 
form. The pre-printed format doesn't have lines or column headers (they are already printed on the form); the plain 
paper form includes lines and headers.

4. Click Customise.

5. Click any of the selections below for information about changing your invoice. 

Changing the font, size and style of a field 
Changing the location of a field 
Changing the size of a field 
Choosing a font for forms and reports 
Selecting a field 



Customising a statement
There are two types of statements in M.Y.O.B.: invoice statements and activity statements. You may make a 
customised version of each type. Here's how: 

1. Select Print Statements from the Sales Ledger Command Centre.

2. Choose the appropriate statement type (Invoice or Activity).

3. Choose the statement format (Pre-Printed Statement or M.Y.O.B.'s Plain Paper Statement) that most closely 
matches your form. The pre-printed statement format doesn't have lines or column headers (they are already printed 
on the form); the plain paper statement includes lines and headers.

4. Click Customise.

5. Click any of the selections below for information about changing your statement. 

Changing the font, size and style of a field 
Changing the location of a field 
Changing the size of a field 
Choosing a font for forms and reports 
Selecting a field 



Customising a mailing label
1. Select Mailing Labels  from the Card File Command Centre. 

2. Choose the format (2.875" X 1" or 1.5" X 4") that most closely matches your labels. The 2.875" X 1" has three 
labels per row and the 1.5" X 4" has two labels per row.

3. Click Customise.

4. Click any of the selections below for information about changing your mailing label. 

Changing the font, size and style of a field 
Changing the location of a field 
Changing the size of a field 
Changing the size of your labels 
Choosing a font for forms and reports 
Selecting a field 



Changing the size of your labels
While in the Customise Forms window, choose Forms Info from the Form menu. Enter the dimensions of your labels.

If your printer cannot print at the very top of the sheet of labels, use the Top Margin setting to skip the first row of 
labels.

See also
Customising a mailing label 



Ouch!



Jobs List button
Using the windows opened from the Jobs List button, you can set up, change and analyse the activity surrounding 
your company's jobs.



Chart of Accounts button
Using the windows opened from the Chart of Accounts button, you can work with the accounts in your business's 
chart of accounts. You can create new accounts, edit and remove existing accounts, establish budgets and enter 
historical account information in these windows.



Nominal Journal Entry button
Using the windows opened from the Nominal Journal Entry button, you can work with transactions in M.Y.O.B.'s 
Nominal Journal - transactions that aren't specific to any of the other command centres in M.Y.O.B.



Transaction Journal button
The Transaction Journal button allows you to open the Transaction Journal window, where you can view information 
about all transactions you've entered in the M.Y.O.B. system, for all journals. From the Transaction Journal window, 
you can also "zoom" to the original window in which transactions (except stock transactions) were entered.



To Do List button
The To Do List button allows you to open the To Do List window, where you can view the business tasks that affect 
your company on a regular basis. You can also use the To Do List to automatically act upon the tasks you need to 
achieve, such as creating purchase orders for items whose quantities are low.



Balance Sheet button
The Balance Sheet button in the M.Y.O.B. Analyst opens the Analyse Balance Sheet window, where you can view 
detailed information about your asset, liability and capital accounts - collectively known as your balance sheet 
accounts. This window, using criteria set in the Analysis Selection window, also provides a graph feature that allows 
you to view illustrated reports of your account activity.



Profit & Loss button
The Profit & Loss button in the M.Y.O.B. Analyst opens the Analyse Profit & Loss window, where you can view 
detailed information about your income, cost of sales, expense, other income and other expense accounts - 
collectively known as your profit and loss accounts.



Inquiry button
The Inquiry button opens the Inquiry Register window, where you can view summary information about each of your 
company's accounts, sales transactions, purchasing transactions, cards and jobs. This window also allows you to 
zoom to the windows in which the individual items were entered.



Write Cheques button
The Write Cheques button opens the Write Cheques window, where you can create records of your cheques drawn 
from any of your business's bank accounts. You can also use the Write Cheques window to set up recurring cheques 
of the same value.



Print Cheques button
The Print Cheques button opens the Print Cheques window, where you can print the cheques you've created in the 
Write Cheques, Settle Returns and Credits and Bill Payments windows. Using this window, you can also open a 
window where you can customise the printed cheques so they look like the cheques you use.



Reconcile Accounts button
The Reconcile Accounts button opens the Reconcile Accounts window, where you can verify that the balances of your
M.Y.O.B. bank accounts match the balances on your bank's statements. You can also verify whether balances of 
credit cards and loans are correct using this window.



Make a Deposit button
The Make a Deposit button opens the Make a Deposit window, where you can record deposits into your M.Y.O.B. 
bank accounts. You can also use this window to set up recurring deposits of the same value.



Cash Flow button
The Cash Flow button in the M.Y.O.B. Analyst opens the Cash Flow Worksheet window, where you can estimate your
short-term cash needs by using information you've entered throughout M.Y.O.B. to create a forecast of your bank 
accounts' future.



Comments & Delivery Methods button
The Comments & Delivery Methods button opens the Comments & Delivery Methods window, where you can set up 
a standard list of greetings, memos, reminders and any other salutations you often include on invoices and purchase 
orders. You can also use this window to set up the ways in which you transport the items you buy and sell; these 
methods can be printed on invoices and purchase orders, if you wish.



Print Statements button
The Print Statements button opens the Print Statements window, where you can print statements for customers with 
outstanding sales balances. Using this window, you can also open a window where you can customise the printed 
statements so they look like the statements you use.



Settle Returns & Credits button
The Settle Returns & Credits button opens the Select From List window, where you can choose a credit note to work 
with. After you've selected a credit note, you can use the Settle Returns and Credits window to apply the credit note 
amount to a customer's outstanding sales balance or write a refund cheque to the customer.



Sales button
The Sales button opens the Sales window, where you can create transaction records for the items and services you 
sell, regardless of whether the items or services are listed in your list of items.



Print Invoices button
The Print Invoices button opens the Print Invoices window, where you can print the invoices you set up in the Sales 
window, as well as packing slips and delivery labels used in the delivery of items. Using this window, you can also 
open a window where you can customise the printed invoices so they look like the invoices you use.



Customer Payments button
The Customer Payments button opens the Customer Payments window, where you can assign customer payments 
to their outstanding sales balances and record deposits on pending invoices.



Sales (Analyst) button
The Sales button in the M.Y.O.B. Analyst opens the Analyse Sales window, where you can view detailed information 
about your sales activity. This window also contains a graph feature that allows you to view illustrated reports of your 
sales activity.



Debtors button
The Debtors button in the M.Y.O.B. Analyst opens the Analyse Debtors window, where you can view detailed 
information about the customers who owe you money and how long they've owed it to you.



Settle Returns & Debits button
The Settle Returns & Debits button opens the Select From List window, where you can choose a debit purchase to 
work with. After you've selected a debit purchase, you can use the Settle Returns and Debits window to apply the 
debit purchase amount to one of your outstanding purchases with the supplier or deposit a refund cheque from the 
supplier.



Purchases button
The Purchases button opens the Purchases window, where you can create transaction records for the items and 
services you buy, regardless of whether the items or services are included in your list of items. 



Print Purchases button
The Print Purchases button opens the Print Purchases window, where you can print the purchase orders you've 
created in the Purchases window. Using this window, you can also open a window where you can customise the 
printed purchase orders so they look like the purchase orders you use.



Bill Payments button
The Bill Payments button opens the Bill Payments window, where you can assign payments to your outstanding 
purchasing balances and record deposits on pending purchase orders.



Creditors button
The Creditors button in the M.Y.O.B. Analyst opens the Analyse Creditors window, where you can view detailed 
information about the suppliers you owe money to and how long you've owed it to them.



Set Item Prices button
The Set Item Prices button opens the Set Item Prices window, where you can quickly define the selling prices for 
items and services provided by your business.



Stock Adjustments button
The Stock Adjustments button opens the Stock Adjustments window, where you can set beginning quantities and 
values for your stock items, as well as enter transactions affecting quantities and values of stock items.



Items List button
The Items List button opens the Items List window, where you can view the items you've set up in the M.Y.O.B. 
system. From the Items List window, you can open other windows that allow you to specify detailed information about
your company's individual items.



Stock Transfers button
The Stock Transfers button opens the Stock Transfers window, where you can build finished items by increasing 
finished item quantities and decreasing the quantities that are used to build those finished items. 



Count Stock button
The Count Stock button opens the Count Stock window, where you can quickly adjust the quantities of you stock 
items recorded in M.Y.O.B. so they match the actual quantities you have in stock.



Auto-Build Stock button
The Auto-Build Stock button opens the Auto-Build Stock window, where you can quickly increase the quantities of 
finished items. Using this window and the information you entered in the Auto-Build Info window, M.Y.O.B. 
automatically creates stock transfer transactions that increase finished item quantities and decrease the quantities of 
the components used to create them.



Stock button
The Stock button in the M.Y.O.B. Analyst opens the Analyse Stock window, where you can review the current status 
of the items and services included in your items list.



Cards button
The Cards button opens the View Card File window, where you can display a list of the people and companies with 
whom you do business. From this window, you can open the Card File Entry window, where you can create a new 
Card File record or edit an existing Card File record.



Mailing Labels button
The Mailing Labels button opens the Mailing Labels window, where you can set up and print mailing labels for 
individual people or companies in the Card File.



Personalised Letters button
The Personalised Letters button opens the Personalised Letters window, where you can create a mail merge file 
containing information about individual people or companies in the Card File, for the purpose of creating letters 
customised with each person's or company's name.



Identifiers button
The Identifiers button opens the Identifiers window, where you can enter descriptions for the identifiers 
you use throughout the M.Y.O.B. system. For each letter of the alphabet, you can enter a line of text that 
can be used to group people or companies that exist in your Card File.



Contact Log button
The Contact Log button opens the View Contact Log window, where you can display a summary list of all contacts 
made to a specific person or company in the Card File. You can also open the Contact Log Entry window using this 
window, where you can access more detailed information about the individual contacts you've made.



Working with your chart of accounts
Your chart of accounts is the heart of your computerised accounting system. Accounts store the balance of the money
that flows in and out of your business, and if they're used properly, they can be valuable tools for tracking your 
financial activity.

Click on a topic below for more information about working with your chart of accounts.

Types of accounts in M.Y.O.B. 
Organising accounts 
Account levels 
Editing an account 
Entering budgets 
Using budget shortcuts 



Entering Nominal Journal transactions
The Nominal Journal Entry window allows you to enter transactions that aren't specific to the Chequebook, Sales 
Ledger, Purchase Ledger and Stock Control command centres.

Click on a topic below for more information about entering Nominal Journal transactions.

Creating a recurring Nominal Journal entry 
Changing a recurring Nominal Journal entry 
Removing a recurring Nominal Journal entry 



Writing cheques and making withdrawals
A large part of your business, unfortunately, revolves around paying money to other people. In M.Y.O.B., you can 
write cheques to disburse your funds, or you can indicate non-cheque withdrawals. Both tasks are accomplished in 
the Write Cheques window.

Click on a topic below for more information about writing cheques and making withdrawals.

Writing a cheque 
Writing a void cheque 
Locating a cheque 
Removing or changing a cheque before it's saved 
Removing or changing a cheque after it's saved 
Reversing (voiding) a cheque 
Creating a recurring cheque 
Removing a recurring cheque 
Entering non-cheque withdrawals 



Making deposits
The positive side of your business is the money that you take in. Enter nominal deposits of money into M.Y.O.B. by 
using the Make a Deposit window.

Click on a topic below for more information about making deposits.

Entering a deposit 
Locating a deposit 
Removing or changing a deposit before it's saved 
Removing or changing a deposit after it's saved 
Reversing a deposit 
Creating a recurring deposit 
Changing a recurring deposit 
Removing a recurring deposit 



General information about the Sales Ledger Command 
Centre
These topics contain information that applies to the entire Sales Ledger Command Centre.

Types of sales transactions 
Assigning credit terms to customers 
How finance charges are calculated 
How finance charges are tracked 



Working with item invoices
These topics contain information about item invoices.

Creating an item invoice 
Entering two or more lines for an item description 
Locating an item invoice 
Removing or changing an item invoice before it's saved 
Removing or changing an item invoice after it's saved 
Reversing item invoices 
Reversing an item invoice with no payments assigned to it 
Reversing a partially paid item invoice 
Reversing a closed item invoice 
Printing invoices with backordered items 



Working with service invoices
These topics contain information about service invoices.

Creating a service invoice 
Locating a service invoice 
Removing or changing a service invoice before it's saved 
Removing or changing a service invoice after it's saved 
Reversing service invoices 
Reversing a service invoice with no payments assigned to it 
Reversing a partially paid service invoice 
Reversing a closed service invoice 



Working with professional invoices
These topics contain information about professional invoices.

Creating a professional invoice 
Locating a professional invoice 
Removing or changing a professional invoice before it's saved 
Removing or changing a professional invoice after it's saved 
Reversing professional invoices 
Reversing a professional invoice with no payments assigned to it 
Reversing a partially paid professional invoice 
Reversing a closed professional invoice 



Working with other sales
These topics contain information about other sales.

Creating an other sale 
Locating an other sale 
Removing or changing an other sale before it's saved 
Removing or changing an other sale after it's saved 
Reversing other sales 
Reversing an other sale with no payments assigned to it 
Reversing a partially paid other sale 
Reversing a closed other sale 



Working with pending invoices
These topics contain information about pending invoices.

About the Pending File 
Creating a pending invoice 
Locating a pending invoice 
Recording a deposit on a pending invoice 
Converting a pending invoice to an actual invoice 
Removing a pending invoice before it's saved 
Removing or changing a pending invoice after it's saved 



Working with item purchase orders
These topics contain information about item purchase orders.

Creating an item purchase order 
Locating an item purchase order 
Removing an item purchase order before it's saved 
Removing or changing an item purchase order after it's saved 
Reversing item purchase orders 
Reversing an item purchase order with no payments assigned to it 
Reversing a partially paid item purchase order 
Reversing a closed item purchase order 



Working with service purchase orders
These topics contain information about service purchase orders.

Creating a service purchase order 
Locating a service purchase order 
Removing a service purchase order before it's saved 
Removing or changing a service purchase order after it's saved 
Reversing service purchase orders 
Reversing a service purchase order with no payments assigned to it 
Reversing a partially paid service purchase order 
Reversing a closed service purchase order 



Working with professional purchase orders
These topics contain information about professional purchase orders.

Creating a professional purchase order 
Locating a professional purchase order 
Removing a professional purchase order before it's saved 
Removing or changing a professional purchase order after it's saved 
Reversing professional purchase orders 
Reversing a professional purchase order with no payments assigned to it 
Reversing a partially paid professional purchase order 
Reversing a closed professional purchase order 



Working with other purchases
These topics contain information about other purchases.

Creating an other purchase 
Locating an other purchase 
Removing an other purchase before it's saved 
Removing or changing an other purchase after it's saved 
Reversing other purchases 
Reversing an other purchase with no payments assigned to it 
Reversing a partially paid other purchase 
Reversing a closed other purchase 



Working with pending purchase orders
These topics contain information about pending purchase orders.

Creating a pending purchase order 
Locating a pending purchase order 
Recording a deposit on a pending purchase order 
Converting a pending purchase order to an actual purchase order 
Removing a pending purchase order before it's saved 
Removing or changing a pending purchase order after it's saved 



Creative uses for the Card File and Contact Log
There are many creative and helpful uses for    M.Y.O.B.'s Card File and Contact Log. These topics describe some of 
these uses.

Tracking walk-in trade 
The Contact Log as a reminder pad 
The Contact Log as a travel log 
Keeping track of the company car 
Tracking your time billing 



Using the Inquiry Register window
These topics contain information about using the Inquiry Register window.

Viewing account detail 
Viewing customer, supplier, employee, personal contact detail 
Viewing sales transaction detail 
Viewing purchasing transaction detail 
Viewing job detail 



Account
A tool used to organise a business. Accounts, divided into eight categories (asset, liability, capital, income, cost of 
sales, expense, other income and other expense), keep track of the additions and subtractions that occur in regular 
business activity. 



Account Number
The unique identifier for an individual account. Each M.Y.O.B. account must have a unique number.



Accounting
The process of recording and maintaining the financial information of a company.



Accounting Equation
The method by which a business balances its assets with its liabilities and capital. The actual equation is Assets = 
Liabilities + Capital.



Accounting Period
A subset of a businesss financial year, also known as a financial period. As a default, M.Y.O.B. establishes 12 
accounting periods for each financial year    one period per month. Thirteen periods may also be used in an M.Y.O.B. 
financial year.



Creditors Control Account
An account listing the amount owed to suppliers for items or services. Also known as the linked creditors account.

In M.Y.O.B., the Creditors Control account is a liability account. When a purchase is recorded in the Purchase Ledger
Command Centre, the unpaid balance of the purchase is added to the balance of the Creditors Control account. 
When a bill payment is entered (using Bill Payments in the Purchase Ledger Command Centre), the amount is 
subtracted from the balance of the Creditors Control account.



Debtors Control Account
An account listing the amount customers owe for items or services. Also known as the Linked Debtors Account.

In M.Y.O.B., the Debtors Control account is an asset account. When a sale is recorded in the Sales Ledger 
Command Centre, the unpaid balance of the sale is added to the balance of the Debtors Control account. When a 
customer payment is made (using Customer Payments in the Sales Ledger Command Centre), the amount is 
subtracted from the balance of the Debtors Control account.



Accrual Method
A method of accounting in which sales and purchases are recorded at the time they're delivered, not at the time 
they're paid for.



Accrued Expense
An expense incurred during an accounting period, but not yet billed or paid in that period. Once the expense is billed, 
the amount is considered an creditor amount.



Accrued Liability
A liability incurred during an accounting period, but not yet billed or paid in that period.



Adjustment (Stock)
The process of changing the quantity of a stock item so it matches the actual quantity on hand.



Ageing
The method that indicates how many days sales or purchasing accounts have had outstanding balances. Ageing 
determines which bills and payments are current and which are past due. Each day in M.Y.O.B., accounts ages are 
incremented by one day.



Alert Message
In M.Y.O.B., an informational note that appears when an incorrect action has been performed by the user, or when a 
hardware or software failure has prevented the M.Y.O.B. system to operating properly.



Allocation Account
In M.Y.O.B., an account    usually an expense or income account    used to automatically balance a transaction such 
as a cheque or deposit, or stock increase or decrease.

Allocation accounts sometimes are also referred to as accounts used to distribute parts of a transaction to various 
other accounts.



Alphanumeric
An entry that contains both numbers and letters.



Apply
In M.Y.O.B., the process of distributing customer payments to outstanding sales transaction balances, and supplier 
payments to outstanding purchasing transaction balances.



Assets
Something a business owns, such as the money in a bank account, computers and an office building. Money owed to
a business is also considered an asset.

Current assets can be converted into cash (including cash itself) within a relatively short period of time (usually less 
than a year).

Fixed assets usually take more than a year to convert into cash. An office building can be considered a fixed asset.

Assets normally have a debit balance.



Audit Trail
A permanent list (paper or on-line) of all transactions that constitute the balance of an account.



Auto-building
In M.Y.O.B., the process of combining two or more stock items, known as components, to create another stock item, 
known as a finished item.



Automatic Transaction Balancing
In M.Y.O.B., the process of automatically ensuring that equal debit and credit amounts are recorded for each 
transaction.



Backing Up
The process of storing computer files at a location other than the primary location, with the intent of easily recovering 
the files if damage occurs to the files at the primary location.



Backup
Computer files stored at a secondary location, copied during the backing-up process.



Bad Debt
Money owed as a result of sales transactions that will probably not be paid. When money is considered bad debt, its 
no longer an asset.

To counter the effect of bad debt on the value of total assets, a contra-asset account containing the value of the bad 
debt can be used.



Balance
The resulting value of all the activity (additions and subtractions) incurred on an account.



Balance Sheet
A financial snapshot of a company's condition on a specific date. A balance sheet contains the balances of a 
companys asset, liability and capital accounts.

On a balance sheet, the total value of all asset accounts must equal the total value of the liability and capital 
accounts.



Bank Statement
Generally, a report issued by a financial institution listing a specific accounts activity over a period of time.



Beginning Balance
In M.Y.O.B., an account balance thats entered during the setup of the M.Y.O.B. system. Also referred to as opening 
balance.



Budget
The expected future activity for an account or group of accounts. Usually based upon past experience, budgets are 
useful for future planning and comparing actual performance with planned performance.



Business Calendar
In M.Y.O.B., a tool that allows a company to set up its business weeks and months. The Business Calendar drives 
the due dates and recontact dates that appear in the To Do List.



Capital
A company's net worth, also known as owners capital or capital. A companys Capital is calculated by subtracting its 
liabilities from its assets.

Capital is an account type in M.Y.O.B., typically with a credit balance. Some common equity accounts are current 
year earnings, retained earnings and shareholders capital.



Cash
Money thats readily accessible, appearing in the forms of paper money, cheques and amounts in bank and savings 
accounts.



Cash Disbursement
Money paid out by a company, usually taking the form of payments made to suppliers or refund cheques to 
customers.

All transactions entered in the Write Cheques, Bill Payments and Settle Returns & Credits windows are recorded as 
cash disbursements and entered in the Cash Disbursement Journal.



Cash Disbursements Journal
A collection of information about transactions, containing the debit and credit amounts for affected accounts. 

In M.Y.O.B., the Cash Disbursements Journal contains information about supplier payments that affect (credit) bank 
accounts.



Cash Drawer
A object in which actual cash is stored, often used as a tool in a point-of-sale business. Some businesses use the 
value of the funds stored in the cash drawer as a balance in an asset account.



Cash Flow
A record of where a companys money came from and where it went to during a specific time period.



Cash Method
A method of accounting in which sales and purchases are recorded at the time theyre paid for, not at the time theyre 
delivered.



Cash Receipts
Money received by a company, usually taking the form of payments made by customers or refund cheques submitted
by suppliers. Also referred to as receipts.

All transactions entered in Make a Deposit, Customer Payments, and Settle Returns & Debits are recorded as cash 
receipts and entered in the Cash Receipts Journal.



Cash Receipts Journal
A collection of information about transactions, containing the debit and credit amounts for affected accounts. 

In M.Y.O.B., the Cash Receipts Journal contains information about customer payments that affect (debit) bank 
accounts.



CD
In M.Y.O.B., an abbreviation that indicates a transaction is recorded in the Cash Disbursements Journal.



Changeable
If your transactions are changeable, you did not mark the Data Records CANNOT be Changed selection in the 
Preferences window.



Chart of Accounts
A list of all accounts in a companys nominal ledger. Also, a window in M.Y.O.B. where chart of accounts information is
viewed.



Check Box
A type of data entry field used to make a selection by making an X mark in a box.



Chequebook Command Centre
In M.Y.O.B., an area where a businesss bank activity is recorded and reviewed.



Chris
The mild-mannered president of Best!Ware, and the mastermind of an incredible software package.



Cleared
The status of a cheque or deposit when the bank with which the transaction was made adjusts the appropriate 
account balance.



Closed Period
An accounting period in which all activity is complete.

In M.Y.O.B., transactions can be entered in a closed period until the period is locked from transactions using the 
Customise M.Y.O.B. window.



Closed Purchase
Purchases that have been paid in full.



Closed Sale
Sales that have been paid in full.



Comma-separated Values (CSV)
A file format that can be used to export or import data. Comma-separated Values format is a standard character (also 
known as ASCII) format used by many popular database programs.

M.Y.O.B. data can be exported using Comma-separated Values file format or Tab-separated Fields (TAB) file format. 
Data can be imported into M.Y.O.B. using these two formats, as well.



Command Centre
In M.Y.O.B., a location in which selections can be made to accomplish accounting tasks. Seven command centres 
exist in M.Y.O.B.: Nominal Ledger, Chequebook, Sales Ledger, Purchase Ledger, Stock and Card File.



Command Centres Menu
In M.Y.O.B., a menu that contains a directory of all M.Y.O.B. command centres and their associated windows.



Company Information
In M.Y.O.B., general information about a company, such as its name, address, VAT registration number and financial 
year. This information is entered in the Set Up M.Y.O.B. window.



Component
In M.Y.O.B., a stock item combined with another stock item to create a finished item.



Contact Log
A record of people and companies in the Card File with whom a company conducts business activity.



Contra Account
An account used to offset the balance, or part of the balance, of another account. Contra accounts are named after 
the accounts against which their balance is offsetting. The contra account of an asset account, for example, is called 
a contra-asset account. 

A common use of a contra account is a contra-asset account used to indicate the accrued depreciation of an asset, 
such as a company car. By using a contra-asset account, the actual value of a company car can be shown by listing 
its purchase price in an asset account and the amount of the cars accrued depreciation in the contra-asset account.



Conversion Month
The month in which a business starts entering transactions in M.Y.O.B.



Cost
The amount paid to purchase a stock item.

In M.Y.O.B., the cost of an individual item is based on the average cost of all the items of the same type. For 
example, if 10 widgets exist in stock and cost a total of £500, an individual widgets cost will be £50.



Cost of Sales
The amount paid to sell a stock item or service, sometimes referred to as cost of goods sold.

This amount can be stored in an account type of the same name that works in a similar way to an expense account. 
Cost of sales accounts are located between income and expense accounts on profit and loss statements.

Cost of sales amounts are subtracted from income amounts to determine gross profit.

In M.Y.O.B., cost of sales accounts are not required.



CR
In M.Y.O.B., an abbreviation that indicates a transaction is recorded in the Cash Receipts Journal.



Credit
An amount that increases the balance of liability, capital and income accounts, and decreases the balance of asset 
and expense accounts. 

In double-entry accounting, the credit amount appears on the right-hand side of the ledger.



Credit Card
A tool    usually in the form of a card    used to make a payment for an item or service. Credit card companies then bill 
the user of a credit card for the amount due.



Credit Invoice
A sale with a negative balance due.



Creditor
Someone who owes you money



Credit Terms
The agreed-upon rules governing the number of days between delivery and payment, discounts for early payment 
and penalties for late payment.



CSV (Comma-separated Values)
A file format that can be used to export or import data. CSV format is a standard character (also known as ASCII) 
format used by many popular database programs.

M.Y.O.B. data can be exported using CSV file format or Tab-separated Fields (TAB) file format. Data can be imported 
into M.Y.O.B. using these two formats, as well.



Current Assets
Assets that can be converted into cash (including cash itself) within a relatively short period of time (usually less than 
a year).Current assets usually dont lose their value over time.

Current asset accounts normally have a debit balance. As a nominal rule, the most quickly converted current assets 
are assigned the lowest numbers in a chart of accounts.



Current Liabilities
Liabilities that should be paid within a relatively short period of time (usually in less than a year).

Some liabilities can be both a current and a long-term liability, due to the terms in which they were agreed to be paid. 
Such liabilities can be divided into two separate liability accounts, one containing the amount due in the next year (the
current liability) and one containing the remaining amount due (the long-term liability).



Current-year Earnings
The increase in a businesss capital during its current financial year.

The balance of current-year earnings, stored in an capital account, is determined by subtracting the balances of all 
cost of sales and expenses accounts from the balance of all income accounts. 

Current-year earnings are zero at the beginning of a financial year. As the financial year progresses, current-year 
earnings are kept as a running total.

When a new financial year is begun, the current-year earnings account balance is moved to a retained earnings 
account and is reset to zero.



Customer
A person or company to whom a business sells items or services. 



Data
In M.Y.O.B., information thats entered by a user and stored in a companys data file.



Data File
In M.Y.O.B., the medium by which data is stored. All the accounting information thats entered in M.Y.O.B. for a single 
company is stored in one data file.



Date Range
A specified period of time, determined by a beginning date and an ending date.



Debit
An amount that increases the balance of asset and expense accounts, and decreases the balance of liability, capital 
and income accounts. 

In double-entry accounting, the debit amount appears on the left-hand side of the ledger.



Debit Purchase
A bill with a negative balance due.



Debtor
Someone who you owe money to.



Default
In M.Y.O.B., a suggested entry that appears in a data entry field.



Deposit From Customers
Money received for items or services not yet delivered, usually in response to a pending sale.

Customer deposits are kept in a liability account.



Deposit To Suppliers
Money paid to suppliers for items or services not yet delivered, usually in response to a pending purchase.

Supplier deposits are kept in an asset account.



Depreciation
The cost of an asset over a period of time.

Depreciation of an asset is often tracked by increasing the balance of a contra-asset account to offset the value of the
asset. A typical depreciation transaction credits the contra-asset account and debits a depreciation expense account. 
Depreciation is usually recorded as a nominal journal entry.



Detail Account
An M.Y.O.B. account to which transactions are assigned.



Directory
In Windows, a location on a hard disk where files can be stored.



Disbursement
Money paid out by a company, usually taking the form of payments made to suppliers or refund cheques to 
customers.

All transactions entered in the Write Cheques, Bill Payments and Settle Returns & Credits windows are recorded as 
cash disbursements and entered in the Cash Disbursement Journal.



Discount Days
The number of days from a sale or purchase within which full payment of the balance due entitles the payee to a 
discount.



Discount: Early Payment
The amount taken off the balance due in return for payment within an agreed upon number of days.



Discount: Volume Purchase
The amount taken off an item's cost because of a special supplier or customer arrangement.



Diskette
The medium on which M.Y.O.B. is distributed to customers. Diskettes can be used in the backing-up process.



DOS
Abbreviation for Disk Operating Software. Software used to manipulate the manner in which some computers work 
with other software.



Double-entry Accounting
A method of bookkeeping in which equal debit and credit accounts are recorded for each transaction.

Correct double-entry accounting always provides a balanced set of books; that is, the total value of all asset accounts
will equal the total value of all liability and capital accounts.



Earnings
Income minus cost of sales and expenses.

In M.Y.O.B., a menu that contains various commands that perform standard computer software functions, such as 
Cut, Copy and Paste. On the Macintosh, the Edit menu also includes commands to facilitate M.Y.O.B.s Publishing 
capabilities.



Enter
In M.Y.O.B., the process of typing information into a field and moving the highlight to a different field.



Entry
In M.Y.O.B., a piece of information thats put into the accounting system.



Equity
A company's net worth, also known as capital or owners capital. A companys equity is calculated by subtracting its 
liabilities from its assets.

In M.Y.O.B., an area where information about a companys business contacts is set up and maintained.



Expense
The cost incurred when a business attempts to create income.

Expense is an account type in M.Y.O.B., typically with a debit balance.



Exporting
The process of transferring data from one software program to another software program, or to another location in the
same program.



VAT Registration Number
An identification number assigned to a company in Great Britain by Customs and Excise for VAT reporting purposes.



Field
In M.Y.O.B., a single location where one unit of information is entered, such as the phone number of a customer.



File
In M.Y.O.B., two different types of files exist:

The Card File is a storage area in the M.Y.O.B. system where information about a companys business contacts is 
located. The Pending File is a similar storage area.

M.Y.O.B.s data file is the medium by which M.Y.O.B. accounting data is stored.



File Format
A manner of saving data as a file so it can be imported or exported.

M.Y.O.B. data can be exported using the Comma-separated Values (CSV) file format or the Tab-separated Fields 
(TAB) file format. Data can be imported into M.Y.O.B. using these two formats, as well.



File Menu
In M.Y.O.B., a menu that contains a variety of commands that maintain the M.Y.O.B. system.



Finance Charge
The amount added to an outstanding balance as defined in a set of credit terms, or as a penalty for late payment.



Financial Statements
A term used to collectively describe the balance sheet and profit & loss statement.



Finished Item
In M.Y.O.B., a stock item thats the final product of combining two or more components.



Financial Period
A period in a businesss financial year, spanning a specific number of days.



Financial Year
A businesss accounting year, spanning the number of days in a calendar year but not necessarily following the same 
January-December month structure as the calendar year.



Fixed Asset
An asset that usually takes more than a year to convert into cash. Fixed assets usually lose some of their value over 
time.

Fixed asset accounts normally have a debit balance.



Folder
A location on a hard disk where files can be stored, usually in reference to a Macintosh.



Footer
A report section thats printed at the bottom of a page.



Form
In M.Y.O.B., reports that are typically distributed to people or companies outside a business, such as cheques, 
invoices, statements, purchase orders and mailing labels.



Format
To design or lay out a report or form.



Nominal Journal
A collection of information about transactions, containing the debit and credit amounts for affected accounts.

In M.Y.O.B., the Nominal Journal contains transactions that do not belong in the Sales, Purchases, Stock, Cash 
Disbursements, or Cash Receipts journals.

In M.Y.O.B., an area where all account information is located, and where Nominal Journal transactions are entered.

The information that appears in financial statements such as the balance sheet and profit and loss statement is drawn
from the information contained in Nominal Ledger.



NJ
In M.Y.O.B., an abbreviation that indicates a transaction is recorded in the Nominal Journal.



Greyed
In M.Y.O.B., a part of a window thats visible on the computer screen but cant be selected.



Gross Profit
Income minus cost of sales.



Hardware
Physical computer equipment, such as a hard disk, monitor, printer and mouse.



Header
A report section thats printed at the top of a page. Also refers to the section containing the title of various lists in 
M.Y.O.B. windows.



Header Account
In M.Y.O.B., an account used to group other accounts together for reporting purposes. A header account typically 
uses a generic name, such as Fixed Assets, to describe all the accounts in its group.

Transactions cannot be assigned to header accounts.



Help
In M.Y.O.B., on-line documentation and video help that can be accessed from the Help menu.

In M.Y.O.B., a menu that contains commands from which on-line documentation and video help are available. In 
Windows, the Help menu appears at the right-hand end of the menu bar; on a Macintosh, the Help menu is accessed 
from the Balloon Help icon.



Highlight
To select a line of text or an icon so it appears in a different colour or in reverse (black on white, for example).



Highlighting
A line of text or an icon that appears in a different colour or in reverse (black on white, for example).



Historical Balance
The balance of an account before its transferred to M.Y.O.B. 



Historical Purchase
A purchase made before the Purchase Ledger Command Centre in M.Y.O.B. was used.

The historical purchases that make up the current balance of the appropriate linked account must be entered before 
the Purchase Ledger Command Centre may be used.



Historical Sale
A sale made before the Sales Ledger Command Centre in M.Y.O.B. was used.

The historical sales that make up the current balance of the appropriate linked account must be entered before the 
Sales Ledger Command Centre may be used.



History
A chronicle of business activity, such as transactions and account balances, for years previous to the current year.



Icon
A graphic representation of an object that appears on a computer screen. Some of the icons in M.Y.O.B. include the 
Card File icon, the zoom arrow and search icon.



Identifier
In M.Y.O.B., a character used to organise cards in the Card File. Up to 26 identifiers can be assigned to each card.



IJ
In M.Y.O.B., an abbreviation that indicates a transaction is recorded in the Stock Journal.



Importing
The process of receiving data into a software program that originated from a different software program, or from a 
different location in the same program.



Income
The increase in capital from the sale of items or services.

Income, also known as revenue, is an account type in M.Y.O.B. It usually carries a credit balance.



Income Statement
A financial statement showing a companys performance over a period of time. Also referred to as Profit and Loss 
Statement.

An M.Y.O.B. income statement shows the income gained by a business, the cost of sales and expenses incurred by 
the business and the net profit or loss that results.



Integration
In M.Y.O.B., the automatic sharing of information between command centres.



Stock Item
A physical unit stored for possible sale to a customer. Also referred to in M.Y.O.B. documentation as item.

Inventoried items are typically considered current assets. 



Stock
A nominal term to describe goods produced for sale.

In M.Y.O.B., a command centre in which information about    items and services provided by a company is located, 
and where transactions used to control the quantities of    items are entered.



Stock Adjustment
The process of changing the quantity of a stock item so it matches the actual quantity on hand.

In M.Y.O.B., an area where information about stock items is set up, maintained and analysed.



Stock Journal
A collection of information about transactions, containing the debit and credit amounts for affected accounts. 

In M.Y.O.B., the Stock Journal contains transaction information affecting quantities of stock items.



Stock Transfer
In M.Y.O.B., the process of adjusting item quantities after finished items are created.



Invoice
The written record of a sale.

In M.Y.O.B., three types of invoices can be recorded: item invoices, which record the sale of stock items; service 
invoices, which record the sale of services and other items not included in stock; and professional invoices, which 
record the sale of services and other items not included in stock, as well as the dates each individual service or item 
was sold.



Item
A physical unit stored for possible sale to a customer, or a chargeable service provided by a company. Physical units 
are also referred to in M.Y.O.B. documentation as stock items.

Items are typically considered current assets. 



Item Invoice
The written record of the sale of a stock item.



Item Purchase Order
The written record of a purchase of a stock item.



Job
A series of specific transactions for which income and expenses are tracked, and for which a separate profit and loss 
statement is desired.

In M.Y.O.B., a profit centre, a product line or a similar division of a business can be considered a job.



Journal
A collection of information about transactions, containing the debit and credit amounts for affected accounts. 

In M.Y.O.B., transactions are grouped into six journals: Nominal, Cash Disbursements, Cash Receipts, Sales, 
Purchases and Stock.



Journal Entry
A transaction consisting of equal debit and credit amounts.



Label
In M.Y.O.B., the descriptive name of a field thats displayed in a window. For example, the field in which you enter a 
customer name in the Sales window uses Customer as its label.



Liability
Something a business owes, such as a working capital loan. Money owed by a business for purchases is also 
considered a liability.

Current liabilities are due within a relatively short period of time (usually less than a year).

Long-term liabilities usually arent due for more than a year.

Liabilities normally have a credit balance.



Linked Account
In M.Y.O.B., an account to which specific transaction amounts are assigned.



Linked Creditors Account
An account listing the amount you owe to suppliers for items or services. Also known as the Creditors Control 
account.

In M.Y.O.B., the linked creditors account is a liability account. When a purchase is recorded in the Purchase Ledger 
Command Centre, the unpaid balance of the purchase is added to the balance of the linked creditors account. When 
a bill payment is made (using Bill Payments in the Purchase Ledger Command Centre), the amount is subtracted 
from the balance of the linked creditors account.



Linked Debtors Account
An account listing the amount customers owe for items or services. Also known as the Debtors Control account.

In M.Y.O.B., the Linked Debtors Account is an asset account. When a sale is recorded in the Sales Ledger Command
Centre, the unpaid balance of the sale is added to the balance of the Linked Debtors Account. When a customer 
payment is made (using Customer Payments in the Sales Ledger Command Centre), the amount is subtracted from 
the balance of the Linked Debtors Account.



Locked Period
In M.Y.O.B., an accounting period in which entries are no longer allowed. Periods are locked using the Customise 
M.Y.O.B. window.



Long-term Liability
A liability that doesnt have to paid for at least a year.



Menu Bar
The row of menus that appears at the top of M.Y.O.B. windows. The M.Y.O.B. menu bar includes the File, Edit, 
Command Centres, Setup, Reports, Window and Help menus.



Multi-user System
A software product that allows more than one user to make entries into it at a time. M.Y.O.B. is not a multi-user 
system.



M.Y.O.B. Analyst
A section in each of M.Y.O.B.s command centres that contains buttons that access various analysis windows.



Navigating
In M.Y.O.B., the process of accessing a specific window in the accounting system. Navigating in M.Y.O.B. consists of 
actions such as clicking buttons, selecting items from menus and clicking zoom buttons.



Net Income
The total of all income accounts minus the sum of all expense and cost of sales accounts. Also called Net Profit 
(Loss).



Net Profit (Loss)
The total of all income accounts minus the sum of all expense and cost of sales accounts. Also called Net Income.



Network
A group of computers connected together so they can share information.



On-line
A method in which actions are performed on a computer instead of manually. 



Opening Balance
In M.Y.O.B., an account balance thats entered during the setup of the M.Y.O.B. system. Also referred to as beginning 
balance.



Operating Profit
A profit amount that doesnt include the balances of the other income and other expense accounts.



Other Expenses
In M.Y.O.B., an account type used to record expenses that arent directly related to a company's operations, such as 
loan interest and fines.

The M.Y.O.B. Profit and Loss Statement doesnt include the balance of other expenses accounts.

Other expense accounts usually have a debit balance.



Other Income
In M.Y.O.B., an account type used to record income that isnt directly related to a company's operations, such as 
interest income.

The M.Y.O.B. Profit and Loss Statement doesnt include the balance of other income accounts.

Other income accounts usually have a credit balance.



Other Purchases
In M.Y.O.B., purchases that arent recorded on    or dont require    a printed purchase order.



Other Sales
In M.Y.O.B., sales that arent recorded on    or dont require    a printed invoice.



Out of Balance
A transaction whose total credit amount doesnt equal the total debit amount.



Outstanding Purchase
A purchase with an outstanding balance due.



Outstanding Sale
A sale with an outstanding balance due.



Paid In Capital
The amount of money paid by shareholders in excess of the par (face) value of the stock.



Par Value
The face value of a share of stock in a company. Often, the par value of a stock has very little to do with the stocks 
actual value.



Password
In M.Y.O.B., a set of characters used to restrict access to specific parts of the M.Y.O.B. system. A password can be 
set up using the Customise M.Y.O.B. window.



Pattern
In M.Y.O.B., a design that can be used to change the appearance of particular M.Y.O.B. windows.



Pattern Background
In M.Y.O.B., the colour that appears behind the pattern foreground around the borders of boxes in M.Y.O.B. windows.



Pattern Foreground
In M.Y.O.B., the colour that appears in front of the pattern background around the borders of boxes in M.Y.O.B. 
windows.



Purchase Debt
An amount owed to suppliers for items or services. Also referred to as an creditor amount.

In M.Y.O.B., the Creditor Control account is a liability account. When a purchase is recorded in the Purchase Ledger 
Command Centre, the unpaid balance of the purchase is added to the balance of the Creditor Control account. When
a bill payment is entered (using Bill Payments in the Purchase Ledger Command Centre), the amount is subtracted 
from the balance of the Creditor Control account.



Payment Terms
The agreed-upon rules governing the payment of sales transactions, including discounts for early payment.



Pending Invoice
In M.Y.O.B., a sale for which the items or services sold havent been delivered yet.

Pending invoices dont record the sale, nor do they decrease stock quantities; they simply keep the invoice on file to 
be recorded when the items or services are delivered.

A payment applied to a pending invoice is considered a deposit.



Pending Purchase
In M.Y.O.B., a purchase for which the items or services purchased havent been delivered yet.

Pending purchases dont record the purchase, nor do they increase stock quantities; they simply keep the purchase 
on file to be recorded when the items or services are delivered.

A payment applied to a pending purchase is considered a deposit.



Performance
The ability of software and hardware to carry out specific tasks.



Period-end Processing
An accounting procedure followed when all accounting entries are made for a specific month.

Period-end processing in M.Y.O.B. consists of the following steps:

1. Reconcile bank accounts
2. Verify entries using the trial balance
3. Print financial statements
4. Back up data
5. Change the accidental posting month in Customise M.Y.O.B.



Physical Stock
A nominal term to describe goods produced for sale.



PJ
In M.Y.O.B., an abbreviation that indicates a transaction is recorded in the Purchases Ledger Journal.



Point-of-sale Transaction Entry
The process of entering and printing invoices at the time the sale is made.



Postcode
A postal code used in the United Kingdom to designate the location of addresses. Outside the United Kingdom, postal
code and    zip code are common equivalents of this term. 



Prepaid Expense
A payment made for something - usually a service - before its received. Prepaid expenses are assets.

An annual insurance payment is an example of a prepaid expense. If, for example, a companys insurance costs 
£1,000 per month, and the full years total of £12,000 is paid at the beginning of the year. The £12,000 would be 
recorded in a prepaid expense account; then, to ensure proper accounting records, £1,000 of the prepaid expense 
should be transferred monthly from the prepaid expense account to an insurance expense account.



Main Supplier
In M.Y.O.B., the supplier from which an item is usually purchased.



Professional Invoice
In M.Y.O.B., a service invoice that contains the dates each service was performed.



Professional Purchase Order
In M.Y.O.B., a service purchase order that contains the dates each service was performed.



Profit
Generally, the revenue earned by a business minus the costs incurred to gain that revenue. Three types of profit 
exist:

Gross profit is calculated by subtracting the balance of cost of sales accounts from the balance of income accounts.

Operating profit is calculated by subtracting the balance of cost of sales and expenses accounts from the balance of 
income accounts.

Net profit is calculated by subtracting the balance of other expenses accounts and adding the balance of other 
income accounts to the operating profit balance.



Profit and Loss Statement
A financial statement showing a companys performance over a period of time. Also referred to as Income Statement.

An M.Y.O.B. profit and loss statement shows the income gained by a business, the cost of sales and expenses 
incurred by the business and the net profit or loss that results.



Profit Centre
A subset of a business for which income and expenses are tracked separately from other parts of the business, and 
for which a separate profit and loss statement is generated.

In M.Y.O.B., jobs are used to track the activity of profit centres.



Program
A computer software product created for a specific purpose. M.Y.O.B. is an accounting program.



Promised Date
The date that the items or services from a pending sale or pending purchase is due to be delivered.



Purchase Order
The written record of a purchase.

In M.Y.O.B., three types of purchase orders can be recorded: item purchase orders, which record the purchase of 
stock items; service purchase orders, which record the purchase of services and other items not included in stock; 
and professional purchase orders, which record the purchase of services and other items not included in stock, as 
well as the dates each individual service or item was purchased.



Purchases Journal
A collection of information about transactions, containing the debit and credit amounts for affected accounts. 

In M.Y.O.B., the Purchases Journal contains purchasing transaction information affecting creditors control, stock 
asset and purchase expense accounts.

In M.Y.O.B., an area where information about purchasing transactions is entered, maintained and analysed. Purchase
Orders are created and printed in the Purchase Ledger Command Centre.



Purging
In M.Y.O.B., the process of removing unnecessary or outdated data from a companys data file. Information that can 
be purged from the data file includes journal entries, closed sales, closed purchases and contact logs.



Recap Transaction
In M.Y.O.B., a feature that allows users to review a journal entry before its saved. This feature, selected from the 
Inquiry menu, is helpful in viewing transactions such as invoices and purchase orders for which the journal entry isn't 
apparent.



Receipts
Money received by a company, usually taking the form of payments made by customers or refund cheques submitted
by suppliers. Also referred to as cash receipts.

All transactions entered in the Make a Deposit, Customer Payments and Settle Returns & Debits windows are 
recorded as receipts and entered in the Cash Receipts Journal.



Sales Debt
An amount owed to a business for items or services. Also referred to as an debtor amount.

In M.Y.O.B., the Debtors Control account is an asset account. When a sale is recorded in the Sales Ledger 
Command Centre, the unpaid balance of the sale is added to the balance of the Debtors Control account. When a 
customer payment is entered (using Customer Payments in the Sales Ledger Command Centre), the amount is 
subtracted from the balance of the Debtors Control account.



Reconciling
The process of verifying that a businesss recordkeeping of various accounts is consistent with a bank's 
recordkeeping of the same accounts.



Recontact Date
In M.Y.O.B.s Contact Log, the next date at which a specific person is due to be contacted.



Record
A collection of information about individual parts of accounting data. For example, all information about a single 
customer is stored as a record.



Recordkeeping
The process of recording transactions and maintaining accounts.



Recurring Transaction
An accounting entry that occurs repeatedly, such as weekly payroll and monthly rent.



Report Field
In M.Y.O.B., an on-screen icon in a forms Customise window representing an individual unit of M.Y.O.B. information. 
Report fields can be repositioned in a forms layout to better fit a businesss preprinted forms. An example of a report 
field is the Date field on a cheque.

In M.Y.O.B., a menu that contains a list of all reports that can be printed from the command centre thats currently 
displayed. The Reports menu also contains an index to all reports in the M.Y.O.B. system.



Retained Earnings
The increase in a businesss capital throughout the businesss lifetime, not including the current year. 

The balance of retained earnings is stored in an capital account. When a new financial year is begun, the current-
year earnings account balance is moved to a retained earnings account, and the current-year earnings account 
balance is returned to zero.



Revenue
The increase in capital from the sale of items or services.

Revenue, also known as income, is an account type in M.Y.O.B. It usually carries a credit balance.



Reversing
The process of offsetting the effects of an incorrect transaction by entering a new transaction (called a reversing 
transaction) that reverses the debit and credit entries of the incorrect transaction.



Root Directory
In Windows File Manager, the main directory on a hard disk, usually C:.



Sales Journal
A collection of information about transactions, containing the debit and credit amounts for affected accounts. 

In M.Y.O.B., the Sales Journal contains sales transaction information affecting sales, debtors control, stock and cost 
of sales accounts.

In M.Y.O.B., an area where information about sales transactions is entered, maintained and analysed. Invoices are 
created and printed in the Sales Ledger Command Centre.



Sales History
In M.Y.O.B., the chronological list of past monthly sales amounts recorded for an item, customer or salesperson.



Sample Company
In M.Y.O.B., the term used to describe Widgets Ltd., a fictitious set of data that allows M.Y.O.B. users to experiment 
with M.Y.O.B.



Service Invoice
The written record of a sale of services or other items not included in stock.



Service Item
In M.Y.O.B., a service performed by a company thats entered in the Item Information window and can have item 
invoices written for it.



Service Purchase Order
The written record of a purchase of services and other items not included in stock.



Session Report
In M.Y.O.B., a report containing journal activity since the M.Y.O.B. system was last started, or since the last time 
changes in the M.Y.O.B. data file were saved.



Settle a Credit Invoice
The process of paying the negative balance due on a customers credit invoice, usually accomplished by writing a 
refund cheque or by applying the balance to one of the customers open invoices.



Settle a Debit Purchase
The process of receiving the negative balance due on a businesss debit purchase order, usually accomplished by 
depositing a suppliers refund cheque or by applying the balance to one of the businesss open purchase orders.



Shareholders Capital
The owners stake in a company. Shareholders capital is comprised of the amount the owners invested in the 
company plus the current-year earnings and retained earnings.

Shareholders capital typically has a credit balance. 



Single-user System
A software product that allows only one user to make entries into it at a time. M.Y.O.B. is a single-user system.



SJ
In M.Y.O.B., an abbreviation that indicates a transaction is recorded in the Sales Journal.



Software
A program or set of programs used to direct a computer to perform specific tasks.



Source Journal
In M.Y.O.B., a recordkeeping tool used to categorise transactions into similar groups. When a transaction is saved, its
assigned to the source journal that best applies to it. M.Y.O.B.s six source journals are the Nominal Journal, Sales 
Journal, Purchases Journal, Cash Receipts Journal, Cash Disbursements Journal and Stock Journal.



Source Journal Code
In M.Y.O.B., a fixed abbreviation for a source journal name. M.Y.O.B.s six source journal codes are:

CD = Cash Disbursements Journal
CR = Cash Receipts Journal
IJ = Stock Journal
NJ = Nominal Journal
PJ = Purchases Journal
SJ = Sales Journal



Source Journal Number
In M.Y.O.B., a identification number assigned to a transaction.



Starter Chart Of Accounts
In M.Y.O.B., a list of accounts provided in the M.Y.O.B. package that contains accounts suited for specific businesses,
such as law firms, educational institutions and non-profit organisations.



Starting a New Year
In M.Y.O.B., the process of completing a financial year and preparing a new financial year for use. Among other 
things, starting a new financial year transfers the balance of current-year earnings accounts to retained earnings and 
returns the balance of income, cost of sales and expenses accounts to zero.



Subdirectory
In Windows, a directory located within a directory on a hard disk.



System (Automated Accounting)
A group of accounting tasks combined to create a fully integrated accounting package. M.Y.O.B. is an automated 
accounting system.



TAB (Tab-delimited Fields)
A file format that can be used to export or import data. TAB format is a standard character (also known as ASCII) 
format used by many Macintosh database programs.

M.Y.O.B. data can be exported using TAB file format or Comma-separated Values (CSV) file format. Data can be 
imported into M.Y.O.B. using these two formats, as well.



Tab-delimited Fields (TAB)
A file format that can be used to export or import data. Tab-delimited Fields format is a standard character (also 
known as ASCII) format used by many Macintosh database programs.

M.Y.O.B. data can be exported using Tab-delimited Fields file format or Comma-separated Values (CSV) file format. 
Data can be imported into M.Y.O.B. using these two formats, as well.



Task
In M.Y.O.B., a button in a command centre that can be selected to open a window in which accounting tasks can be 
performed.



VAT Code Table
In M.Y.O.B., a set of VAT rates and codes used for calculating VAT on transactions. M.Y.O.B can use up to 10 
different VAT rates.



Terms
The agreed-upon rules governing the number of days between delivery and payment, discounts for early payment 
and penalties for late payment.



Text
In M.Y.O.B., the characters that comprise an entry in a data entry field. For example, a name thats entered in a 
Customer field is considered text.



To Do List
In M.Y.O.B., a function that allows a company to keep track of regular business activities, such as paying suppliers 
and contacting customers, that need to be accomplished. 



Transaction
In M.Y.O.B., an entry that affects the balance of an account or group of accounts.



Transfer (Stock)
In M.Y.O.B., the process of adjusting item quantities after finished items are created.



Trial Balance
A report reflecting all activity for an account or group of accounts within a specified period, often used to review 
financial activity before the end of a period. It shows the beginning balance of a specific account, a summary of the 
activity within the specified period, and the ending balance of the account.



Typical Balance
The type of balance (either credit or debit) that an account usually has.

Asset and expense accounts usually have debit balances, while liability, income and capital accounts usually have 
credit balances.



Unchangeable
If your transactions are unchangeable, you marked the Data Records CANNOT be Changed selection in the 
Preferences window.



User
In M.Y.O.B., a person who enters information into the M.Y.O.B. system.



Supplier
A person or company from whom a business purchases items and services.



Wages
Money paid to employees for work done, including salaries, hourly earnings, bonuses, commissions and other 
employee income.



Widgets Ltd.
In M.Y.O.B., the term used to describe the sample company provided in the M.Y.O.B. package. Widgets Ltd., is a 
fictitious set of data that allows M.Y.O.B. users to experiment with M.Y.O.B.



Wildcard
In M.Y.O.B., a character used to further define search criteria in reports. M.Y.O.B. uses an asterisk (*) and a question 
mark (?) as wildcards.



Wildcarding
In M.Y.O.B., the process of defining search criteria in reports.



Window Menu (Windows)
In M.Y.O.B., a menu that lists all active (open) M.Y.O.B. windows.



Windows Menu (Macintosh)
In M.Y.O.B., a menu that lists all active (open) M.Y.O.B. windows.



Year End
The end of a businesss financial year.



Zoom Arrow
In M.Y.O.B., an icon in a window that allows a user to review, or zoom, to more detailed information about a specific 
topic, such as a transaction.



Zooming
In M.Y.O.B., the process of clicking a zoom arrow to review more detailed information about a specific topic, such as 
a transaction.



Chart of Accounts Report [Summary]
This report contains a list of all accounts and their balances.

See also
Nominal Ledger reports 



Chart of Accounts Report [Detail]
This report contains a list of all accounts with their type, level, bank status and current balance.

See also
Nominal Ledger reports 



Account Inquiry Report 
This report displays only the debit or credit piece of any transaction that is attached to the selected account, in the 
selected source journal and within a range of dates. It does not display the entire transaction.

See also
Nominal Ledger reports 



Nominal Journal Report 
This report displays the transactions assigned to the Nominal Journal within a range of dates.

See also
Nominal Ledger reports 



Recurring Nominal Journal Entries Report 
This report displays the names of recurring transactions, dates last recorded, frequencies and dates next due.

See also
Nominal Ledger reports 



Jobs List
This report displays a list of your jobs.

See also
Nominal Ledger reports 



Job Inquiry Report 
This report displays all the transactions that are associated with specific jobs.

See also
Nominal Ledger reports 



Job Activity Report [Summary]
This report displays only the totals of every job within a selected account for a range of dates and journals.

This report doesn't include purged transactions.

See also
Nominal Ledger reports 



Job Activity Report [Detail]
This report displays every transaction assigned to a job within a range of dates and journals for specific accounts.

This report doesn't include purged transactions.

See also
Nominal Ledger reports 



Job Profit & Loss Report 
This report is a profit and loss statement containing transactions assigned to a specific job.

This report displays the balance of your asset, liability and capital accounts as of the end of a specific accounting 
period.

See also
Nominal Ledger reports 



Balance Sheet [Spreadsheet]
This report displays a balance sheet  for multiple accounting periods in spreadsheet format.

See also
Nominal Ledger reports 



Balance Sheet [Budget Spreadsheet]
This report displays the monthly budgeted amounts for asset, liability and capital accounts in spreadsheet format.

See also
Nominal Ledger reports 



Balance Sheet [Last Year Analysis]
This report compares your current balance sheet as of the end of a specific accounting period  with your balance 
sheet as of the same period last year.

See also
Nominal Ledger reports 



Balance Sheet [Budget Analysis]
This report compares your balance sheet as of the end of a specific accounting period  with a depiction of what your 
balance sheet would look like if you had met your budgeted activity every month of the year.

See also
Nominal Ledger reports 



Profit & Loss Statement
This report displays your income, cost of sales, expense, other income and other expense accounts for specific 
accounting periods .

See also
Nominal Ledger reports 



Profit & Loss Statement [Spreadsheet]
This report displays the profit and loss for multiple accounting periods in spreadsheet format.

See also
Nominal Ledger reports 



Profit & Loss Statement [Budget Spreadsheet]
This report displays the monthly budgeted amounts for income, cost of sales, expense, other income and other 
expense accounts in spreadsheet format.

See also
Nominal Ledger reports 



Profit & Loss Statement [with Year to Date]
This report compares the activity of your income, cost of sales, expense, other income and other expense accounts 
for specific accounting periods  with the year-to-date activity.

See also
Nominal Ledger reports 



Profit & Loss Statement [with Last Year]
This report compares the net activity of your income, cost of sales, expense, other income and other expense 
accounts for specific accounting periods  to the activity for the same periods last year.

See also
Nominal Ledger reports 



Profit & Loss Statement [% Sales Analysis]
This report calculates all your income, cost of sales, expense, other income and other expense accounts as a percent
of total sales; then compares the percentages to last year and to your budgeted activity for the same period.

See also
Nominal Ledger reports 



Profit & Loss Statement [Last Year Analysis]
This report compares your profit and loss for a specific accounting period  in the current financial year  against your 
profit and loss for the same period last year.

See also
Nominal Ledger reports 



Profit & Loss Statement [Budget Analysis]
This report compares your actual profit and loss for a specific accounting period  with a depiction of what your profit 
and loss would have looked like if you had met your budgeted activity during the same period.

See also
Nominal Ledger reports 



Trial Balance Report
For each account, this report displays the total debits and credits for the selected period(s) and for the year to date.

See also
Nominal Ledger reports 



Nominal Ledger Report [Summary]
For each account, this report displays account balances at the beginning of a range of dates, the total debits and 
credits within a date range, the net activity and the balances at the end of a range of dates.

See also
Nominal Ledger reports 



Nominal Ledger Report [Detail]
Within a range of dates, for each account, this report displays the beginning balance, a line for each transaction, the 
total debits and credits and the ending balance.

See also
Nominal Ledger reports 



Cash Disbursements Journal Report 
This report displays the transactions assigned to the Cash Disbursements Journal within a range of dates.

See also
Chequebook reports 



Cash Receipts Journal Report 
This report displays the transactions assigned to the Cash Receipts Journal within a range of dates.

See also
Chequebook reports 



Chequebook Register
This report displays every cheque, withdrawal and deposit for a specific bank account within a range of dates. A 
running balance is provided.

See also
Chequebook reports 



Cash Flow Analysis Report 
This report displays a printed version of the on-screen Cash Flow Worksheet.

See also
Chequebook reports 



Reconciliation Report
This report displays a reconciliation summary and a list of uncleared cheques and deposits.

See also
Chequebook reports 



Recurring Cheques Report 
This report displays the names of recurring cheque transactions, dates last recorded, frequencies and dates next 
due.

See also
Chequebook reports 



Recurring Deposits Report 
This report displays the names of recurring deposit transactions, dates last recorded, frequencies and dates next due.

See also
Chequebook reports 



To Do List Report [Recurring Transactions]
This report displays a list of recurring cheques, deposits and Nominal Journal entries from the To Do List window.

See also
Chequebook reports 



Sales Journal Report 
This report displays the transactions assigned to the Sales Journal within a range of dates.

See also
Sales Ledger reports 



Invoice Inquiry Report 
This report displays all the transactions that affect the current balance of a sales transaction, including the original 
transaction, VAT, customer payments, discounts and customer deposits.

See also
Sales Ledger reports 



Recurring Sale Report 
This report displays the names of recurring sales, dates last recorded, frequencies and dates next due.

See also
Sales Ledger reports 



Aged Debtors Report [Summary]
For each customer, this report displays a single line with the customers current balance followed by the age of that 
balance.

See also
Sales Ledger reports 



Aged Debtors Report [Detail]
For each customer, this report displays the customers current balance  followed by a list of their open sales with the 
amount due in the appropriate ageing column.

See also
Sales Ledger reports 



Debtors Reconciliation Report [Summary]
This report displays a list of debtors as of a specific date presented in summary (one line per customer) format.

See also
Sales Ledger reports 



Debtors Reconciliation Report [Detail]
This report displays a list of debtors as of a specific date presented in detail (one line per invoice) format.

See also
Sales Ledger reports 



Analyse Sales Report [Item]
This report displays working sales, cost of sales, gross profit, units, average cost and percent margin for specific 
items within a range of accounting periods.

See also
Sales Ledger reports 



Analyse Sales Report [Item - vs. Last Year]
This report compares this years working sales, units, gross profit and percent margin for specific items to the same 
figures for the same accounting period last year.

See also
Sales Ledger reports 



Analyse Sales Report [Item Spreadsheet]
This report displays your choice of item working sales, quantities sold or cost of sales for multiple accounting periods 
in spreadsheet format.

See also
Sales Ledger reports 



Analyse Sales Report [Customer]
This report displays working sales and percent of total sales for selected customers within a range of accounting 
periods.

See also
Sales Ledger reports 



Analyse Sales Report [Customer - vs. Last Year]
This report compares this years working sales for specific customers with working sales for the same accounting 
period last year.

See also
Sales Ledger reports 



Analyse Sales Report [Customer Spreadsheet]
This report displays customer working sales for multiple accounting periods in spreadsheet format.

See also
Sales Ledger reports 



Analyse Sales Report [Salesperson]
For a selected accounting period, this report lists every each salesperson's total working sales and percent of total 
sales.

See also
Sales Ledger reports 



Analyse Sales Report [Salesperson Detail]
For each salesperson, this report lists every item sold within a range of dates.

See also
Sales Ledger reports 



Analyse Sales Report [Salesperson - vs. Last Year]
This report compares this years working sales for specific salespeople to working sales for the same accounting 
period last year.

See also
Sales Ledger reports 



Analyse Sales Report [Salesperson Spreadsheet]
This report displays salesperson working sales for multiple accounting periods in spreadsheet format.

See also
Sales Ledger reports 



Customer Payment History Report 
This report displays closed (fully paid) sales, sorted by customer. It also notes the amount of each sale and the 
elapsed number of days from the sale date until final payment.

See also
Sales Ledger reports 



Customer Payments Report [Salesperson]
This report displays a list of cash payments made on sales within a range of dates, sorted and totalled by specific 
salespeople.

See also
Sales Ledger reports 



Sales Report [Customer Summary]
This report displays the original sale amount, the VAT collected and the current balance for all sales within a range of 
dates.

See also
Sales Ledger reports 



Sales Report [Customer Detail]
This report displays the invoice line items, including quantity sold, for all sales to the selected customers within a 
range of dates.

See also
Sales Ledger reports 



Sales Report [Salesperson Summary]
For each salesperson, this report displays every sale within a range of dates.

See also
Sales Ledger reports 



Sales Report [Salesperson Detail]
For each salesperson, this report displays every item sold within a range of dates.

See also
Sales Ledger reports 



Sales Report [Item Summary]
This report displays the total quantity and working sales, summarised by customer, for specific items within a range of
dates.

See also
Sales Ledger reports 



Sales Report [Item Detail]
This report displays the quantity and sale amount on sale-by-sale basis for selected items within a range of dates.

See also
Sales Ledger reports 



VAT Report [Summary]
This report displays a summary of the VAT on transactions within a range of dates, sorted by VAT Code. 

[Note: If you've purged transactions during the VAT period, add this total to the total from a pre-purged backup.]

See also
Chequebook reports 
Sales Ledger reports 
Purchase Ledger reports 



VAT Report [Summary - Cash]
This report displays a summary VAT on transactions for which money has been received for the selected payment 
date range, sorted by VAT Code.

[Note: If you've purged transactions during the VAT period, add this total to the total from a pre-purged backup.]

See also
Chequebook reports 
Sales Ledger reports 
Purchase Ledger reports 



VAT Report [Detail]
This report displays a list of transactions with the VAT for a range of dates, sorted by VAT Code. 

[Note: If you've purged transactions during the VAT period, add this total to the total from a pre-purged backup.]

See also
Chequebook reports 
Sales Ledger reports 
Purchase Ledger reports 



VAT Report [Detail - Cash]
This report displays a list of transactions with the VAT for which money has been received for the selected payment 
date range, sorted by VAT Code.

[Note: If you've purged transactions during the VAT period, add this total to the total from a pre-purged backup.]

See also
Chequebook reports 
Sales Ledger reports 
Purchase Ledger reports 



To Do List Report [Debtors]
This report displays the list of open debtors from the To Do List window.

See also
Sales Ledger reports 



To Do List Report [Recurring Sales]
This report displays the list of recurring sales transactions from the To Do List window. 

See also
Sales Ledger reports 



To Do List Report [Orders to be Delivered and Received]
This report displays the list of pending invoices and pending purchase orders from the To Do List window. 

See also
Sales Ledger reports 



Purchases Journal Report 
This report displays the transactions assigned to the Purchases Journal within a range of dates.

See also
Purchase Ledger reports 



Purchase Order Inquiry Report 
This report displays all transactions that affect the current balance of a purchasing transaction, including the original 
transaction, payments, discounts and deposits.

See also
Purchase Ledger reports 



Recurring Purchase Order Report 
This report displays the names of recurring purchasing transactions, dates last recorded, frequencies and dates next 
due.

See also
Purchase Ledger reports 



Aged Creditors Report [Summary]
For each supplier, this report displays a single line with the current balance due followed by the age of that balance.

See also
Purchase Ledger reports 



Aged Creditors Report [Detail]
For each supplier, this report displays the current balance due followed by a list of your open purchases, with the 
amount due in the appropriate ageing column.

See also
Purchase Ledger reports 



Creditors Reconciliation Report [Summary]
This report displays a list of creditors as of a specific date presented in summary (one line per supplier) format.

See also
Purchase Ledger reports 



Creditors Reconciliation Report [Detail]
This report displays a list of creditors as of a specific date presented in detail (one line per purchase debt) format.

See also
Purchase Ledger reports 



Purchases Report [Supplier Summary]
This report displays the original purchase amount, the VAT paid and the current balance for all purchasing 
transactions within a range of dates.

See also
Purchase Ledger reports 



Purchases Report [Supplier Detail]
This report displays purchase order line items, including quantity purchased, for all purchases from specific suppliers 
within a range of dates. 

See also
Purchase Ledger reports 



Purchases Report [Item Summary]
This report displays the total quantity bought and workings spent, summarised by supplier, for selected items within a 
range of dates.

See also
Purchase Ledger reports 



Purchases Report [Item Detail]
This report displays the quantity and purchase amount on an purchase-by-purchase basis for specific items within a 
range of dates.

See also
Purchase Ledger reports 



To Do List Report [Creditors]
This report displays a list of creditors from the To Do List window. 

See also
Purchase Ledger reports 



To Do List Report [Recurring Purchases]
This report displays a list of recurring purchasing transactions from the To Do List window. 

See also
Purchase Ledger reports 



To Do List Report [Expiring Discounts]
This report displays a list of expiring discounts from the To Do List window. 

See also
Purchase Ledger reports 



Stock Journal Report 
This report displays the transactions assigned to the Stock Journal within a range of dates.

See also
Stock reports 



Items List [Summary]
This report displays your items, including their main suppliers, units on hand, total value of items in stock and the 
current selling prices.

See also
Stock reports 



Items List [Detail]
This report displays your items and most corresponding item information.

See also
Stock reports 



Auto-Build Report 
This report displays the components and average costs for specific finished items.

See also
Stock reports 



Price List
This report displays a list of item prices.

See also
Stock reports 



Price Analysis Report 
This report displays the gross profit, percent margin and percent markup of your items.

See also
Stock reports 



Stock Count Sheet
This report is a helpful form for recording your physical stock.

See also
Stock reports 



Analyse Stock Report [Summary]
This report is your current order book. As the report is created, M.Y.O.B. looks at your pending invoices and pending 
purchase orders to determine items on hand, items on order from suppliers and items delivery to customers.



Analyse Stock Report [Detail]
This report displays a list of pending invoices and pending purchase orders  that include a specific item.

See also
Stock reports 



To Do List Report [Stock Alert]
This report displays the items that need reordering (or auto-building) from the To Do List window. 

See also
Stock reports 



Identifiers Report 
This report displays a list of your identifiers and their descriptions.

See also
Card File reports 



Address List
This report displays the card name, contact name, address and phone number for specific people and companies in 
your Card File.

See also
Card File reports 



Card File Report [Summary]
This report displays a list of all people and companies in your Card File.

See also
Card File reports 



Card File Report [Detail]
This report displays a comprehensive list of all people and companies in your Card File.

See also
Card File reports 



Card Inquiry Report 
This report displays all the transactions that are linked to specific people and companies in your Card File.

See also
Card File reports 



Contact Log Report 
This report displays your Contact Log for specific people and companies within a range of dates. It also contains 
totals of elapsed time.

See also
Card File reports 



To Do List Report [Overdue Contacts]
This report displays a list of overdue Contact Log reminders from the To Do List window. 

See also
Card File reports 



Nominal Ledger reports
Account Inquiry Report
Balance Sheet
Balance Sheet [Budget Analysis]
Balance Sheet [Budget Spreadsheet]
Balance Sheet [Last Year Analysis]
Balance Sheet [Spreadsheet]
Chart of Accounts Report [Detail]
Chart of Accounts Report [Summary]
Nominal Journal Report
Job Activity Report [Detail]
Job Activity Report [Summary]
Job Inquiry Report
Jobs List
Job Profit & Loss Report
Nominal Ledger Report [Detail]
Nominal Ledger Report [Summary]
Profit & Loss Statement
Profit & Loss Statement [% Sales Analysis]
Profit & Loss Statement [Budget Analysis]
Profit & Loss Statement [Budget Spreadsheet]
Profit & Loss Statement [Last Year Analysis]
Profit & Loss Statement [Spreadsheet]
Profit & Loss Statement [with Year to Date]
Profit & Loss Statement [with Last Year]
Recurring Nominal Journal Entries Report
Session Report
Trial Balance Report



Chequebook reports
Cash Disbursements Journal Report
Cash Flow Analysis Report
Cash Receipts Journal Report
Chequebook Register
Reconciliation Report
Recurring Cheques Report
Recurring Deposits Report
To Do List Report [Recurring Transactions]
VAT Report [Detail]
VAT Report [Summary]
VAT Report [Detail - Cash]
VAT Report [Summary - Cash]



Sales Ledger reports
Aged Debtors Report [Detail]
Aged Debtors Report [Summary]
Analyse Sales Report [Customer]
Analyse Sales Report [Customer Spreadsheet]
Analyse Sales Report [Customer - vs. Last Year]
Analyse Sales Report [Item]
Analyse Sales Report [Item Spreadsheet]
Analyse Sales Report [Item - vs. Last Year]
Analyse Sales Report [Salesperson]
Analyse Sales Report [Salesperson Spreadsheet]
Analyse Sales Report [Salesperson - vs. Last Year]
Customer Payment History Report
Customer Payments Report [Salesperson]
Debtors Reconciliation Report [Detail]
Debtors Reconciliation Report [Summary]
Invoice Inquiry Report
Recurring Sale Report
Sales Journal Report
Sales Report [Customer Detail]
Sales Report [Customer Summary]
Sales Report [Item Detail]
Sales Report [Item Summary]
Sales Report [Salesperson Detail]
Sales Report [Salesperson Summary]
To Do List Report [Orders to be Delivered and Received]
To Do List Report [Debtors]
To Do List Report [Recurring Sales]
VAT Report [Detail]
VAT Report [Summary]
VAT Report [Detail - Cash]
VAT Report [Summary - Cash]



Purchase Ledger reports
Aged Creditors Report [Detail]
Aged Creditors Report [Summary]
Creditors Reconciliation Report [Detail]
Creditors Reconciliation Report [Summary]
Purchase Journal Report
Purchase Order Inquiry Report
Purchases Report [Supplier Detail]
Purchases Report [Supplier Summary]
Purchases Report [Item Detail]
Purchases Report [Item Summary]
Recurring Purchase Order Report
To Do List Report [Expiring Discounts]
To Do List Report [Creditors]
To Do List Report [Recurring Purchases]
VAT Report [Detail]
VAT Report [Summary]
VAT Report [Detail - Cash]
VAT Report [Summary - Cash]



Stock reports
Analyse Stock Report [Detail]
Analyse Stock Report [Summary]
Auto-Build Report
Items List [Detail]
Items List [Summary]
Price Analysis Report
Price List
Stock Count Sheet
Stock Journal Report
To Do List [Stock Alert]



Card File reports
Address List
Card File Report [Detail]
Card File Report [Summary]
Card Inquiry Report
Contact Log Report
Identifiers Report
To Do List Report [Overdue Contacts]



Date
Enter the date of this transaction.

Transaction dates are used to sort your lists of transactions; the oldest transaction date appears first in the 
Transaction Journal window.

Dates that occur before your conversion date or in a previous financial year cant be used. 



Save Recurring button
Click this button to open the Save Recurring Transaction window, where you can duplicate this transaction for 
repeated use in the future.

This button appears only if youre not already using a recurring transaction.



Use Recurring button
Click this button to open the Select a Recurring Transaction window, where you can select, change or delete an 
existing recurring transaction.

This button appears only if youre not already using a recurring transaction.



Dont Record button
Click this button if you dont want to use the recurring transaction you selected. The transaction wont be recorded, but 
will remain in the list of recurring transactions that you can use.

This button appears only if youre using a recurring transaction.



Pending button
Click this button if you want to save this transaction as a pending transaction. When you click this button, the 
transaction will be placed in the Pending File.



All button
Click this button to select everything in the list.



Phone button
Click this button to dial the telephone number associated with the card displayed in this window.

You can use this feature only if a modem is properly connected to your computer and if you've marked the I Have a 
Modem for Autodialing selection and selected the proper modem port in the Preferences window.

See also

Entering telephone numbers for modem use 



None button
Click this button to deselect everything in the list.



Print button
Click this button to print the contents of this window.



Journal button
Click this button to display the Transaction Journal window, which contains summary information about transactions 
youve entered in the M.Y.O.B. system.



New button
Click this button to begin creating a new entry in this window.



Cancel button
Click this button to clear the entries you made in this window and close the window.



Close button
Click this button to close this window.



Record button
Click this button to record the transaction youve made in this window.



Record Reversal button
Click this button to record a reverse transaction.



OK button
Click this button to accept the entries youve made in this window.



Auto-Build Stock window
The Auto-Build Stock window allows you to quickly increase the quantity of finished items. Using this window and 
auto-build information you entered in the Auto-Build Info window, M.Y.O.B. automatically creates stock transfer 
transactions that increase finished item quantities and decrease the quantities of the components used to create 
them.

Fields in this window:

Cancel button
Item No. column
Name column
Net on Hand column
None button
On Hand column
Pending column
Qty. to Build column



Item No. column
This column displays the numbers of all items that have had auto-build information set up for them in the Auto-Build 
Info window. 



Name column
This column displays the names of all items that have had auto-build information set up for them in the Auto-Build Info
window.



On Hand column
This column displays the current quantities in M.Y.O.B. of all items that have had auto-build information set up for 
them in the Auto-Build Info window.



Pending column
This column displays the pending quantities in M.Y.O.B. of all items that have had auto-build information set up for 
them in the Auto-Build Info window. Pending quantities are calculated by subtracting the quantity of items on pending 
invoices from the quantity of items on pending purchases.



Net on Hand column
This column displays the net quantities in M.Y.O.B. of all items that have had auto-build information set up for them in
the Auto-Build Info window. A net quantity is calculated by adding an amount in the On Hand column to its 
corresponding amount in the Pending column.



Qty. to Build column
Enter the quantity of finished items you want to build, or accept the default quantity, which is the amount of items 
thats needed to raise the items quantity above the minimum level you set for the item in the Item Information window.



None button
Click this button to return the numbers in the Qty to Build column to zero.



Build Items button
Click this button to automatically build the items you designated in the Qty to Build column of this window. The Stock 
Transfers window will appear, displaying the stock transfer transaction that was created. To complete the auto-build 
process, click Record in the Stock Transfers window.



Bill Payments window
The Bill Payments window allows you to assign payments to your outstanding purchasing balances and record 
deposits on pending purchase orders.

Fields in this window:

Amount
Amount Applied column
Amount column
Balance
Bank accounts list
Cancel button
Cheque No.
Date
Date column
Discount column
Finance Charge
Handwritten
Journal button
Memo
New button
Print button
Purchase No. column
Record button
Status column
Supplier
Total Owed column



Bank accounts list
Select the bank account you want to use to make a payment.

The accounts in this list were assigned bank privileges in the Edit Accounts window.



Balance
This field displays the current balance of the bank account you selected in the left-hand corner of the window. If you 
wish to display the Inquiry Register window to view more detailed information about the bank account, click the zoom 
arrow.



Supplier
Enter the name of the supplier whose transactions you wish to apply your payment to. If you wish to view detailed 
information about the supplier, click the zoom arrow to display the Card File Entry window.

After you enter a supplier name, all purchases youve conducted with that supplier are displayed. Open purchases are
displayed at the top of the list, followed by pending purchase orders and then by closed purchases. 



Handwritten
Mark this selection if you dont intend to print this cheque using M.Y.O.B.

When you mark this selection, M.Y.O.B. will record the cheque as printed; when you select Unprinted Cheques Only 
in the Print Cheques window, this cheque wont be printed.

If youre viewing cheque thats been printed, this selection will be already marked.



Cheque No.
Enter the number of the cheque you wish to print, or accept the default cheque number, which is one number higher 
than the last cheque you wrote from this bank account.

If you enter a different cheque number in this field, the next cheque number from this bank account will increment by 
one from the number you enter.



Date
Enter the date of the cheque.

Dates that occur before your conversion date or in a previous financial year cant be used. 



Amount
Enter the total amount of the cheque.

When you save this cheque, the balance of the bank account you selected in the left-hand corner of the window will 
be decreased by the amount you enter here. 



Memo
Enter a description of the transaction. This description will appear on various M.Y.O.B. reports, as well as the Cash 
Disbursements Journal. If you dont enter anything in this field, the first line of the box below the Supplier field will 
appear in the Cash Disbursements Journal.

We suggest you use the word "Payment" in the memo to remind you of the nature of the transaction.



Purchase No. column
This column displays the numbers assigned to the purchasing transactions entered in the Purchases window. 



Status column
This column displays the status of each of the purchasing transactions in the list. 

OPEN: Purchasing transactions with a positive balance.
CLOSED: Purchasing transactions with a zero balance.
PENDING: Purchase orders assigned a Pending status in the Purchases window.

If you want to open the Inquiry Register window to view more detailed information about a specific purchasing 
transaction, click the zoom arrow next to the purchasing transactions status.



Date column
This column displays the date each of the purchasing transactions in the list was recorded.



Amount column
This column displays the current amount due for each of the purchasing transactions in the list.



Discount column
Enter early-payment discounts for each of the purchasing transactions in this list, or accept the default amounts, 
which were entered for this supplier in the Credit Terms window.

Enter a discount amount only when youre settling the entire remaining balance of a purchasing transaction. If you 
enter a discount on a partial payment of a purchases remaining balance, that discount wont be recorded. For 
example, if you enter a £2 discount on £100 purchase, the total due amount is £98. However, if you apply only £75 to 
the purchase, the discount wont be calculated; £25 will be the remaining balance of the purchase.



Total Owed column
This column displays the total amount owed for each purchasing transaction in the list.



Amount Applied column
Enter the amount of the payment you want to apply to each purchasing transaction in the list, or accept the default 
amounts that appear in this column. The default amount that appears in this column is either the total amount of one 
purchases remaining balance or the remainder of the payment amount.

You can distribute the payment amount to more than one purchasing transaction.



Finance Charge
Enter the amount you wish to apply to your finance charges with this supplier.

When you click Record, the balance of the account you entered in the Expense Account for Late Charges field of the 
Creditors Control Linked Accounts window will be increased.



Record button
Click this button to record the application of the payment amount in the Cash Disbursements Journal, decrease your 
linked creditors bank account and decrease your outstanding balance with the supplier. If the payment was applied to
a pending purchase order, your linked creditors deposits account is increased.



Chart of Accounts window
The Chart of Accounts window allows you to set up and maintain the accounts that you use in your business.

This window contains a list of your accounts, displayed in a way that looks like file folder tabs. Each tab allows you to 
view a list of accounts for one of M.Y.O.B.s eight account types. To view the accounts assigned to a specific account 
type, click on that account types tab.

Fields in this window:

Account Name column
Assets tab
Balance column
Close button
Cost of Sales tab
Edit button
Capital tab
Expenses tab
History button
Income tab
Level Down button
Level Up button
Liabilities tab
Linked column
New button
Other Expenses tab
Other Income tab
Print button
Type column



Assets tab
Asset accounts track things a business owns, such as the money in a bank account, computers and office buildings. 
Money owed to a business is also considered an asset.

Current assets can be converted into cash (including cash itself) within a relatively short period of time (usually less 
than a year).

Fixed assets usually take more than a year to convert into cash. An office building can be considered a fixed asset.

Asset accounts are assigned the prefix 1 in M.Y.O.B., and normally have a debit balance.



Liabilities tab
Liability accounts track things a business owes, such as a working capital loan. Money owed by a business for 
purchases is also considered a liability.

Current liabilities are due within a relatively short period of time (usually less than a year).

Long-term liabilities usually arent due for more than a year.

Liability accounts are assigned the prefix 2 in M.Y.O.B., and normally have a credit balance.



Income tab
Income accounts, also known as "revenue accounts," track the increase in capital from the sale of items or services.

Income accounts are assigned the prefix 4 in M.Y.O.B., and normally have a credit balance.



Expenses tab
Expense accounts track the cost incurred when a business attempts to create income.

Expense accounts are assigned the prefix 6 in M.Y.O.B., and normally have a debit balance.



Capital tab
Capital accounts track a companys net worth. A companys capital, also known as "owners capital" or "capital,"    is 
calculated by subtracting its liabilities from its assets. Some common capital accounts are current year earnings, 
retained earnings and shareholders capital.

Capital accounts are assigned the prefix 3 in M.Y.O.B., and normally have a credit balance.



Cost of Sales tab
Cost of sales accounts track the amount paid to sell an item or service. The amounts tracked by cost of sales 
accounts are sometimes referred to as "cost of goods sold" amounts.

Cost of sales amounts are subtracted from income amounts to determine gross profit.

Cost of sales accounts are assigned the prefix 5 in M.Y.O.B., and normally have a debit balance.



Other Income tab
Other income accounts track the income that isnt directly related to a companys operations, such as interest income.

Other income accounts are assigned the prefix 8 in M.Y.O.B., and normally have a credit balance.



Other Expense tab
Other expense accounts track the expenses that arent directly related to a companys operations, such as loan 
interest and fines.

Other expense accounts are assigned the prefix 9 in M.Y.O.B., and normally have a debit balance.



Account Name column
This column displays the accounts in the category you selected at the top of the window. If you want to view more 
detail about a specific account, click the zoom arrow next to the accounts name.



Type column
This column displays the type of each account in the list. The three types of accounts are described below. These 
types are assigned to accounts in the Edit Accounts window.

HEADER: Header accounts are used as titles of groups of accounts.

Header accounts are used only for grouping accounts of a similar purpose. Typically, header accounts have detail 
accounts "under" them; that is, detail accounts are assigned to specific header accounts. In the list in the left-hand 
side of the Chart of Accounts window, header accounts appear in bold type, and their detail accounts appear below 
them in plain type at the next level.

Transaction amounts cant be assigned (posted) to header accounts - only to detail accounts.

Header accounts arent required in M.Y.O.B., except for the eight Level 1 accounts (asset, liability, income, expense, 
capital, cost of sales, other income and other expense). Header accounts you create must be either Level 2 or Level 
3.

DETAIL: Detail accounts are the M.Y.O.B. accounts that have transactions assigned to them.

Each detail account is assigned to the header account that appears directly above it in the list in the left-hand side of 
the Chart of Accounts window. Detail accounts appear in plain type, and header accounts appear in bold type.

Transaction amounts can be assigned (posted) to detail accounts; that is, when you enter a transaction in M.Y.O.B., 
you can enter the number of a detail account. The amount of the transaction will then be included in the balance of 
the detail account.

Detail accounts can be Level 2, Level 3 or Level 4.

Note: The capital account called Current Year Earnings is a detail account, but it cant have transactions assigned to 
it. This account, used by M.Y.O.B. to record your companys profit or loss, uses your year-to-date profit or loss as its 
current balance.

DETAIL BANK: Detail bank accounts are the M.Y.O.B. accounts whose funds you can use when you write cheques.

Accounts with bank privileges appear in lists in transaction windows throughout the M.Y.O.B. system. Each time you 
write a cheque in M.Y.O.B., you can select the bank account you want to use.

Each detail bank account is assigned to the header account that appears directly above it in the list in the left-hand 
side of the Chart of Accounts window. Detail bank accounts appear in plain type, and header accounts appear in bold 
type.

Detail bank accounts can be Level 2, Level 3 or Level 4.

Only asset or liability accounts can be detail bank accounts.



Linked column
This column displays a mark next to each account in the list thats linked - in other words, those accounts that are 
automatically affected when a particular type of transaction is entered in M.Y.O.B. For example, one asset account is 
linked to all sales transactions that result in money owed to you; each time you enter a sales transaction thats not 
fully paid at the time of the sale, the amount youre owed will automatically be added to this accounts balance. 

To view the types of transactions an account is linked to, click the zoom arrow next to the accounts name in the 
Account Name column. In the Edit Accounts window, the Linked Account for field describes what the account is linked
to.



Balance column
This field displays the current balance of this account. If this is a header account, this field displays the sum of all the 
detail accounts assigned to it.

If this is an asset, liability or capital account, the amount shown here is the value of the account. If this is an income, 
expense, cost of sales, other income or other expense account, the amount shown here is the total of all activity with 
the account since the beginning of the current financial year.

Note: If youre viewing the capital account named Current Year Earnings, the current balance displayed is your 
companys year-to-date profit or loss amount.



Level Up button
Click this button to move this account up one level.

You can assign Level 2, Level 3 or Level 4 to detail accounts. Header accounts can be assigned either Level 2 or 
Level 3.

Level 1 is permanently assigned to each of the eight account types in M.Y.O.B., and cant be assigned to any other 
account.

Depending upon the account thats currently displayed, you can change the level of an account. For example, if the 
account is a Level 3 section header account with detail accounts under it, you wont be able to change its level.



Level Down button
Click this button to move this account up one level.

You can assign Level 2, Level 3 or Level 4 to detail accounts. Header accounts can be assigned either Level 2 or 
Level 3.

Level 1 is permanently assigned to each of the eight account types in M.Y.O.B., and cant be assigned to any other 
account.

Depending upon the account thats currently displayed, you can change the level of an account. For example, if the 
account is a Level 3 section header account with detail accounts under it, you wont be able to change its level. 
Similarly, if the account is a Level 3 detail account with a Level 2 section header account above it, you wont be able 
to change its level down to Level 4.



History button
Click this button to open the Account Historical Balances window, where you can view and enter balances of the 
detail accounts in your chart of accounts from previous months.



New button
Click this button to open the Edit Accounts window, which allows you to create a new account in your chart of 
accounts.



Edit button
Click this button after highlighting an account in the list to open the Edit Accounts window, which allows you to make 
changes to the account you highlighted.



Comments and Delivery Methods window
The Comments and Delivery Methods window allows you to set up the ways items are typically delivered by you and 
to you, and to set up a standard list of greetings, memos, reminders and any other salutations you often include on 
invoices and purchase orders. The methods you enter in this window can be selected in the Sales and Purchases 
windows and printed on invoices and purchase orders, if you wish.

Fields in this window:

Comments tab
Edit button
List of comments or delivery methods
New button
OK button
Delivery Methods tab



Comments tab
Click this tab to display all comments currently in the M.Y.O.B. system.



Delivery Methods tab
Click this tab to display all delivery methods currently in the M.Y.O.B. system.



List of comments or delivery methods
The list displays all the comments or delivery methods in the M.Y.O.B. system, depending upon which tab you 
selected at the top of the list.

If you want to change a comment or delivery method, highlight it and click Edit.

If you want to delete a comment or delivery method, highlight it and select Delete Comment or Delete Delivery 
Method from the Edit menu.

If you want to create a new comment or delivery method, click New.



New button
Click this button to open either the New Comment window or New Delivery Method window, depending upon whether 
youre viewing comments or delivery methods in this window.



Edit button
Click this button after highlighting a comment or delivery method in the list to display either the Edit Comment window
or Edit Delivery Method window, where you can change the name of the comment or delivery method.

If you want to delete a comment or delivery method, highlight it and select Delete Comment or Delete Delivery 
Method from the Edit menu.



Count Stock window
The Count Stock window allows you to quickly adjust the quantities of your stock items recorded in M.Y.O.B. so they 
match the actual quantities you have in stock.

The list displays all stock items in the M.Y.O.B. system - in other words, the items for which you selected I Stock This 
Item in the Item Information window. 

Fields in this window:

Adjust Stock button
Cancel button
Counted column
Difference column
Item No. column
Name column
On Hand column
Print Button



Item No. column
This column displays the numbers of all stock items in the M.Y.O.B. system.



Name column
This column displays the names of all stock items in the M.Y.O.B. system.



On Hand column
This column displays the current quantities in M.Y.O.B. of all stock items in the M.Y.O.B. system.

This quantity is displayed in individual units of measure, not buying units of measure or selling units of measure. For 
example, if one 24-can case of soda is in stock, 24 will appear as the on-hand quantity.



Counted column
Enter the actual quantities of your stock items in this column.

Enter this quantity in individual units of measure, not buying units of measure or selling units of measure. For 
example, if you have two 24-can cases of soda in stock, enter 48 as the counted quantity.



Difference column
This column displays the quantity difference between the amounts currently recorded in M.Y.O.B. and your actual 
stock amounts - in other words, the amount displayed in the On Hand column minus the amount displayed in the 
Counted column.



Adjust Stock button
Click this button to begin the process of adjusting quantities for items with amounts in the Counted column. The 
Adjustment Information window appears.

At this point, the next step you follow depends upon whether youre setting up Stock or youre making a routine 
quantity adjustment. If youre setting up Stock, refer to the Getting Started manual for more information about properly
setting up Stock.

If you're making a routine adjustment of your stock quantities, use the Adjustment Information window to enter the 
number of the expense account you wish to use to track the expense of quantities that are no longer in your stock. 
Click Continue. The Stock Adjustments window appears, displaying the stock adjustment transaction that was created
to make your M.Y.O.B. records match your actual quantities. To complete the adjustment process, click Record in the 
Stock Adjustments window.



Print button
Click this button to print the Stock Count Sheet. This is a helpful form for recording your physical stock.



Customer Payments window
The Customer Payments window allows you to assign customer payments to their outstanding sales balances and 
record deposits on pending invoices.

Fields in this window:

Amount Applied column
Amount column
Amount Received
Cancel button
Customer
Date
Date column
Discount column
Finance Charge
ID No.
Invoice No. column
Journal button
Memo
New button
Record button
Status column
Total Due column



Customer
Enter the name of the customer whose payment you wish to apply, or click the search icon to display a list of 
customers to choose from. If you wish to view detailed information about the customer, click the zoom arrow to 
display the Card File Entry window.

After you enter a customer name, all sales transactions for the customer are displayed. Open sales are displayed at 
the top of the list, followed by pending invoices and then by closed sales. 



ID No.
Using up to eight characters, enter the journal number you want to assign to this transaction, or accept the default 
journal number. This number will be recorded in the Sales Journal.

We recommend that you use the default journal number, because it ensures that you dont use duplicate journal 
numbers, which may cause confusion in your recordkeeping. If you want to assign a different number, consider 
leaving the SJ prefix assigned to the number, so its easy for you to distinguish the transaction as a Sales Journal 
transaction.



Amount Received
Enter the amount of the payment.



Memo
Using up to 255 characters, enter a description of the transaction. This description will appear on various M.Y.O.B. 
reports, as well as the Sales Journal.



Invoice No. column
This column displays the numbers assigned to the customers sales transactions, entered in the Sales window. 



Status column
This column displays the status of each of the sales transactions in the list. 

OPEN: Sales transactions with a positive balance.
CLOSED: Sales transactions with a zero balance.
PENDING: Invoices assigned a Pending status in the Sales window.

If you want to open the Inquiry Register window to view more detailed information about a specific sales transaction, 
click the zoom arrow next to the sales transactions status.



Date column
This column displays the date each of the sales transactions in the list was recorded.



Amount column
This column displays the current amount due for each of the sales transactions in the list.



Discount column
Enter early-payment discounts for each of the sales transactions in this list, or accept the default amount, which was 
entered for this customer in the Credit Terms window.

Enter a discount amount only when youre settling the entire remaining balance of a sales transaction. If you enter a 
discount on a partial payment of a sales remaining balance, that discount wont be recorded. For example, if you enter
a £2 discount on £100 sale, the total due amount is £98. However, if you apply only £75 to the sale, the discount wont
be calculated; £25 will be the remaining balance of the sale.



Total Due column
This column displays the total amount due for each sales transaction in the list. This amount is calculated by 
subtracting the amount in the Discount column from the amount in the Amount column.



Amount Applied column
Enter the amount of the payment you want to apply to each sales transaction in the list, or accept the default amounts
that appear in this column. The default amount that appears in this column is either the total amount of one sales 
remaining balance or the remainder of the payment amount.

You can distribute the payment amount to more than one sales transaction.

If you apply more payment to a sales transaction than is due, a credit note will be created when you click Record.



Finance Charge
Enter the amount you wish to apply to the customers finance charges.

When you click Record, the balance of the account you entered in the Income Account for Late Charges field of the 
Sales Ledger Linked Accounts window will be increased.



Record button
Click this button to record the application of the payment amount in the Cash Receipts Journal, increase your linked 
debtors bank account and decrease the customers outstanding balance. If the payment was applied to a pending 
invoice, your linked debtors deposits account is increased.



Nominal Journal Entry window
The Nominal Journal Entry window allows you to enter transactions that arent specific to the Chequebook, Sales 
Ledger, Purchase Ledger and Stock Control Command Centres.

Fields in this window:

Acct No. column
Cancel button
Credit column
Debit column
Don't Record button
Nominal Journal No.
Job column
Journal button
Memo
Name column
Out of Balance
Record button
Save Recurring button
Total
Use Recurring button



Nominal Journal No.
Using up to eight characters, enter the journal number you want to assign to this transaction, or accept the default 
journal number. This number will be recorded in the Nominal Journal.

We recommend that you use the default journal number, because it ensures that you dont use duplicate journal 
numbers, which may cause confusion in your recordkeeping. If you want to assign a different number, consider 
leaving the NJ prefix assigned to the number, so its easy for you to distinguish the transaction as a Nominal Journal 
transaction.



Memo
Using up to 255 characters, enter a description of the transaction. This description will appear on various M.Y.O.B. 
reports, as well as the Nominal Journal.



Acct No. column
Enter the number of the account you want to assign this transaction to, or click the search icon to display a search list
of accounts you can select from. From the list, you can also create a new account to assign the transaction to.



Name column
This column displays the name of the account.



Debit column
If you want to assign a debit amount to the account you entered in the Acct No. column, enter that amount in this 
column. If you wish to assign a credit amount for the account, press TAB to move the highlight to the Credit column. 

For each line, you can enter an amount in either the Debit column or the Credit column only; you cant enter amounts 
in both columns in the same line. (In other words, you cant debit and credit the same account on one line.) You can, 
however, use the same account on multiple lines.

Negative numbers cant be entered in this window. If you want to record a negative debit amount, enter a positive 
amount of the same number in the Credit column. Likewise, if you want to record a negative credit amount, enter a 
positive amount of the same number in the Debit column.

If the Out of Balance field at the bottom of the window lists an amount other than £0.00, this field will display a default 
amount that matches the Out of Balance amount. You can change this amount, if you wish.

If you dont want to enter an amount in either the Debit or the Credit column, move to the next line. Keep in mind, 
however, that lines without amounts arent saved as part of a journal entry.



Credit column
If you want to assign a credit amount to the account you entered in the Acct No. column, enter that amount in this 
column. If you wish to assign a debit amount for the account, press TAB to move the highlight back to the Debit 
column. 

For each line, you can enter an amount in either the Debit column or the Credit column only; you cant enter amounts 
in both columns in the same line. (In other words, you cant debit and credit the same account on one line.) You can, 
however, use the same account on multiple lines.

Negative numbers cant be entered in this window. If you want to record a negative debit amount, enter a positive 
amount of the same number in the Credit column. Likewise, if you want to record a negative credit amount, enter a 
positive amount of the same number in the Debit column.

If the Out of Balance field at the bottom of the window lists an amount other than £0.00, this field will display a default 
amount that matches the Out of Balance amount. You can change this amount, if you wish.

If you dont want to enter an amount in either the Debit or the Credit column, move to the next line. Keep in mind, 
however, that lines without amounts arent saved as part of a journal entry.



Job column
Enter the number of the job to which you wish to assign this amount, or click the search icon to display a search list of
jobs to select.

If you need to assign an amount from one account to more than one job, use multiple lines to record the transaction. 
For example, assume you want to credit your Widget Sales account £100, but you want to assign £30 to job 12 and 
£70 to job 43. To do this, enter the Widget Sales account number in the Acct No. column, then enter £30 in the Credit 
column and 12 in the Job column. Move to the next line, enter the Widget Sales account number again, enter £70 in 
the Credit column and 43 in the Job column.



Total
This field displays the total amounts of the Debit and Credit columns entered above. If the amounts are the same, you
can click Record to save the transaction.



Out of Balance
This field displays the amount by which this journal entry is out of balance. If the amount appears below the Debit 
column, the debit amount is larger than the credit amount. If the amount appears below the Credit column, the credit 
amount is larger than the debit amount.

To save a journal entry, the total debit amount must equal the total credit amount - in other words, no amount should 
appear in the Out of Balance field if you want to save a journal entry.



Identifiers window
The Identifiers window allows you to enter descriptions for the identifiers you use throughout the M.Y.O.B. system. 
For each letter of the alphabet, you can enter a line of text that can be used to group people or companies that exist 
in your Card File. When you print reports (including mailing labels), you can restrict the reports to print only cards that
use a specific identifier or set of identifiers.

When you create a new card in the Card File Entry window, you can assign up to 10 identifiers to each card. For 
example, you could enter Cash for the letter C in this window; then, for each customer who should pay cash only for 
their transactions, you can enter C in the Identifiers field in the Card File Entry window.

Fields in this window:

Identifiers list
OK button
Print button



Identifiers list
Enter a description for this letter of the alphabet in this field.



Inquiry Register window
The Inquiry Register window allows you to view summary information about each of your companys accounts, sales 
transactions, purchasing transactions, cards and jobs. This window also allows you to zoom to the windows in which 
the individual topics were entered.

To view information about a topic, click its corresponding tab at the top of the window.

The other available views -    Account View, Card View, Invoice View, Purchase View and Job View- are very similar to
each other.

Fields in this window:

Account
Account activity amounts
Account tab
Card tab
Close button
Date column
Dated From/To
Debit/Credit columns
ID No. column
Invoice tab
Job column
Job tab
Memo column
Print button
Purchase tab
Source Journal list
Src column



Account tab
Account View allows you to view summary information about each of the transactions that makes up the current 
balance of individual accounts. This window also allows you to zoom to the transaction entry windows in which 
individual transactions were entered.



Card tab
Card View allows you to view summary information about each person and company in your Card File. This window 
also allows you to zoom to the Card File Entry window, where the card information was entered.



Invoice tab
Invoice View allows you to view summary information about activity for individual sales transactions. This window 
also allows you to zoom to the transaction entry windows in which individual transactions were entered.

To display Invoice View, click Inquiry in any command centres M.Y.O.B. Analyst, then click the Invoice tab. You can 
also open this window by clicking the zoom arrow in the Status column of the Apply to Sale View of the Settle Returns
and Credits window, or in the Customer Payments window.



Purchase tab
Purchase View allows you to view summary information about activity for individual purchasing transactions. This 
window also allows you to zoom to the transaction entry windows in which individual transactions were entered.

To display Purchase View, click Inquiry in any command centres M.Y.O.B. Analyst, then click the Purchase tab. You 
can also open this window by clicking the zoom arrow in the Status column of the Apply to Purchase View of the 
Settle Returns and Debits window, or in the Bill Payments window.



Job tab
Job View allows you to view summary information about transaction activity for individual jobs. This window also 
allows you to zoom to the transaction entry windows in which individual job-related transactions were entered.



Account
Enter the number of the account whose detail you wish to view, or click the search icon to display a search list of 
cards to choose from.

If an account number is displayed on this field and you want to view more information about the account, click the 
zoom arrow to open the Chart of Accounts window.



Source Journal list
This list displays the current journal displayed. If you wish, you can select a different journal to view, or view entries in
all journals in the M.Y.O.B. system.



Dated From/To
These fields display the date range in the current month. If you wish, you can enter different dates to view 
transactions from a different period of time.



ID No. column
This column displays the identifying numbers of the transactions in the list. These numbers were entered in the ID 
fields of the windows in which you entered the transactions, such as Cheque No., PO No. and Stock Journal No..

If you wish to view the window in which a specific transaction was entered, click the zoom arrow next to the 
transactions ID No..



Src column
This column displays the abbreviations of the source journals for the transactions in the list. The abbreviations that 
can appear in this column include:

CR Cash Receipts Journal
CD Cash Disbursements Journal
NJ Nominal Journal
IJ Stock Journal
PJ Purchasing Journal
SJ Sales Journal

This column appears only if you selected All from the Source Journal list.



Date column
This column displays the date each transaction in the list was recorded.



Memo column
This column displays the descriptions of each transaction in the list. This description is typically entered in a Memo 
field in transaction entry windows.



Debit/Credit columns
These columns display the amounts by which this account is debited and credited by the transactions in the list.



Job column
This column displays the jobs to which the transactions in the list are assigned.



Account activity amounts
This box contains a summary of the transaction activity that affect this account for the time period you specified at the
top of the window.

The Beginning Balance field that appears here is from either the first day of your conversion month, the first day of 
your financial year (if youve used the Start a New Financial Year windows) or the day the transactions from this 
account were last purged.



Stock Adjustments window
The Stock Adjustments window allows you to set beginning stock item quantities and values when you start using 
M.Y.O.B., as well as enter transactions affecting quantities and value of stock items.

Fields in this window:

Account column
Amount column
Cancel button
Date
Stock Journal No.
Item No. column
Job column
Journal button
Memo
Name column
Quantity column
Record button
Unit Cost column



Stock Journal No.
Enter the journal number you want to assign to this transaction, or accept the default journal number. This number will
be recorded in the Stock Journal.

We recommend that you use the default journal number, because it ensures that you dont use duplicate journal 
numbers, which may cause confusion in your recordkeeping. If you want to assign a different number, consider 
leaving the IJ prefix assigned to the number, so its easy for you to distinguish the transaction as a stock transaction.



Memo
Enter a description of the stock transaction. This description will appear on various M.Y.O.B. reports, as well as the 
Stock Journal.

A suggested entry for this field is the quantity information for this transaction. When you record this transaction, only 
the value of the stock items affected will be recorded in the Stock Journal, not the actual quantities. If you enter the 
quantity an item is increased or decreased in this field, you can view the quantity changes in the Stock Journal. For 
example, if you reduce widgets by 12 units, you may want to enter "-12 widgets" in this field; this description will then 
appear in the Stock Journal.



Item No. column
Enter the item number of the stock item whose quantity you want to adjust, or click the search icon to display a 
search list of items you can select from.

Only stock items - items for which you selected I Stock This Item in the Item Information window - can be entered in 
this window.



Name column
This field displays the name of the item you entered in the Item No. field.



Quantity column
Enter the quantity of the item you entered in the Item No. field that should be increased or decreased. To increase the
quantity of an item, enter a positive number; to decrease the quantity of an item, enter a negative number by entering 
a hyphen before the amount.

Enter the quantity in individual units of measure, not buying units of measure or selling units of measure. For 
example, if you increase your soda quantity by one case of cans (24 cans), enter 24 in this field.

You cant decrease the quantity of stock items to less than zero units.



Unit Cost column
Enter the value of each item added to or subtracted from stock, or accept the default, which is the average cost of the
item - the total cost of the items quantities divided by the number of units on hand.



Amount column
Enter the total value of all the items added to or subtracted from stock, or accept the default, which is the amount 
entered in the Quantity field multiplied by the amount entered in the Unit Cost field. If you enter an amount other than 
the default amount, the Unit Cost field will change to reflect the different amount.

If the amount that appears in this field is a positive number, the total value of your stock is increased and the 
appropriate asset account (assigned to the item in the Asset Account for Item Stock field in the Item Information 
window) is increased.

If the amount that appears in this field is a negative number, the total value of your stock is decreased and the 
appropriate asset account (assigned to the item in the Asset Account for Item Stock field in the Item Information 
window) is decreased.



Account column
Enter the account number to which you wish to allocate this items change in stock.

This account, known as an allocation account, is used to balance this transaction, and can often be used as an 
explanation of why the stock adjustment occurred. A typical allocation account is a Shrinkage account, which explains
that an items quantities were reduced due to shrinkage of some sort.

If the number that appears in the Amount field is a positive number, the total value of your stock is increased and the 
appropriate asset account (assigned to the item in the Asset Account for Item Stock field in the Item Information 
window) is increased. The account you enter here will then be decreased.

If the number that appears in the Amount field is a negative number, the total value of your stock is decreased and 
the appropriate asset account (assigned to the item in the Asset Account for Item Stock field in the Item Information 
window) is decreased. The account you enter here will then be increased.



Job column
Enter the number of the job to which you wish to assign this items change in stock, or click the search icon to display 
a search list of jobs to select.



Stock Transfers window
The Stock Transfers window allows you to build finished items by increasing finished item quantities and decreasing 
the quantities of the components used to build the finished items. The purpose of this window is similar to the Auto-
Build Stock window, but it also provides more control over the details of the item-building process.

Fields in this window:

Amount column
Cancel button
Date
Stock Journal No.
Item No. column
Journal button
Memo
Name column
Out of Balance
Quantity column
Record button
Unit Cost column



Memo
Enter a description of the stock transaction. This description will appear on various M.Y.O.B. reports, as well as the 
Stock Journal.

You may consider entering the transactions quantity information in this field. When you record this transaction, only 
the value of the stock items affected will be recorded in the Stock Journal, not the actual quantities. If you enter the 
quantities that finished items are increased and components are decreased in this field, you can view these changes 
in the Stock Journal. For example, if you reduce boards by four units to create one shelf, you may want to enter "-4 
boards, 1 shelf" in this field; this description will then appear in the Stock Journal.



Item No. column
Enter the item number of the stock item you want to transfer, or click the search icon to display a search list of items 
to select from.

Only stock items - items for which you selected I Stock This Item in the Item Information window - can be entered in 
this window.



Name column
This field displays the name of the item you entered in the Item No. field.



Quantity column
Enter the quantity of the item you entered in the Item No. field that should be increased or decreased. To increase the
quantity of an item, enter a positive number; to decrease the quantity of an item, enter a negative number by entering 
a hyphen (-) before the amount.

If youre changing the quantity of a component, this amount should be a negative number. If youre changing the 
quantity of a finished item, this amount should be a positive number.

Enter the quantity in individual units of measure, not buying units of measure or selling units of measure. For 
example, if you increase your end table sets by one pair of end tables (two end tables), enter 2 in this field.

You cant decrease the quantity of stock items to less than zero units.



Unit Cost column
Enter the value of each item transferred to or from stock, or accept the default, which is the average cost of the item - 
the total cost of the items quantities divided by the number of units on hand.



Amount column
Enter the total value of all the items transferred to or from stock, or accept the default, which is the amount entered in 
the Quantity field multiplied by the amount entered in the Unit Cost field. If you enter an amount other than the default
amount, the Unit Cost field will change to reflect the different amount.

If the amount that appears in this field is a positive number, the total value of your stock is increased and the 
appropriate asset account (assigned to the item in the Asset Account for Item Stock field in the Item Information 
window) is increased.

If the amount that appears in this field is a negative number, the total value of your stock is decreased and the 
appropriate asset account (assigned to the item in the Asset Account for Item Stock field in the Item Information 
window) is decreased.

You cant decrease the value of stock items to less than £0.00.



Out of Balance
This field displays the amount the transaction is out of balance. Before you can record the transaction, this field must 
display £0.00. 



Item Information window
The Item Information window allows you to set up information about the items and services stored, sold and provided 
by your business.

Fields in this window:

No. of Items per Buying Unit
No. of Items per Selling Unit
Asset Account for Item Stock
AutoBuild button
Buying Unit of Measure
Cost of Sales Account
Expense Account for Tracking Costs
History button
I Buy This Item
I Stock This Item
I Sell This Item
Income Account for Tracking Sales
Item No.
Name
New button
Record button
Restock button
Selling Price
Selling Unit of Measure
Track Sales History
VAT Code When Bought
 VAT Code When Sold



Item No.
Enter a unique number to assign to a new item, or enter the number of an existing item to display that items 
information.

You can use numbers, letters and symbols in the item number.

If youre displaying an existing item record, you can change the item number.



Name
Enter the name of a new item.

If youre displaying an existing item record, you can change the item name.



I Buy This Item
Mark this selection if you purchase this item. When this selection is marked, you can record the item on a purchase 
order.

When you mark this selection and the I Stock This Item selection is unmarked, the Expense Account for Tracking 
Costs field will appear.



I Sell This Item
Mark this selection if you sell this item. When this selection is marked, you can record an item on an invoice, price an 
item in the Set Item Prices window and track an items sales history.

When you mark this selection, the Income Account for Tracking Sales field will appear.



I Stock This Item
Mark this selection if this item is a stock item. When this selection is marked, you can change an items stock 
quantities using the Stock Adjustments, Stock Transfers and Count Stock windows.

When you mark this selection, the Asset Account for Item Stock field will appear. If the I Buy This Item and I Sell This 
Item selections are also marked, the Cost of Sales Account field will also appear.



Asset Account for Item Stock
Enter the account number you use for tracking the total value of this item.

A default account number may appear in this field. If so, make sure the default account number is the correct account
you want to use.

This field appears only if the I Stock This Item selection is marked.



Income Account for Tracking Sales
Enter the account number you use for tracking the income you receive from the sale of stock items and service items.

A default account number may appear in this field. If so, make sure the default account number is the correct account
you want to use.

This field appears only if the I Sell This Item selection is marked. 



Cost of Sales Account
Enter the account number you use for tracking the costs associated with selling stock items.

A default account number may appear in this field. If so, make sure the default account number is the correct account
you want to use.

This field appears only if the I Sell This Item and I Stock This Item selections are marked.



Expense Account for Tracking Costs
Enter the account number you use for tracking the costs associated with purchasing non-stock items.

An example of an item you might use an expense account for is a pencil. Unless your business sells pencils, you 
probably dont track the exact number of pencils you have in stock and you want to assign purchase costs to an 
expense account such as "Office Expenses."

This field appears only if the I Buy This Item selection is marked and the I Stock This Item isnt marked.



Buying Unit of Measure
Enter the method by which this item is packaged when you purchase it.

Some typical units of measure include Each, Pair, Case, Gross, Hour and Day. These descriptions are printed on 
purchase orders. For example, assume one of your items is a lamp set thats always purchased in pairs; this item 
could be assigned a unit of measure of Pair. Then, if you purchased four lamp sets, youd purchase four pair of lamps,
or eight lamps.

This field appears only if the I Buy This Item selection is marked.



No. of Items per Buying Unit
Enter the number of units that comprise the unit of measure you entered in the Buying Unit of Measure field.

The entry you make in this field is used to determine how many items should be added to stock when you purchase 
one buying unit. For example, if you entered Pair in the Buying Unit of Measure field to indicate that you buy two units
of this item each time you buy it, you should enter 2 in this field. Then, for each pair of the item you buy, the quantity 
of the item will be increased by two.

This field appears only if the I Buy This Item and I Stock This Item selections are marked.



VAT Code When Bought
Enter the VAT code applicable when you purchase this item.

The VAT Code will automatically appear as a default on this items purchase orders.

This field appears only if the I Buy This Item selection is marked.



Selling Price
Enter the price at which you usually sell one selling unit of measure of this item. For example, if you sell cans of beer 
in cases, enter the price of one case of beer.

This field appears only if the I Sell This Item selection is marked.



Track Sales History
Mark this selection if you want to keep monthly sales totals, including unit and working figures, as well as cost of 
sales, for this item.

Totals are stored for the previous financial year and the current financial year. Click the Sales History button at the 
bottom of the window to enter historical sales figures. You can also use the Analyse Sales window to review the 
collected totals.

This field appears only if the I Sell This Item selection is marked.

Note: Sales history begins to accumulate only after youve marked this selection. Sales that occurred before this 
selection was marked will NOT be included in the items sales history.

Note: Sales history figures use considerable disk space. If you dont need to track sales for this item, be sure the 
selection isnt marked. 



VAT Code When Sold
Enter the VAT code applicable when you sell this item.

The VAT Code will automatically appear as a default on this items sales invoices.

This field appears only if the I Sell This Item selection is marked.



Selling Unit of Measure
Enter the method by which this item is packaged when you sell it.

Some typical units of measure include Each, Pair, Case, Gross, Hour and Day. These descriptions are printed on 
invoices. For example, assume one of your items is a lamp set thats always sold in pairs; this item could be assigned 
a unit of measure of Pair. Then, if you sold four lamp sets, youd sell four pair of lamps, or eight lamps.

This field appears only if the I Sell This Item selection is marked.



No. of Items per Selling Unit
Enter the number of units that comprise the unit of measure you entered in the Selling Unit of Measure field.

The entry you make in this field is used to determine how many items should be subtracted from stock when you sell 
one buying unit. For example, if you entered Pair in the Selling Unit of Measure field to indicate that you sell two units 
of this item each time you sell it, you should enter 2 in this field. Then, for each pair of the item you sell, the quantity 
of the item will be decreased by two.

If you dont make an entry in this field, the number 1 will appear as a default.

This field appears only if the I Sell This Item and I Stock This Item selections are marked.



History button
Click this button to display the Item Sales History window, where you can enter historical sales activity for the past 
financial year and current financial year for this item, including the current month.



Auto-Build button
If this item is a finished item, click this button to display the Auto-Build Info window, where you can enter information 
about the components used to build this item.



Restock button
Click this button to open the Restocking Information window, where you can enter information about maintaining this 
items quantity levels.



Jobs List window
The Jobs List window allows you to view summary information about all the current jobs in your business. This 
window shows the jobs total revenue, expenses and net profit or loss. If your business has "profit centres," that is, 
parts of your business that have separate profit and loss responsibility, you can use this window to track them.

Fields in this window:

Edit Job button
Expenses column
Job column
Net Profit (Loss) column
New button
Print button
Revenue column



Job column
This column displays the names of all jobs in the M.Y.O.B. system.

If you wish to view detail about a particular job, click the zoom arrow next to the jobs name. The Edit Job window will 
appear, allowing you to view, change or delete job information.



Revenue column
This column displays the total revenues gained from each job in the Job column.



Expenses column
This column displays the total expenses incurred from each job in the Job column.



Net Profit (Loss) column
This column displays the net profit or loss from each job in the Job column. This amount is calculated by subtracting 
the amount in the Expenses column from the amount in the Revenue column.



Edit Job button
Click this button after youve highlighted a job to open the Edit Job button, which allows you to view, change or 
remove an existing job in your company. 



Make a Deposit window
The Make a Deposit window allows you to record deposits into your M.Y.O.B. bank accounts. The top half of the 
window contains fields that allow you to enter deposit information. The bottom half of the window contains a scrolling 
list of the accounts and jobs affected by each deposit, as well as the amounts that comprise each deposit.

You can also use this window to set up recurring deposits of the same value and examine the Cash Receipts Journal.

Fields in this window:

Allocation Account columns
Amount
Amount column
Balance
Cancel button
Bank accounts list
Date
Don't Record button
ID No.
Job column
Journal button
Memo
New button
Drawer
Record button
Record Reversal button
Save Recurring button
Total VAT
Use Recurring button
VAT Column



Bank accounts list
Select the bank account you wish to make a deposit into.

The accounts in this list were assigned bank privileges in the Edit Accounts window.



Balance
This field displays the current balance of the bank account you selected at the top of the window. If you wish to 
display the Inquiry Register window to view more detailed information about the bank account, click the zoom arrow.



Drawer
Enter the name of the person or company in the Card File from whom you received this deposit, or click the search 
icon to display a search list of the people and companies in your Card File that you can select from.

After a card name is entered in this field, you can click the zoom arrow to display the Card File Entry window and 
view detailed information about the person or company.



ID No.
Using up to eight characters, enter the journal number you want to assign to this transaction, or accept the default 
journal number. This number will be recorded in the Cash Receipts Journal.

We recommend that you use the default journal number, because it ensures that you dont use duplicate journal 
numbers, which may cause confusion in your recordkeeping. If you want to assign a different number, consider 
leaving the CR prefix assigned to the number, so its easy for you to distinguish the transaction as a Cash Receipts 
Journal transaction.

One instance where you might find duplicate journal numbers handy is when you include more than one deposit 
transaction on a single deposit slip you send to your bank. Use the same journal number for each deposit transaction 
so you can remember that the deposits were grouped together when you sent them to the bank.



Amount
Enter the total amount of the deposit.

When you save this deposit, the balance of the bank account you selected at the top of the window will be increased 
by the amount you enter here. If you enter a negative amount here, the bank account will be decreased by that 
amount.



Memo
Enter a description of the transaction. This description will appear on various M.Y.O.B. reports, as well as the Cash 
Receipts Journal.

We suggest you use the word "Deposit" in the memo to remind you of the nature of the transaction.



Allocation Account columns
Enter the number of the account(s) you want to assign this deposit amount to, or click the search icon to display a 
search list of accounts you can select from. From the list, you can also create a new account to assign the deposit 
amount to. Typically, deposits are assigned to income accounts. The name of the account you selected will also 
appear here.

The deposit amount you entered in the Amount field is considered a debit amount. When you enter accounts and 
positive amounts in this list, the accounts will be credited by the amounts you enter.



Amount column
Enter the amount that you wish to assign to this account for this deposit. If the total of the amounts in this column 
doesnt match the amount in the Amount field (in other words, if the transaction is out of balance), this field will display
a default amount that balances the transaction. You can change the default, if you wish.

The deposit amount you entered in the Amount field is considered a debit amount, and the amounts you enter in this 
column are considered credit amounts. If you want an amount in this column to be used as a debit instead, enter the 
amount as a negative number.



Job column
You can assign a job to each income, cost of sales, expense, other income or other expense account in the list. To do
so, enter the job number here or click the search icon to display a search list of existing jobs. From the search list, 
you can also create a new job to assign the account to.

If you need to assign an amount from one account to more than one job, use multiple lines to record the transaction. 
For example, assume you want to credit your Widget Income account £100, but you want to assign £30 to job 12 and 
£70 to job 43. To do this, enter the Widget Income account number in the Acct No. column, then enter £30 in the 
Amount column and 12 in the Job column. Move to the next line, enter the Widget Income account number again, 
enter £70 in the Amount column and 43 in the Job column.



Record button
Click this button to record the transaction youve made in this window.

If the total of the amounts in the Amount column in the bottom half of this window dont equal the number you entered 
in the Amount field in the top half of the window, you wont be allowed to record the deposit. Change your entries in 
the Amount column so they total the number in the Amount field.



Total VAT
The amount of VAT for the whole deposit. The VAT will be allocated to the Linked VAT account for Deposits.

Note: If for any reason you need to amend the VAT calculated click on the arrow to the left of Total Vat. The Vat 
Information window will open



VAT column
This column is used to enter the VAT code(s) applicable if any to this deposit. The default code prompted is the first 
one in the VAT Codes window. You can enter any valid VAT code in the VAT column.

Note: When a deposit transaction line (such as Share Capital invested in a company) which is outside the scope is 
entered the VAT column should be left blank.    The transaction will not then appear on the VAT reports.



Purchases window (Item Purchase Order View)
The Purchases window allows you to create transaction records for the items and services you buy, regardless of 
whether the items or services are included in your list of items.

Depending upon the type of transaction youre entering in this window (item purchase order, service purchase order, 
professional purchase order or other purchase), the list in the middle of the window will change to allow you to enter 
appropriate information.

The Item Purchase Order View, displayed when you click the PO Type button in this window and choose the Item 
Purchase Order selection, allows you to record the purchase of items and services for which you marked the I Buy 
This Item and I Stock This Item selections in the Item Information window.

Fields in this window:

Backorder column
Balance Due
Cancel button
Comment
Date
Del. to.
Del. Via
Promised Date
Description column
Disc% column
Don't Record button
Carriage
Handwritten
Item No. column
Job column
Journal button
Journal Memo
New button
Paid Today
Pending button
PO Type button
PO No.
Price column
Print button
Received column
Record button
Save Recurring button
Supplier
Supplier Invoice No.
Terms
Total Amount
Total column
Total VAT
Use Recurring button
VAT column



Supplier
Enter the name of the supplier for whom this purchase order is intended, or click the search icon to display a search 
list of suppliers to choose from. You can also use the Easy-Add function in the search list to create a new supplier 
record to assign this purchase order to.

If pending purchase orders exist for the supplier, a window will appear, listing your pending purchase orders with the 
supplier. You can either select a pending purchase order or click Cancel or New Purchase to return to the Purchases 
window, where you can create a new purchase order.



Terms
This field displays the credit terms assigned to your business by the supplier. This information will be printed on the 
purchase order.

If you wish to change these terms, click the zoom arrow next to the Supplier field to display the Card File Entry 
window, then click the Terms button at the bottom of the window.



Handwritten
Mark this selection if you dont intend to print this purchase order using M.Y.O.B.

When you mark this selection, M.Y.O.B. will record the purchase order as printed; then, when you choose to print 
unprinted purchase orders only in the Print Purchases window, this purchase order wont be printed.

If youre viewing a purchase order thats been printed, this selection is already marked.



Del. to.
Enter the address you want to print on the purchase order, or accept the default address, which was entered in the 
Company Information window. You can also click the search icon to display a search list of all the people and 
companies in the Card File to select a different address from.



PO No.
Using up to eight characters, enter the number you want to assign to this purchase order, or accept the default 
purchase order number. This number will be recorded in the Purchases Journal.

We recommend that you use the default purchase order number, because it ensures that you dont use duplicate 
journal numbers, which may cause confusion in your recordkeeping. (Another way to ensure you dont use duplicate 
purchase order numbers is to mark the Warn for Duplicate Purchase Order Numbers selection in the Preferences 
window.)

If you make an entry in this field that contains numbers only, the next purchase order you create will use an purchase 
order number incremented by one. If your entry contains letters, the next purchase orders number will be 
incremented by one from the last numbers-only purchase order number you used.



Supplier Invoice No.
Enter the number assigned to the invoice the supplier sent you.

This number can be printed on the purchase order, if you wish.



Received column
Enter the quantity of items you intend to receive with this purchase order, using up to three decimal places. When you
click Record, the on-hand quantities of the items on this purchase order will be increased by the amounts you enter 
here.

Enter this number in buying units of measure. For example, if you buy three pair of lamps, enter 3 in this field.

You can also enter 0 as a quantity in this column, if you wish. Zero can be used as a quantity for special "items" such 
as carriage; although no quantities are increased, the "item" appears on the printed purchase order.



Backorder column
Enter the quantity of items you intend to include on a pending purchase order for this transaction, using up to three 
decimal places. When you click Record, a pending purchase order listing the quantity of items you entered here will 
be created.

Enter this number in buying units of measure. For example, if you want to put three pair of lamps on back order, enter
3 in this field.



Item No. column
Enter the number of each item you wish to include on this purchase order, or click the search icon to display a search 
list of existing items to choose from. From the list of items, you can also create a new item to include on the purchase
order.

Only items for which you selected I Buy This Item in the Item Information window can be entered in this column.



Description column
Enter a description of the item, or accept the default description, which was assigned to this item in the Item 
Information window. You can use up to 255 characters for the item description.



Price column
Enter the price youre paying for each item, or accept the default price, which is the last price you paid for the item. 
You can use up to three decimal places for the price.



Disc% column
Enter the discount percentage youre offered by this supplier when you make large volume purchases from this 
supplier, or accept the default percentage, which was assigned to the supplier in the Credit Terms window.

This is a discount for large-volume purchases. It isnt a discount for early payments you make. 



Total column
Enter the total    amount of each line on the purchase order in this column, or accept the default, which is the amount 
in the Price field multiplied by the quantity in the Received column, then subtracted by the percentage in the Disc% 
field. The final amount is then rounded to the nearest penny.

If you change the default amount, the percentage in the Disc% field will automatically change to reflect the new 
amount.



Job column
You can assign a job to each line in Item Purchase Order View. To do so, enter the job number here or click the 
search icon to display a search list of existing jobs. From the search list, you can also create a new job to assign the 
amount to.

If you need to assign a single item to more than one job, use multiple lines to record the transaction. For example, 
assume you want to include 100 widgets on a purchase order, but you want to assign 30 widgets to job 12 and 70 
widgets to job 43. To do this, enter the Widgets item number in the Item No. column, then enter 30 in the Received 
column or Backorder column and 12 in the Job column. Move to the next line, enter the Widgets item number again, 
enter 70 in the Received column or Backorder column and 43 in the Job column.



VAT column
This column is used to designate which VAT code should be assigned to each item. All items display the VAT Code 
entered in the VAT Code When Bought field in the Item Information window. You can change the VAT code or select 
search from the Edit menu to display a search list of VAT codes to choose from.



Comment
Enter a comment to print on the purchase order, or click the search icon to display a search list of comments to 
choose from. You can also use the Easy-Add function in the search list to create a new comment.



Del. Via
Enter the method by which you want to the supplier to deliver the items on the purchase order, or click the search 
icon to display a search list of delivery methods to choose from. You can also use the Easy-Add function in the search
list to create a new delivery method.

This method can be printed on the purchase order.



Promised Date
If you intend to record this purchase order as a pending purchase order, enter the date you expect to receive the 
items on the purchase order.

If this isnt a pending purchase order, the entry you make in this field is for your information only.



Journal Memo
Enter a description of the purchase order, or accept the default memo. This description will appear on various 
M.Y.O.B. reports, as well as the Purchases Journal. You can also print this memo on the purchase order.

If you change the default memo, we suggest you keep the word "Purchase" in the memo to remind you of the nature 
of the transaction.



Carriage
Enter the amount youll pay to deliver the items on this purchase order. The prompted VAT Code is the first one in the 
VAT Codes table. You may enter any valid VAT code. If you enter an invalid code or select search from the Edit menu,
The VAT Codes Search List appears allowing you to select the correct one.

This field is available only if you assigned an account number for carriage charges in the Expense or Cost of Sales 
Account for Carriage field in the Purchase Ledger Linked Accounts window.



Total VAT
The amount of VAT for the whole purchase. The VAT will be allocated to the Linked VAT account for Purchases.

Note: If for any reason you need to amend the VAT calculated click on the arrow to the left of Total VAT. The VAT 
Information window will open allowing you changes the VAT amounts.



Total Amount
This field displays the total amount of the purchase order, including all items and services in the list, VAT and carriage
charges.



Paid Today
Enter the amount of money you paid at the time of the purchase for this transaction.

This amount will decrease the balance of your linked creditors bank account and will appear as an entry in the Cash 
Disbursements Journal.



Balance Due
This field displays the total amount of the purchase order, minus the amount in the Paid Today field.

Depending upon the amount in this column, one of three things will occur when you click the Record button:

* If the amount is zero, a purchase order with no balance (sometimes known as a "closed purchase") will be created.
* If the amount is a positive number, a purchase order with an outstanding balance (sometimes known as an "open 
purchase") will be created. This amount will be recorded in your linked creditors account.
* If the amount is a negative number, a debit purchase will be created.



PO Type button
Click this button to choose the type of purchasing transaction you want to enter in this window. The PO Type window 
appears, allowing you to select a type of purchasing transaction. These types are summarised below.

ITEM: Choose this selection if you want to create a purchase order thats used to record the purchase of items and 
services for which you selected I Buy This Item in the Item Information window. When you save an item purchase 
order, your in-house quantities of the items for which you also selected I Stock This Item in the Item Information 
window (also known as stock items) listed on the purchase order change accordingly.

SERVICE: Choose this selection if you want to record the purchase of items and services that you didnt enter 
information about in the Item Information window. This type of purchase order allows you to track purchasing 
transactions that dont affect your stock quantities. 

PROFESSIONAL: Choose this selection if you want to record the purchase of items and services that you didnt enter 
information about in the Item Information window, and include the specific date each item was purchased.

OTHER PURCHASE: Choose this selection if you want to record the purchase of items and services that you didnt 
enter information about in the Item Information window, and that dont require a printed purchase order. 



Record button
Click this button to record the transaction youve made in this window.

If youve entered quantities for items in the Backorder column, a pending purchase order will be created for those 
items.



Purchases window (Service Purchase Order View)
The Purchases window allows you to create transaction records for the items and services you buy, regardless of 
whether the items or services are included in your list of items.

Depending upon the type of transaction youre entering in this window (item purchase order, service purchase order, 
professional purchase order or other purchase), the list in the middle of the window will change to allow you to enter 
appropriate information.

The Service Purchase Order View, displayed when you click the PO Type button in this window and choose the 
Service Purchase Order selection, allows you to record the purchase of items and services for which you didnt enter 
information about in the Item Information window. This type of purchase order allows you to track purchasing 
transactions that dont affect your stock quantities. 

Fields in this window:

Acct No. column
Amount column
Balance Due
Cancel button
Comment
Date
Del. to.
Del. Via
Description column
Don't Record button
Carriage
Handwritten
Job column
Journal button
Journal Memo
New button
Paid Today
Pending button
PO Type button
PO No.
Print button
Promised Date
Record button
Save Recurring button
Supplier
Supplier Invoice No.
Terms
Total Amount
Total VAT
VAT column
Use Recurring button



Description column
Enter a description of the item or service youre buying, using up to 255 characters.



Acct No. column
Enter the number of the account you want to assign the items or services in this transaction to, or click the search 
icon to display a search list of accounts you can select from. From the list, you can also create a new account to 
assign the transaction to.

Purchasing transactions are typically assigned to expense accounts.



Amount column
Enter the amount you expect to pay for each line of this transaction.

If you enter a positive number in this column, your linked creditors account will be increased.

If you enter a negative number in this column (for example, if youre entering a purchasing adjustment or a return), 
your linked creditors account will be decreased. When you click Record, a debit purchase will be created.

You can enter 0, if you wish. Zero can be used as an amount for items you want to appear on a purchase order; 
although no amount is charged, the item appears on the printed purchase order. The item, however, wont appear in 
the Purchases Journal.



Job column
Enter the number of the job to which you wish to assign each amount in the list, or click the search icon to display a 
search list of jobs to select. From the search list, you can also create a new job to assign the amount to.

If you need to assign an amount to more than one job, use multiple lines to record the transaction. For example, 
assume you want to assign £100 your Widget Purchases account, but you want to assign £30 to job 12 and £70 to 
job 43. To do this, enter the Widget Purchases account number in the Acct No. column, then enter £30 in the Amount 
column and 12 in the Job column. Move to the next line, enter the Widget Purchases account number again, enter 
£70 in the Amount column and 43 in the Job column.



VAT column
This column is used to designate which VAT code should be assigned to each item. The default code prompted is the 
first one in the VAT Codes window. You can enter any valid VAT code or select search from the Edit menu to display a
search list of VAT codes to choose from.



Purchases window (Professional Purchase Order View)
The Purchases window allows you to create transaction records for the items and services you buy, regardless of 
whether the items or services are included in your list of items.

Depending upon the type of transaction youre entering in this window (item purchase order, service purchase order, 
professional purchase order or other purchase), the list in the middle of the window will change to allow you to enter 
appropriate information.

The Professional Purchase Order View, displayed when you click the PO Type button in this window and choose the 
Professional Purchase Order selection, allows you to record the purchase of items and services that you didnt enter 
information about in the Item Information window; and allows you to assign a date to each individual transaction on 
the purchase order.

Fields in this window:

Acct No. column
Amount column
Balance Due
Cancel button
Comment
Date column
Date
Del. to.
Description column
Don't Record button
Handwritten
Job column
Journal button
New button
Paid Today
Pending button
PO Type button
PO No.
Print button
Record button
Save Recurring button
Supplier
Supplier Invoice No.
Terms
Total Amount
Total VAT
VAT column
Use Recurring button



Date column
Enter the date of each transaction on the purchase order.



Description column
Enter a description of the item or service youre buying, using up to 255 characters.



Acct No. column
Enter the number of the account you want to assign the items or services in this transaction to, or click the search 
icon to display a search list of accounts you can select from. From the list, you can also create a new account to 
assign the transaction to.

Purchasing transactions are typically assigned to expense accounts.



Amount column
Enter the amount you expect to pay for each line of this transaction.

If you enter a positive number in this column, your linked creditors account will be increased.

If you enter a negative number in this column (for example, if youre entering a purchasing adjustment or a return), 
your linked creditors account will be decreased. When you click Record, a debit purchase will be created.

You can enter 0, if you wish. Zero can be used as an amount for items you want to appear on a purchase order; 
although no amount is charged, the item appears on the printed purchase order. The item, however, wont appear in 
the Purchases Journal.



Job column
Enter the number of the job to which you wish to assign each amount in the list, or click the search icon to display a 
search list of jobs to select. From the search list, you can also create a new job to assign the amount to.

If you need to assign an amount to more than one job, use multiple lines to record the transaction. For example, 
assume you want to assign £100 your Widget Purchases account, but you want to assign £30 to job 12 and £70 to 
job 43. To do this, enter the Widget Purchases account number in the Acct No. column, then enter £30 in the Amount 
column and 12 in the Job column. Move to the next line, enter the Widget Purchases account number again, enter 
£70 in the Amount column and 43 in the Job column.



VAT column
This column is used to designate which VAT code should be assigned to each item. The default code prompted is the 
first one in the VAT Codes window. You can enter any valid VAT code or select search from the Edit menu to display a
search list of VAT codes to choose from.



Purchases window (Other Purchase View)
The Purchases window allows you to create transaction records for the items and services you buy, regardless of 
whether the items or services are included in your list of items.

Depending upon the type of transaction youre entering in this window (item purchase order, service purchase order, 
professional purchase order or other purchase), the list in the middle of the window will change to allow you to enter 
appropriate information.

The Other Purchase View, displayed when you click the PO Type button in this window and choose the Other 
Purchase selection, allows you to record the purchase of items and services that you didnt enter information about in 
the Item Information window, and that dont require a printed purchase order. 

Fields in this window:

Account columns
Amount column
Balance Due
Cancel button
Date
Description column
Don't Record button
Job column
Journal button
Journal Memo
New button
Paid Today
Pending button
PO Type button
PO No.
Print button
Record button
Save Recurring button
Supplier
Terms
Total Amount
Total VAT
Use Recurring button
VAT column



Supplier
Enter the name of the supplier for whom this other purchase is intended, or click the search icon to display a search 
list of suppliers to choose from. You can also use the Easy-Add function in the search list to create a new supplier 
record to assign this other purchase to.

If pending purchase orders exist for the supplier, a window will appear, listing your pending purchase orders with the 
supplier. You can either select a pending purchase order or click Cancel or New Purchase to return to the Purchases 
window, where you can create a new other purchase.

You dont have to assign purchasing transactions to individual suppliers if you dont want to. However, youll need to 
set up at least one supplier card to track your purchases. You may want to name this card "Cash Supplier" or 
something similar to distinguish it as a card used to track purchasing transactions. If the supplier is providing credit to 
you for your purchases, however, we suggest you create a "real" supplier record for this supplier.



Terms
This field displays the credit terms assigned to your business by the supplier.

If you wish to change these terms, click the zoom arrow next to the Supplier field to display the Card File Entry 
window, then click the Terms button at the bottom of the window.



PO No.
Using up to eight characters, enter the number you want to assign to this transaction, or accept the default number. 
This number will be recorded in the Purchases Journal.

We recommend that you use the default number, because it ensures that you dont use duplicate numbers, which may
cause confusion in your recordkeeping. (Another way to ensure you dont use duplicate numbers is to mark the Warn 
for Duplicate Purchase Order Numbers selection in the Preferences window.)

If you want to assign a different number, consider leaving the PJ prefix assigned to the number, so its easy for you to 
distinguish the transaction as a Purchases Journal transaction.



Journal Memo
Enter a description of the other purchase, or accept the default memo. This description will appear on various 
M.Y.O.B. reports, as well as the Purchases Journal.

If you change the default memo, we suggest you keep the word "Purchase" in the memo to remind you of the nature 
of the transaction.



Description column
Enter a description of the item or service youre buying, using up to 255 characters.



Account columns
Enter the number of the account you want to assign the items or services in this transaction to, or click the search 
icon to display a search list of accounts you can select from. From the list, you can also create a new account to 
assign the transaction to. When you enter or select an account number, the accounts name will appear in the second 
column.

Purchasing transactions are typically assigned to expense accounts.



Amount column
Enter the amount that youre charged for each line of this transaction.

If you enter a positive number, the account you entered in the Acct No. column will be increased.

If you enter a negative number, the amount will decrease the account you entered in the Acct No. column. In addition,
when you click Record, a debit purchase will be created for the amount you entered.

You can enter 0, if you wish. The item, however, wont appear in the Purchases Journal.



Job column
Enter the number of the job to which you wish to assign each amount in the list, or click the search icon to display a 
search list of jobs to select. From the search list, you can also create a new job to assign the amount to.

You can assign amount to jobs only if the accounts you enter in the Acct No. column are income, expense, cost of 
sales, other income or other expense accounts.

If you need to assign an amount to more than one job, use multiple lines to record the transaction. For example, 
assume you want to assign £100 your Widget Purchases account, but you want to assign £30 to job 12 and £70 to 
job 43. To do this, enter the Widget Purchases account number in the Acct No. column, then enter £30 in the Amount 
column and 12 in the Job column. Move to the next line, enter the Widget Purchases account number again, enter 
£70 in the Amount column and 43 in the Job column.



VAT column
This column is used to designate which VAT code should be assigned to each item. The default code prompted is the 
first one in the VAT Codes window. You can enter any valid VAT code or select search from the Edit menu to display a
search list of VAT codes to choose from.



Total Amount
This field displays the total amount of the other purchase, including all items and services in the list, as well as VAT 
charges.



Balance Due
This field displays the total amount of the other purchase, minus the amount in the Paid Today field.

Depending upon the amount in this column, one of three things will occur when you click the Record button:

* If the amount is zero, an other purchase with no balance (sometimes known as a "closed purchase") will be created.
* If the amount is a positive number, an other purchase with an outstanding balance (sometimes known as an "open 
purchase") will be created. This amount will be recorded in your linked creditors account.
* If the amount is a negative number, a debit purchase will be created.



Reconcile Accounts window
The Reconcile Accounts window allows you to verify that the balances of your M.Y.O.B. bank accounts match the 
balances on your banks statements. You can also verify whether balances of credit cards and loans are correct using 
this window.

Fields in this window:

Account
All button
Cancel button
Checkmark column
Current Balance
Date button
Date of Bank Statement
Deposits column
ID No. button
Last Reconciled
Mark All Cleared Transactions columns
New Balance from Statement
None button
Out of Balance
Print button
Reconcile button
Withdrawals column



Account
Enter the number of the account you want to reconcile, or click the search icon to display a search list of accounts 
you can select from.

After you enter an account number, many of the fields will display current information about the account.



Current Balance
This field displays the current balance of the account you entered in the Account field. If you wish to display the 
Inquiry Register window to view more detailed information about the account, click the zoom arrow.



Last Reconciled
If youve previously reconciled this account, the date this account was last reconciled appears in this field. This field is 
updated with the date you enter in the Date of Bank Statement field when you complete the M.Y.O.B. reconciliation 
process.

If youve never reconciled this account, no date will appear in this field.



Out of Balance
This field displays the difference between the amount in the Current Balance field (the balance of the account in 
M.Y.O.B.) and the amount in the New Balance from Statement field (the balance of the account according to your 
bank). The account isn't considered reconciled until this number is £0.00.



Date of Bank Statement
Enter the date that appears on your bank statement, or accept the default date, which is the current date.

This field will be used to update the Last Reconciled field when you complete the M.Y.O.B. reconciliation process.



New Balance from Statement
Enter the ending balance that appears on your bank statement for this account, or accept the default amount, which 
is the balance in M.Y.O.B. for this account. If the default amount is the same as the amount on your bank statement, 
all transactions in the list below have been recorded by the bank.



Checkmark column
This column is used to designate which transactions in the list have been recorded by the bank, as indicated on your 
bank statement. All transactions with a mark displayed in this column are marked to be reconciled; if a transaction 
hasnt been recorded by the bank yet, click the mark to remove it. If a transaction has been recorded by the bank and 
a mark doesnt appear in this column, click the column to add a mark.

When you complete the reconciliation process, all marked transactions will be removed from the list.



Mark All Cleared Transactions columns
This column displays all transactions that havent been recorded by your bank yet.

Only transactions that youve recorded in M.Y.O.B. are displayed in this list. Remember to click the Record button in 
transaction entry windows such as Sales or Nominal Journal Entry to fully record the transactions you enter before 
you use this window.



Deposits column
This column displays the amounts assigned to deposit transactions in the list.



Withdrawals column
This column displays the amounts assigned to bank and withdrawal transactions in the list.



Date button
Click this button to display all uncleared transactions in the list by the dates they were recorded.



ID No. button
Click this button to display all uncleared transactions in the list by the numbers that they were assigned.



Reconcile button
Click this button to attempt to reconcile the current balance of this account with the balance shown on your bank 
statement.

M.Y.O.B. will calculate a new current balance by removing the transaction amounts that were marked with a mark in 
the list, adding all uncleared withdrawals to the current balance and subtracting all uncleared deposits from the 
current balance. M.Y.O.B. will then compare the new balance amount with the amount in the New Balance from 
Statement field.

If the new M.Y.O.B. account balance matches the amount in the New Balance from Statement field, an alert message
will appear, informing you that you can complete the reconciliation process. Click the OK button in this message to 
remove all transactions that have been recorded by the bank from the list in the Reconcile Accounts window.

If the new account balance doesnt match the amount in the New Balance from Statement field, an alert message will 
appear, showing you the amount by which the two amounts differ. When you click OK in this message, the difference 
will be displayed in the Out of Balance field.



Sales window (Item Invoice View)
The Sales window allows you to create transaction records for the items and services you sell, regardless of whether 
the items or services are included in your list of items.

Depending upon the type of transaction youre entering in this window (item invoice, service invoice, professional 
invoice or other sale), the list in the middle of the window will change to allow you to enter appropriate information.

The Item Invoice View, displayed when you click the Invoice Type button in this window and choose the Item Invoice 
selection, allows you to record the sale of stock items and service items for which you marked the I Sell This Item and
I Stock This Item selections in the Item Information window.

Fields in this window:

Backorder column
Balance Due
Cancel button
Comment
Customer
Customer PO No.
Date
Deliver column
Del. to.
Del. Via
Description column
Disc% column
Don't Record button
Carriage
Handwritten
Invoice Type button
Invoice No.
Item No. column
Job column
Journal button
Journal Memo
New button
Paid Today
Pending button
Price column
Print button
Promised Date
Record button
Salesperson
Save Recurring button
Total VAT
Terms
Total Amount
Total column
Use Recurring button
VAT column



Customer
Enter the name of the customer for whom this invoice is intended, or click the search icon to display a search list of 
customers to choose from. You can also use the Easy-Add function in the search list to create a new customer record
to assign this invoice to.

If pending invoices exist for the customer, a window will appear, listing the customers pending invoices. You can 
either select a pending invoice or click Cancel or New Sale to return to the Sales window, where you can create a 
new invoice.

You dont have to assign sales transactions to individual customers if you dont want to. However, youll need to set up 
at least one customer card to track your sales. You may want to name this card "Cash Customer" or something 
similar to distinguish it as a card used to track sales transactions. If youre providing credit for the customer, however, 
we suggest you create a "real" customer record for this customer.



Terms
This field displays the credit terms assigned to the customer. This information will be printed on the invoice.

If you wish to change these terms, click the zoom arrow next to the Customer field to display the Card File Entry 
window, then click the Terms button at the bottom of the window.



Handwritten
Mark this selection if you dont intend to print this invoice using M.Y.O.B.

When you mark this selection and click Record, M.Y.O.B. will record the invoice as printed; then, when you choose to 
print unprinted invoices only in the Print Invoices window, this invoice wont be printed.

If youre viewing an invoice thats been printed, this selection is already marked.



Del. to.
Enter the address you want to print on the invoice, or accept the default address, which was entered for the customer
in the Card File Entry window. You can also click the search icon to display a search list containing all the people and 
companies in the Card File to select a different address from.

If you didnt enter an address for the customer in the Del. to. field of the Card File Entry window, the mailing address 
you entered will be displayed here instead.



Invoice No.
Using up to eight characters, enter the number you want to assign to this invoice, or accept the default invoice 
number. This number will be recorded in the Sales Journal.

We recommend that you use the default invoice number, because it ensures that you dont use duplicate journal 
numbers, which may cause confusion in your recordkeeping. (Another way to ensure you dont use duplicate invoice 
numbers is to mark the Warn for Duplicate Invoice Numbers selection in the Preferences window.)

If you make an entry in this field that contains numbers only, the next invoice you create will use an invoice number 
incremented by one. If your entry contains letters, the next invoices number will be incremented by one from the last 
numbers-only invoice number you used.



Customer PO No.
If you wish, enter the number assigned to the purchase order the customer sent you.

This number can be printed on the invoice.



Deliver column
Enter the quantity of items you intend to deliver with this invoice, using up to three decimal places. When you click 
Record, the on-hand quantities of the items on this invoice will be decreased by the amounts you enter here.

Enter this number in selling units of measure. For example, if you sell three pair of lamps, enter 3 in this field.

You can also enter 0 as a quantity in this column, if you wish. Zero can be used as a quantity for special "items" such 
as carriage; although no quantities are reduced, the "item" appears on the printed invoice.



Backorder column
Enter the quantity of items you intend to include on a pending invoice for this transaction, using up to three decimal 
places. When you click Record, a pending invoice listing the quantity of items you entered here will be created.

Enter this number in selling units of measure. For example, if you want to put three pair of lamps on back order, enter 
3 in this field.



Item No. column
Enter the number of each item you wish to include on this invoice, or click the search icon to display a search list of 
existing items to choose from. From the list of items, you can also create a new item to include on the invoice.

Only items for which you selected I Sell This Item in the Item Information window can be entered in this column.



Description column
Enter a description of the item, or accept the default description, which was assigned to this item in the Item 
Information window. You can use up to 255 characters for the item description.



Price column
Enter the price youre charging for each item, or accept the default price, which was assigned to this item in the Item 
Information window or Set Item Prices window. You can use up to three decimal places for the price.



Disc% column
Enter the discount percentage you offer to this customer when you make large volume sales to the customer, or 
accept the default percentage, which was assigned to the customer in the Credit Terms window.

This is a discount for large-volume customers. It isnt a discount for customers who make early payments. 



Total column
Enter the total amount of each line on the invoice, or accept the default, which is the amount in the Price field 
multiplied by the quantities in the Deliver and Backorder fields, then subtracted by the percentage in the Disc% field. 
The final amount is then rounded to the nearest penny.

If you change the default amount, the percentage in the Disc% field will automatically change to reflect the new 
amount.



Job column
You can assign a job to each line in Item Invoice View. To do so, enter the job number here or click the search icon to 
display a search list of existing jobs. From the search list, you can also create a new job to assign the amount to.

If you need to assign a single item to more than one job, use multiple lines to record the transaction. For example, 
assume you want to include 100 widgets on an invoice, but you want to assign 30 widgets to job 12 and 70 widgets to
job 43. To do this, enter the Widgets item number in the Item No. column, then enter 30 in the Deliver column or 
Backorder column and 12 in the Job column. Move to the next line, enter the Widgets item number again, enter 70 in 
the Deliver column or Backorder column and 43 in the Job column.



VAT column
This column is used to designate which VAT code should be assigned to each item. All items display the VAT Code 
entered in the VAT Code When Sold field in the Item Information window You can change the VAT code or select 
search from the Edit menu to display a search list of VAT codes to choose from.



Salesperson
Enter the name of the employee who conducted this sale, or click the search icon to display a search list of 
employees to choose from. You can also use the Easy-Add function in the search list to create a new employee 
record.

You can use this field for your information only, or you can track the invoice amount as part of the employees sales 
history (if youve marked the Track Sales History selection in the Card File Entry window for the employee).



Comment
Enter a comment to print on the invoice, or click the search icon to display a search list of comments to choose from. 
You can also use the Easy-Add function in the search list to create a new comment.



Deliver Via
Enter the method by which you want to deliver the items on the invoice, or click the search icon to display a search 
list of delivery methods. You can also use the Easy-Add function in the search list to create a new delivery method.

This method can be printed on the invoice.



Promised Date
If you intend to record this invoice as a pending invoice, enter the date you expect to deliver the items on the invoice. 
This date will be placed as a reminder in your To Do List.

If this isnt a pending invoice, the entry you make in this field is for your information only.



Journal Memo
Enter a description of the invoice, or accept the default memo. This description will appear on various M.Y.O.B. 
reports, as well as the Sales Journal. You can also print this memo on the invoice.

If you change the default memo, we suggest you keep the word "Sale" in the memo to remind you of the nature of the
transaction.



Carriage
Enter the amount youre charging to deliver the items on this invoice. The prompted VAT Code is the first one in the 
VAT Codes table. You may enter any valid VAT code. If you enter an invalid code or select search from the Edit menu,
The VAT Codes Search List appears allowing you to select the correct one.

This field is available only if you assigned an account number for carriage charges in the Income Account for Carriage
field in the Sales Ledger Linked Accounts window.



Total VAT
The amount of VAT for the whole purchase. The VAT will be allocated to the Linked VAT account for Sales.

Note: If for any reason you need to amend the VAT calculated click on the arrow to the left of Total VAT. The VAT 
Information window will open allowing you changes the VAT amounts.



Total Amount
This field displays the total amount of the invoice, including all items and services in the list, VAT and carriage 
charges.



Paid Today
Enter the amount of money you received at the time of the sale for this transaction.

This amount will increase the balance of your linked debtors bank account, and will appear as an entry in the Cash 
Receipts Journal.



Balance Due
This field displays the total amount of the invoice, minus the amount in the Paid Today field.

Depending upon the amount in this column, one of three things will occur when you click the Record button:

* If the amount is zero, an invoice with no balance (sometimes known as a "closed sale") will be created.
* If the amount is a positive number, an invoice with an outstanding balance (sometimes known as an "open sale") 
will be created. This amount will be recorded in your linked debtors account.
* If the amount is a negative number, a credit note will be created.



Invoice Type button
Click this button to choose the type of sales transaction you want to enter in this window. The Invoice Type window 
appears, allowing you to select a type of sales transaction. These types are summarised below.

ITEM: Choose this selection if you want to create an invoice thats used to record the sale of items and services for 
which you selected I Sell This Item in the Item Information window. When you save an item invoice, your in-house 
quantities of the items for which you also selected I Stock This Item in the Item Information window (also known as 
stock items) listed on the invoice change accordingly.

SERVICE: Choose this selection if you want to record the sale of items and services that you didnt enter information 
about in the Item Information window. This type of invoice allows you to track sales transactions that dont affect your 
stock quantities. 

PROFESSIONAL: Choose this selection if you want to record the sale of items and services that you didnt enter 
information about in the Item Information window, and include the specific date each item was sold.

OTHER SALE: Choose this selection if you want to record the sale of items and services that you didnt enter 
information about in the Item Information window, and that dont require a printed invoice. 



Record button
Click this button to record the transaction youve made in this window.

The quantities you listed in the Deliver column will be used to decrease your on-hand quantity of each item thats 
listed on the invoice. If the quantity of an item in the Deliver quantity is greater than the items on-hand quantity, the 
Backorder List window will appear, where you can automatically build, buy or backorder more of the item.

If youve entered quantities for items in the Backorder column, a pending invoice will be created for those items.



Sales window (Service Invoice View)
The Sales window allows you to create transaction records for the items and services you sell, regardless of whether 
the items or services are included in your list of items.

Depending upon the type of transaction youre entering in this window (item invoice, service invoice, professional 
invoice or other sale), the list in the middle of the window will change to allow you to enter appropriate information.

The Service Invoice View, displayed when you click the Invoice Type button in this window and choose the Service 
Invoice selection, allows you to record the sale of items and services for which you didnt enter information about in 
the Item Information window. This type of invoice allows you to track sales transactions that dont affect your stock 
quantities. 

Fields in this window:

Acct No. column
Amount column
Balance Due
Cancel button
Comment
Customer
Customer PO No.
Date
Del. to.
Del. Via
Description column
Don't Record button
Carriage
Handwritten
Invoice Type button
Invoice No.
Job column
Journal button
Journal Memo
New button
Paid Today
Pending button
Print button
Promised date
Record button
Salesperson
Save Recurring button
Terms
Total Amount
Total VAT
Use Recurring button
VAT column



Description column
Enter a description of the item or service youre selling, using up to 255 characters.



Acct No. column
Enter the number of the account you want to assign the items or services in this transaction to, or click the search 
icon to display a search list of accounts you can select from. From the list, you can also create a new account to 
assign the transaction to.

Sales transactions are typically assigned to income accounts.



Amount column
Enter the amount you wish to charge for each line of this transaction.

If you enter a positive number in this column, your linked debtors account will be increased.

If you enter a negative number in this column (for example, if youre entering a sales adjustment or a return), your 
linked debtors account will be decreased. When you click Record, a credit note will be created.

You can enter 0, if you wish. Zero can be used as an amount for items you want to appear on an invoice; although no
amount is charged, the item appears on the printed invoice. The item, however, wont appear in the Sales Journal.



Job column
Enter the number of the job to which you wish to assign each amount in the list, or click the search icon to display a 
search list of jobs to select. From the search list, you can also create a new job to assign the amount to.

If you need to assign an amount to more than one job, use multiple lines to record the transaction. For example, 
assume you want to assign £100 to your Widget Sales account, but you want to assign £30 to job 12 and £70 to job 
43. To do this, enter the Widget Sales account number in the Acct No. column, then enter £30 in the Amount column 
and 12 in the Job column. Move to the next line, enter the Widget Sales account number again, enter £70 in the 
Amount column and 43 in the Job column.



VAT column
This column is used to designate which VAT code should be assigned to each item. The default code prompted is the 
first one in the VAT Codes window. You can enter any valid VAT code or select search from the Edit menu to display a
search list of VAT codes to choose from.



Sales window (Professional Invoice View)
The Sales window allows you to create transaction records for the items and services you sell, regardless of whether 
the items or services are included in your list of items.

Depending upon the type of transaction youre entering in this window (item invoice, service invoice, professional 
invoice or other sale), the list in the middle of the window will change to allow you to enter appropriate information.

The Professional Invoice View, displayed when you click the Invoice Type button in this window and choose the 
Professional Invoice selection, allows you to record the sale of items and services that you didnt enter information 
about in the Item Information window; and allows you to assign a date to each individual transaction on the invoice.

Fields in this window:

Acct No. column
Amount column
Balance Due
Cancel button
Comment
Customer
Date column
Date
Description column
Don't Record button
Handwritten
Invoice Type button
Invoice No.
Job column
Journal button
Journal Memo
New button
Paid Today
Pending button
Print button
Record button
Salesperson
Save Recurring button
Terms
Total Amount
Total VAT
Use Recurring button
VAT column



Date column
Enter the date of each transaction on the invoice.



Description column
Enter a description of the item or service youre selling, using up to 255 characters.



Acct No. column
Enter the number of the account you want to assign the items or services in this transaction to, or click the search 
icon to display a search list of accounts you can select from. From the list, you can also create a new account to 
assign the transaction to.

Sales transactions are typically assigned to income accounts.



Amount column
Enter the amount you wish to charge for each line of this transaction.

If you enter a positive number in this column, your linked debtors account will be increased.

If you enter a negative number in this column (for example, if youre entering a sales adjustment or a return), your 
linked debtors account will be decreased. When you click Record, a credit note will be created.

You can enter zero, if you wish. Zero can be used as an amount for items you want to appear on an invoice; although
no amount is charged, the item appears on the printed invoice. The item, however, wont appear in the Sales Journal.



Job column
Enter the number of the job to which you wish to assign each amount in the list, or click the search icon to display a 
search list of jobs to select. From the search list, you can also create a new job to assign the amount to.

If you need to assign an amount to more than one job, use multiple lines to record the transaction. For example, 
assume you want to assign £100 to your Widget Sales account, but you want to assign £30 to job 12 and £70 to job 
43. To do this, enter the Widget Sales account number in the Acct No. column, then enter £30 in the Amount column 
and 12 in the Job column. Move to the next line, enter the Widget Sales account number again, enter £70 in the 
Amount column and 43 in the Job column.



VAT column
This column is used to designate which VAT code should be assigned to each item. The default code prompted is the 
first one in the VAT Codes window. You can enter any valid VAT code or select search from the Edit menu to display a
search list of VAT codes to choose from.



Sales window (Other Sale View)
The Sales window allows you to create transaction records for the items and services you sell, regardless of whether 
the items or services are included in your list of items.

Depending upon the type of transaction youre entering in this window (item invoice, service invoice, professional 
invoice or other sale), the list in the middle of the window will change to allow you to enter appropriate information.

The Other Sale View, displayed when you click the Invoice Type button in this window and choose the Other Sale 
selection, allows you to record the sale of items and services that you didnt enter information about in the Item 
Information window, and that dont require a printed invoice. 

Fields in this window:

Account columns
Amount column
Balance Due
Cancel button
Customer
Date
Description column
Don't Record button
Invoice Type button
Invoice No.
Job column
Journal button
Journal Memo
New button
Paid Today
Pending button
Print button
Record button
Salesperson
Save Recurring button
Terms
Total Amount
Total VAT
Use Recurring button
VAT column



Customer
Enter the name of the customer for whom this other sale is intended, or click the search icon to display a search list of
customers to choose from. You can also use the Easy-Add function in the search list to create a new customer record
to assign this other sale to.

If pending invoices exist for the customer, a window will appear, listing the customers pending invoices. You can 
either select a pending invoice or click Cancel or New Sale to return to the Sales window, where you can create a 
new other sale.

You dont have to assign sales transactions to individual customers if you dont want to. However, youll need to set up 
at least one customer card to track your sales. You may want to name this card "Cash Customer" or something 
similar to distinguish it as a card used to track sales transactions. If youre providing credit for the customer, however, 
we suggest you create a "real" customer record for this customer.



Terms
This field displays the credit terms assigned to the customer.

If you wish to change these terms, click the zoom arrow next to the Customer field to display the Card File Entry 
window, then click the Terms button at the bottom of the window.



Invoice No.
Using up to eight characters, enter the number you want to assign to this transaction, or accept the default number. 
This number will be recorded in the Sales Journal.

We recommend that you use the default number, because it ensures that you dont use duplicate numbers, which may
cause confusion in your recordkeeping. (Another way to ensure you dont use duplicate numbers is to mark the Warn 
for Duplicate Invoice Numbers selection in the Preferences window.)

If you want to assign a different number, consider leaving the SJ prefix assigned to the number, so its easy for you to 
distinguish the transaction as a Sales Journal transaction.



Journal Memo
Enter a description of the other sale, or accept the default memo. This description will appear on various M.Y.O.B. 
reports, as well as the Sales Journal.

If you change the default memo, we suggest you keep the word "Sale" in the memo to remind you of the nature of the
transaction.



Description column
Enter a description of the item or service youre selling, using up to 255 characters.



Account columns
Enter the number of the account you want to assign the items or services in this transaction to, or click the search 
icon to display a search list of accounts you can select from. From the list, you can also create a new account to 
assign the transaction to. When you enter or select an account number, the accounts name will appear in the second 
column.

Sales transactions are typically assigned to income accounts; VAT amounts are typically assigned to liability 
accounts.



Amount column
Enter the amount you wish to charge for each line of this transaction.

If you enter a positive number, the account you entered in the Acct No. column will be increased.

If you enter a negative number in this column (for example, if youre entering a sales adjustment or a return), the 
account you entered in the Acct No. column will be decreased. When you click Record, a credit note will be created.

You can enter zero, if you wish. The item, however, wont appear in the Sales Journal.



Job column
Enter the number of the job to which you wish to assign each amount in the list, or click the search icon to display a 
search list of jobs to select. From the search list, you can also create a new job to assign the amount to.

If you need to assign an amount to more than one job, use multiple lines to record the transaction. For example, 
assume you want to assign £100 to your Widget Sales account, but you want to assign £30 to job 12 and £70 to job 
43. To do this, enter the Widget Sales account number in the Acct No. column, then enter £30 in the Amount column 
and 12 in the Job column. Move to the next line, enter the Widget Sales account number again, enter £70 in the 
Amount column and 43 in the Job column.



VAT column
This column is used to designate which VAT code should be assigned to each item. The default code prompted is the 
first one in the VAT Codes window. You can enter any valid VAT code or select search from the Edit menu to display a
search list of VAT codes to choose from.



Salesperson
Enter the name of the employee who conducted this sale, or click the search icon to display a search list of 
employees to choose from. You can also use the Easy-Add function in the search list to create a new employee 
record.

You can use this field for your information only, or you can track the transaction amount as part of the employees 
sales history (if youve marked the Track Sales History selection in the Card File Entry window for the employee).



Total Amount
This field displays the total amount of the other sale, including all items and services in the list, VAT and carriage 
charges.



Balance Due
This field displays the total amount of the other sale, minus the amount in the Paid Today field.

Depending upon the amount in this column, one of three things will occur when you click the Record button:

* If the amount is zero, an other sale with no balance (sometimes known as a "closed sale") will be created.
* If the amount is a positive number, an other sale with an outstanding balance (sometimes known as an "open sale") 
will be created. This amount will be recorded in your linked debtors account.
* If the amount is a negative number, a credit note will be created.



Set Item Prices window
The Set Item Prices window allows you to quickly define selling prices for items sold by your business.

The selling prices you establish in this window can be changed when you create invoices.

Fields in this window:

Avg Cost button
Current Price column
Last Cost button
List of items you sell
None button
OK button
Print button
Shortcut column
Shortcuts button



Shortcut column
Click the Shortcut column for an item if you wish to use the Pricing Shortcuts window to change prices for the item or 
a group of items. A mark will appear in the column next to the item. If you dont want a mark to appear for an item, 
click the mark to remove it.

Note: Choose Select All from the Edit menu to select all items in the list.



List of items you sell
The list displays all items you sell and provide - in other words, the items for which you selected I Sell This Item in the
Item Information window. For each item, the item number, name, average cost or last purchase price and current 
selling price are displayed.



Current price column
This column contains the current price for one selling unit of measure for each item you established in the Item 
Information window. You can change the prices that are displayed in this column individually, or use the Pricing 
Shortcuts window to change the prices of a group of items.



Shortcuts button
Click this button to open the Pricing Shortcuts window, which will allow you to change the prices of all your items, or 
just the prices of items whose Shortcut column contains a mark.



Last Cost button
Click this button to view the most recent cost of each item in the list.

For items for which you selected I Buy This Item in the Item Information window, the last price you paid to purchase 
those items is displayed. For items for which you did NOT select I Buy This Item, but for which you selected I Stock 
This Item in the Item Information window, the last cost that was used when you transferred those items in the Stock 
Transfers window or sold those items in the Sales window is displayed.

If this selection is marked and you click the Shortcuts button, the prices you change can be based on the last 
purchase prices of the selected items.



Avg Cost button
Click this button to view the average cost of each stock item in the list. Average cost is calculated by dividing the 
current value of each item's quantities by the number of items on hand.

If this selection is marked and you click the Shortcuts button, the prices you change can be based on the average 
cost of the selected items.



Select from List window (Settle Returns and Credits)
The Settle Returns and Credits windows allow you to use credit notes to decrease the balance of sales invoices and 
write refund cheques.

M.Y.O.B.s Settle Returns and Credits function consists of two windows: Select from List, where you select a credit 
note to work with, and Settle Returns and Credits, where you apply the credit note you selected to a particular task.

The Select From List window allows you to view the credit notes currently in the M.Y.O.B. system and select a credit 
note to apply or write a refund cheque.

Fields in this window:

Apply to Invoice button
Cancel button
List of credit notes
Refund button



List of credit notes
The list displays information about each of the credit notes in the M.Y.O.B. system, including the customer name, 
invoice number and amount.



Refund button
Click this button to open Refund Cheque View of the Settle Returns and Credits window, where you can apply the 
credit note you selected in the list to a refund cheque to the customer.



Apply to Invoice button
Click this button to open the Apply to Sale View of the Settle Returns and Credits window, where you can apply the 
credit note you selected in the list to an open, closed or pending invoice, or to an other sale.



Settle Returns and Credits window (Apply to Sale View)
The Settle Returns and Credits windows allow you to use credit notes to decrease the balance of sales invoices and 
write refund cheques.

M.Y.O.B.s Settle Returns and Credits function consists of two windows: Select from List, where you select a credit 
note to work with, and Settle Returns and Credits, where you apply the credit note you selected to a particular task. 
Additionally, the Settle Returns and Credits window consists of two views, Apply to Sale View and Refund Cheque 
View.

Apply to Sale View allows you to assign a credit note amount to open, closed and pending invoices, as well as other 
sales transactions entered in M.Y.O.B.

All sales transactions for this customer are displayed in the list in the bottom half of the window. Open sales are 
displayed at the top of the list, followed by pending invoices and then by closed sales. 

Fields in this window:

Amount Applied column
Amount column
Cancel button
Credit Amount
Customer
Date
Date column
Discount column
Finance Charge
ID No.
Invoice No. column
Journal button
Memo
Record button
Record Reversal button
Status column
Total Due column



Customer
This field displays the name of the customer whose credit note you selected in the Select from List window. This 
name cant be changed using this window; however, if you wish to view detailed information about the customer, click 
the zoom arrow to display the Card File Entry window.



ID No.
Using up to eight characters, enter the journal number you want to assign to this transaction, or accept the default 
journal number. This number will be recorded in the Sales Journal.

We recommend that you use the default journal number, because it ensures that you dont use duplicate journal 
numbers, which may cause confusion in your recordkeeping. If you want to assign a different number, consider 
leaving the SJ prefix assigned to the number, so its easy for you to distinguish the transaction as a Sales Journal 
transaction.



Credit Amount
Enter the amount of the credit note, or accept the default amount, which is the amount that resulted from the 
transaction that created the credit note.

If you decide to change the default amount, you can only decrease it.



Memo
Using up to 255 characters, enter a description of the transaction. This description will appear on various M.Y.O.B. 
reports, as well as the Sales Journal.



Invoice No. column
This column displays the numbers assigned to the sales transactions entered in the Sales window in the Sales 
Ledger Command Centre. 



Status column
This column displays the status of each of the sales transactions in the list. 

OPEN: Sales transactions with a positive balance.
CLOSED: Sales transactions with a zero balance.
PENDING: Invoices assigned a pending status in the Sales window.

If you want to open the Inquiry Register window to view more detailed information about a specific sales transaction, 
click the zoom arrow next to the sales transactions status.



Date column
This column displays the date each of the sales transactions in the list was recorded.



Amount column
This column displays the current amount due for each of the sales transactions in the list.



Discount column
Enter early-payment discounts for each of the sales transactions in this list, or accept the default amounts, which 
were entered for this customer in the Credit Terms window.

Enter a discount amount only when youre settling the entire remaining balance of a sales transaction. If you enter a 
discount on a partial payment of a sales remaining balance, that discount wont be recorded. For example, if you enter
a £2 discount on £100 sale, the total due amount is £98. However, if you apply only £75 to the sale, the discount wont
be calculated; £25 will be the remaining balance of the sale.



Total Due column
This column displays the total amount due for each sales transaction in the list. This amount is calculated by 
subtracting the amount in the Discount column from the amount in the Amount column.



Amount Applied column
Enter the amount of the credit note you want to apply to each sales transaction in the list, or accept the default 
amounts that appear in this column. The default amount that appears in this column is either the total amount of one 
sales remaining balance or the remainder of the credit note amount.

You can distribute the credit note amount to more than one sales transaction.



Finance Charge
Enter the amount you wish to apply to the customers finance charges.

When you click Record, the balance of the account you entered in the Income Account for Late Charges field of the 
Sales Ledger Linked Accounts window will be increased.



Settle Returns and Credits window (Refund Cheque View)
The Settle Returns and Credits windows allow you to use credit notes to decrease the balance of sales invoices and 
write refund cheques.

M.Y.O.B.s Settle Returns and Credits function consists of two windows: Select from List, where you select a credit 
note to work with, and Settle Returns and Credits, where you apply the credit note you selected to a particular task. 
Additionally, the Settle Returns and Credits window consists of two views, Apply to Sale View and Refund Cheque 
View.

Refund Cheque View allows you to write a refund cheque for the credit note you selected in the Select from List 
window.

Fields in this window:

Amount
Balance
Cancel button
Cheque No.
Bank account
Customer
Date
Handwritten
Journal button
Memo
Print button
Record button



Bank account
Select the bank account you want to use to write the refund cheque.

The accounts in this list were assigned bank privileges in the Edit Accounts window.



Balance
This field displays the current balance of the bank account displayed in the upper left-hand corner of the window. If 
you wish to display the Inquiry Register window to view more detailed information about the bank account, click the 
zoom arrow.



Handwritten
Mark this selection if you dont intend to print this cheque using M.Y.O.B.

When you mark this selection, M.Y.O.B. will record the cheque as printed; when you select Unprinted Cheques Only 
in the Print Cheques window, this cheque wont be printed.

If youre viewing a cheque thats been printed, this selection will be already marked.



Cheque No.
Enter the number of the cheque you wish to print, or accept the default cheque number, which is one number higher 
than the last cheque you wrote from this bank account.



Date
Enter the date of the cheque.

Dates that occur before your conversion date or in a previous financial year cant be used. 



Amount
Enter the total amount of the cheque, or accept the default amount, which is the entire amount of the credit note. If 
you choose to change the default amount, you can enter an amount less than the default amount only.

When you click Record to save this cheque, the balance of the bank account displayed in the upper left-hand corner 
of the window will be decreased by the amount you enter here. 



Customer
Enter the name of the person or company who will receive this cheque, or accept the default name. The address of 
the person or company appears below the name.

If you want to view the Card File Entry window for more information about the customer, click the zoom arrow.



Memo
Enter a description of the transaction or accept the default description. This description will appear on various 
M.Y.O.B. reports, as well as the Cash Disbursements Journal.

We suggest you use the default description to remind you of the nature of the transaction.



Record button
Click this button to record the refund cheque. The balance of the bank account displayed in the upper left-hand 
corner of the window will be decreased by the amount you entered in the Amount field. 



Select from List window (Settle Returns & Debits)
The Settle Returns and Debits windows allow you to use debit purchases to decrease the balance of outstanding 
purchasing balances and deposit refund cheques.

M.Y.O.B.s Settle Returns and Debits function consists of two windows: Select from List, where you select a debit 
purchase to work with, and Settle Returns and Debits, where you apply the debit purchase you selected to a 
particular task.

The Select From List window allows you to view the debit purchases currently in the M.Y.O.B. system and select a 
debit purchase to apply to an open purchase or deposit a refund cheque.

Fields in this window:

Apply to Purchase button
Cancel button
List of debit purchases
Refund button



List of debit purchases
The list displays information about each of the debit purchases in the M.Y.O.B. system, including the supplier name, 
purchase number and amount.



Refund button
Click this button to open Refund Cheque View of the Settle Returns and Debits window, where you can record the 
debit purchase you selected in the list as a refund cheque from the supplier.



Apply to Purchase button
Click this button to open Apply to Purchase View of the Settle Returns and Debits window, where you can apply the 
debit purchase you selected in the list to an open, closed or pending purchase order, or to an other purchase.



Settle Returns and Debits window (Apply to Purchase 
View)
The Settle Returns and Debits windows allow you to use debit purchases to decrease the balance of outstanding 
purchasing balances and deposit refund cheques.

M.Y.O.B.s Settle Returns and Debits function consists of two windows: Select from List, where you select a debit 
purchase to work with, and Settle Returns and Debits, where you apply the debit purchase you selected to a 
particular task. Additionally, the Settle Returns and Debits window consists of two views, Apply to Purchase View and 
Refund Cheque View.

Apply to Purchase View allows you to assign a debit purchase amount to open, closed and pending purchase orders, 
as well as other purchases entered in M.Y.O.B.

All purchases for this customer are displayed. Open purchases are displayed at the top of the list, followed by 
pending purchase orders and then by closed purchases. 

Fields in this window:

Amount Applied column
Amount column
Cancel button
Date
Date column
Debit Amount
Discount column
Finance Charge
ID No.
Journal button
Memo
Purchase No. column
Record button
Status column
Total Owed column
Supplier



Supplier
This field displays the name of the supplier whose debit purchase you selected in the Select from List window. This 
name cant be changed using this window; however, if you wish to view detailed information about the supplier, click 
the zoom arrow to display the Card File Entry window.



ID No.
Using up to eight characters, enter the journal number you want to assign to this transaction, or accept the default 
journal number. This number will be recorded in the Purchases Journal.

We recommend that you use the default journal number, because it ensures that you dont use duplicate journal 
numbers, which may cause confusion in your recordkeeping. If you want to assign a different number, consider 
leaving the PJ prefix assigned to the number, so its easy for you to distinguish the transaction as a Purchases Journal
transaction.



Debit Amount
Enter the amount of the debit purchase, or accept the default amount, which is the amount that resulted from the 
transaction that created the debit purchase.

If you decide to change the default amount, you can only decrease it.



Memo
Using up to 255 characters, enter a description of the transaction. This description will appear on various M.Y.O.B. 
reports, as well as the Purchases Journal.



Purchase No. column
This column displays the numbers assigned to the purchasing transactions entered in the Purchases window. 



Status column
This column displays the status of each of the purchasing transactions in the list. 

OPEN: Purchasing transactions with a positive balance.
CLOSED: Purchasing transactions with a zero balance.
PENDING: Purchase orders assigned a pending status in the Purchases window.

If you want to open the Inquiry Register window to view more detailed information about a specific purchasing 
transaction, click the zoom arrow next to the purchasing transactions status.



Date column
This column displays the date each of the purchasing transactions in the list was recorded.



Amount column
This column displays the current amount due for each of the purchasing transactions in the list.



Discount column
Enter early-payment discounts for each of the purchasing transactions in this list, or accept the default amounts, 
which were entered for this supplier in the Credit Terms window.

Enter a discount amount only when youre settling the entire remaining balance of a purchasing transaction. If you 
enter a discount on a partial payment of a purchases remaining balance, that discount wont be recorded. For 
example, if you enter a £2 discount on £100 purchase, the total due amount is £98. However, if you apply only £75 to 
the purchase, the discount wont be calculated; £25 will be the remaining balance of the purchase.



Total Owed column
This column displays the total amount you owe for each purchasing transaction in the list. This amount is calculated 
by subtracting the amount in the Discount column from the amount in the Amount column.



Amount Applied column
Enter the amount of the debit purchase you want to apply to each purchasing transaction in the list, or accept the 
default amounts that appear in this column. The default amount that appears in this column is either the total amount 
of one purchases remaining balance or the remainder of the debit purchase amount.

You can distribute the debit purchase amount to more than one purchasing transaction.



Finance Charge
Enter the amount you wish to apply to your finance charges with this supplier.

When you click Record, the balance of the account you entered in the Expense Account for Late Charges field of the 
Purchase Ledger Linked Accounts window will be increased.



Record button
Click this button to record the application of the debit purchase amount in the Sales Journal.



Settle Returns and Debits window (Refund Cheque View)
The Settle Returns and Debits windows allow you to use debit purchases to decrease the balance of outstanding 
purchasing balances and deposit refund cheques.

M.Y.O.B.s Settle Returns and Debits function consists of two windows: Select from List, where you select a debit 
purchase to work with, and Settle Returns and Debits, where you apply the debit purchase you selected to a 
particular task. Additionally, the Settle Returns and Debits window consists of two views, Apply to Purchase View and 
Refund Cheque View.

Refund Cheque View allows you to deposit a suppliers refund cheque for the debit purchase you selected in the 
Select from List window. When you click Record in this window, the refund cheque will be deposited into the bank 
account you select in this window.

Fields in this window:

Amount Received
Cancel button
Bank account
Date
ID No.
Journal button
Memo
Record button
Supplier



Bank account
Select the bank account you want to deposit the refund cheque into.

The accounts in this list were assigned bank privileges in the Edit Accounts window.



Supplier
This field displays the name of the supplier whose debit purchase you selected in the Select from List window. This 
name cant be changed using this window; however, if you wish to view detailed information about the supplier, click 
the zoom arrow to display the Card File Entry window.



ID No.
Using up to eight characters, enter the journal number you want to assign to this transaction, or accept the default 
journal number. This number will be recorded in the Cash Receipts Journal.

We recommend that you use the default journal number, because it ensures that you dont use duplicate journal 
numbers, which may cause confusion in your recordkeeping. If you want to assign a different number, consider 
leaving the CR prefix assigned to the number, so its easy for you to distinguish the transaction as a Cash Receipts 
Journal transaction.



Date
Enter the date of the refund cheque.

Dates that occur before your conversion date or in a previous financial year cant be used. 



Amount Received
Enter the total amount of the refund cheque, or accept the default amount, which is the entire amount of the debit 
purchase. If you choose to change the default amount, you can enter an amount less than the default amount only.

When you click Record to save this refund cheque, the balance of the bank account you selected will be increased by
the amount you enter here. 



Memo
Enter a description of the transaction or accept the default description. This description will appear on various 
M.Y.O.B. reports, as well as the Cash Receipts Journal.

We suggest you use the default description to remind you of the nature of the transaction.



Record button
Click this button to save the refund cheque. The balance of the bank account you selected will be increased by the 
amount you enter here. 



To Do List window
The To Do List window contains lists of reminders that inform you to perform your regular business tasks on a 
consistent basis. M.Y.O.B. uses the dates you set up in the Business Calendar window to add reminders to the To Do
List. If the number of days for a reminder - except for money due to you thats overdue - places the reminder on a 
non-business day, the reminder will be moved to the previous business day.

To view a specific group of reminders, click its corresponding tab at the top of the window.

The available views - Creditors View, Debtors View, Recurring Transactions View, Recurring Sales View, Recurring 
Purchases View, Expiring Discounts View, Pending View, Restock Alert View and Contact Alert View - are very similar
to each other.

Fields in this window:

Creditors tab
Debtors tab
Close button
Contact Alert tab
Expiring Discounts tab
Mail Merge button
Pending tab
Print button
Recurring Purchases tab
Recurring Sales tab
Recurring Transactions tab
Stock Alert tab



Debtors tab
Click this tab to display all unpaid sales to date.

The due date is calculated by comparing the original date of the sale to the current date and reviewing the customers 
credit terms. If a positive number of days appears in the Overdue column, the amount is overdue by the number of 
days displayed; if the number is negative, the amount isnt due yet.

To send a "payment due" notice to a customer, click in an invoices Action column. The notice will be included in a mail
merge file when you click the Mail Merge button at the bottom of the window.

Note: If a customer has more than one overdue amount, only one notice will be created, containing the total amount 
of all their overdue sales.

Click the zoom arrow next to the customers name to open the Sales window, displaying the original invoice whose 
payments are due.



Creditors tab
Click this tab to display all unpaid purchases to date.

The due date is calculated by comparing the original date of the sale to the current date and reviewing your credit 
terms with the supplier. If a positive number of days appears in the Overdue column, the amount is overdue by the 
number of days displayed; if the number is negative, the amount isnt due yet.

To send a cheque to a supplier, click in a purchase orders Action column. The cheque will be created when you click 
the Pay Bills button at the bottom of the window.

Click the zoom arrow next to the suppliers name to open the Bill Payments window. 



Recurring Transactions tab
Click this tab to display a list of all your recurring transactions, such as cheques, deposits, Nominal Journal entries.

The due date is calculated by adding the number of days between occurrences of the transaction to the last day the 
transaction was previously recorded.

If a positive number of days appears in the Overdue column, the transaction is overdue by the number of days 
displayed; if the number is negative, the transaction isnt due yet.

To record a transaction, click in a transactions Action column. The transaction will be recorded when you click the 
Record button at the bottom of the window.

Click the zoom arrow next to the transaction name to open the window in which the transaction was originally 
created.



Recurring Sales tab
Click this tab to display a list of all your recurring sales transactions.

The due date is calculated by adding the number of days between occurrences of the transaction to the last day the 
transaction was previously recorded.

If a positive number of days appears in the Overdue column, the amount is overdue by the number of days displayed;
if the number is negative, the amount isnt due yet.

To record a sales transaction, click in the transaction's Action column. The transaction will be recorded when you click
the Record button at the bottom of the window.

Click the zoom arrow next to the customers name to open the Sales window, where the sales transaction was first 
created.



Recurring Purchases tab
Click this tab to display a list of all your recurring purchasing transactions.

The due date is calculated by adding the number of days between occurrences of the transaction to the last day the 
transaction was previously recorded.

If a positive number of days appears in the Overdue column, the amount is overdue by the number of days displayed;
if the number is negative, the amount isnt due yet.

To record a purchasing transaction, click on a transaction's Action column. The transaction will be recorded when you 
click the Record button at the bottom of the window. 

Click the zoom arrow next to the suppliers name to zoom to the window in which the transaction was first created.



Expiring Discounts tab
Click this tab to display a list of purchasing transactions youve made for which discounts still apply if you make an 
early payment.

To write a cheque for one of the transactions in the list, click on a transaction's Action column. A transaction will be 
recorded when you click the Pay Bills button at the bottom of the window. 

Click the zoom arrow next to the suppliers name to open the Bill Payments window.



Pending tab
Click this tab to display a list of your pending invoices and purchase orders.

If the transaction is a pending invoice, a zoom arrow will appear in the Inv column; if its a pending purchase order, a 
zoom arrow will appear in the P.O. column.

The date that appears in the Promised date column is the delivery date for the transactions.

To record a pending transaction as an actual transaction, click a pending transactions Action column. The transaction 
will be recorded when you click the Record as Actual button in the bottom of the window.

Click the transactions zoom arrow to open the window in which the transaction was first created.



Stock Alert tab
Click this tab to display a list of stock items whose quantity levels are lower than the minimum levels you set up in the
Restocking Information window.

Each time you record a sale of a stock item, M.Y.O.B. calculates the items quantity by taking the current quantity of 
the item you have on hand, adding the quantity on order, and subtracting the quantity delivery to customers. If the 
quantity of the item is less than the minimum level, the item appears in this list.

If you marked the I Buy This Item selection in the Item Information window for the item, a zoom arrow will appear in 
the Order column. Click the zoom arrow to open the Purchases window, where you can create a purchase order for 
the item. If the item has a main supplier and a reorder quantity (also entered in the Restocking Information window), 
most of the information in the purchase order will be automatically entered.

If this item is created by auto-building it, a zoom arrow will appear in the Build column. Click the zoom arrow to zoom 
to the Auto-Build window, where you can automatically build more of the item. 

Its possible that you may have items that can be both purchased and automatically built. When an item fits this 
scenario, zoom arrows will appear in both the Order and Build columns. If you mark the Action column and click 
Order/Build for these items, no action will occur; you must click one of the zoom arrows next to the item name to 
either create a purchase order or automatically build the item.



Contact Alert tab
Click this tab to display a list of the people or companies youre due to contact. 

If you entered a recontact date for a person in the Contact Log Entry window, the persons name will appear in this list
on the day you entered. Names will remain in the list until you remove them. 

To remove a contact from the list, click in the contact's Action column. The contact will be removed when you click the
Remove button in the bottom of the window.

Click the zoom arrow next to a contacts name to open the Contact Log Entry window.



Mail Merge button
(or: Pay Bills; Record; Record as Actual; Order/Build; Remove)
Click this button to create a mail merge file of the customers who have outstanding sales balances with your 
company. The mail merge file can be used to send "payment due" notices to those customers.

The Mail Merge button appears only if you're viewing A/R View of the To Do List window. (If you're viewing a different 
view, this button will be labelled with one of the titles listed above. In each case, clicking the button performs an 
action. For more information about the other actions this button can perform, click the various tabs at the top of this 
illustration.)



Transaction Journal window
The Transaction Journal window allows you to view the current transactions that are recorded in the Cash 
Disbursements, Cash Receipts, Nominal, Stock, Purchases and Sales journals.

The journal information that appears in this window is view-only; that is, you cant change any of the transaction 
information using this window.

Fields in this window:

Account column
All tab
Close button
Date column
Dated From/To
Debit/Credit columns
Disbursements tab
Nominal tab
ID No. column
Stock tab
Job column
Print button
Purchases tab
Receipts tab
Sales tab
Src column



Nominal tab
Click this tab to view the transactions in the Nominal Journal, which contains transactions recorded in the Nominal 
Ledger Command Centre.



Disbursements tab
Click this tab to view the transactions in the Cash Disbursements Journal, which contains information about money 
youve paid out that affects (credits) bank accounts.



Receipts tab
Click this tab to view the transactions in the Cash Receipts Journal, which contains information about money youve 
received that affects (debits) bank accounts.



Sales tab
Click this tab to view the transactions in the Sales Journal, which contains sales transaction information affecting 
sales,debtors control, stock and cost of sales accounts.



Purchases tab
Click this tab to view the transactions in the Purchases Journal, which contains purchasing transaction information 
affecting creditors control, stock asset and purchase expense accounts.



Stock tab
Click this tab to view the transactions in the Stock Journal, which contains transaction information affecting the value 
of stock items.



All tab
Click this tab to view the transactions in all six M.Y.O.B. journals.



Dated From/To
Enter a range of dates in this field to display transaction information for a specific time frame in this window.



Src column
This column contains the source journal codes are assigned to the transactions displayed in the window. M.Y.O.B.s 
source journal codes are listed below.

CD = Cash Disbursements Journal
CR = Cash Receipts Journal
IJ = Stock Journal
NJ = Nominal Journal
PJ = Purchases Journal
SJ = Sales Journal

This column appears only if youre viewing transactions in all journals (that is, the All tab is selected at the top of the 
window).



Date column
This column contains the dates that are assigned to the transactions displayed in this window.



ID No. column
This column contains the numbers that identify the transactions displayed in this window in their appropriate journals.



Account column
This column contains the accounts that are affected by the transactions that are displayed in this window.



Debit/Credit columns
These columns contain the amounts by which the accounts listed in the Account column are debited and credited for 
each transaction thats displayed in this window.



Job column
This column contains the jobs that are affected by the transactions that are displayed in this window.



Write Cheques window
The Write Cheques window allows you to create records of your cheques drawn from any of your businesss bank 
accounts. The top half of the window is designed to look like an actual paper cheque, with fields that allow you to 
enter cheque information. The bottom half of the window contains a scrolling list of the accounts and jobs affected by 
each cheque, as well as the amounts that comprise each cheque.

You can also use this window to set up recurring cheques of the same value and examine the Cash Disbursements 
Journal.

Fields in this window:

Allocation Account columns
Amount
Amount column
Balance
Cancel button
Card
Cheque No.
Bank accounts list
Date
Don't Record button
Handwritten
Job column
Journal button
Memo
New button
Payee
Print button
Record button
Record Reversal button
Save Recurring button
VAT Column
Use Recurring button
Total VAT



Bank accounts list
Select the bank account you normally use to write cheques.

The accounts in this list were assigned bank privileges in the Edit Accounts window.



Balance
This field displays the current balance of the bank account you selected in the left-hand corner of the window. If you 
wish to display the Inquiry Register window to view more detailed information about the bank account, click the zoom 
arrow.



Handwritten
Mark this selection if you dont intend to print this cheque using M.Y.O.B.

When you mark this selection, M.Y.O.B. will record the cheque as printed; when you select Unprinted Cheques Only 
in the Print Cheques window, this cheque wont be printed.

If youre viewing a cheque thats been printed, this selection will be already marked.



Card
Enter the name of the person or company in the Card File who will receive this cheque, or click the search icon to 
display a search list of the people and companies in your Card File that you can select from.

After a card name is entered in this field, you can click the zoom arrow to display the Card File Entry window and 
view detailed information about the person or company.

If the person or company isnt in the Card File and you dont want to add them to the Card File, press TAB to move the
highlight to the Payee field, where you can enter "Pay to the Order of" information for the person or company. We 
recommend, however, that you include the person or company in the Card File, so you have more flexibility in 
tracking where your money is going.



Payee
If you entered the name of a person or company from the Card File in the Card field, this field will display the name 
and address of the person or company. The name and address thats displayed was entered in the Card File Entry 
window. If you wish, you can change this information for this cheque; the original information will remain in the Card 
File Entry window.

If you left the Card field blank, enter the name and address of the person or company to whom youre writing this 
cheque.

This information will be printed in the "Pay to the Order of" section of the cheque. If you use window envelopes, this 
information will show through the window.



Memo
Enter a description of the transaction. This description will appear on various M.Y.O.B. reports, as well as the Cash 
Disbursements Journal. If you dont enter anything in this field, the first line of the Payee field will appear in the Cash 
Disbursements Journal.

We suggest you use the word "Cheque" in the memo to remind you of the nature of the transaction.



Cheque No.
Enter the number of the cheque you wish to print, or accept the default cheque number, which is one number higher 
than the last cheque written from this bank account.



Date
Enter the date of the cheque.

Dates that occur before your conversion date or in a previous financial year cant be used. 



Amount
Enter the total amount of the cheque.

When you save this cheque, the balance of the bank account you selected in the left-hand corner of the window will 
be decreased by the amount you enter here. 



Allocation Account columns
Enter the number of the account you want to assign to each line in the transaction, or click the search icon to display 
a search list of accounts you can select from. From the list, you can also create a new account to assign the cheque 
amount to. The name of the account you selected will also appear here.

The cheque amount you entered in the Amount field is considered a credit amount. When you enter accounts and 
amounts in this list, the accounts will be debited by the amounts you enter.



Amount column
Enter the amount that you wish to assign to this account for this cheque. If the total of the amounts in this column 
doesnt match the amount in the Amount field (in other words, if the transaction is out of balance), this field will display
a default amount that balances the transaction. You can change the default, if you wish.

The cheque amount you entered in the Amount field is considered a credit amount, and the amounts you enter in this 
column are considered debit amounts. If you want an amount in this column to be used as a credit instead, enter the 
amount as a negative number.



Job column
You can assign a job to each income, cost of sales, expense, other income or other expense account in the list. To do
so, enter the job number here or click the search icon to display a search list of existing jobs. From the search list, 
you can also create a new job to assign the account to.

If you need to assign an amount from one account to more than one job, use multiple lines to record the transaction. 
For example, assume you want to debit your Office Supplies account £100, but you want to assign £30 to job 12 and 
£70 to job 43. To do this, enter the Office Supplies account number in the Acct No. column, then enter £30 in the 
Amount column and 12 in the Job column. Move to the next line, enter the Office Supplies account number again, 
enter £70 in the Amount column and 43 in the Job column.



Record button
Click this button to record the transaction youve made in this window.

If the total of the amounts in the Amount column in the bottom half of this window dont equal the number you entered 
in the Amount field in the top half of the window, you wont be allowed to record the cheque. Change your entries in 
the Amount column so they total the number in the Amount field.



Total VAT
The amount of VAT for the whole deposit. The VAT will be allocated to the Linked VAT account for Deposits.

Note: If for any reason you need to amend the VAT calculated click on the arrow to the left of Total Vat. The Vat 
Information window will open



VAT column
This column is used to enter the VAT code(s) applicable if any to this deposit. The default code prompted is the first 
one in the VAT Codes window. You can enter any valid VAT code in the VAT column.

Note: When a deposit transaction line (such as Share Capital invested in a company) which is outside the scope is 
entered the VAT column should be left blank.    The transaction will not then appear on the VAT reports.



Set Up VAT Codes window
The Set Up VAT Codes window allows you to set up codes for all VAT rates assigned to transactions you enter in 
M.Y.O.B. After you set up these codes, they'll be available in search lists in the Chequebook, Sales and Purchasing 
windows for you to select.

Fields in this window:

Code
Description
OK button
Rate



Code
Enter a letter of the alphabet to assign a code to a VAT rate.

Each time you enter a transaction in the Sales window or Purchasing window, you can assign a VAT code so the 
appropriate rate is applied to the transaction.

If you change the rate assigned to a code, the new code will be used in all existing transactions that use the code.



Rate
Enter the VAT percentage you want to assign to this VAT code. The percentage you enter can be between 0 and 
99.99.

Changing the VAT rate will not affect existing transactions.



Description
Enter a description of this VAT code.



Company Information window
The Company Information window allows you to enter nominal information about your company that affects various 
parts of the M.Y.O.B. system.

The entries in the Current Financial Year, Last Month in Financial Year, Conversion Month and Accounting Periods 
per Year fields were entered when you created your company's data file. These entries can't be changed.

Fields in this window:

Customer Number
Company Name
Address
Phone Number
VAT Reg. Number
Company Reg. No.
Current Financial Year
Last Month in Financial Year
Conversion Month
Accounting Periods per Year
Record button



Customer Number
This field displays the number assigned to you when you registered M.Y.O.B. This number is your company's unique 
identifier with BestWare, and can't be changed.



Company Name
Enter or change your company's name, using up to 40 characters.

The name that's entered in this field is displayed in all command centre windows, and, if you wish, on your M.Y.O.B. 
reports.



Address
Enter your company's address.

The address you enter here will be displayed on M.Y.O.B. invoices and purchase orders.



Phone Number
Enter your company's telephone number. Add hyphens and an extension, if you wish.



VAT Reg. Number
Enter or change your company's VAT registration number. If this is the first time you've opened the Company 
Information window and an entry already appears in this field, this number was entered in the M.Y.O.B. Setup 
Interview.



Company Reg. No.
Enter or change your company's registration number. If this is the first time you've opened the Company Information 
window and an entry already appears in this field, this number was entered in the M.Y.O.B. Setup Interview.



Current Financial Year
This field displays the name of your current financial year. This entry was made when you created your company's 
data file during the M.Y.O.B. Setup Interview, and can't be changed.



Last Month in Financial Year
This field displays the last month of your current financial year. This entry was made when you created your 
company's data file during the M.Y.O.B. Setup Interview, and can't be changed.



Conversion Month
This field displays the month in which you started using M.Y.O.B. to track your business. This entry was made when 
you created your company's data file during the M.Y.O.B. Setup Interview, and can't be changed.



Accounting Periods per Year
This field displays the number of accounting periods you have in your current financial year. This entry was made 
when you created your company's data file during the M.Y.O.B. Setup Interview, and can't be changed.



Preferences window

The Preferences window allows you to establish various settings that affect the entire M.Y.O.B. system.

Fields in this window:

Apply Bill Payments Automatically to Oldest Purchase First
Apply Customer Payments Automatically to Oldest Invoice First
Automatically Prompt for a Session Report
Close button
Data File Records CANNOT be Changed; Saved Entries Must be Reversed
Default Cheque is Handwritten
Display Payee, Rather Than Memo, in Registers
Display To Do List When Starting M.Y.O.B.
Forms button
I Have a Modem for Autodialing
Include Currency Symbols in Forms
Include Currency Symbols in Reports
Lock Periods
Make a Contact Log Entry for Every Cheque
Make a Contact Log Entry for Every Deposit
Make a Contact Log Entry for Every Purchase
Make a Contact Log Entry for Every Sale
Password button
Pies button
Print Invoices When They're Recorded
Print Packing Slips When Invoices are Printed
Print Purchases When They're Placed in the Pending File
Print Delivery Labels When Invoices are Printed
Prompt for Data Backup When Leaving M.Y.O.B.
Reports button
Save Window Sizes and Locations
Select Items by Item Name, not Item Number
Show Currency Signs in Windows
Terms button
The ENTER Key Works Like the TAB Key When Entering Data
Warn Before Recording Post-Dated Transactions
Warn for Duplicate Cheque Numbers
Warn for Duplicate Invoice Numbers
Warn for Duplicate Purchase Order Numbers
Warn if Customer has an Outstanding Credit Before Applying a Payment
Warn if Supplier Owes Me Money Before Making a Bill Payment
Windows button



Apply Bill Payments Automatically to Oldest Purchase First
Mark this selection if you want to automatically apply payments to suppliers to the oldest outstanding purchasing 
transaction you have with those suppliers.

If you mark this selection, the amount you enter in the Amount field of the Bill Payments window will automatically be 
entered in the Amount Applied field of the oldest purchasing transaction you have with the supplier whose name you 
entered in the Supplier field.

If you don't mark this selection, you must manually distribute the amount you entered in the Amount field to the 
purchasing transaction(s) you want to apply your bill payment to.



Apply Customer Payments Automatically to Oldest Invoice First
Mark this selection if you want to automatically apply customer payments to the oldest outstanding sales transaction 
they have with your business.

If you mark this selection, the amount you enter in the Amount field of the Customer Payments window will 
automatically be entered in the Amount Applied field of the oldest sales transaction the customer has with your 
business.

If you don't mark this selection, you must manually distribute the amount you entered in the Amount field to the sales 
transaction(s) you want to apply the payment to.



Automatically Prompt for a Session Report
Choose when you'd like a session report to print.

If you select Upon Saving, an alert message will appear each time you choose Save from the File menu, asking 
whether you'd like to print a session report.

If you select Upon Quitting, an alert message will appear each time you select Quit, Exit, Open or New from the File 
menu, asking whether you'd like to print a session report.

When you choose to print a session report, the command you chose (Save, Quit, Exit, Open or New) is cancelled. 
After the report is printed, choose your command again, then select No Report in the alert message.



Data File Records CANNOT be Changed; Saved Entries Must be 
Reversed
Choose whether your saved accounting information, such as individual transactions, can be changed.

If you mark this selection, entries you've made and saved in M.Y.O.B. can't be edited; instead, they must be reversed.
If you wish to keep an audit trail of the errors and corrections made to your financial records, you should mark this 
selection. (Even if you mark this selection, you can still make changes to transaction entries until you choose Save 
from the File menu.)

If you don't mark this selection, all entries you make in M.Y.O.B. can be edited.

Regardless of your selection here, saved stock adjustment and transfer transactions can't be changed. To correct a 
mistaken stock transaction, you must create a reversing transaction to cancel the effects of the incorrect transaction, 
then enter the correct transaction.



Default Cheque is Handwritten
Mark this selection if the cheques you write usually aren't printed using M.Y.O.B.

If you mark this selection, the Handwritten selection in the Write Cheques, Settle Returns and Credits windows will be
automatically marked each time you write a cheque. (You can unmark the selection, if you want.)

If you don't mark this selection, the Handwritten selection won't be automatically marked.



Display Payee, Rather Than Memo, in Registers
Mark this selection if you want to display the name of the people who receive your cheques in the Inquiry Register 
window.

If you mark this selection, the name that appears in the Payee field of the Write Cheques, Write Paycheques and 
Settle Returns and Credits windows will appear in the Inquiry Register window next to the summary descriptions of 
the cheques written in those windows.

If you don't mark this selection, the text that appears in the Memo field of those windows will appear in the Inquiry 
Register window instead.



Display To Do List When Starting M.Y.O.B.
Mark this selection if you wish to view the To Do List immediately after you've opened your M.Y.O.B. data file.

If you mark this selection, the To Do List window will appear when you start M.Y.O.B. and open a data file, or when 
you choose Open from the File menu and select a data file.

If you don't mark this selection, the Command Centre window will appear when you open a data file.



Forms button
Click this button to open the Change Default Forms Font window, where you can change the default font you use in 
your printed forms, such as cheques, invoices, statements, purchase orders and mailing labels.



I Have a Modem for Autodialing
Mark this selection if a modem is connected to your computer and you wish to use M.Y.O.B. to dial telephone 
numbers.

If you mark this selection, select the external port to which your modem is connected from the list. On Windows 
computers, M.Y.O.B. supports COM1 through COM4.



Include Currency Symbols in Forms
Mark this selection if you wish to display currency symbols next to amounts in your printed forms, such as cheques, 
statements, invoices and purchase orders.



Include Currency Symbols in Reports
Mark this selection if you wish to display currency symbols next to amounts in your printed reports.



Lock Periods
Select an accounting period in the current year, or Current Year, from the list to disallow transaction entries from 
occurring in or before the period you select. This prevents you from inadvertently adding, changing or removing 
transactions in periods in which changes could disturb the accuracy of your financial records.

Making a selection here is a safeguard against entries being made in the incorrect period; it doesn't close the period, 
erase transactions or permanently prevent you from recording a transaction in or before the period you select. If you 
need to make entries in or before the period you select, you can change this selection to an earlier period. (Note, 
however, that if you record a transaction in an earlier period, your financial statements, such as your balance sheet 
and profit and loss statement, for that month and all succeeding months may be affected. You may want to reprint 
them after you make your transaction entries.)



Make a Contact Log Entry for Every Cheque
Mark this selection if you want to record a contact in the Contact Log each time you record a cheque.

If you mark this selection, a contact will be entered in the Contact Log for each person or company who exists in the 
Card File and for whom you write a cheque.



Make a Contact Log Entry for Every Deposit
Mark this selection if you want to record a contact in the Contact Log each time you record a deposit.

If you mark this selection, a contact will be entered in the Contact Log for each person or company who exists in the 
Card File and for whom you record a deposit.



Make a Contact Log Entry for Every Purchase
Mark this selection if you want to record a contact in the Contact Log each time you record a purchasing transaction.

If you mark this selection, a contact will be entered in the Contact Log for each supplier who exists in the Card File 
and for whom you record a purchasing transaction.



Make a Contact Log Entry for Every Sale
Mark this selection if you want to record a contact in the Contact Log each time you record a sales transaction.

If you mark this selection, a contact will be entered in the Contact Log for each customer who exists in the Card File 
and for whom you record a sales transaction.



Password button
Click this button to open windows in which you can secure your M.Y.O.B. system with password protection.



Pies button
Click this button to open the Pie Slice Patterns window, where you can establish the colours and patterns of the pie 
graphs you display in M.Y.O.B.



Print Invoices When They're Recorded
Mark this selection if you wish to print an invoice immediately after you record it.

If you mark this selection, the print dialogue box for your computer will appear immediately after you create an item, 
service or professional invoice and click the Record button in the Sales window.

If you don't mark this selection, select Print Invoices from the Sales Ledger Command Centre to print invoices you've 
created in the Sales window.



Print Packing Slips When Invoices are Printed
Mark this selection if you wish to print packing slips that accompany the invoices you're printing.

If you mark this selection, you'll have the option to print packing slips when you select Print Invoices in the Sales 
Ledger Command Centre.



Print Purchases When They're Placed in the Pending File
Mark this selection if you want to print a purchase order at the time it's placed in the Pending File.

If you mark this selection, the print dialogue box for your computer will appear when you create a purchase order and 
click Pending in the Purchases window.

If you don't mark this selection, select Print Purchases from the Purchase Ledger Command Centre to print purchase 
orders in the Pending File.



Print Delivery Labels When Invoices are Printed
Mark this selection if you wish to print delivery labels that accompany the invoices you're printing.

If you mark this selection, you'll have the option to print delivery labels when you select Print Invoices in the Sales 
Ledger Command Centre.



Prompt for Data Backup When Leaving M.Y.O.B.
Mark this selection if you want the option of creating a backup of your data file.

If you mark this selection, an alert message will appear when you select Quit, Exit or Open from the File menu, 
asking whether you want to create a backup of your data. To automatically create a backup, click Yes.

See also
Using the Backup and Restore commands 



Reports button
Click this button to open the Change Default Reports Font window, where you can change the default font you use in 
your printed reports.



Save Window Sizes and Locations
Mark this selection if you wish M.Y.O.B. windows to open in the same on-screen location they were in when you last 
closed them.

Regardless of your selection here, alert messages and other dialogue boxes will always appear in the centre of your 
computer screen.



Select Items by Item Name, not Item Number
Mark this selection if you wish to select items by their descriptive names.

If you mark this selection, you can enter item names in the Sales window and Purchases window when you're 
creating item invoices and item purchase orders. In addition, when you display a search list of items at any time, the 
items will be listed in alphabetical order.

If you don't mark this selection, you can enter item numbers in the Sales window and Purchases window when you're 
creating item invoices and purchase orders. Search lists of items will be listed in numerical order.



Show Currency Symbols in Windows
Mark this selection if you wish to display currency symbols next to amounts in windows throughout the M.Y.O.B. 
system.



Terms button
Click this button to open the Credit Terms window, where you can create a set of default credit terms for all customers
or suppliers (depending upon whether you're currently viewing Sales View or Purchases View of the Preferences 
window) in the M.Y.O.B. system.

When you create a set of default terms using the Credit Terms window here, the terms you select will be 
automatically applied to every new customer or supplier record you add to the Card File. (The terms of existing 
customers and suppliers will remain the same.) If you wish, you can change the terms assigned to an individual 
customer or supplier by displaying that person's or company's name in the Card File Entry window and clicking the 
Terms button in that window.



The ENTER Key Works Just Like the TAB Key When Entering
Data
Mark this selection if you wish to use the ENTER key to perform the same functions as the TAB key.

This selection appears only in M.Y.O.B. for Windows.

See also
Using your keyboard with M.Y.O.B. 



Warn Before Recording Post-Dated Transactions
Mark this selection if you want an alert message to appear each time you enter a transaction that's assigned a date in
the future.

If you mark this selection, an alert message will appear when you enter a date in a transaction entry window that 
hasn't occurred yet. This message is for your information only; you can continue to enter the post-dated transaction if 
you want.

If you don't mark this selection, an alert message won't appear when you enter a date in the future.



Warn for Duplicate Cheque Numbers
Mark this selection if you want an alert message to appear each time you attempt to record a cheque whose number 
is already recorded from the bank account you're using.

If you mark this selection, an alert message will appear when you attempt to record a cheque assigned a number 
that's already been used for this bank account.

If you don't mark this selection, you can use the same cheque number multiple times for a bank account.

Marking this selection will require that M.Y.O.B. scan all the cheques you've written; as a result, it will take more time 
to record your cheques. Therefore, be sure you want to use this feature before you mark this selection.



Warn for Duplicate Invoice Numbers
Mark this selection if you want an alert message to appear each time you attempt to record a sales transaction whose
number is already recorded.

If you mark this selection, an alert message will appear when you attempt to record a sales transaction assigned a 
number that's already been used.

If you don't mark this selection, you can use the same sales transaction number multiple times.

Marking this selection will require that M.Y.O.B. scan all the sales transactions you've recorded; as a result, it will take
more time to record your sales transactions. Therefore, be sure you want to use this feature before you mark this 
selection.



Warn for Duplicate Purchase Order Numbers
Mark this selection if you want an alert message to appear each time you attempt to record a purchasing transaction 
whose number is already recorded.

If you mark this selection, an alert message will appear when you attempt to record a purchasing transaction 
assigned a number that's already been used.

If you don't mark this selection, you can use the same purchasing transaction number multiple times.

Marking this selection will require that M.Y.O.B. scan all the purchasing transactions you've recorded; as a result, it 
will take more time to record your purchasing transactions. Therefore, be sure you want to use this feature before you
mark this selection.



Warn if Supplier has an Outstanding Credit Before Applying a 
Payment
Mark this selection if you want an alert message to appear if you have oustanding debit purchases with a supplier 
and you attempt to make a payment to that supplier.

If you mark this selection, an alert message will appear when you enter a supplier name in the Supplier field of the Bill
Payments window, and you have outstanding debit purchases with that supplier. This message is informational only; 
you can continue to enter the payment, if you wish.



Warn if Supplier Owes Me Money Before Making a Bill Payment
Mark this selection if you want an alert message to appear if a customer has outstanding credit notes with your 
business and you attempt to apply a payment from that customer.

If you mark this selection, an alert message will appear when you enter a customer name in the Customer field of the 
Customer Payments window, and that customer has outstanding credit notes with your business. This message is 
informational only; you can continue to enter the payment, if you wish.



Windows button
Click this button to open the Window Patterns window, where you can establish the colours and patterns of the 
windows you display in M.Y.O.B.



Card File Entry window

The Card File Entry window allows you to add, change, delete and view information about individual customer, 
suppliers, employees and personal contacts - known as cards.

Fields in this window:

Creditor Balance
Debtor Balance
Address
Card Type
Town
Close button
Company
Company Name
Contact Name
Fax No.
First Name
History button
Identifiers
Individual
Last Name
Log button
New button
Notes
Phone No.1
Phone No.2
Phone button
Salutation
Del. to.
County
Terms button
Track Sales History
Postcode



Creditor Balance
This field displays the current outstanding balance of your purchasing transactions with the supplier displayed in this 
window. To view the Analyse Creditors window, containing a list of the transactions that comprise this balance, click 
the zoom arrow.

This field appears only if you're viewing a supplier card.



Debtor Balance
This field displays the current outstanding balance of the sales transactions for the customer displayed in this window.
To view the Analyse Debtors window, containing a summary list of the transactions that comprise this balance, click 
the zoom arrow.

This field appears only if you're viewing a customer card.



Address
Enter the address for the card displayed in this window.

If you're viewing a supplier card, two Address fields appear in this window. The first Address field is the supplier's 
main address; this address will be used on purchase orders  you create. The second Address field is the supplier's 
secondary address, if you need to send purchase orders to an address other than the main address.



Card Type
Choose a type of card - Customer, Supplier, Employee or Personal - from the list.

You don't have to track individual customers if you don't want to. However, if your company makes sales of any type, 
you'll need to set up at least one customer card. You may want to name this card "Cash Customer" or something 
similar to distinguish it as a card used to track sales transactions.

Similarly, if you don't track individual suppliers, you'll need to set up at least one supplier card if you make purchases 
of any type. You may wish to set up a supplier card named "Cash Supplier" or something similar to distinguish it as a 
card used to track purchasing transactions.



Town
Enter the town in which this person or company is located.

If you're viewing a customer card, two Town fields appear in this window. The first Town field is the customer's main 
address; this town will be used in the address for invoices. The second Town field is the customer's "deliver to" 
address; this town name will be used in invoices and delivery labels.

If you're viewing a supplier card, two Town fields also appear in this window. The first Town field is the supplier's main 
address; this town will be used in the address for purchase orders. The second Town field is the supplier's secondary 
address, if you need to send purchase orders to an address other than the main address.



Company
Choose this selection if you wish to set up a card in the Card File for a company or organisation.



Company Name
Enter the name of a company you wish to add to the Card File.



Contact Name
Enter the name of the person with whom you regularly do business for the person or company whose card is 
displayed in this window.

The name you enter here can be used as the addressee for personalised letters. 

See also

Creating personalised letters 



Fax No.
Enter the fax number of the person or company whose card you're viewing.



First Name
Enter the first name of a person you want to add to your Card File.



History button
Click this button to open the Sales History window, which allows you to view and enter sales totals from the pervious 
and current financial years for the customer or employee card you're viewing.

This button is available only if you're viewing a customer or employee card, and you've marked the Track Sales 
History selection in this window.



Identifiers
Enter up to 10 identifiers for the person or company whose card you're viewing. If you wish to view or add to the list of
identifiers you can use, click the zoom arrow; the Identifiers window will appear.



Individual
Choose this selection if you wish to set up a card in the Card File for an individual person or a specific company 
contact.



Last Name
Enter the last name of a person you want to add to your Card File.



Log button
Click this button to open the View Contact Log window, which allows you to view a summary list of all contacts made 
to the person or company whose card you're viewing.



Notes
Use this field to enter additional information about the person or company whose card you're viewing.



Phone No.1
Enter the telephone number of the person or company whose card you're viewing.

See also

Entering telephone numbers for modem use 



Phone No.2
Enter the telephone number of the person or company whose card you're viewing.

See also

Entering telephone numbers for modem use 



Salutation
Enter a name or title you wish to use in the greeting of a personalised letter for the person or company whose card 
you're viewing. For example, if you want to greet a customer named Kara Watanabe as "Kara," enter Kara in this 
field. The personalised letters you create for Kara Watanabe will begin with "Dear Kara."

See also

Creating personalised letters 



Del. to.
Enter the address to which items are delivered to the customer displayed in this window.

If this entry is the same as the entry you made in the Address field, you can leave this field blank.

This address will appear as a default on the customer's invoices. You can override the address on individual invoices,
if you want.



County
Enter the county in which this person or company is located.

If you're viewing a customer card, two County fields appear in this window. The first County field is the customer's 
main address; this county will be used in the address for invoices. The second Town field is the customer's "deliver 
to" address; this county name will be used on invoicesand delivery labels.

If you're viewing a supplier card, two County fields also appear in this window. The first County field is the supplier's 
main address; this county will be used in the address for purchase orders. The second County field is the supplier's 
secondary address, if you need to send purchase orders to an address other than the main address.



Terms button
Click this button to open the Credit Terms window, where you can create a set of credit terms for the customer or 
supplier displayed in this window.

When you create a set of default terms using the Credit Terms window here, the terms you select will be applied only 
to the customer or supplier displayed in this window. If you wish, you can create a set of default terms for all new 
customers and suppliers in the M.Y.O.B. system. To do this, open the Credit Terms window by clicking the Terms 
button in the Preferences window.



Track Sales History
Mark this selection if you want to keep monthly sales totals, known as history, for the person or company whose card
you're viewing. You can track sales totals for customers and employees (salespeople).

Totals are stored for the previous financial year  and the current financial year. Use the Analyse Sales window  to 
review the collected totals in detail.

This field appears only if you're viewing a customer or employee card.

Sales history figures use considerable disk space. If you don't need to track sales history for a customer or employee,
be sure this selection isn't marked.



Postcode
Enter the post code in which this person or company is located.

If you're viewing a customer card, two postcode fields appear in this window. The first postcode field is the customer's
main address; this code will be used in the address for invoices. The second postcode field is the customer's "deliver 
to" address; this code will be used in invoices and delivery labels.

If you're viewing a supplier card, two postcode fields also appear in this window. The first postcode field is the 
supplier's main address; this code will be used in the address for purchase orders. The second postcode field is the 
supplier's secondary address, if you need to send purchase orders to an address other than the main address.



Contact Log Entry window

The Contact Log Entry window allows you to note every time you call, meet, bill or otherwise contact a person or 
company in the Card File. You can also use this window to place a telephone call to a person or company in the Card 
File.

Fields in this window:

Cancel button
Date
Elapsed Time
Log button
Name
New button
Notes
Phone button
Recontact Date
Record button



Date
Enter the date this contact was made.



Elapsed Time
Enter the duration of the contact, up to 99 hours and 59 minutes. If you bill for time spent with customers, you can 
use this field to track your time billing.

You can make your entry in either HH:MM format (where HH is the number of hours and MM the number of minutes), 
or by entering the total number of minutes the contact lasted. If the total number of minutes is 60 or larger, the field 
will convert the number to an hourly format (for example, 61 minutes will appear as 01:01).



Log button
Enter a card name in the Name field, then click this button to open the View Contact Log window, where you can view
a summary list of all contacts made to the card.



Name
If you wish to enter information about a contact made with a person or company that already exists in the Card File, 
enter the name in this field or click the search icon to display a list of cards to search from.

If you wish to enter information about a contact made with a person or company not in the Card File, enter the name 
of the person or company, then press TAB or RETURN; a search list of all cards in the Card File will appear. Click 
New; the Card File Entry window  will appear, where you can enter information about the person or company. When 
you click Record, the Contact Log Entry window will appear again, and you can enter the contact information.



Notes
Enter a description of the contact, using up to 255 characters.



Recontact Date
Enter the next date you should contact this person or company.

This date will be stored in the To Do List, where a reminder will appear on the date you entered here.

See also

Using Recontact Date 



Account Classification
If you're creating a new account, select the type of account you're creating. If you're viewing an existing account's 
information, the account's classification appears here.

Each account in an M.Y.O.B. chart of accounts is assigned a unique number that consists of a one-digit prefix and 
four-digit number. The prefix is a fixed number that's assigned to the account classification. Prefixes in M.Y.O.B. are 
assigned to account classifications in the following manner:

1 Asset accounts
2 Liability accounts
3 Capital accounts
4 Income accounts
5 Cost of sales accounts
6 Expense accounts
8 Other income accounts
9 Other expense  accounts



Account Name
Enter up to 30 characters to describe this account.



Account Number
Enter the four-digit account number used to uniquely identify this account. Any four digits except 0000 can be used in 
the account number. If you enter fewer than four digits, zeros will be added to the end of the number. When you enter
an account number, the number will be automatically placed in the chart of accounts list in numerical order.

You can change the number of an account at any time; however, we suggest you keep the same account numbers if 
you've used M.Y.O.B. for some time, because a new numbering system may be confusing to remember.



Budgets button
Click this button to open the History and Budgets window, where you can create monthly budgets for this account.

This button is available only if a detail account  is displayed in the window.



Current Balance
This field displays the current balance of this account. If this is a header account, this field displays the sum of all the 
detail accounts assigned to it.

If this is an asset, liability or capital account, the amount shown here is the value of the account. If this is an income, 
expense, cost of sales, other income or other expense  account, the amount shown here is the total of all activity with 
the account since the beginning of the current financial year.

If this is a detail account and you want to view more information about the account balance, click the zoom arrow. 
The Inquiry Register window will appear, listing the transactions that make up the current balance.

If you're viewing the capital account named Current Year Earnings, the current balance displayed is your company's 
year-to-date profit or loss amount.



Detail Account (Postable)
Choose this selection if you intend to assign transactions to the account you're creating. If this selection is marked for
an existing account, the account has already been designated as a detail account.

Each detail account is assigned to the header account  that appears directly above it in the list in the left-hand side of 
the Chart of Accounts window. Detail accounts appear in plain type, and header accounts appear in bold type.

Transaction amounts can be assigned (posted) to detail accounts; that is, when you enter a transaction in M.Y.O.B., 
you can enter the number of a detail account. The amount of the transaction will then be included in the balance of 
the detail account.

If a detail account has bank privileges - in other words, if the account is a "bank account" - don't choose this 
selection. Instead, choose the Detail Bank Account (Postable) selection.

Detail accounts can be Level 2, Level 3 or Level 4. See also Account levels.

The capital account named Current Year Earnings is a detail account, but it can't have transactions assigned to it. 
This account, used by M.Y.O.B. to record your company's profit or loss, uses your year-to-date profit or loss as its 
current balance.



Detail Bank Account (Postable)
Choose this selection if you intend to assign transactions to the account you're creating, and you want to write 
cheques using the funds in this account. If this selection is marked for an existing account, the account has already 
been designated as a detail bank account.

Accounts with bank privileges appear in lists in transaction windows throughout the M.Y.O.B. system. Each time you 
write a cheque in M.Y.O.B., you can select the bank account you want to use.

Each detail bank account is assigned to the header account  that appears directly above it in the list in the left-hand 
side of the Chart of Accounts window. Detail bank accounts appear in plain type, and header accounts appear in bold
type.

Transaction amounts can be assigned (posted) to detail accounts; that is, when you enter a transaction in M.Y.O.B., 
you can enter the number of a detail bank account. The amount of the transaction will then be included in the balance
of the detail bank account.

Detail accounts can be Level 2, Level 3 or Level 4. See also Account levels.

This selection should be used only if this is an asset  or liability account.

Cheque numbers are entered in windows such as Write Cheques, where you write your cheques. Each time you write
a cheque in M.Y.O.B., the next cheque's number will increment by one. If you change the number when you create a 
cheque, the next cheque's number will increment by one from the number you entered.



Header Account (Non-Postable)
Choose this selection if the account you're creating is intended to be used as a title of a group of accounts. If this 
selection is marked for an existing account, the account has already been designated as a header account.

Header accounts are used only for grouping accounts of a similar purpose. Typically, header accounts have detail 
accounts  "under" them; that is, detail accounts are assigned to specific header accounts. In the list in the left-hand 
side of the Chart of Accounts window, header accounts appear in bold type, and the detail accounts appear below 
them in plain type at the next level.

Transaction amounts can't be assigned (posted) to header accounts - only to detail accounts. You can, however, 
combine the amounts of all the detail accounts under a header account and display the total amount on reports. To do
this, mark the selection in this window named When Reporting, Generate a Subtotal for This Section.

Header accounts aren't required in M.Y.O.B., except for the eight Level 1 accounts (asset, liability, income, expense, 
capital, cost of sales, other income and other expense). Header accounts you create must be either Level 2 or Level 
3. See also Account levels.



Linked Account for
This field displays the types of transactions this account is linked to. When an account is linked to a particular type of 
transaction, that account's balance is automatically updated whenever a transaction of that transaction type is 
entered anywhere in M.Y.O.B. For example, one asset account is linked to all sales transactions that result in money 
owed to you; each time you enter a sales transaction that's not fully paid at the time of the sale, the amount you're 
owed will automatically be added to that account's balance.

To view the window in which the account was linked to a transaction type, click the zoom arrow. If this field displays 
Unlinked, you can link the account to a transaction type using the Linked Accounts command  in the Setup menu.



Opening Balance
Enter the balance of this account as of the first day of your conversion month. If an amount already appears in this 
field, you may have already entered an opening balance for this account in the Account Opening Balances window.



When Reporting, Generate a Subtotal for This Section
Mark this selection if you want to combine the amounts of all the detail accounts  under this header account  and print
the total amount on reports.

This selection appears only if a header account is displayed in this window.



Account Historical Balances window

The Account Historical Balances window allows you to view balances of the detail accounts  in your chart of accounts
for the current and previous financial years. You can also enter the balances of detail accounts for the months before 
you began using M.Y.O.B.

See also

Setting up Nominal Ledger 



Account Opening Balances window

The Account Opening Balances window allows you to enter the balance of each account in your chart of accounts  as
of the first day of your conversion month - the month in which you begin using M.Y.O.B. to track your business.

See also

Setting up Nominal Ledger 



Purchase Ledger Linked Accounts window
The Purchase Ledger Linked Accounts window allows you to review and change the linked accounts assigned to your
M.Y.O.B. purchasing transactions. 

These accounts are automatically linked when you create a new data file using the M.Y.O.B. Setup Interview. You 
may wish to review the linked accounts, to be sure they're the ones you want to use.

See also

Setting up Purchase Ledger 
Using the Linked Accounts commands 



Sales Ledger Linked Accounts window
The Sales Ledger Linked Accounts window allows you to review and change the linked accounts assigned to your 
M.Y.O.B. sales transactions. 

These accounts are automatically linked when you create a new data file using the M.Y.O.B. Setup Interview. You 
may wish to review the linked accounts, to be sure they're the ones you want to use.

See also

Setting up Sales Ledger 
Using the Linked Accounts commands 



Adjustment Information window

The Adjustment Information window allows you to enter the expense account  you wish to use to track the expense of
quantities that are no longer in your stock.

See also

Count Stock window 



Ageing Date window (Analyse Creditors)

The Ageing Date window allows you to set the criteria for how information about the suppliers you owe money to will 
appear in the Analyse Creditors window.



Ageing Date window (Analyse Debtors)
The Ageing Date window allows you to set the criteria for how information about the customers who owe you money 
will appear in the Analyse Debtors window.



Analysis Selection window (Analyse Balance Sheet)

The Analysis Selection window attached to the Analyse Balance Sheet window allows you to set the criteria for how 
your asset, liability and capital accounts will appear in the Analyse Balance Sheet window.



Analysis Selection window (Analyse Profit & Loss)

The Analysis Selection window attached to the Analyse Profit & Loss window allows you to set the criteria for how 
your income, cost of sales, expense, other income  and other expense  accounts will appear in the Analyse Profit & 
Loss window.



Analysis Selection window (Analyse Sales)

The Analysis Selection window attached to the Analyse Sales window allows you to set the criteria for how your sales
information will appear in the Analyse Sales window.



Analyse Balance Sheet window

The Analyse Balance Sheet window allows you to view detailed information about your asset, liability and capital 
accounts - known collectively as your "balance sheet accounts." This window, using criteria set in the Analysis 
Selection window, also provides a graph feature that allows you to view illustrated reports of your account activity.

The information that's displayed in this window depends upon the selections you made in the Analysis Selection 
window. For example, if you selected This Year's Actuals Only, the information that appears in this window will include
each balance sheet account's balance and percentage of its account type for the current financial year.

You can view this window in two ways: Ledger View and Graph View. Ledger View provides a list of your asset, 
liability and capital accounts, along with their corresponding amounts. Ledger View is available for any selection you 
make in the Analysis Selection window. Graph View displays graphs of either your asset, liability or capital accounts, 
along with a list of their each account's percentage of the entire account type. Graph View can be displayed if you 
selected This Year's Actuals Only, Last Year's Actuals Only or Budgets Only in the Analysis Selection window.



Analyse Stock window

The Analyse Stock window allows you to review the current status of the items you've entered into the M.Y.O.B. 
system. The fields in this window are view-only; that is, you can't change any of the information using this window.

This window shows quantity information only. If you want to see past sales activity of items, use the Analyse Sales 
window to do so.

Two different views are available for this window: Summary and Detail. Summary View, displayed by choosing the 
Summary selection at the top of the window, allows you to view quantity information for all items in the M.Y.O.B. 
system. Detail View, displayed by entering a specific item number in the Item No. field at the top of the window, allows
you to view pending transaction information for a single item at a time. Detail View can also be displayed from 
Summary View by clicking a zoom arrow  next to an item's number.



Analyse Creditors window

The Analyse Creditors window allows you to view detailed information about the suppliers you owe money to and how
long you've owed it to them. The information in this window is based upon the entries you make in the Ageing Date 
window.

Three views are available for this window: Summary View, Supplier Detail View and Purchase Detail View. Each view 
displays a different level of detail about the money you owe.



Analyse Profit & Loss window

The Analyse Profit & Loss window allows you to view detailed information about your income, cost of sales, expense, 
other income  and other expense  accounts - known collectively as your "profit and loss accounts."

The information that's displayed in this window depends upon the selections you made in the Analysis Selection 
window. For example, if you selected This Year's Actuals Only in the Analysis Selection window, the information that 
appears in this window will include each profit and loss account's balance and percentage of its account type.



Analyse Debtors window

The Analyse Debtors window allows you to view detailed information about the customers who owe you money and 
how long they've owed it to you. The information in this window is based upon the entries you make in the Ageing 
Date window.

Three views are available for this window: Summary View, Customer Detail View and Invoice Detail View. Each view 
displays a different level of detail about the money owed to you.

Summary View displays all the money that's owed to you, totalled by customer. Customer Detail View displays all the 
money that's owed to you by the customer whose name appears in the Customer Detail field at the top of the window.
Invoice Detail View displays all the transactions assigned to the sales transaction that appears in the Invoice Detail 
field for the customer whose name appears in the Customer Detail field at the top of the window. 



Analyse Sales window

The Analyse Sales window allows you to view detailed information about your sales activity. This window, using 
criteria set in the Analysis Selection window, also provides a graph feature that allows you to view illustrated reports 
of your sales activity.

The information that's displayed in this window depends upon the selections you made in the Analysis Selection 
window. For example, if you selected This Year's Actuals Only, the information that appears in this window includes 
information about the current financial year's sales activity only. In addition, the icons that appear at the bottom of this
window will change depending upon your choices in the Analysis Selection window.



Auto-Build Info window

The Auto-Build Info window is used to indicate the components used to create the finished item currently displayed in 
the Item Information window. The information entered in this window is used to properly increase quantities of 
finished items and decrease quantities of components used to create finished items when you use the Auto-Build 
Stock window.



Backorder List window

The Backorder List window allows you to automatically build, buy or backorder more of an item you're including on an
item invoice  in the Sales window.

This window appears only if you've indicated you want to sell more of an item than you currently have in stock, using 
the Deliver column of the Sales window. For example, if you enter 1,000 in the Deliver column but only have 500 of 
the item on hand, this window will appear when you click the Record button in the Sales window.

The list in this window contains only the items for which you've entered a quantity in the Deliver column of the Sales 
window that's greater than your on-hand quantities.



Budget Shortcuts window

The Budget Shortcuts window allows you to quickly set an account's budget amounts for all months in the current 
financial year.

See also

Using budget shortcuts 



Business Calendar window

The Business Calendar window allows you to:

* Establish the days in which your business is closed for the upcoming year, so reminders on your To Do List appear 
on open-for-business days

* Note which days of the year contain important company events



Change Default Forms Font window

The Change Default Forms Font window allows you to change the font and font size that's assigned to the forms 
(such as cheques, invoices and statements) you can print using M.Y.O.B.



Change Default Report Font window

The Change Default Report Font window allows you to change the font and font size that's assigned to the reports 
you can print using M.Y.O.B.



Change Default Windows Font window

The Change Default Windows Font window allows you to change the font and font size that's assigned to all windows
in M.Y.O.B.

This window is available only if you're using M.Y.O.B. for Windows.



Colours window

The Colours window allows you to change the colour of various parts of the M.Y.O.B. system.

This window is available only if you're using M.Y.O.B. for Macintosh.



Create Report Batches window

The Create Report Batches window allows you to create groups of reports that you can print using the Run Report 
Batches window.

See also

Creating a report batch 
Printing a report batch 



Credit Terms window

The Credit Terms window allows you to set up various credit terms  for customers and suppliers. Depending upon 
how you opened this window, you can set credit terms for individual customers and suppliers, or for all new customer 
and supplier records you create.

You can open this window in two ways: by clicking the Terms button in the Card File Entry window  or by clicking the 
Terms button in the Preferences window.

The functions and fields of this window differ, depending upon whether you're viewing the terms of a customer or a 
supplier. 



Customise window

The Customise window allows you to customise the look of your printed forms, such as cheques, invoices and 
customer statements. Using this window, you can rearrange the layout of items that appear on specific forms you 
use, so you and your customers, employees, suppliers and partners won't need to acquaint yourselves with new 
documents.

When you first open the Customise window for a form, you'll notice that a number of boxes appear in a large layout 
window. These boxes indicate all the data fields that are available for the form, and how much space each field uses 
on the form. The field names that are displayed are assigned by M.Y.O.B. and can't be changed; likewise, no fields in 
the window can be removed. However, if you don't want to print a field on the form, you can inactivate it.

See also

Working with forms 



Customise Reports window

The Customise Reports window allows you to determine how you want the printed output of individual reports to look.

The left side of this window contains seven sections - Company, Address, Report, Headers, Subtitles, Body and 
Subtotals - that correspond to the seven sections of each M.Y.O.B. report. If a section doesn't apply to a particular 
report, the section won't contain any information in this window. If you want to change the aspects of a specific 
section, click the section.

The right side of this window contains various characteristics that can be changed in the report, such as the font, font 
size, style and margins. After you've selected a section in the left-hand side of this window, you can change the 
section's characteristics using the right-hand side of the window.



Default Font Selection window

The Default Font Selection window allows you to access the Change Default Font windows, where you can modify 
the look of various aspects of the M.Y.O.B. system.



Edit Accounts window

The Edit Accounts window allows you to add new accounts and make changes to existing accounts in your chart of 
accounts. See also Setting up Nominal Ledger.

Fields in this window:

Account Classification
Account Name
Account Number
Budgets button
Current Balance
Detail Account (Postable)
Detail Bank Account (Postable)
Header Account (Non-Postable)
Linked Account for
New button 
Opening Balance
When Reporting, Generate a Subtotal for This Section



Edit Comments window

The Edit Comments window allows you to add, change or remove comments from the M.Y.O.B. system.



Edit Job window

The Edit Job window allows you to change information about existing jobs in your company.



Edit Delivery Methods window

The Edit Delivery Methods window allows you to add, change or remove delivery methods from the M.Y.O.B. system.



Export Data window

The Export Data window allows you to select specific information to export from your M.Y.O.B. data file. This window 
also works with the information you entered in the Export File window to create export files.

See also

Using the Import Data and Export Data commands 



Export File window

The Export File window allows you to select criteria for exporting information from your M.Y.O.B. data file.

See also

Using the Import Data and Export Data commands 



Field Information window - Data Field

The Field Information window for data fields allows you to determine various characteristics of individual data fields 
you select in the Customise window for forms such as cheques, invoices and customer statements.



Field Information window - Line

The Field Information window for lines allows you to determine various characteristics of individual lines you select in 
the Customise window for forms such as cheques, invoices and customer statements.

See also

Working with forms 



Field Information window - Picture

The Field Information window for pictures allows you to determine various characteristics of individual picture fields 
you select in the Customise window for forms such as cheques, invoices and customer statements.

See also

Working with forms 



Field Information window - Rectangle

The Field Information window for rectangles allows you to determine various characteristics of individual rectangle 
fields you select in the Customise window for forms such as cheques, invoices and customer statements.

See also

Working with forms 



Field Information window - Text Field

The Field Information window for text fields allows you to determine various characteristics of individual text fields you
select in the Customise window for forms such as cheques, invoices and customer statements.

See also

Working with forms 



Forms Info window

The Forms Info window allows you to adjust various settings for your printed forms.

This window is available only when the Customise window for a form is displayed, and is accessed from the Form 
menu.

See also

Working with forms 



Nominal Ledger Linked Accounts window

The Nominal Ledger Linked Accounts window allows you to review and change the linked accounts assigned to 
Nominal Ledger.

These accounts are automatically linked when you create a new data file  using the M.Y.O.B. Setup Interview. You 
may wish to review the linked accounts, to be sure they're the ones you want to use.

See also

Setting up Nominal Ledger 
Using the Linked Accounts commands 



Historical Purchase window

The Historical Purchase window allows you to enter individual purchasing transactions that occurred before your 
conversion month. The balances of the transactions you enter here should equal the outstanding purchasing balance 
your company has with each supplier you do business with.

See also

Setting up Purchase Ledger 



Historical Sale window

The Historical Sale window allows you to enter individual sales transactions that occurred before your conversion 
month. The balances of the transactions you enter here should equal the outstanding sales balance each customer 
has with your business.

See also

Setting up Sales Ledger 



History and Budgets window

The History and Budgets window allows you to create monthly budgets for a detail account selected in the Chart of 
Accounts window. The budgets you enter in this window can be used to review the progress of your accounts in the 
Analyse Balance Sheet and Analyse Profit & Loss  windows.

See also

Setting up Nominal Ledger 



Import Data window

The Import Data window allows you to select specific information to import into your M.Y.O.B. data file. This window 
also works with the information you entered in the Import File window  to import information from import files.

See also

Using the Import Data and Export Data commands 



Import File window

The Import File window allows you to select criteria for importing information into your M.Y.O.B. data file.

See also

Using the Import Data and Export Data commands 



Index to Reports window

The Index to Reports window allows you to select an M.Y.O.B. report to print.



Invoice Type window

The Invoice Type window allows you to select a type of sales transaction to enter in the Sales window. You have four 
choices: item invoice, service invoice, professional invoice and other sale.

See also

Creating a professional invoice 
Creating a service invoice 
Creating an item invoice 
Creating an other sale 



Item Sales History window

The Item Sales History window is used to enter and view historical sales activity for the past calendar year and 
current calendar year for the item displayed in the Item Information window. This window is accessed only if you've 
marked the I Sell This Item selection in the Item Information window.

Refer to the Getting Started manual for more information about setting up Stock.



Items List window

The Items List window allows you to view all the items you've created in M.Y.O.B., to begin adding new item records 
and to change or remove existing items.

See also

Item Information window 



Mailing Labels window

The Mailing Labels window allows you set up and print mailing labels for individual people or companies in the Card 
File.

See also

Customising a mailing label 



New Job window

The New Job window allows you to set up information about a new job in your company.



Supplier Balances window
The Creditor Balances window allows you to view the historical purchases whose amounts make up the balance of 
your linked creditors account. You can also open the Historical Purchase window from this window, where you can 
enter individual historical purchases.

Before you use this window, you should enter an opening balance for your linked creditors account in the Account 
Opening Balances window.

See also

Setting up Purchase Ledger 
Using the Balances commands 



Password Access window

The Password Access window allows you to prevent M.Y.O.B. users from accessing various parts of the program that
may contain sensitive information you don't want others to view or change.

See also

Using the Preferences command 



Personalised Letters window

The Personalised Letters window allows you to create a mail-merge file containing information about individual 
people or companies in the Card File, for the purpose of creating letters customised with each person's or company's 
name.

See also

Creating personalised letters 



Pie Slice Patterns window

The Pie Slice Patterns window allows you to establish the colours and patterns of the pie graphs you display in 
M.Y.O.B.

See also

Preferences window 



PO Type window

The PO Type window allows you to select a type of purchasing transaction to enter in the Purchases window. You 
have four choices: item purchase order, service purchase order, professional purchase order and other purchase.

See also

Creating a professional purchase order 
Creating a service purchase order 
Creating an item purchase order 
Creating an other purchase 



Pricing Shortcuts window

The Pricing Shortcuts window, accessed from the Set Item Prices window, allows you define prices for a number of 
items you sell.



Print Cheques window

The Print Cheques window allows you to print the cheques you've created in four windows in M.Y.O.B.:

* Write Cheques window  (Chequebook Command Centre)
* Settle Returns and Credits window  (Sales Ledger Command Centre)
* Bill Payments window  (Purchase Ledger Command Centre)

This window is accessed by selecting Print Cheques from the Chequebook Command Centre.

Using this window, you can also open a window where you can customise the printed cheques so they look like the 
cheques you use.

See also

Customising a cheque 



Print Invoices window

The Print Invoices window allows you to print the invoices you've created in the Sales window, as well as packing 
slips and delivery labels used in the delivery of items. Using this window, you can also open a window where you can 
customise the printed invoices so they look like the invoices you use.

See also

Customising an invoice 



Print Preview window

The Print Preview window allows you to view how the form you're customising in the Customise window will look on 
paper before you actually print it.

See also

Working with forms 



Print Purchases window

The Print Purchases window allows you to print the purchase orders you've created in the Purchases window. Using 
this window, you can also open a window where you can customise the printed purchase orders so they look like the 
purchase orders you use.

See also

Customising a purchase order 



Print Statements window

The Print Statements window allows you to print statements for customers with outstanding sales balances. Using 
this window, you can also open a window where you can customise the printed statements so they look like the 
statements you use.

See also

Customising a statement 



Purge Closed Purchases windows

The Purge Closed Purchases windows allow you to specify and purge the closed purchasing transactions you want to
remove from your M.Y.O.B. data file.

Before you purge information from your data file, be sure to print all reports that you wish to keep that show the 
closed information you intend to purge. You might consider printing a copy of the Purchases Journal, which contains 
detailed information about all purchasing transactions.

See also

Purging closed purchases 
Using the Purge commands 



Purge Closed Sales windows

The Purge Closed Sales windows allow you to specify and purge the closed sales transactions you want to remove 
from your M.Y.O.B. data file.

Before you purge information from your data file, be sure to print all reports that you wish to keep that show the 
closed information you intend to purge. You might consider printing a copy of the Sales Journal, which contains 
detailed information about all sales transactions.

See also
Purging closed sales 
Using the Purge commands 



Purge Contact Logs windows

The Purge Contact Logs windows allow you to specify and purge the contact logs you want to remove from your 
M.Y.O.B. data file.

Before you purge information from your data file, be sure to print all reports that you wish to keep that show the 
closed information you intend to purge. You might consider printing the Contact Log Report, which contains detailed 
information about all contacts.

See also
Purging contact logs 
Using the Purge commands 



Purge Journal Entries windows

The Purge Journal Entries windows allow you to specify and purge the journal entries  you want to remove from your 
M.Y.O.B. data file.

Before you purge information from your data file, be sure to print all reports that you wish to keep that show the 
closed information you intend to purge. You might consider printing any account inquiry report, which contains 
detailed information about accounts.

See also
Purging journal entries 
Using the Purge commands 



Recap Transaction window

The Recap Transaction window allows you to quickly view a summary of a transaction before you record it. This 
summary includes the name of the journal the transaction will be saved in - a helpful tool, if the journal isn't apparent 
by the type of transaction you're entering.

See also

Using the Recap Transaction command 



Customer Balances window
The Debtor Balances window allows you to view the historical sales whose amounts make up the balance of your 
linked debtors account. This window is also used to open the Historical Sale window, where you can enter individual 
historical sales.

Before you use this window, you should enter an opening balance for your linked debtors account in the Account 
Opening Balances window.

See also
Setting up Sales Ledger 
Using the Balances commands 



Report Selection windows

All report windows in M.Y.O.B. allow you to set criteria for how each report in M.Y.O.B. will present its information. 
Using a report window, you can also open the Customise Reports window, where you can customise the printed 
report output so it displays the information you want in the manner you want to view it.

Because the information that appears on different reports is different, the fields that appear in report windows will 
vary. However, report windows are essentially the same; they're divided into three sections, with the top two sections 
containing fields for the specific report and the bottom section containing fields that appear on each report window.



Restocking Information window

The Restocking Information window allows you to set parameters for how you want M.Y.O.B. to keep track of your 
stock items'  quantity levels. Using this window, you can specify when you want the To Do List to remind you to order 
more items, as well as information that will appear on the purchase order  you send to your primary supplier for each 
item, if you wish.



Review Before Processing Windows
These windows allow you to verify that the records you've chosen are the ones that you really want

See also

Review Cards Before Exporting Window 
Review Cheques Before Printing Window 
Review Invoices Before Printing window 
Review Labels Before Printing window 
Review Packing Slips Before Printing window 
Review Purchases Before Printing window 
Review Delivery Labels Before Printing window 
Review Statements Before Printing window 



Review Cards Before Exporting window

The Review Cards Before Exporting window allows you to verify that the records you've chosen to export into a mail-
merge file are the correct records. The mail-merge file can then be used to create personalised letters to the people 
or companies whose information you included in the file.

See also

Creating personalised letters 



Review Cheques Before Printing window

The Review Cheques Before Printing window allows you to review information about each of the cheques you 
selected in the Print Cheques window, as well as choose specific cheques to print.

See also

Writing a cheque 



Review Invoices Before Printing window

The Review Invoices Before Printing window allows you to review information about each of the invoices you selected
in the Print Invoices window, as well as choose specific invoices to print.

See also

Working with item invoices 
Working with professional invoices 
Working with service invoices 



Review Labels Before Printing window

The Review Labels Before Printing window allows you to review information about each of the mailing labels you 
selected in the Mailing Labels window, as well as choose specific labels to print.



Review Packing Slips Before Printing window

The Review Packing Slips Before Printing window allows you to review information about each of the packing slips 
you selected in the Print Invoices window, as well as choose specific packing slips to print.



Review Purchases Before Printing window

The Review Purchases Before Printing window allows you to review information about each of the purchase orders 
you selected in the Print Purchases window, as well as choose specific purchase orders to print.

See also

Working with item purchase orders 
Working with professional purchase orders 
Working with service purchase orders 



Review Delivery Labels Before Printing window

The Review Delivery Labels Before Printing window allows you to review information about each of the delivery labels
you selected in the Print Invoices window, as well as choose specific delivery labels to print.



Review Statements Before Printing window

The Review Statements Before Printing window allows you to review information about each of the statements you 
selected in the Print Statements window, as well as choose specific statements to print.



Run Report Batches window

The Run Report Batches window allows you to print a group of reports.

See also

Creating a report batch 
Printing a report batch 



Sales History window

The Sales History window allows you to view and enter sales totals from the previous and current financial years for 
the customer or employee whose card is currently displayed in the Card File Entry window.



Save Recurring Transaction window

The Save Recurring Transaction window allows you to duplicate a transaction you've created in any of the following 
windows:

* Nominal Journal Entry  (Nominal Ledger Command Centre)
* Write Cheques  (Chequebook Command Centre)
* Make a Deposit  (Chequebook Command Centre)
* Sales (Sales Ledger Command Centre)
* Purchases (Purchase Ledger Command Centre)

Recurring transactions you set up here can be chosen at any time in the future from the Select a Recurring 
Transaction window, which is opened by clicking the Use Recurring button in any of the windows listed above. You 
can also set a frequency for each transaction, which will cause the To Do List to inform you each time a recurring 
transaction is due to occur.

The fields in this window differ slightly, depending upon which window you used to open this window.



Select a Recurring Transaction window

The Select a Recurring Transaction window allows you to choose, change or delete a transaction you previously 
saved as recurring. You can access this window by clicking the Use Recurring button from any of the following 
windows:

* Nominal Journal Entry  (Nominal Ledger Command Centre)
* Write Cheques  (Chequebook Command Centre)
* Make a Deposit  (Chequebook Command Centre)
* Sales (Sales Ledger Command Centre)
* Purchases (Purchase Ledger Command Centre)

Recurring transactions that appear in this window apply only to the window you used to open this window.



Set Up M.Y.O.B. window

The Set Up M.Y.O.B. window allows you to follow the necessary setup procedures to get your business up and 
running with M.Y.O.B.

The checklists in this window allow you to set up your company, nominal ledger, sales and purchases information. For
each set of information you need, zoom arrows  are available for you to quickly navigate to the windows in which this 
setup information is entered. When a step is completed, a mark will appear next to the description of the step.

See also

"Setup" chapter of the Getting Started manual
Setup menu 
Setting up Nominal Ledger    
Setting up Purchase Ledger 
Setting up Sales Ledger 



Set Up Passwords window

The Set Up Passwords window allows you to access the Password Access window, enter new passwords and 
change existing passwords.

See also

Using the Preferences command 



Start a New Financial Year windows

The Start a New Financial Year windows allow you to complete the necessary steps to close the previous financial 
year and begin the next financial year.

See also

Starting a new financial year 



View Card File window

The View Card File window allows you to view summary information about all your customers, suppliers, employees 
and personal contacts. You can also open the Card File Entry window  from this window, where you can access more 
detailed information about the individual people and companies in the Card File.

This window contains a number of ways you can restrict your search for a specific card. The Search field at the top of
the window can be used to enter the name of a specific card, while the other fields in the window can be used to limit 
the search criteria to a specific card type, time frame, identifier and Postcode.

See also

Card File Command Centre 



View Contact Log window

The View Contact Log window allows you to display a summary list of all contacts made to a specific person or 
company in the Card File. You can also open the Contact Log Entry window from this window, where you can access 
more detailed information about individual contacts you've made.

See also

Card File Command Centre 



Window Patterns window

The Window Patterns window allows you to establish the colours and patterns of the windows you display in M.Y.O.B.

See also

Preferences window 




